Preface

This guide describes the Cisco Prime Network (Prime Network) 4.0 customization suite and provides instructions for using the components of the customization suite.

This preface includes the following topics:

- New and Changed Information, page xi
- Related Documentation, page xi
- Obtaining Documentation and Submitting a Service Request, page xii

New and Changed Information

The following table describes information that has been added or changed since this guide was first published.

<table>
<thead>
<tr>
<th>Date Released</th>
<th>Revision</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>October 3, 2013</td>
<td>Clarified that only users with Configurator or Administrator privileges can run transactions, and that these privileges can be further affected by the global setting for job scheduling.</td>
<td>Setup Tasks for Transaction Manager, page 5-2</td>
</tr>
<tr>
<td>September 8, 2013</td>
<td>Clarified the instructions explaining how to find the document Prime Network 4.0—Creating Prime Network Transactions on the Cisco Developer Network.</td>
<td>Creating Transactions Using the Prime Network XDE SDK, page 5-4</td>
</tr>
<tr>
<td>July 2013</td>
<td>Initial release.</td>
<td>—</td>
</tr>
</tbody>
</table>

Related Documentation

Note: We sometimes update the documentation after original publication. Therefore, you should also review the documentation on Cisco.com for any updates.

For a complete list of Prime Network 4.0 documentation, see the Cisco Prime Network 4.0 Documentation Overview.

Cisco Prime Network Integration Developer Guide is available on the Prime Network Technology Center. This guide describes how to use Prime Network integration interfaces.
The Prime Network Technology Center is an online resource for additional downloadable Prime Network support content, including help for integration developers who use Prime Network application programming interfaces (APIs). The website provides information, guidance, and examples to help you integrate your applications with Prime Network. It also provides a platform for you to interact with subject matter experts. To view the information on the Prime Network Technology Center website, you must have a Cisco.com account with partner level access, or you must be a Prime Network licensee. You can access the Prime Network Technology Center at:

**Obtaining Documentation and Submitting a Service Request**

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly *What’s New in Cisco Product Documentation*, which also lists all new and revised Cisco technical documentation, at:

Subscribe to the *What’s New in Cisco Product Documentation* as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.
Prime Network Customization Overview

Prime Network provides the ability to customize the application in order to extend its functionality beyond what is provided “out-of-the-box”.

Table 1-1 describes the extensions you can make to Prime Network and where to find the procedures that will guide you through the process.

<table>
<thead>
<tr>
<th>To make this extension:</th>
<th>Use these tools:</th>
<th>Described here:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Extend the Information Model</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extend the set of supported properties for a network element and display them in the Inventory window.</td>
<td>Soft Properties</td>
<td>Modeling and Displaying Additional NE Properties, page 2-1</td>
</tr>
<tr>
<td>Add support for currently unsupported device types.</td>
<td>VNE Customization Builder</td>
<td>Adding Support for Additional Device Types by Creating U-VNEs, page 3-6</td>
</tr>
<tr>
<td>Add support for currently unsupported device software versions</td>
<td>VNE Customization Builder</td>
<td>Adding Support for Additional Software Versions, page 3-11</td>
</tr>
<tr>
<td>Add support for new standard and pluggable modules</td>
<td>VNE Customization Builder</td>
<td>Add Support for Additional Modules, page 3-12</td>
</tr>
<tr>
<td><strong>Create New Commands and Activation Workflows for Configuring Devices</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create new device commands and add them to the GUI</td>
<td>Command Manager Command Builder</td>
<td>Creating Commands and Command Scripts to Perform Device Configuration Operations, page 4-1</td>
</tr>
<tr>
<td>Create new transactions to allow users to deploy activations to devices</td>
<td>Transaction Manager¹</td>
<td>Performing Device Configuration and Activation Workflows Using Transaction Manager, page 5-1</td>
</tr>
<tr>
<td><strong>Extend the GUI Client</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add launch points to external applications</td>
<td>External Launch procedure</td>
<td>Adding External Launch Points to the GUI Client, page 8-1</td>
</tr>
</tbody>
</table>
Tools for Extending Prime Network

This topic provides a brief introduction to the tools you can use to extend the features of Prime Network.

Soft Properties

The Soft Properties tool in Prime Network Vision enables you to extend the set of supported properties for a network element (NE), by adding new (soft) properties. These properties extend the Cisco Information Model Object (IMO) and are available through the client GUI as well as through the Broadband Query Language (BQL) API. Soft properties are retrieved from the NE using Simple Network Management Protocol (SNMP) or Telnet/Secure Shell Protocol (SSH). In addition, alarm thresholds enable you to constantly monitor selected properties and generate an alarm every time these properties cross a user-defined threshold or violate a condition. The Soft Properties tool is launched by right-clicking a VNE and choosing Management > Soft Properties Management. To use this tool, you must have Configurator privileges.

Command Manager and Command Builder

Prime Network Command Manager and Command Builder allow you to create customized commands and scripts that perform device configuration operations. Commands can range from simple show commands to wizards with multiple pages and input methods such as check boxes and drop-down lists. The commands you create execute a programmable sequence of SNMP or Telnet command lines. Once you have created and tested a new command, you can apply it to a wider scope of NEs. The new commands will be listed in the NE’s context-sensitive menu and can be executed from there. The commands can also be used to create transactions which call a sequence of commands.

Command Manager uses the Command Builder back-end, but it provides the following additional features:

- View the command repository, which displays all device-level commands that are available in the system
- Execute commands on multiple devices
- Use input from files to provide parameter substitution
- Apply versions to individual commands
- Create command packages

Table 1-1  Supported Extensions for Prime Network (continued)

<table>
<thead>
<tr>
<th>To make this extension:</th>
<th>Use these tools:</th>
<th>Described here:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Extend or Change Fault Management Capabilities</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add support for currently unsupported events</td>
<td>VNE Customization Builder</td>
<td>Adding Support for New Events Using the VCB, page 6-1</td>
</tr>
<tr>
<td>Change the way Prime Network deals with events</td>
<td>VNE Customization Builder</td>
<td>Customizing Existing Events, page 6-12</td>
</tr>
<tr>
<td>Create new threshold-crossing alarms</td>
<td>Soft Properties</td>
<td>Adding New Threshold-Crossing Alarms, page 7-1</td>
</tr>
</tbody>
</table>

1. Transaction Manager replaces the Prime Network Workflow and Action features in all new installations of Prime Network 4.0. If you have upgraded to Prime Network 4.0, the Workflow and Activation features are still available (see Creating Workflows and Wizards Using the Workflow Editor and Activation Features, page D-1). Because these features will be deprecated in the future, we recommend that you use Transaction Manager.
However, Command Manager commands can only be applied at the network element (IManagedElement) level, while Command Builder commands can be associated with any existing object group (IMO), type, or instance.

You can launch Command Manager from the main menu of the Change and Configuration Management (CCM) GUI. You must have Configurator privileges to run Command Manager. To open CCM, use the following URL:

http://gateway-IP:8043/ccmweb/ccm/login.htm

To launch Command Builder, right-click a VNE and choose Management. This client also requires Configurator privileges.

**Transaction Manager**

Transaction Manager provides a GUI framework you can use to schedule and run transactions (activation workflows) that are created using the Prime Network XDE Eclipse SDK. It replaces the Workflow and Activation Wizard Builder features that were provided in previous releases of Prime Network. You can also run transactions using the NBI.

Transaction Manager replaces the Prime Network Workflow and Action features in all new installations of Prime Network 4.0. If you have upgraded to Prime Network 4.0, the Workflow and Activation features are still available, but they will be deprecated in the future. We recommend that you use Transaction Manager.

You can launch Transaction Manager from the main menu of the Change and Configuration Management (CCM) GUI. You must have Configurator privileges to run Transaction Manager. To open CCM, use the following URL:

http://gateway-IP:8043/ccmweb/ccm/login.htm

**VNE Customization Builder (VCB)**

The VCB is a tool that allows you to enable support for currently unsupported device types, software versions, and modules. You can also use the VCB to make Prime Network process unsupported syslogs, traps, or service events as Prime Network events, or to customize the way in which Prime Network processes events.

You must have Configurator or Administrator privileges to use the VCB. The VCB GUI client is launched from the Prime Network Administration GUI client by choosing Tools > VNE Customization Builder or by using the following URL:


**External Launch**

You can add launch points to external applications or URLs to the right-click menu of NEs, links, tickets, and events. When the external launch point is clicked, it invokes the external application (for example, a script or batch file), or opens the specified URL in the default browser. You can also add filters so that the launch points are only displayed if the instance meets the filter requirements. You must have Configurator or higher privileges to use this procedure.

**Editing the Registry**

The Prime Network registry is a collection of xml files (called hives) that comprise and control the Prime Network system configuration. The registry contains almost all definitions and configurations used by Prime Network, including whether service alarms are correlated, the settings that control flapping, the severity, and so forth. You can change these parameters using the Registry Controller available from the Administration GUI client. Other parameters can be changed using the CLI. Those parameters are documented in this guide.
Modeling and Displaying Additional NE Properties

Prime Network models and displays a fixed set of network element properties in the Inventory windows. If there are additional properties you want to display and monitor, you can do so using Soft Properties. These topics explain how to use Soft Properties to add new network element properties to the Inventory window and control how these new properties are displayed:

- What are Soft Properties?, page 2-1
- Steps for Adding New NE Property Information to the Inventory, page 2-3
- Displaying a New Property in the Inventory Window, page 2-4
- Adding a New Inventory Table Containing SNMP get Details, page 2-11
- Making the Soft Property Available to Other NEs, page 2-14

Note

We recommend that the users who manage Soft Properties have the following:

- For their user account—Configurator or higher default permissions.
- For all assigned device scopes—Configurator or higher security level.

What are Soft Properties?

Soft properties are definitions that contain rules for retrieving new NE information, parsing the retrieved information, and displaying it in the Inventory window, either as an additional property or as a table. In effect, soft properties can be used to extend the default subset of device properties that Prime Network models. Using soft properties allows you to quickly adapt to new software upgrades and new requirements that arise during ongoing operation and deployment.

For example, consider the case where the Prime Network system monitors the port parameters of an ATM switch, and the operator installs a new software version on the switch that is capable of reporting the bit error rate (BER) for each of the ports. Since this capability was not supported in previous software versions of the NE, the Prime Network VNE might not support the property. To avoid the need for a new VNE from Cisco, you can immediately support the new BER feature by creating a soft property.
A soft property is implemented through a set of definitions that determine how to retrieve, parse, and display a certain MIB variable from the NE. Information can be retrieved from the NE using SNMP or Telnet/SSH, and the definitions are stored in the XML registry. You define the protocol and rules using the Soft Properties GUI client. The new properties are applied in runtime and do not require system restart.

You can also associate alarm conditions with a soft property and create a new TCA that will be displayed in the Prime Network Vision and Events GUI clients. Creating TCAs is described in Creating a New Threshold-Crossing Alarm, page 7-1.

When you develop the soft property, only the specific NE instance is affected so that you can debug it and determine any impact it may have on the VNE. When you restart the VNE, the soft property is applied to all similar components on that VNE. Then you can apply it to multiple devices and components.
Steps for Adding New NE Property Information to the Inventory

Figure 2-1 illustrates the steps required to define a new soft property.

The steps are described in these topics:
- Displaying a New Property in the Inventory Window, page 2-4
- Adding a New Inventory Table Containing SNMP get Details, page 2-11
- Creating a New Threshold-Crossing Alarm, page 7-1
Displaying a New Property in the Inventory Window

This procedure leads you through the process of creating a new Property type so that new NE attributes can be modeled and displayed in the Inventory window. This allows you to monitor a new attribute on an ongoing basis.

To create a new Property type soft property:

**Step 1** In Prime Network Vision, right-click the node on which you want to apply a new soft property. The node can be the NE itself or an inventory node. For example, you can create a soft property on a port.

**Step 2** Choose **Management > Soft Properties Management**.

The Soft Properties Manager dialog box opens and displays any existing soft properties for the selected node. As shown in Figure 2-2, the choices in the Properties Panel drop-down list align to the panels in the Inventory window for the selected node. For example, the properties panels for an ATM port are Location Information, ATM, and DS3.

**Figure 2-2  Soft Properties Manager Dialog Box**

**Step 3** From the Panel Properties drop-down list, choose the inventory panel in which you want the new property to be displayed.

**Step 4** Open the Add Soft Property dialog box by choosing **File > New Element**.

**Step 5** In the General tab, define the general parameters for the soft property.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique identifier for the soft property.</td>
<td>sp01</td>
</tr>
<tr>
<td>Label</td>
<td>Identifying text that will be displayed in Inventory window.</td>
<td>My Soft Property</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) Description of the soft property</td>
<td>Example of soft property</td>
</tr>
<tr>
<td>Type</td>
<td>Type of soft property, which determines the format of the information. In this case, select <strong>Property</strong> to display the defined information in the form of an additional field in the Inventory window. Telnet/SSH or SNMP is used to retrieve and parse information from the NE.</td>
<td>Property</td>
</tr>
</tbody>
</table>
Chapter 2  Modeling and Displaying Additional NE Properties

Displaying a New Property in the Inventory Window

### Step 6
In the Parsing tab, select the protocol you want to use to retrieve the information.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use SNMP get(OID)</td>
<td>SNMP retrieval expression. The SNMP OID must start with a dot.</td>
</tr>
<tr>
<td></td>
<td>1. Enter the OID in the text box; for example:</td>
</tr>
<tr>
<td></td>
<td>.1.3.6.1.2.1.2.2.1.16.</td>
</tr>
<tr>
<td></td>
<td>2. With the cursor in the text box, click <strong>Ctrl-Spacebar</strong> to display the available fields and their current values.</td>
</tr>
<tr>
<td></td>
<td>3. Choose a field from the drop-down list and press <strong>Enter</strong>. The variable is populated in the text box with surrounding $ characters. This example retrieves the interface OutOctets:</td>
</tr>
<tr>
<td></td>
<td>.1.3.6.1.2.1.2.2.1.16.$ifIndex$</td>
</tr>
<tr>
<td>Use Telnet/SSH</td>
<td>The Telnet/SSH retrieval expression. (To use Telnet, it must be enabled on the device.)</td>
</tr>
<tr>
<td></td>
<td>1. Enter the Telnet/SSH command in the text box; for example:</td>
</tr>
<tr>
<td></td>
<td><em>show interface</em></td>
</tr>
<tr>
<td></td>
<td>With the cursor in the text box, click <strong>Ctrl-Spacebar</strong> to display the available fields and their current values. For example:</td>
</tr>
<tr>
<td></td>
<td>2. Choose a field from the drop-down list and press <strong>Enter</strong>. The variable is populated in the text box with surrounding $ characters. For example, when this command is executed, $portalias$ will be replaced with Ethernet1/0:</td>
</tr>
<tr>
<td></td>
<td>.1.3.6.1.2.1.2.2.1.16.$portAlias$</td>
</tr>
</tbody>
</table>

### Step 7
Define parsing rules. You can create multiple rules in order to retrieve exactly the information you require. Click **Add** to start defining your parsing rules.
The Add/Edit Parsing Rule dialog box appears.

**Figure 2-3  Add/Edit Parsing Rule Dialog Box**

1. **Input Buffer**—Determines what input will be used for the parsing rule. The drop-down list in this field contains a blank item representing the default input, and a list of variables created by redirecting the output of previous rules (if any).

   If the input buffer is blank (default), the output of the previous parsing rule is used as this rule’s input unless the output of the previous rule was directed to an output variable. In this case, the default input is the output of the last rule that was not directed to an output variable. For example, you create Rule 1. Then you create Rule 2 and Rule 3, but you redirect Rule 3’s output to a variable. When you create Rule 4, it will use the output from Rule 2 as its input. That is because Rule 2 is the last rule with output that was not redirected.


3. **Direct result to output buffer variable** check box—When checked, you can save the parsing output as a variable with a unique name. This means that the output will not automatically be used as the input for the next rule, but the variable will be available for selection as the input for subsequent rules defined for this soft property.

4. **Simulation panel**—Allows you to test the rule by entering your rule and clicking **Test Expression**. This information is not saved when you close the window.

5. The parsed result that is displayed after clicking **Test Expression**. This information is not saved when you close the window.
Step 8  To simulate the parsing rule without sending the command to the device:

a. Enter the text into the top Simulation window. For example:

<table>
<thead>
<tr>
<th>Name</th>
<th>Default RD</th>
<th>Interfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>example</td>
<td>55:55</td>
<td>example</td>
</tr>
</tbody>
</table>

b. Click Test Expression. The parsing rule result is displayed, as shown in Figure 2-4.

Figure 2-4  Match Parsing Rule
Step 9  Click OK. The rule is added to the Parsing tab, as shown in Figure 2-5.

Figure 2-5  Parsing Tab with Match Parsing Rule

Step 10  Click Add to create another parsing rule. For example:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Substring</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Index</td>
<td>1</td>
</tr>
<tr>
<td>Length</td>
<td>1</td>
</tr>
<tr>
<td>Simulation text box</td>
<td>55</td>
</tr>
</tbody>
</table>
Step 11  Click **Test Expression**. The result 5 is displayed in the Result text box, as shown in Figure 2-6.

*Figure 2-6  Substring Parsing Rule*

Step 12  Click **OK**. The rule is added to the Parsing tab, as shown in Figure 2-7.

*Figure 2-7  Parsing Tab with Match and Substring Parsing Rules*
Step 13  To simulate the rule sequence without sending any commands to the device:
  a. From the Add Soft Property dialog box (Parsing tab), click **Test** to open the Test Parsing Rules dialog box.
  b. Copy the output of the native commands into the Input Buffer.
  c. Click Test (in the Test Parsing Rules dialog) and verify the results.
     a. Click **Close**.

Step 14  To send the command to the device to check its validity, in the Add Soft Properties dialog box, click **Debug**.

**Note**  No notification message is displayed when a VNE fails to collect properties. The properties are simply not populated in the GUI.

The results of the test are displayed Debug Soft Property dialog box.

Step 15  The Debug Soft Property dialog box is displayed.

*Figure 2-8  Debug Soft Property Dialog Box*

Step 16  After the Status is returned as valid, confirm that the input parameters have returned the correct values; for example:

Telnet Commands=[show ip vrf example]

Step 17  Click **Close** to exit the Debug Soft Property window.
Adding a New Inventory Table Containing SNMP get Details

This procedure leads you through the process of creating a new Table type soft property that extracts information from the MIB and displays it (in a table) in the Inventory window.

To create a new Table type soft property:

**Step 1** In Prime Network Vision, right-click the node on which you want to apply a new soft property. The node can be the NE itself or an inventory node. For example, you can create a soft property on a port.

**Step 2** Choose Management > Soft Properties Management.

The Soft Properties Manager dialog box opens and displays any existing soft properties for the selected node. As shown in Figure 2-2, the choices in the Properties Panel drop-down list align to the panels in the Inventory window for the selected node. For example, the properties panels for an ATM port are Location Information, ATM, and DS3.
Adding a New Inventory Table Containing SNMP get Details

**Step 3**
From the Panel Properties drop-down list, choose NE inventory panel in which you want the new property table to be displayed.

**Step 4**
Open the Add Soft Property dialog box by choosing **File > New Element**.

**Step 5**
Define the general parameters for the soft property in the General tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique identifier for the soft property.</td>
<td>sp02</td>
</tr>
<tr>
<td>Label</td>
<td>Identifying text that will be displayed in Inventory window.</td>
<td>My Soft Table</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) Description of soft property</td>
<td>Example of a Soft Table</td>
</tr>
<tr>
<td>Type</td>
<td>Type of soft property, which determines the format of the information.</td>
<td>Table</td>
</tr>
<tr>
<td>Polling Rate</td>
<td>Rate at which Prime Network will poll the NE for the information.</td>
<td>Status</td>
</tr>
<tr>
<td>Enabled</td>
<td>Whether the VNE is running the command.</td>
<td>(Selected)</td>
</tr>
</tbody>
</table>

**Step 6**
Define the SNMP retrieval expression. The SNMP OID must start with a dot.

a. Enter the OID in the text box; for example:
   
   .1.3.6.1.2.1.4.20.1.

b. With the cursor in the text box, click **Ctrl-Spacebar** to display the available fields and their current values.

c. Choose a field from the drop-down list and press **Enter**.

**Step 7**
Click **Add** and define the column and data information in the Add Edit Column Controller dialog box. For example:

<table>
<thead>
<tr>
<th>Column Title</th>
<th>My First Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Data</td>
<td>2</td>
</tr>
</tbody>
</table>

**Step 8**
Add more column titles and data as needed; for example:

<table>
<thead>
<tr>
<th>Column Title</th>
<th>My Second Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Data</td>
<td>5</td>
</tr>
</tbody>
</table>

When you are done, click **OK**. See the example in Figure 2-10.
Adding a New Inventory Table Containing SNMP get Details

Step 9  To send the command to the device to check its validity, in the Add Soft Properties dialog box, click **Debug**.

**Note**  No notification message is displayed when a VNE fails to collect properties. The properties are simply not populated in the GUI.

When you finish testing the rules, click **Close** to close the Debug Soft Property dialog box.

Step 10  Click **OK** to exit the Add Soft Property dialog box.

Step 11  Click **Close** to exit the Soft Properties Manager dialog box.

Step 12  Click **Close** to exit the Soft Properties Manager.

The soft property is activated on the NE. You should see the new information in your Inventory window the next time you open it. When you restart the VNE, the soft property is applied to all similar components on the VNE.

To make other NEs display the property, see **Making the Soft Property Available to Other NEs**, page 2-14.
Making the Soft Property Available to Other NEs

A property definition is applicable to all objects of the same type in the selected NE. After the soft property has been defined and tested on a specific instance of a managed element, it can be published and applied to a wider scope of managed NEs in the network. This requires moving the property definition from the specific NE instance to a higher level in the registry hierarchy.

The Soft Properties Publish Controller dialog box enables you to publish the soft property to one or more locations across the inheritance hierarchy (as defined in the system). In other words, you define the scope where the soft property is to be applied in the hierarchy.

**Note**

Users with Configurator privileges can add and publish soft properties on all devices.

Figure 2-11 shows an example of the inheritance hierarchy. In this example, the top level of the hierarchy is All devices, and the lowest level of the hierarchy is Device XYZ.

![Inheritance Hierarchy Example](image)

When a soft property is published to a node in the hierarchy, it overrides any inherited soft properties from a higher level and applies automatically to all its children. For example, if a soft property is published to Cisco 7200 devices, it overrides any variant of this soft property which is defined at a higher level, and is assigned to all devices of type Cisco 7200 in the system.

**Caution**

Soft property publishing can affect system memory usage, device utilization, and system performance. For example, publishing a property that contains the `show running-config` command to many devices could negatively impact system memory usage and device utilization. We strongly recommend that you measure the effect of publishing the soft property on system memory usage before you publish the soft property. To view the changes, you must restart the VNE or unit for the publishing to take effect.

To publish a soft property:

**Step 1**

In Prime Network Vision, right-click a managed element, then choose Management > Soft Properties Management. This opens the Soft Properties Manager window.

**Step 2**

Select the soft property you want to publish. Remember that the soft properties that are displayed depend on the NE, and the choice you make in the Properties Panel drop-down list.
**Step 3**
Open the hierarchy manager by choosing **Tools > Hierarchy Manager**.

Each row that is displayed in the hierarchy manager table represents a different level of the hierarchy. The rows are displayed in descending order; the top row is the highest level of the hierarchy and the bottom row is the lowest level of the hierarchy.

The following information is displayed in the table:
- **Exist**—When a node in the hierarchy is selected, it indicates that a local variant of the soft property exists for that node.
- **VNE Hierarchy Location**—The hierarchy path, as defined in the registry.
- **IMO Class Name**—Currently unavailable in this version.

Table 2-1 describes the icons that appear.

**Table 2-1  Hierarchy Manager Window Tools**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Copy icon]</td>
<td>Copy</td>
<td>Copies the soft property from a selected node in the hierarchy to another node in the hierarchy. A copy icon is displayed to the left of the selected node.</td>
</tr>
<tr>
<td>![Cut icon]</td>
<td>Cut</td>
<td>Cuts the soft property from a selected node in the hierarchy to move it to another node in the hierarchy. A cut icon is displayed to the left of the selected node.</td>
</tr>
<tr>
<td>![Paste icon]</td>
<td>Paste</td>
<td>Pastes the soft property that was copied or cut from a selected node in the hierarchy to another node in the hierarchy. A paste icon is displayed to the left of the selected node.</td>
</tr>
<tr>
<td>![Delete icon]</td>
<td>Delete</td>
<td>Deletes the soft property from the selected node in the hierarchy. <strong>Note</strong> If the soft property has been deleted from all nodes, it is removed from the list in the main dialog box of the Soft Properties Manager.</td>
</tr>
</tbody>
</table>

**Step 4**
Select the node in the hierarchy from which you want to publish the soft property.

**Step 5**
Click the Copy or Cut icons to perform the required action.

**Step 6**
Select the node in the hierarchy where you want to publish the soft property, and click the Paste icon.

**Step 7**
Restart the VNE on which you want to publishing to take effect.
Adding Support for New Devices, Software Versions and Modules Using the VCB

This chapter describes using the VNE Customization Builder (VCB) to add support for currently unsupported devices, software versions, and modules. For information about adding support for new events, see Adding Support for New Events Using the VCB, page 6-1.

This chapter contains the following topics:

- VCB Overview, page 3-1
- Comparison of Generic SNMP VNEs, U-VNEs, and Developed VNEs, page 3-3
- Adding Support for Additional Device Types by Creating U-VNEs, page 3-6
- Adding Support for Additional Software Versions, page 3-11
- Add Support for Additional Modules, page 3-12
- Testing and Certifying VCB Customizations, page 3-14
- Deploying VCB Customizations to Your Production Environment, page 3-24
- Deleting VNE Customizations from the Registry, page 3-27

VCB Overview

The VCB is a tool that allows advanced users to extend the “out-of-the-box” support and capabilities of Prime Network:

- Enable discovery of currently unsupported device types by creating user-defined VNE drivers, known as U-VNEs.
- Clone from an existing VNE driver to manage new devices that belong to an existing supported device family.
- Extend the discovery and management capabilities of existing VNE drivers to enable Prime Network to:
  - Recognize cards that would otherwise be treated as “Unknown”.
  - Process syslogs, traps, or service events as Prime Network events.
  - Recognize additional software versions, such as maintenance releases of Cisco IOS and other software.
- Produce a list of unsupported traps for a particular MIB and add them as Prime Network events.
VCB Overview

Note
An event is generated for all VCB write operations (add, update, override, and delete) and is displayed in the System tab in the Prime Network Events GUI client.

VCB GUI vs. VCB CLI
VCB functions can be performed using the GUI interface that is available in the Prime Network Administration application (from the Tools menu), or by executing VCB commands in the Command Line Interface (CLI).

If you are new to the VCB, we recommend using the VCB GUI. If you are already familiar with using the CLI to perform VCB functions, or you want to perform more advanced VCB functions that are not yet included in the GUI, you can use the CLI.

Accessing the VCB

You can access the VCB through Prime Network Administration or by specifying a URL in your web browser. To open the VCB:

Step 1
In Prime Network Administration, choose Tools > VNE Customization Builder.

or

In your web browser, enter the following URL. The gateway-IP can be an IPv6 address.

Step 2
Enter the login credentials and then select VNE Customization Builder in the Home page. The VCB opens, and the VNE Drivers page is displayed.

Note
Only two users can be logged into the VCB GUI client at one time.
**Note**
You can reorder the columns by dragging and dropping the column headers. You can also determine which columns will be displayed by using the Settings tool in the toolbar above the table.

**Cisco vs. Non-Cisco Devices**

The VCB displays the details of the Cisco and the third-party (non-Cisco) VNE drivers in separate tabs as Prime Network supports separate installation directories and registry service for Cisco and non-Cisco drivers. Non-Cisco VNEs do not support pluggable module specification, and the pluggable module information is retrieved from the network element itself.

**Note**
The Non-Cisco Drivers tab in VCB GUI is displayed only after successful installation of a non-Cisco device package in Prime Network.

### Comparison of Generic SNMP VNEs, U-VNEs, and Developed VNEs

Before using the VCB to add support for unsupported network elements, you should understand the difference between the types of VNEs.

**Developed VNEs**

A VNE for a supported NE that was developed by Cisco and supplied with the product or through a downloadable Device Package. These VNEs are created using the Prime Network Administration GUI client.
You should always use a developed VNE, if possible, and extend it using the VCB, if necessary. Developed VNE drivers are designed and tuned for specific technologies and devices, while U-VNEs model a subset of device capabilities.

Generic SNMP VNEs

Generic SNMP VNEs are usually created to monitor the most basic inventory information for an unsupported NE. These VNEs are created using the Prime Network Administration GUI client and by choosing Generic SNMP as the VNE Type. (Supported VNE types are AutoDetect, Cloud, ICMP, and Generic SNMP.)

Use the VCB to extend Generic SNMP VNEs to monitor unsupported events.

U-VNEs

A U-VNE is a user-defined VNE created using the VCB to enable support for an unsupported device. A U-VNE can be created from scratch, based on a specific U-VNE template, or it can be created by cloning an existing supported device.

Features, advantages, and limitations of template-based U-VNEs are template-dependent. The GenericUVNE template supplies the same level of modeling as a Generic SNMP VNE. You can then further extend the U-VNE for additional event recognition using the VCB.

Table 3-1 shows the differences levels of support for Prime Network features in Generic SNMP VNEs, U-VNEs, and developed VNEs.

Note The information in this table is for comparative purposes only. The support provided by each U-VNE template might vary from template to template.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Generic SNMP VNEs</th>
<th>U-VNEs</th>
<th>Developed VNEs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault Analysis</td>
<td>Standard traps that are supported by Generic SNMP VNEs. Can be extended to support proprietary traps and syslogs.</td>
<td>Standard and proprietary traps and syslogs defined in the U-VNE template or NE instrumentation of cloned device. Syslogs are not supported by the GenericUVNE template but it can be extended to support proprietary traps and syslogs.</td>
<td>Standard and proprietary traps and syslogs.</td>
</tr>
<tr>
<td>MIB support</td>
<td>Standard MIB-II</td>
<td>Standard MIB-II and private MIBs for physical inventory discovery depending on template or cloned device. Can import traps to add event recognition. Based on most commonly used subset of standard MIB-II MIBs which some device manufacturers might alter; information from the proprietary implementation of third-party device vendors is not available through the use of standard MIBs.</td>
<td>Standard MIB-II and private MIBs</td>
</tr>
<tr>
<td>CLI or XML over Telnet is used to query NE</td>
<td>No</td>
<td>Protocol used to query depends on setting in template or cloned device.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 3-1  Features Supported in Generic SNMP VNEs, U-VNEs, and Developed VNEs (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Generic SNMP VNEs</th>
<th>U-VNEs</th>
<th>Developed VNEs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multivendor</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>NBI</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Discovery</td>
<td>Yes</td>
<td>Yes (CDP is supported for Cisco devices). Template-based U-VNEs support the instrumentation defined in template</td>
<td>Yes</td>
</tr>
<tr>
<td>Physical Inventory, Containment</td>
<td>No</td>
<td>Yes, depending on setting in template or cloned device.</td>
<td>Yes, depending on the NE instrumentation</td>
</tr>
<tr>
<td>Logical Inventory and Technologies</td>
<td>Routing table, ARP table, default bridge, IP interfaces</td>
<td>Routing table, ARP table, default bridge, IP interfaces</td>
<td>Technologies and NE instrumentation supported in Prime Network</td>
</tr>
<tr>
<td>Alarm Correlation (root cause analysis)</td>
<td>No</td>
<td>Yes (for factory-defined events only, provided that the related technologies are supported by the U-VNE or cloned device). Events are associated to managed element. For events that were added via the VCB, correlation is done based on the DC key (correlation using network flow is not supported). Event is correlated to service events with the same source. Users cannot customize correlation parameters such as weight, correlation delay, and so on. Root-cause events cannot be added via the VCB.</td>
<td>Yes (for factory-defined events). For events that were added via the VCB, correlation is done based on the DC key (correlation using network flow is not supported). Event is correlated to service events with the same source. Users cannot customize correlation parameters such as weight, correlation delay, and so on. Root-cause events cannot be added via the VCB.</td>
</tr>
<tr>
<td>NE Image Management</td>
<td>No</td>
<td>Yes, if supported in the VNE from which it was cloned.</td>
<td>Yes</td>
</tr>
<tr>
<td>Configuration Archival</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Path Tracing</td>
<td>No</td>
<td>Only physical and Ethernet are supported. Template-based U-VNEs: Provide limited support for path tracing. If U-VNE does not support routing, network paths that traverse the U-VNE will stop and the result of the trace will show only the path to or from the U-VNE. Exact behavior depends on technologies used by NE, level of adherence to standard MIB support, and location of U-VNE on the path.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Adding Support for New Devices, Software Versions and Modules Using the VCB

Chapter 3  Adding Support for Additional Device Types by Creating U-VNEs

Using the VCB, you can enable Prime Network to discover and manage devices that have no system-defined VNE driver and are therefore not currently supported. To enable support for additional device types, you create a U-VNE and can then add the VNE to Prime Network in the normal manner, using the Administration GUI client. It will be modeled and added to the Prime Network device inventory. The level of modeling depends on the amount of detail provided to the system when you create the U-VNE.

Prime Network creates the registry information for these VNEs and saves it in site.xml, which is the registry location where all local changes should be stored. As with all VNEs, to maintain a live model of each network element and the entire network, VNEs must have connectivity with the device.

User-defined VNEs created with the VCB are not a replacement for developed VNE drivers. Developed VNE drivers are packaged with the Prime Network product and are also available in downloadable Device Packages. Developed VNE drivers are designed and tuned for specific technologies and devices, while U-VNEs model a subset of device capabilities.

These topics describe the methods for adding support for a new device type:

- Methods for Creating U-VNEs—Overview, page 3-7
- Creating a U-VNE Using the GenericUVNE Template, page 3-7
- Create a U-VNE by Cloning, page 3-8

Table 3-1 Features Supported in Generic SNMP VNEs, U-VNEs, and Developed VNEs (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Generic SNMP VNEs</th>
<th>U-VNEs</th>
<th>Developed VNEs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topology Discovery</td>
<td>Physical and Ethernet</td>
<td>Template-based U-VNEs: Only physical and Ethernet are supported. Supported technologies are documented in the templates. Dynamic topology discovery is limited to U-VNEs on the network edge that are connected to a developed VNE. U-VNEs support IP topologies on high-level data link control (HDLC) and serial ports in point-to-point links, with no duplicate IP addresses, and same IP subnet. Cloned U-VNEs: Depends on the VNE from which it was cloned.¹</td>
<td>Full</td>
</tr>
</tbody>
</table>

¹ For a U-VNE driver cloned from a developed VNE driver, the logical inventory, technology and topology discovery instrumentation usage are inherited from the developed VNE driver.

² For example, link up/down correlates to the card-out service alarm, while MPLS TE Tunnel down is associated to managed element and is not correlated to other alarms.
Methods for Creating U-VNEs—Overview

Several approaches are available for creating U-VNEs. Depending on the approach you choose, the modeling capabilities will be more specific or less specific. Table 3-2 lists the supported methods and how to choose the one that is appropriate for your situation.

<table>
<thead>
<tr>
<th>If the unsupported device...</th>
<th>Use this Method:</th>
<th>Described in:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belongs to a supported device series or device family</td>
<td>Clone a developed VNE driver from the supported device series or family. An unsupported device in a supported series or family has the same or a very similar management interface as the developed VNE driver. The cloned U-VNE inherits the behavior of the source VNE driver, and can be further extended using the VCB to add more device module discovery and event recognition. This method produces the most specific modelling results.</td>
<td>Create a U-VNE by Cloning, page 3-8</td>
</tr>
<tr>
<td>Uses the same NE software version as another supported device</td>
<td>Clone a developed VNE driver that uses the supported software version. An unsupported device running a supported NE software version should share the same management interface as a supported device. The cloned U-VNE inherits the behavior of the source VNE driver, and can be further extended using the VCB to add more device module discovery and event recognition.</td>
<td>Create a U-VNE by Cloning, page 3-8</td>
</tr>
<tr>
<td>Does not belong to a supported device series or family, or does not run a supported NE software version</td>
<td>Create a U-VNE “from scratch” using the GenericUVNE template. This is typically the case for non-Cisco devices and Cisco device families that are not supported by Prime Network, where the instrumentation or management interface for the unsupported device does not match that of any supported VNE. <strong>Note</strong> Network core devices should not use GenericUVNE template.</td>
<td>Creating a U-VNE Using the GenericUVNE Template, page 3-7</td>
</tr>
</tbody>
</table>

Creating a U-VNE Using the GenericUVNE Template

The following example shows how to enable support for an unsupported device by creating a U-VNE. For the purposes of this example, we will create a U-VNE to enable support for a Linux server. The U-VNE will be based on the GenericUVNE template. See U-VNE Templates, page B-56 for more information about this template.

**Before You Begin**

- Make sure this is the proper method for your situation by checking the information in Methods for Creating U-VNEs—Overview, page 3-7.
- Obtain the sysOID of the NE you want to manage. The sysOID can be retrieved from the properties of the system event generated for an unsupported device (shown in Prime Network Vision or Prime Network Events). Alternatively, you can query the device using the snmp get command.
Adding Support for Additional Device Types by Creating U-VNEs

To create a U-VNE:

**Step 1** Access the VCB, as described in Accessing the VCB, page 3-2.

**Step 2** In the VNE Drivers tab, click **Add Row**.

**Step 3** In the SysOID field, enter the sysOID of the new device.

**Step 4** Specify the name that will represent the device in the Prime Network GUI by creating a new device type, as follows:

a. In the Device Type field, click the down arrow to display the Device Type Selector.

b. Click the Tools icon in the upper right area of the Device Type Selector and select **Add**.

c. In the Device Type field, enter the device name that will represent the device in the Prime Network maps and element tables. We recommend that you prefix the device type name with the network element vendor name for easy identification.

d. In the Category field, select the category to which the device belongs. In this case, select **Server**.

e. In the Device Series field, specify the device series to which the device belongs.

f. Click **OK**. The new Device Type name will appear in the Device Type field.

**Step 5** In the Type field, select **User Defined VNE - by Template**.

**Step 6** In the Cloning Reference field, select **GenericUVNE**.

**Step 7** Click **Save**.

**Step 8** Complete tests and certify the customization; see Testing and Certifying VCB Customizations, page 3-14.

Create a U-VNE by Cloning

This section describes how to enable support for an unsupported device by cloning a developed VNE driver from a supported device series or family. The cloned U-VNE inherits the behavior of the source VNE driver, and can be further extended using the VCB to add more device module discovery and event recognition.

**Before You Begin**

- Make sure this is the proper method for your situation by checking the information in Methods for Creating U-VNEs—Overview, page 3-7.

- Obtain the sysOID of the NE you want to manage. The sysOID can be retrieved from the properties of the system event generated for an unsupported device (shown in Prime Network Vision or Prime Network Events). Alternatively, you can query the device using the snmp get command.

- Confirm that Prime Network does not support the sysOID. You can do this by filtering the VNE drivers list in the VCB GUI by the sysOID. If it is not found, it is not supported.
To create a U-VNE by cloning:

Step 1
Access the VCB, as described in Accessing the VCB, page 3-2.

Step 2
In the VNE Drivers tab, click Add Row.

Step 3
In the SysOID field, enter the sysOID of the new device.

Step 4
In the Device Type field, select the device type that will represent the new supported device in the Prime Network maps and element tables. If necessary, you can create a new device type from the Tools icon in the Device Type selector.

Step 5
To clone from a supported device family: In the Type field, select User Defined VNE - by Device Family.
To clone from a supported software version: In the Type field, select User Defined VNE - by Software Version, then select the device series and the scheme.

Note
Cloning by software version performs two customizations in a single operation. It clones both the device type and software versions. The new driver will be listed in the GUI as cloned by device.

Step 6
In the Cloning Reference field, specify the item from which you want to clone the new VNE.

Step 7
Click Save.

Step 8
Complete tests and certify the customization; see Testing and Certifying VCB Customizations, page 3-14.

Defining a Device Type to Determine the GUI Representation of VNE Drivers

Each VNE is represented by a specific name and icon in the maps and element tables. The device type determines the name used to represent the VNE while the device family determines the icon used to represent the VNE. When you create a U-VNE, you need to select a device type so that the system knows how to represent the new device in the GUI. If none of the existing device types is a suitable representation of your U-VNE, you can create a new device type. You can create a new device type in one of the following ways:

- From the VNE drivers window, during the VNE driver creation/editing process. See Creating a U-VNE Using the GenericUVNE Template, page 3-7.
- From the Device Types window, as described below.

To add a new device type:

Step 1
Access the VCB, as described in Accessing the VCB, page 3-2.

Step 2
In the VNE Drivers tab, click Configure Device Types. The Device Types window appears.
The Device Types window provides a table listing all the available device types.

**Step 3** Click **Add Row**. A row is added to the device types table, enabling you to define the parameters of the new device type.

**Step 4** Define the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>The name that will represent the device in the Prime Network GUI, in maps and tables. We recommend that you prefix the device type name with the network element vendor name for easy identification.</td>
</tr>
<tr>
<td>Category</td>
<td>The type of device, for example, router, switch, and so on.</td>
</tr>
<tr>
<td>Device Series</td>
<td>The device family to which the device type belongs, for example, Cisco 10000 Routers. This will determine which icon will be used to represent the device.</td>
</tr>
<tr>
<td>Type</td>
<td>Since you are adding a device type that is not provided as a system default, this field is automatically populated as “User-Defined”.</td>
</tr>
</tbody>
</table>

**Step 5** Click **Save**.
Adding Support for Additional Software Versions

Note
You cannot edit or delete system default software versions.

The VCB enables you add support for additional software versions and to manage currently supported software versions.

Step 1
Access the VCB, as described in Accessing the VCB, page 3-2.

Step 2
In the VNE Drivers tab, expand the VNE driver for which you want to add a supported software version by clicking on the arrow on the left.

Step 3
Click Supported s/w versions in the Software Versions field.

The list of currently supported software for the selected VNE driver is displayed.

Step 4
Click Add Row.

Step 5
Enter the values for the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Software Version</td>
<td>The name of the software version to be supported.</td>
</tr>
<tr>
<td>Scheme</td>
<td>The scheme based on which the VNE is modeled, either Product or IpCore. For more information about schemes, see the Cisco Prime Network 4.0 Administrator Guide.</td>
</tr>
<tr>
<td>Supported Software Version</td>
<td>The already supported software version to be cloned in order to add support for the new software version.</td>
</tr>
</tbody>
</table>
Add Support for Additional Modules

These topics explain how to use the Prime Network VCB to enable support for new standard and pluggable modules on developed VNEs and U-VNEs.

- Adding Support for a New Standard Module, page 3-12
- Adding Support for a New Pluggable Module, page 3-13

If a module does not have “out-of-the-box” support, Prime Network will discover it on a best-effort basis and will generate an informational event with the following description:

“Unsupported module was auto-discovered”

You should validate that all the components of the module were discovered in full. If not, you can add support for the module using the VCB.

Adding Support for a New Standard Module

Module templates are used to enable developed VNEs to recognize new standard modules. Module templates define a set of port layers—from the connector at Layer 0 to encapsulation at Layer 2—that are applicable to a module. Module templates ensure that each port is modeled with the correct port layer information based on the ifType obtained from the SNMP MIB output.

Before You Begin

- Obtain the module identifier and research the capabilities of the module. The module identifier can be found in the properties of the event generated when an unsupported module is auto-discovered.
- Identify the appropriate module template. See Module Templates, page B-65.

To add support for a new standard module:

Step 1  From the Prime Network Administration GUI client, choose Tools > VNE Customization Builder.
Step 2  Choose VNE Customization Builder > Modules. In the Modules page, the Cisco Modules tab is selected by default and all the available Cisco module groups are shown. If you are adding support for a non-Cisco module, click the Non-Cisco Modules tab.
Step 3  Click on a module group to show all the modules for that group.
Step 4  Click on the arrow next to a module to expand its display and see all the port layers supported by that module.

If you want to edit a module, select the radio button to the left of the row and then click the Edit button. If you edit a system default module, the value in the Overriding column will change to True. To revert back to the system default values, click Restore.
Step 5  Select the module group under which you want to create the new module. All the modules under the module group you choose are displayed.
Step 6 Click the **Add Row** button on the taskbar. A new row opens in an editable mode at the end of the modules display area. Enter the value(s) for the following parameters:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the new module. This field cannot be empty.</td>
</tr>
<tr>
<td>Template</td>
<td>Name of the template to be used to enable recognition of the new module. You can select a template from the drop-down list. See <a href="#">Module Templates</a> for information about each template.</td>
</tr>
<tr>
<td>Part Number</td>
<td>The part number of the new module.</td>
</tr>
<tr>
<td>Hardware Description</td>
<td>The MIB name of the module is usually used as the hardware description. For example, for module .1.3.6.1.4.1.9.12.3.1.9.2.175 (SPA-4XOC48POS/RPR) the hardware description could be cevSpa4pOc48PosSfp. Alternatively, you can use a readable string followed by the mib name, for example, 4 Port OC48 POS SPA (cevSpa4pOc48PosSfp).</td>
</tr>
<tr>
<td>Type</td>
<td>The module type can be System Default or User Defined. If you are adding a new module, this field is automatically populated as User Defined and cannot be edited.</td>
</tr>
<tr>
<td>Overrides</td>
<td>Indicates if a system defined module has been modified by the user.</td>
</tr>
</tbody>
</table>

Step 7 Click **Save**.

Step 8 Test the new module. See [Testing and Certifying Module Customizations](#), page 3-21.

---

**Adding Support for a New Pluggable Module**

This procedure explains how to add support for a pluggable module. When you add support for a new pluggable module, you do not need to specify a template to use.

**Note** You cannot edit or delete Prime Network default pluggable modules.

To add support for a new pluggable module:

1. **Step 1** From the Prime Network Administration GUI client, choose **Tools > VNE Customization Builder**.
2. **Step 2** Choose **VNE Customization Builder > Pluggable Modules**. The Pluggable Modules tab displays all the pluggable modules in Prime Network VCB.

   If you want to edit a module, select the radio button to the left of the row and then click the **Edit** button.
Chapter 3      Adding Support for New Devices, Software Versions and Modules Using the VCB

Testing and Certifying VCB Customizations

Step 3  
Click the **Add Row** button on the taskbar. A new row opens in an editable mode at the end of the pluggable modules display area. Enter the value(s) of the following parameters:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pluggable Module Name</td>
<td>Name of the new pluggable module.¹ This field cannot be empty.</td>
</tr>
<tr>
<td>Media Type</td>
<td>Specifies the media type of the port through which the pluggable module is connected. You can manually enter the values or choose a value from the drop-down list². Only values in drop-down list are valid entries.</td>
</tr>
<tr>
<td>PID</td>
<td>The unique Pluggable Module ID. ¹</td>
</tr>
<tr>
<td>Pluggable Type</td>
<td>Specifies the type of the new pluggable module. Pluggable types are SFP, XFP, X2, and XENPAK. You can manually enter the values or choose the value from the drop-down list.²</td>
</tr>
<tr>
<td>Type</td>
<td>Specifies whether the pluggable module is user-defined or Prime Network default. This field by default is “User Defined” and is not editable.</td>
</tr>
</tbody>
</table>

1. You can enter letters and numbers in pluggable module names and PID. Valid characters for module names are -, ., (, ) and +.
2. When you enter the value in this field, Prime Network VCB GUI displays the values which narrow down as you enter the value.

Step 4  
Click **Save**.

Step 5  
Test the new module. For the procedure on testing the VNEs, see Testing and Certifying Module Customizations, page 3-21.

---

**Testing and Certifying VCB Customizations**

Testing and certifying ensures that you:

- Do not create unintended or undesired results in your production network
- Do obtain the best possible result, a customization that most closely fits technologies, topologies, and other aspects that you need to model

These topics describe the tests you should perform:

- Preparing to Test Your VCB Customizations, page 3-15
- Testing and Certifying U-VNEs, page 3-15
- Testing and Certifying Module Customizations, page 3-21
- Testing and Certifying Event Customizations, page 3-22
- Troubleshooting VCB Customizations, page 3-23
Preparing to Test Your VCB Customizations

Table 3-3 provides a recommended list of test resources for verifying your customizations. Some of these resources are outside of Prime Network.

In addition, the VCB log file is useful for debugging issues that might occur when you use the VCB.

Use the \texttt{-logfile} option to specify the name of the log file and the \texttt{-debuglevel} option to define the logging level to use. The relevant command is:

\begin{verbatim}
vcb mode command \[command args\] -debuglevel INFO -logfile logfilename -user username -password password
\end{verbatim}

When debugging, set the debug level to INFO. The log file is created in the \texttt{NETWORKHOME/Main/logs} directory. Error messages are written to the log file and are displayed on the console.

\begin{table}[h]
\centering
\begin{tabular}{|l|p{10cm}|}
\hline
Tool/Resource & Purpose \tabularnewline
\hline
Prime Network Vision GUI client & Creating a U-VNE instance to verify the physical and logical inventory, that events from the device are received, and ensure the U-VNE does not impact VNE performance. \tabularnewline
\hline
Direct communication with device & Communicating directly with the device and measuring performance-related issues, such as CPU and memory usage (both with and without the VNE) in various scenarios. \tabularnewline
\hline
VNE documentation & \textit{VCB Template Reference, page B-56}, provides the list of technologies and properties that are supported by the template on which the U-VNE is based. The \textit{Cisco Prime Network 4.0 Supported VNEs} lists the Prime Network supported devices, software versions, modules, and technologies. \tabularnewline
\hline
Trap simulator (not supplied with Prime Network) & Enables testing of new events. \tabularnewline
\hline
\end{tabular}
\caption{Testing Tools and Resources}
\end{table}

Testing and Certifying U-VNEs

After using the VCB to perform device customizations, you must test the VNE or U-VNE to verify that the device and its components can be managed by Prime Network to your satisfaction. To test the results of your VCB commands, we recommend that you add a single instance of the customized VNE to its own AVM in Prime Network.

Examples of the support you should test for include:

- Physical containment
- Logical inventory
- Topology
- Events

We recommend that you record the results of your tests in a compliance report, which certifies the capabilities of the customized VNE. See \textit{Preparing Compliance Reports, page 3-18}. After you successfully complete the testing process, create additional VNE instances to manage the rest of the devices of this type in the network.
When performing the tests described in this section, bear in mind that unlike developed VNEs, U-VNEs are not optimized for a particular device type. The VCB enables you to extend VNEs and create U-VNEs as specified in this document. Other Prime Network features, such as Soft Properties and Command Manager, offer further extensibility to the U-VNE and developed VNE drivers. Prime Network users who need more management capability—or who prefer to have developed VNE drivers for devices that are not already in the Prime Network VNE support scope—can contact their Cisco account representative for any available Cisco Advanced Services alternative.

For details about testing U-VNEs, please see the following sections:
- Setting Up the U-VNE Test Environment, page 3-16
- Performing the U-VNE Tests, page 3-18
- Troubleshooting VCB Customizations, page 3-23

### Setting Up the U-VNE Test Environment

Before beginning the testing process, you must ensure that:
- All the mandatory processes—avm11, avm0, and avm100 (only for event support)—are running normally.
- You have access to the device.
- You complete the actions described in Table 3-4.

#### Table 3-4 Actions to Perform Before You Begin Testing

<table>
<thead>
<tr>
<th>Action</th>
<th>Purpose</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure the device to send events to the Prime Network server.</td>
<td>This is required before you test whether Prime Network can receive events from the VNE.</td>
<td>Cisco Prime Network 3.10 Administrator Guide</td>
</tr>
<tr>
<td>Create an A VM for hosting the VNE instance on which you will perform the tests.</td>
<td>By isolating the test VNE on its own A VM, you prevent any actions that might impact the functionality of your network.</td>
<td>Creating a Test A VM and VNE, page 3-16</td>
</tr>
<tr>
<td>Measure device performance (such as CPU and memory usage) on the device, with and without the VNE.</td>
<td>This enables you to determine whether the VNE is placing an unreasonable load on the device.</td>
<td>Measuring Device Performance, page 3-17</td>
</tr>
<tr>
<td>Prepare a compliance report</td>
<td>Fill in the compliance report during testing to track your results against the list of supported technologies and properties outlined in U-VNE Templates, page B-56.</td>
<td>Preparing Compliance Reports, page 3-18</td>
</tr>
</tbody>
</table>

### Creating a Test A VM and VNE

We recommend that you create an A VM for the sole purpose of hosting the VNE instance on which you will perform the tests described in this chapter. Placing the VNE instance in its own A VM enables you to test your customizations in a safe environment, where the logs and any errors generated by the VNE are isolated from the rest of your network. This enables you to proceed with testing without having your VNE customizations impact the network, until you are satisfied that the customizations function as required.
Testing a single VNE instance also helps you scale a rollout more easily. For example, if you have 100 devices of a certain type that you are introducing to your managed network, first create a single VNE instance on which to test your customizations. After testing is complete, create additional VNEs for the other 99 devices.

AVMs and VNEs can be created in the Prime Network Administration client. For further details about creating an AVM and adding a VNE, see the *Cisco Prime Network 4.0 Administrator Guide*.

### Checking the Communication and Investigation State of the Test Instance

After you create a test instance of the U-VNE, you must verify that Prime Network can communicate with the device (communication state) and that Prime Network can discover the physical and logical inventory of the device (investigation state).

To check the communication and investigation state of the test instance:

1. Log into Prime Network Vision.
2. Choose **Network Inventory > Network Elements**.
3. Perform a search to locate the device.
4. Check the Communication State column to see the status of the communication between Prime Network and the device:
   - If the status is Device Reachable, this indicates that all of the enabled protocols on the device are responding.
   - If the status is Device Unreachable, this indicates that at least one of the enabled protocols is not responding. If this occurs, troubleshoot the problem, as described in *Device Unreachable*, page 3-23.
5. Check the Investigation State column to see how successfully the VNE has modeled the device it represents:
   - If the status is Operational, proceed to the next test.
   - If the status is Incomplete, this indicates that Prime Network is unable to model all the components in the device. You must investigate further to determine whether the components or properties that cannot be modeled prevent you from using the U-VNE in your network. For troubleshooting details, see *Investigation State Not Operational*, page 3-23.

---

**Note**

For more information on troubleshooting VNE modeling, see the *Cisco Prime Network 4.0 Administrator Guide*.

### Measuring Device Performance

We recommend that you use an element manager or similar application to measure CPU and memory usage on the device before you start managing it with the VNE. This provides a baseline for comparison when you later measure the load on the VNE as part of the testing process. You should simulate various scenarios, including those that place heavy loads on the device, so that you can later determine the effect of your VNE customizations on device performance. See *Testing CPU and Memory Usage*, page 3-20.
Performing the U-VNE Tests

To test and certify U-VNEs, we recommend that you follow these procedures.

1. Preparing Compliance Reports, page 3-18
2. Testing the Physical Inventory, page 3-18
3. Testing the Logical Inventory, page 3-20
4. Testing CPU and Memory Usage, page 3-20
5. Verifying That Prime Network Receives Events from an NE and Generates Tickets, page 3-21

Preparing Compliance Reports

As you complete the tests described in this chapter, we recommend that you capture the results in a compliance report. A compliance report makes it easier for you to evaluate whether the U-VNE suits your needs or whether you will need to try again by cloning from a different device or using a different U-VNE template.

Create a compliance report using the information provided in Cisco Prime Network 4.0 Supported Cisco VNEs (for a U-VNE that was cloned from an existing device family) or U-VNE Templates, page B-56 (for a template-based U-VNE). Use the information to do the following:

1. Copy each technology table to a file (such as a spreadsheet).
2. Remove any columns that describe support for templates other than the one you are using.
3. Add a column for verifying whether each supported property is modeled in Prime Network.
4. Fill out the final column, identifying the supported and unsupported properties.

Assessing a customization requires that you test on a reasonable configuration (test-to-success) and that you evaluate extreme cases (test-to-fail).

Note

You cannot use the VCB to change the templates themselves; for example, to support additional CLIs or MIBs or to modify the parsing of the device results.

If you find gaps in the modeling of the U-VNE, you can try using Soft Properties. If you need more management capability or you prefer to have developed VNE drivers for devices that are not already in the Prime Network VNE support scope, contact your Cisco account representative for any available Cisco Advanced Services alternative.

Testing the Physical Inventory

The physical inventory reflects the physical components of the managed device, including its:

- Port Connector—Port details.
- Shelf—Chassis or rack where various types of equipment may be placed or inserted.
- Slot—Details on where the modules are inserted.
- Module—Physical module or adapter card details; hardware description.

Note

The list of components that are actually displayed for the U-VNE in the Prime Network client are dependent on the device from which the U-VNE was cloned or on the template that was used to create the U-VNE.
To view the physical inventory:

**Step 1** Log into Prime Network Vision.

**Step 2** Choose **Network Inventory > Network Elements**.

**Step 3** Perform a search to locate the device.

**Step 4** Double-click the device.

**Step 5** Expand the **Physical Inventory** tree node.

**Step 6** Compare the physical containment displayed in the Physical Inventory tree with the actual components contained in the device managed by the U-VNE. In particular, make sure that the following information is accurate:

- Slot Number
- Number of Ports
- Connector Type

**Step 7** Look for signs that the U-VNE does not fully model the device, including:

- Investigation state is Currently Unsynchronized.
- A module without ports; for example, if the WS-X6724 module is described as having 24 ports, but no ports appear beneath the module in the tree.

**Step 8** Select each component in the tree, then check the Properties window to verify that the physical inventory includes all the properties that are supported by the U-VNE (as defined in the U-VNE template on which it is based).

**Step 9** Record your results in a compliance report. See **Preparing Compliance Reports, page 3-18**.

**Step 10** If there are components or properties that are missing or incomplete, you must decide whether these components or properties prevent you from using the U-VNE in your network:

- If you determine that the U-VNE can be managed successfully by Prime Network without the unsupported component or property, proceed to the next test.

**Tip** In the case of a missing property, try adding it using the Soft Property Builder.

- If you need more management capability or you prefer to have developed VNE drivers for devices that are not already in the Prime Network VNE support scope, you can contact your Cisco account representative for any available Cisco Advanced Services alternative.

(The VCB enables you to extend VNEs and create U-VNEs as specified in this chapter. Other Prime Network features, such as Soft Properties and Command Builder, described in separate chapters, offer further extensibility to the U-VNE and developed VNE drivers.)
Testing the Logical Inventory

The logical inventory reflects dynamic data such as configuration data, forwarding, and service-related components that affect traffic handling in the element. The list of components that are actually displayed in the logical inventory are dependent on the technologies supported either the device family from which the U-VNE was cloned or by the template that was used to create the U-VNE.

To view the logical inventory:

Step 1  Log into Prime Network Vision.
Step 2  Choose Network Inventory > Network Elements.
Step 3  Perform a search to locate the device.
Step 4  Double-click the device.
Step 5  Expand the Logical Inventory tree node.
Step 6  Compare the information displayed in the Logical Inventory tree with the actual technologies supported by the U-VNE, as defined by the template on which the U-VNE is based. See U-VNE Templates, page B-56.
Step 7  Select each component in the tree, then check the Properties view to verify that the logical inventory includes all the properties that are supported by the U-VNE (as defined in the U-VNE template on which it is based).
Verify the IP interfaces by querying the device for its list of IP interfaces and verifying that all of them appear under IP Flow Points. Verify that all the IP interfaces configured on the device appear in the IP Interfaces tab under Routing Entity.
Step 8  Record your results in a compliance report. See Preparing Compliance Reports, page 3-18.
Step 9  If any technologies or properties are missing or incomplete, you must investigate further to determine whether these technologies or properties prevent you from using the U-VNE in your network:
  • If you determine that the device can be managed successfully by Prime Network without the unsupported technology or property, proceed to the next test.
  • If you need more management capability or you prefer to have developed VNE drivers for devices that are not already in the Prime Network VNE support scope, you can contact your Cisco account representative for any available Cisco Advanced Services alternative.

Testing CPU and Memory Usage

Note
Ensure that you perform both positive testing (on a reasonable configuration) and negative testing (on simulations of expected network scenarios).

In addition to verifying how well the U-VNE models the device, we recommend that you measure the CPU and memory usage demands placed by the U-VNE on the device. During test preparation, before adding the VNE instance, you measured CPU and memory usage on the NE; (see Measuring Device Performance, page 3-17). Now, compare the usage on the NE against the usage for the VNE instance on
the Prime Network AVM and unit as follows:

- To view CPU usage, look at the properties of the device in the Inventory window.
- To monitor additional information, such as memory usage, use the Prime Network diagnostic client. To access the diagnostic client, enter the following address in your web browser (the username is normally admin; you will have to get the password from your system administrator):

  https://gateway-IP-address:1311

**Verifying That Prime Network Receives Events from an NE and Generates Tickets**

This topic provides steps for verifying that Prime Network receives events from an NE and that the VNE driver parses the events correctly, generating tickets if the events are ticketable.

---

**Note**

Event parsing depends on the completeness and correctness of the modeling. Parsing BGP events, for example, depends on BGP being modeled correctly in the inventory.

---

**Before You Begin**

Make sure that you have configured the device to send events to the Prime Network server and created a Link Down event.

To check for events from the NE:

**Step 1** Log into Prime Network Vision.

**Step 2** Add the device to a map.

**Step 3** Right-click on the device in the map and select Filter Tickets. The tickets pane below the map will show the tickets for the selected device.

**Step 4** Check whether the Link Down event that you generated during your test preparations appears in the table.

**Step 5** Generate additional events from the device, then see if they appear in the events table.

**Step 6** If the events do not appear in the events table, proceed as follows:

- Check for mistakes in the device configuration.
- Use an external tool, such as a MIB browser, to determine whether events are being sent by the device.
- Troubleshoot event customization, as described in Customizing Existing Events, page 6-12.

---

**Testing and Certifying Module Customizations**

First perform a static test of the module, using the `vcb view module` command. If the module is not correctly configured, delete it and add the module again.

After verifying the module statically, set up your test environment just as you would for testing device customization—see Setting Up the U-VNE Test Environment, page 3-16. Then view the physical inventory for your U-VNE test instance as follows.

**Step 1** Launch Prime Network Vision.
Step 2  Add the containing device to a map.
Step 3  Double-click the device.
Step 4  Expand the Physical Inventory tree node.
Step 5  Confirm the correctness of the following for the module:
   • Slot Number
   • Number of Ports
   • Connector Type

Testing and Certifying Event Customizations

It is recommended that you test and certify event customizations in your lab before moving them to production:

To receive events from a device, you must configure the device with the details of the Prime Network server. For example, use the following commands for devices running Cisco IOS or Catalyst OS software:

```
snmp-server host 172.20.2.160
logging trap informational
logging source-interface Loopback0
logging on
logging 172.20.2.160
```

A similar set of commands should be used for devices belonging to other manufacturers.

These commands enable the device to send traps to the specified gateway IP over port 162. Therefore, port 162 must be enabled to receive traps from the device. In addition, you must reserve port 1162 for the general trap processing by the Prime Network server. This task is handled by the AVM 100 process.

To test your event:

Step 1  Send an event from an NE or from a simulator. Open Prime Network Events and verify that:
   • Prime Network recognizes and processes the event
   • Event parameters—type, subtype, severity, and so on—are as expected
   • Unique ID is appended to source ID (ManagedElement)

After you complete the tests, move the customization to production and test there as well; see Testing and Certifying Event Customizations, page 3-22.
**Troubleshooting VCB Customizations**

This section describes basic troubleshooting procedures to perform when Prime Network cannot communicate with a U-VNE, and includes the following topics:

- Device Unreachable, page 3-23
- Investigation State Not Operational, page 3-23

**Device Unreachable**

If you cannot communicate with a U-VNE, try the following:

- Launch Prime Network Administration and verify the Admin Status and Operational Status of the VNE. The Admin Status should be Enabled and the Operational Status should be Up.
- Verify that you are using the correct SNMP and Telnet credentials for the device.
- Ping the device from the Prime Network server.

*Note*

For more information, see the *Cisco Prime Network 4.0 Administrator Guide*.

**Investigation State Not Operational**

If the investigation state of the U-VNE is any value other than Operational, perform the actions described in the following table.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partially Synchronized</td>
<td>The U-VNE is encountering a problem, such as an exception caused by a particular discovery command or an unsupported module.</td>
<td>Examine the AVM log for messages about:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Failed commands or OIDs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: For more information, see Prime Network Logs in the <em>Cisco Prime Network 4.0 Administrator Guide</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check Prime Network Vision or Events for an “unsupported module” system event.</td>
</tr>
<tr>
<td>Unsupported</td>
<td>The U-VNE is encountering registration problems.</td>
<td>Use the <code>vcb sitechanges view</code> command to verify that the U-VNE registrations were created properly. In particular, make sure that you used the correct sysObjectID for this device type when using the VCB to create the U-VNE-driver.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the sysObjectID is not correct:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete the U-VNE.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recreate the U-VNE driver using the correct sysObjectID. See Creating a U-VNE Using the GenericUVNE Template, page 3-7.</td>
</tr>
</tbody>
</table>

*Note*

For more information, see the *Cisco Prime Network 4.0 Administrator Guide*. 

*Table 3-5 Troubleshooting the Investigation State*
### Log Entry for Unsupported Module

The log entry for an unsupported module looks like this:

```
ERROR [07 07 2010 17:07:47.810 IST] - PhysicalCommandHandler.isEntitySupported -
192.168.20.1 can't create module with entry
value spec/physical/modules/.1.3.6.1.4.1.9.12.3.1.9.29.118.1/loaders will use
default module loader
```

If you have an unsupported module, your choices are to either use the VCB to add the module (see Adding Support for a New Pluggable Module, page 3-13), or manage the device in Prime Network without managing that particular module.

### Deploying VCB Customizations to Your Production Environment

**Tip**

Always perform customization in a maintenance window.

During a maintenance window, recreate the extensions that you have tested and certified in your lab by following this procedure:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>(Optional) View the extensions that exist in your lab system, taking note of those that you want to deploy in your Prime Network production system.</td>
<td>Viewing Existing VCB Customizations in the Registry, page 3-24</td>
</tr>
<tr>
<td>Step 2</td>
<td>Export the extensions from the Prime Network gateway in the lab to the VcbImportCommands.sh file, located in NETWORKHOME/Main.</td>
<td>Exporting VCB Customizations to Another Gateway, page 3-26</td>
</tr>
<tr>
<td>Step 3</td>
<td>Import the VcbImportCommands.sh file to the Prime Network gateway in the production environment. If necessary, you can remove any extensions that you do not want to deploy from the script.</td>
<td>Importing VCB Customizations from Another Gateway, page 3-26</td>
</tr>
<tr>
<td>Step 4</td>
<td>Restart all AVMs and VNEs that support the customizations.</td>
<td></td>
</tr>
<tr>
<td>Step 5</td>
<td>Repeat testing and certification to ensure that the customizations are functioning as expected in your production environment.</td>
<td>Performing the U-VNE Tests, page 3-18</td>
</tr>
</tbody>
</table>

### Viewing Existing VCB Customizations in the Registry

To view registry changes to the site.xml file made with the VCB, enter the following command:

```
vcb sitechanges view -user username -password password
```

Here is an example of the `vcb sitechanges view` command output; this examples shows customizations that were made, including some event patterns, event parsing rules, and events.

```
# [~/Main/registry/ConfigurationFiles]% vcb sitechanges view -user username -password password

>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>>Event Pattern<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<<
Hive Name:cisco-syslog-ipcore-parsing-rules
Group: cisco-syslog-ipcore-parsing-rules
```
Pattern ID: 5004
Rule Name: FWSM-5-713131
Repository: cisco-syslog-repository
User-defined: true

Pattern ID: 5005
Rule Name: FWSM-4-109022
Repository: cisco-syslog-repository
User-defined: true

Hive Name: cisco-syslog-repository
Group: cisco-syslog-repository
Pattern ID: 5006
Rule Name: FWSM-5-713131
Repository: cisco-syslog-repository
User-defined: true

Hive Name: cisco-trap-product-parsing-rules
Group: cisco-trap-product-parsing-rules
Pattern ID: 5007
Rule Name: STACKWISE-MEMBER-STATUS
Repository: cisco-trap-repository
User-defined: true

Event Parsing Rules

**Event Name: stackwise status trap**
Alarm ID: 9061
User Defined: true
Subtype: stack member removed
Severity: WARNING
Short Description: Stack Member Removed
Ticketable: true
Auto Clear: true
Subtype: stack member added
Exporting VCB Customizations to Another Gateway

You can export your VCB customizations and then import them to another Prime Network gateway. During export, all customizations in the registry will be exported, including all user-defined items and all system default overrides.

To export VCB customizations:

Step 1 In the VCB tool, click Export Customization. The customizations are exported from site.xml to a VCB command script file, VcbImportCommands.sh, located in \NETWORKHOME\Main.

Step 2 Save the file.

Importing VCB Customizations from Another Gateway

To import VCB customizations:

Step 1 In the VCB tool, click Import Customization.

Step 2 Select the VcbImportCommands.sh file to be imported. The full script is displayed in the Import Customizations dialog.

Step 3 Optional. Review the script and remove commands that you do not want to import. Click Next.

Step 4 Enter the required credentials, as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway Username and Password</td>
<td>The username and password used to access Prime Network components, including the gateway.</td>
</tr>
<tr>
<td>Prime Network Username and Password</td>
<td>The username and password used when logging into the Prime Network GUI.</td>
</tr>
</tbody>
</table>
Deleting VNE Customizations from the Registry

These topics describe how to roll back a registry configuration to its original settings, and how to completely delete customizations from the registry.

Customizations using the VCB affect VNE drivers and update the Prime Network registry in a safe manner. The VCB enables you to roll back easily; you can remove:

- All VCB customizations with one command, restoring your system to a factory-defined state.
- Selective VCB customizations, using one command per customization that you want to remove.

Because VCB customizations are carried forward during an upgrade to a new version of Prime Network, your customizations continue to override any new or updated VNE drivers or newly supported events and modules. The ability to remove changes selectively enables you to discontinue particular overrides only and take advantage of any newly added support.

To delete VNE customizations:

**Step 1** Create a script file, VcbDeleteCommands.sh, in NETWORKHOME/Main by entering this command:

```
vcb sitechanges delete -user username -password password
```

**Step 2** (Optional) To retain any specific customizations, edit the VcbDeleteCommands.sh file and remove any line that deletes a customization that you want to keep. The commands of interest in the file start with `$VCBPATH` as shown in this example:

```
$VCBPATH eventpattern delete -group cisco-syslog-ipcore-parsing-rules -patternid 5001 -user $USER -password $PASS >> "$VCT_IMPORT_SCRIPT_LOG"
```

**Step 3** Change permissions on the script to ensure that it is executable, by entering a command such as this one:

```
chmod 755 VcbDeleteCommands.sh
```

**Step 4** Run the script from the NETWORKHOME/Main folder, by entering this command:

```
VcbDeleteCommands.sh user username password password
```
Creating Commands and Command Scripts to Perform Device Configuration Operations

Prime Network provides two tools for creating commands and scripts that perform device configuration operations: Command Builder and Command Manager. Commands can range from simple show commands to command scripts that contain wizards with multiple pages and input methods, such as check boxes and drop-down lists. After you create command scripts, you can add them to the Vision GUI client. Users with the required privileges can run the command scripts by right-clicking an NE’s Commands menu. To get started, see these topics:

- How is Command Manager Different From Command Builder?, page 4-1
- Checking Global Command Settings Before You Begin Using Command Manager, page 4-2
- Using Command Manager to Create and Execute Device Configuration Command Scripts, page 4-3
- Using Command Builder to Create Device Configuration Command Scripts, page 4-19

How is Command Manager Different From Command Builder?

Command Manager uses the Command Builder back-end, but unlike Command Builder, it also provides a command repository that contains all of the device-level commands and command scripts on the Prime Network gateway. Command Manager also allows you to execute commands on multiple devices at one time. You can organize commands by assigning versions to commands, or group commands into user-specified packages. For bulk configurations, you can do parameter substitution by importing data from a file.

Command Manager supports creating commands and command scripts at the network element level (IManagedElement). Therefore, the command repository only displays scripts that are available at the device level. To create commands at other levels, use Command Builder.
Chapter 4      Creating Commands and Command Scripts to Perform Device Configuration Operations

Checking Global Command Settings Before You Begin Using Command Manager

While Command Manager and Command Builder let you specify the required user access level for commands, Prime Network has some global settings which will also affect authentication and authorization:

- Whether users must enter their credentials before running command scripts
- Whether users can schedule device configuration jobs
- Whether a warning message is displayed when users run command scripts

These settings are controlled from the Administration GUI client and are described in the following sections.

Controlling Who Can Run Command Scripts

Users can execute commands from the Vision GUI client when a device is in their scope and they have sufficient privileges. You specify the required privileges when you create the command’s basic information. However, the following two settings in the Administration GUI client will also affect command operation. (These are in the Administration GUI client under Global Settings > Security Settings > User Account Settings.)

<table>
<thead>
<tr>
<th>Global Setting</th>
<th>How It Affects Command Manager and Command Builder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution of Commands</td>
<td>If enabled (“Ask for user credentials when running device configuration operation” check box is checked), requires users to enter their credentials when they execute a command from a device’s right-click Commands menu in the Vision GUI client, or when commands are run from Command Manager. This only applies to commands that are executed immediately (it does not apply to scheduled commands). Provisioning and Audit events display an additional column that lists the username. This setting is disabled by default.</td>
</tr>
<tr>
<td>Job Scheduling</td>
<td>Enables and disables the global per-user job authorization mode. This affects Command Manager jobs, and commands that are scheduled using the device right-click Commands menu in the Vision GUI client. If the mode is enabled, job scheduling privileges are controlled by the setting in the individual user accounts.</td>
</tr>
<tr>
<td></td>
<td>• If this mode is enable and a user is granted privileges, the user can schedule jobs across the product.</td>
</tr>
<tr>
<td></td>
<td>• If this mode is enabled and a user is not granted privileges, the job scheduling features in the user’s GUI clients are disabled.</td>
</tr>
<tr>
<td></td>
<td>If the global per-user authorization mode is disabled, all users can schedule jobs; the setting in the user’s account is ignored. This mode is disabled by default (all users can schedule jobs).</td>
</tr>
</tbody>
</table>

For more information on these global settings, see the Cisco Prime Network 4.0 Administrator Guide.
Displaying a Warning Message When Users Run Commands

Prime Network can be configured to display a warning message whenever users execute commands. This affects Command Manager jobs, and any commands that are executed using the device right-click Commands menu in the Vision GUI client.

Users must acknowledge the message before proceeding. This feature is disabled by default. To enable it and specify a message, choose Global Settings > Commands in the Administration GUI client, enable the feature, and enter the message text. When users run commands, they will have to acknowledge the warning message or Prime Network will not allow them to proceed.

Using Command Manager to Create and Execute Device Configuration Command Scripts

These topics describe how to use Command Manager to create device configuration commands and command scripts:

- What is Command Manager?, page 4-3
- Steps for Creating and Deploying Commands with Command Manager, page 4-4
- Command Manager Window and Repository, page 4-5
- Creating and Testing a Command or Command Sequence, page 4-7
- Running Commands Using Input Stored in a File, page 4-16
- Controlling Command Manager Jobs, page 4-17
- Moving, Importing, and Exporting Commands, page 4-17
- Deleting Commands and Packages, page 4-18
- Deleting Commands and Packages from the Prime Network Command Repository, page 4-18

What is Command Manager?

Like Command Builder, Command Manager provides a GUI framework for creating programmable SNMP or Telnet commands. Commands can include multiple input screens and multiple input methods—text fields, check boxes, drop-down lists, and so forth. Commands can include parameters that are fixed. You can also perform bulk configurations using XLS or CSV files to populate the parameter values.

Command Manager uses the Command Builder back-end, but it provides the following additional features:

- View the command repository, which contains all device-level commands available on the system
- Execute commands on multiple devices
- Use input from files to provide parameter substitution
- Apply versions to individual commands
- Create command packages
However, Command Manager commands can only be applied at the network element (IManagedElement) level, while Command Builder commands can be associated with any existing object group (IMO), type, or instance. This is why only device-level commands are listed in the command repository.

Once a command is created, it is added to the central repository and can be made available to other NEs of the same family, NE type, or software version, and can be executed from the Vision GUI client by users according to their device scope and privileges. Users with Configurator privileges can also create simple command sequences, although command sequences can only be run from the command repository (not from the Vision GUI client).

Command information is stored in XML files that can be organized into packages. The Default package contains all commands that are provided with Prime Network. If applicable, the Production package contains customized commands that were migrated from another installation.

Command Manager jobs are purged according to the Prime Network job purging settings. Commands information (including rules, parameters, and script implementations) are stored on the gateway and are not purged; only Command Manager jobs are purged.

Commands created with Command Manager can be used by Transaction Manager and the legacy Workflow and Activation features. Commands can also be integrated into external configuration applications using the Prime Network API. For information on how to do this, see the Cisco Prime Network Integration Developer Guide on the Cisco Developer Network website.

**Note**

The Prime Network Workflow and Action features are replaced by Transaction Manager in all new installations of Prime Network 4.0. If you have upgraded to Prime Network 4.0, the Workflow and Activation features are still available, but they will be deprecated in the future. We recommend that you use Transaction Manager for device configuration operations.

### Steps for Creating and Deploying Commands with Command Manager

The following table lists the steps you must follow to create a command or command sequence.

<table>
<thead>
<tr>
<th>Step Description</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 Check the settings that may affect who can run commands you create, and</td>
<td>Checking Global Command Settings Before You Begin Using Command Manager, page 4-2</td>
</tr>
<tr>
<td>whether a warning message is displayed when users run a command.</td>
<td></td>
</tr>
<tr>
<td>Step 2 Create a package for the command, giving it a name that is meaningful for</td>
<td>Creating a New Package, page 4-7</td>
</tr>
<tr>
<td>its contents (such as a device type). We recommend not using the Default package</td>
<td></td>
</tr>
<tr>
<td>to keep customized commands separate from out-of-the-box commands (for ease of</td>
<td></td>
</tr>
<tr>
<td>management).</td>
<td></td>
</tr>
<tr>
<td>Step 3 Provide a name for the command (that will appear in the NE right-click menu) and specify the required user access level (this is the command’s basic information).</td>
<td>Defining a Command’s Basic Information, page 4-8</td>
</tr>
</tbody>
</table>
Chapter 4      Creating Commands and Command Scripts to Perform Device Configuration Operations

Using Command Manager to Create and Execute Device Configuration Command Scripts

<table>
<thead>
<tr>
<th>Step Description</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 4</td>
<td>Define the properties that determine the format and structure of the command input form. These are called the <em>Execution Parameters</em>. For each parameter, define the type of input the user must provide (a string, a choice from a drop-down list, a checked check box, and so forth). A command can have multiple parameters, or multiple input pages (tabs), each with their own parameters. If you use Bean Shell scripts in the next step, you can use the script logic to populate and validate the parameter values.</td>
</tr>
<tr>
<td></td>
<td>Defining Execution Parameters for a Command, page 4-9</td>
</tr>
</tbody>
</table>
| Step 5 | Specify the devices and software versions that the command can be run on, along with the scripts that should run when a user executes the command. These are called *Command Implementations*. Scripts can use:  
  * Bean Shell over Telnet or SNMP, or  
  * Cisco Prime Network Macro language (over Telnet only).  
You can also specify rollback scripts and the conditions that indicate the command has failed. |
| | Defining the Implementations (Scripts) for a Command, page 4-11 |
| Step 6 | Test the command locally by previewing each implementation. |
| Step 7 | Create the command. |
| Step 8 | Test the command to see how it will appear to the user, review the script execution, and execute the command (which deploys the command to applicable devices). |
| | Testing and Deploying Commands and Checking Command Job Results, page 4-15 |
| Step 9 | Check the command job status. |
| | Controlling Command Manager Jobs, page 4-17 |

**Command Manager Window and Repository**

Launch the Command Manager from Change and Configuration Management, as shown in the following figure. You may have to expand the title bar by clicking the arrow at the top left.

![Command Manager Window](image)

When you select **Command Manager > Repository**, Prime Network displays all of the device-level commands in the system. The Default package contains the out-of-the-box commands provided with Prime Network. The Production package is only populated in upgrade scenarios and contains the commands that were migrated from the older deployment. Commands can be executed from the repository or from the devices (in the Vision GUI client). Commands displayed in the repository are filtered according to the user’s access level.

The command repository only lists device-level commands (that is, commands at the IMangedElement level). For commands at other levels, use Command Builder.
Commands are indicated by a yellow lightning bolt and sequences by a blue lightning bolt. You can get the following information from the repository:

- Find out whether the command can be executed on different device types. This is indicated by a hyperlink in the Device Type column, as shown in the following figure. In this example, the Add DNS Server command can be executed on all CRS, ASR 9000, and 12000 routers. This also indicates that if those devices appear in a Vision GUI client map, the Add DNS Server command can be executed from the device’s right-click Commands menu.

![Figure 4-1 Command Manager Repository Showing Applicable Device Types for a Command](image)

- Find out if the command can be executed on multiple software versions (for a single device type). This is indicated by a hyperlink in the Software Version column. In the following example, the Create Lane command can be executed on a Cisco RF Gateway Series device that is running any of the software versions that are listed.

![Figure 4-2 Command Manager Window Showing Applicable Software Versions for a Command](image)

Users with Administrator and Configurator privileges can perform all operations on all commands—editing, executing, deleting, moving, and so forth. All other users can perform these operations if they have the required privileges for the command, and the device is in their scope.
Creating and Testing a Command or Command Sequence

Commands and sequences must be created within a package. A best practice is to create a package with a name that describes the contents, such as the device series the command can be run on.

Commands can be duplicated and edited, but only if they are user-created commands. You cannot duplicate out-of-the-box commands that are packaged with Prime Network.

When you create a command (by clicking Create in the Command Implementations area), the command is saved to the database. It is not deployed to any NEs until you go to the repository, select the command, and click Run Command.

These topics provide the steps required to create, test, and deploy commands and command sequences:

- Creating a New Package, page 4-7
- Creating a New Command, page 4-8
- Creating a Command Sequence, page 4-14
- Testing and Deploying Commands and Checking Command Job Results, page 4-15

Creating a New Package

Use the package mechanism to organize your command scripts. Naming packages by device type is a good practice, as shown in the following figure. If you need to create a new package, click the New Package icon on the upper left side of the window and provide a name and optional description.

Figure 4-3 Command Packages

If you delete a command from a user-created package (such as CRS-1 or Nexus7000 in the previous figure), the command is removed from the package but it is copied to the Default package. This ensures that there will be no problems if the command is part of a scheduled job.

New commands that are installed from a Device Package are not listed in the command repository unless Prime Network is restarted. (Remember that the command repository only lists device-level commands; that is, commands at the IManagedElement level.)

To create a new command, proceed to the next section. To create a command sequence, see Creating a Command Sequence, page 4-14.
Creating a New Command

These are the steps for creating a new command script with Command Manager:

- Defining a Command’s Basic Information, page 4-8
- Defining Execution Parameters for a Command, page 4-9
- Defining the Implementations (Scripts) for a Command, page 4-11

Defining a Command’s Basic Information

The basic information for a command includes the name that will appear in the Vision GUI client (in the NE right-click menu) the user authorization that is required to use the command.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Select a package from the Commands Organization area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tip</td>
<td>Do not use the Default package because it contains all commands provided by Prime Network. This makes it easier to manage customized commands.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
<th>Click New Command to open the command wizard builder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Configure the command’s basic information in the Command Info area.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command Info</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td></td>
</tr>
<tr>
<td>Command Title</td>
<td>The name of the command. This is what will be displayed in the Vision GUI client when a user right-clicks an NE and chooses Commands.</td>
</tr>
<tr>
<td>Menu Category</td>
<td>The menu under which the command should be listed. This specifies where the command is displayed when a user right-clicks the NE in the Vision GUI client. For example, for a command named new-command:</td>
</tr>
<tr>
<td></td>
<td>- Commands—Would render Commands &gt; new-command</td>
</tr>
<tr>
<td></td>
<td>- Commands/Custom—Would render Commands &gt; Custom &gt; new-command</td>
</tr>
<tr>
<td>Version</td>
<td>A number or letter which helps you track instances of the same command. A best practice is to change this when you upgrade a device software image or add a new NE model.</td>
</tr>
<tr>
<td>Visible in menu</td>
<td>Whether users can see the command in the Vision GUI client.</td>
</tr>
<tr>
<td></td>
<td>Tip            Do not make commands visible until you have tested them.</td>
</tr>
<tr>
<td>Description</td>
<td>Command description. A best practice is to fill this field because it will make it easier to identify customized commands from those that are supplied with Prime Network.</td>
</tr>
<tr>
<td>Authorization</td>
<td>User access level required to run the command. (The user will be permitted to execute the command only if the device is in their scope.)</td>
</tr>
</tbody>
</table>

| Step 4 | Click Next to begin entering the command’s implementation parameters. |
Defining Execution Parameters for a Command

Note
If you are creating a command that requires no input—for example, a simple show command—skip this section and proceed to Defining the Implementations (Scripts) for a Command, page 4-11.

The Execution Parameters determine the structure and format of the input form and the data that users must supply. Each parameter has an associated input type which determines how information is entered (for example, typing in a number or string, checking a check box, choosing from a drop-down list). You can specify:

- Required parameters and optional parameters.
- Parameters with default values which can be visible or hidden in the input form.

A command can have one parameter, multiple parameters, and multiple input pages (tabs) with their own parameters.

Step 1
Define your first parameter by clicking New Parameter in the Execution Parameters area, and provide the basic information for the execution parameter.

<table>
<thead>
<tr>
<th>Execution Parameters Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name of the parameter. This is what will be displayed in the command dialog when the user runs the command.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Parameter name. This entry must be unique and can contain only letters, numbers, hyphens (-), and underscores (_).</td>
</tr>
<tr>
<td>Tooltip</td>
<td>A tooltip (maximum of 256 characters).</td>
</tr>
</tbody>
</table>

Step 2
Define the input type for the parameter.

Tip
Use TextArea for multi-line parameter values (e.g., license, banner, and so on). Do not use it to configure multiple commands in a single parameter. Doing so will download all commands to the device, but the command output will only be partial.

<table>
<thead>
<tr>
<th>For this type of user input:</th>
<th>Choose this type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A type conversion</td>
<td>String</td>
</tr>
<tr>
<td></td>
<td>Long</td>
</tr>
<tr>
<td>A number</td>
<td>Integer or float</td>
</tr>
<tr>
<td>Multi-line string that will be referenced as a single attribute (for example, information that can be cut and pasted (including end-of-line characters &lt;CR&gt;&lt;LF&gt;))</td>
<td>TextArea</td>
</tr>
<tr>
<td>An IP address or IP subnet mask</td>
<td>IPSubnet</td>
</tr>
<tr>
<td></td>
<td>IPAddress</td>
</tr>
<tr>
<td>A drop-down list of choices (see the following instructions)</td>
<td>Combo</td>
</tr>
</tbody>
</table>
If you choose **Combo**, an Add button appears in the wizard. Click **Add** to create choices for the combo box.

<table>
<thead>
<tr>
<th>Add Combo Options</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>A value that will be associated with the option; for example, 1.</td>
<td>1 2</td>
</tr>
<tr>
<td>Label</td>
<td>The description of the entry that is displayed in the selection list (drop-down list) of the input form, such as <strong>Up</strong>.</td>
<td>Up Down</td>
</tr>
</tbody>
</table>

The example in the previous table would create a combo box with the choices **Up** and **Down**.

**Step 3**

Define the rest of the execution parameter. The choices depend on what you specified in the Type field.

<table>
<thead>
<tr>
<th>Execution Parameters Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>default</td>
<td>The default value (a number, enabled, etc.).</td>
</tr>
<tr>
<td></td>
<td>To force the user to enter a value (without specifying a default), leave it blank and choose <strong>Required</strong>.</td>
</tr>
<tr>
<td>Display width</td>
<td>The maximum width in characters.</td>
</tr>
<tr>
<td>Visible</td>
<td>Whether the parameter will be visible in the command dialog.</td>
</tr>
<tr>
<td></td>
<td>If you uncheck the box, the parameter is hidden from the user but can still be used in the command with a default value.</td>
</tr>
<tr>
<td></td>
<td>To provide a constant value but keep it hidden from the user, uncheck the visible check box and provide a default value in the Default area.</td>
</tr>
<tr>
<td>Required</td>
<td>Specifies the input as mandatory. Mandatory input is designated by a red asterisk in the command.</td>
</tr>
<tr>
<td>Group</td>
<td>Indicates that the parameter belongs to a specified group. Parameters in a group are displayed together inside a box, with the group name as their title. For example, you could create a group called Authentication with two parameters: Username and Password. Username and Password would be enclosed in a box entitled Authentication.</td>
</tr>
</tbody>
</table>

**Step 4**

If you want the input to be either validated or populated when the user runs the command, click the **Validate** tab.

- **On Populate**—When Run Command is clicked, the BeanShell script should populate the parameters values according the script logic.
- **On Validate**—When Preview or Execute Now is clicked, the BeanShell script should validate the parameters values according the script logic.

**Note**

When creating or editing **On Populate** or **On Validate** BeanShell scripts, you must restart the Vision GUI client for the changes to take effect.

**Step 5**

Click **OK**, and the new parameter is added to the list of Execution Parameters.

**Step 6**

Create more parameters as needed by repeating **Step 1 through Step 5**.
Step 7 If you want to create additional pages (tabs) or adjust the order of parameters, use the tools illustrated in the following figure.

Step 8 When you have finished creating the parameters, click Next to begin entering the Command Implementations (the scripts that will be executed and the devices they can run on).

Defining the Implementations (Scripts) for a Command

Note All scripts are run at the network element level (IManagedElement).

The Command Implementations are the scripts that are run when the user executes the command. Implementations can use BeanShell (Telnet or SNMP) or Cisco Prime Network Macro language (Telnet only). You can also specify a rollback script and the conditions that indicate the command has failed.

When you create an implementation you also define which device types the command applies to. You can choose different degrees of granularity:

- All devices
- Device family (such as routers)
- Device series (such as Cisco 7200 routers)
- Device model (Cisco 7207)

However, if you choose all devices, you cannot specify multiple software versions.

When a command is deployed, it overrides any inherited command from a higher level and automatically applies to elements below it. For example, the following tables shows how command versions can be overwritten:

<table>
<thead>
<tr>
<th>Chronological Actions</th>
<th>Results in these devices using this version:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>7200 routers</td>
</tr>
<tr>
<td>1. Version 1 is applied to all devices (family)</td>
<td>1</td>
</tr>
<tr>
<td>2. Version 2 is applied to only the Cisco 7207 (model)</td>
<td>1</td>
</tr>
<tr>
<td>3. Version 3 is applied to all Cisco 7200 routers (series)</td>
<td>3</td>
</tr>
<tr>
<td>4. Version 4 is applied to all switches (family)</td>
<td>3</td>
</tr>
</tbody>
</table>
Chapter 4  Creating Commands and Command Scripts to Perform Device Configuration Operations

Using Command Manager to Create and Execute Device Configuration Command Scripts

**Step 1**  Define the scripts that will run by clicking **New Implementation** in the Implementations area.

**Step 2**  In the General tab, provide the following script information.

<table>
<thead>
<tr>
<th>Command Implementations Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name for the implementation, such as a device type, device series, or technology. For example, one profile could be <em>command-AllDevices</em>, another could be <em>command-Cisco7600</em>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td>Device Types</td>
<td>The NEs that this command can be run on. To apply multiple software versions, choose the same device type. The device type should align to the profile name.</td>
</tr>
<tr>
<td>Software Version</td>
<td>The device software versions that are available for the chosen devices. If you select a device series, this choice is disabled. If you subsequently update the software version on a device, you must also update the command.</td>
</tr>
<tr>
<td>Type</td>
<td>The scripting language to be used for the command:</td>
</tr>
<tr>
<td></td>
<td>• CiscoCisco Prime Network Macro—Simple mode. (See <em>Prime Network Macro Language</em>, page C-1.)</td>
</tr>
<tr>
<td></td>
<td>• BeanShell—Programmable mode; full scripting language. (See <em>BeanShell Commands</em>, page C-11.)</td>
</tr>
<tr>
<td>Protocol</td>
<td>The protocol to use. If the command has multiple profiles, they must use the same protocol.</td>
</tr>
<tr>
<td></td>
<td>• Telnet</td>
</tr>
<tr>
<td></td>
<td>• SNMP (BeanShell only)</td>
</tr>
<tr>
<td>Timeout</td>
<td>The timeout value for the command, in milliseconds. If a timeout occurs, the command continues to run in the background.</td>
</tr>
</tbody>
</table>

**Step 3**  Click the Script tab to define the command script, using these guidelines:

- **Tip**  A best practice is to create the script in a text editor, then cut and paste it into the Script area of the Script tab.

- To view all user-defined and built-in parameters in the Command Builder application, position the cursor in the Script or Rollback field and press **Ctrl-Spacebar**. A dialog box is displayed that lists all available arguments (containing both the user-defined input argument and the built-in properties...
Using Command Manager to Create and Execute Device Configuration Command Scripts

of the IMO context). Also see Supported Pragmas, page C-4.

- Enclose pragmas with square brackets: [...].
- To enter a required carriage return in the command line, enter the escape sequence &cr.
- It is possible to use multiple pragmas in a single line, in which case all pragmas are analyzed. If the same type of pragma is repeated, only the last one is used.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>The Telnet or script lines to be sent to the NE. The script lines can contain optional inline directives (pragmas) for finer granularity control. For more information about the supported pragmas, see Supported Pragmas, page C-4.</td>
</tr>
<tr>
<td>Rollback</td>
<td>(Optional) The rollback script that is used when the command fails. Note: If the rollback script fails, no additional actions are performed.</td>
</tr>
<tr>
<td>Failure Condition</td>
<td>(Optional) A general failure condition that applies to all script lines. To specify a failure condition: 1. Check the Failure Condition check box. 2. In the Failure Condition field, enter the text that is to be looked for during script execution. If the specified text appears in the reply, the command is aborted.</td>
</tr>
</tbody>
</table>

**Step 4** When you are finished with the implementation, click OK.

**Step 5** Create more profiles as needed by repeating Step 2 through Step 4.

**Step 6** Click Create when you are done. The newly created command is displayed in the command repository table. (It is not yet deployed to devices; that happens when you select Run Command.)

**Step 7** Test the command locally before deploying it. See Testing and Deploying Commands and Checking Command Job Results, page 4-15.
Creating a Command Sequence

Users with Configurator privileges can create command sequences. Sequences can only be executed from the command repository (not from the Vision GUI client). You cannot specify different devices for the different commands in a sequence.

**Step 1** Choose a package. If you need to create a new package, click the New Package icon on the upper left side of the window and provide a name and optional description.

**Tip** Do not use the Default package because it contains all commands provided by Prime Network. This makes it easier to manage customized commands.

**Step 2** Click **New Sequence** to open the Create Command Sequence wizard.

**Step 3** Configure the sequence’s basic information in the Command Sequence Info area. Note that there is no authorization level field; only users with Configurator privileges can create and run sequences. There is also no menu field because sequences can only be run from the command repository, not from the Vision GUI client.

**Step 4** Add the commands to the sequence in the Define Sequence area by clicking **Add Commands**. A dialog opens that lists all device-level commands in the repository (from all packages, including the Default package).

**Step 5** Select the commands you want to add to the sequence and click **Add**.

**Step 6** Configure the commands in the sequence. (You cannot edit the command contents.)

- Ensure that each command is also configured with a rollback sequence in the Create Command Sequence area. You can add a rollback sequence from the command repository by clicking the **Add** link.
- Adjust the command order.

**Step 7** Click **Create** when you are done. The newly-created command is displayed in the command repository and can be executed from the repository.

**Step 8** Test the command locally. See Testing and Deploying Commands and Checking Command Job Results, page 4-15.

<table>
<thead>
<tr>
<th>Command Info Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Sequence Title</td>
<td>The name of the sequence. This is what will be displayed in the repository.</td>
</tr>
<tr>
<td>Command Sequence Name</td>
<td>The sequence name used and saved in the database.</td>
</tr>
<tr>
<td>Version</td>
<td>A number which helps you manage multiple instances of the command. A best practice is to change this when you have a command deployed to specific devices, and you want to update it for those devices.</td>
</tr>
<tr>
<td>Description</td>
<td>Command description. A best practice is to fill this field because it will make it easier to identify customized commands from those that are supplied with Prime Network.</td>
</tr>
</tbody>
</table>
Testing and Deploying Commands and Checking Command Job Results

Testing a command provides a command trial run so you can see how it will appear to users. You can also use the preview feature to see the expected script output without performing any real command executions.

Once you execute a command with Create Execution Job (at the end of the following procedure) Prime Network creates a command job and displays a dialog that contains a hyperlink to the job details. To check the job status for completed and schedule jobs, select Command Manager > Jobs from the Change and Configuration Management menu.

---

**Step 1** Select the command or sequence in the repository and click Run Command. The command input forms are generated.

**Step 2** Enter the required input.

**Step 3** Choose the devices and software versions on which you want to run the command.

**Step 4** To verify the parameters that you entered and see what the executed scripts will look like, click Preview.

**Step 5** If the result is satisfactory, click Create Execution Job to:

- For a command, deploy it to the selected NEs.
- For a command sequence, save it to the repository.

**Step 6** Click the job hyperlink to view the job results. To get job details, select the job and click the hyperlink under the Last Run Result column. If the job was for a command sequence, as in the following example, you can check the results of each command in the sequence.
• If the job failed or was only partially successful, click the red X under Status to get details about the failure. By hovering over the Device Properties icon, you can get quick device details about the reachability of the device.

• If the job was successful, click the Transaction Log tab to see what scripts were sent to the device. Click the Debug Trace tab to view the information that was received from the device.

Running Commands Using Input Stored in a File

For bulk configurations, you can create an XLS or CSV files with parameter values and import the file into the command.

**Step 1** Create a file that contains the parameter values.

a. Select the command from the repository and click **Run Command**.

b. Select the devices you want to configure and click the **Export** icon at the top right of the screen.

c. In the Export Execution Parameters dialog, click **OK** to continue with the export operation.

d. When your browser displays its file management dialog, download the file. The file is created with the name `command.csv`.

**Step 2** Populate the `command.csv` file with your desired attribute values. One column is dedicated to each attribute.

**Step 3** Run the command using your `command.csv` file as input.

a. Select the command in the repository and click **Run Command**.

b. Select the devices you want to configure. They must match the devices in your spreadsheet.
c. In the Execution Parameters area, click the import icon.

<table>
<thead>
<tr>
<th>Execution Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>* All Selected Devices</td>
</tr>
<tr>
<td>10.17.204.22</td>
</tr>
<tr>
<td>77meg176</td>
</tr>
<tr>
<td>7430176</td>
</tr>
<tr>
<td>7box</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customer Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
</tr>
<tr>
<td>Active Customer</td>
</tr>
</tbody>
</table>

| OK                    |

d. Navigate to the file that contains your input, and click **OK**.

**Step 4** Run the command.

---

**Controlling Command Manager Jobs**

Users with Configurator privileges can perform all job actions from the Command Manager Jobs window. This includes suspending and rescheduling jobs, and editing job properties (such as changing the selected devices). Other users can only manage jobs that they own.

Command Manager jobs are automatically deleted according to the Prime Network job purging settings. By default, these jobs are never purged.

For examples of how to view job results, see Testing and Deploying Commands and Checking Command Job Results, page 4-15.

**Moving, Importing, and Exporting Commands**

To move commands to a different package, select the commands in the repository and click the Move To icon. You can only move user-created commands; you cannot move the out-of-the-box commands packaged with Prime Network (these are in the Default package).

You can also export and import user-created commands and packages. Exported items are saved in a zip file on the client machine. This is useful when you want to clean up the repository or if you create commands that you plan to use at a later time. You can choose individual files to export but it is easiest to create a new package and export the package. This allows you to organize the commands and, if needed, create several packages to export. The organization is maintained when the commands or packages are imported.

Import operations will query you for the location of the zip file that contains the commands. If a command already exists, you will see an error message. You must delete the existing command instance from the repository, or move it to another location.

Export operations will use the dialog that is appropriate to your browser. For example, the zip may be saved to your Downloads directory by default.
Deleting Commands and Packages

The following procedures explain how to:

- Remove a command from the Vision GUI client, but leave it in the command repository
- Remove a command or package from the command repository

Removing a Command from the Vision GUI Client

If you want to remove a customized command from the Vision GUI client, you can hide it without removing it from the repository. You cannot hide out-of-the-box commands that are provided with Prime Network.

**Note**

This operation may take some time depending on the number of NEs that are will be affected.

To remove a command from the Vision GUI client:

**Step 1** Select the command in the repository and click the **Edit** icon.

**Step 2** In the Command Info page, deselect the Visible in Menu check box.

**Step 3** Click **Save**. The command is hidden in the Vision GUI client.

Deleting Commands and Packages from the Prime Network Command Repository

You can only delete customized commands—that is, commands that were created by Prime Network users. Out-of-the-box commands cannot be deleted. In addition, customized commands can only be deleted if they are not part of:

- A scheduled job
- A command sequence

When a command is successfully deleted, it is removed from the repository and the Vision GUI client, and all related command data is deleted from the gateway and database.

When you delete a package, none of the customized commands in the package are deleted. Instead, the commands are moved to the Default package, from where you can delete them.

To delete a command, make sure that you are working from the right package in the Commands Organization area. Then choose the command and click the Delete button above the commands table.

To delete a package, select the package and use the Delete button in the Commands Organization area.
Using Command Builder to Create Device Configuration Command Scripts

These topics explain how to use Command Builder to create commands and make them available to other NEs:

- What is Command Builder?, page 4-19
- Steps for Defining a New Command, page 4-20
- Command Builder Window, page 4-20
- Creating a Command Using Command Builder, page 4-22
- Testing and Publishing Commands, page 4-33
- Exporting Commands with Command Builder, page 4-36
- Importing Commands with Command Builder, page 4-36
- Deleting Commands, page 4-37

What is Command Builder?

Command Builder is an integral part of the Prime Network Vision GUI. It is used to create custom commands to be executed on specified devices. These commands can be tested and then published, which enables a wider scope of NEs to use them. You can publish commands to NEs of the same family, NE type, or software version.

Command Builder commands execute a programmable sequence of SNMP or Telnet command lines. Commands can be created using the BeanShell scripting language or the Prime Network Macro Language. Commands can be associated with any existing object group (IMO), type, or instance. This enables access to the live information of the network object with which the command is associated.

Only users with Administrator or Configurator privileges can create commands using Command Builder. Commands can be used in a variety of ways:

- Using Command Builder, add the commands to the Prime Network Vision GUI client. Users will be able to run the commands by right-clicking an NE. When running the command, the user will be presented with a dialog for entering the input parameters that were defined during the command creation process.
- Using Prime Network Workflow, you can create a workflow template that calls multiple commands. This procedure is described in Steps for Creating a Workflow Template, page D-5.
- Using Prime Network Activation, you can create an activation wizard that will be added to the Prime Network Vision under the Activations menu. Users can start the wizard and pass values to the workflow, which in turn calls the Command Builder commands. This procedure is described in Steps for Creating an Activation Wizard, page D-24.
- Use the Prime Network API to integrate the commands into external configuration applications. For information on how to do this, see the Cisco Prime Network Integration Developer Guide on the Cisco Developer Network website.
Steps for Defining a New Command

These steps describe how to create a new command definition using Command Builder and the order in which the steps must be performed.

Figure 4-4   Steps for Defining a New Command

At any time after the command has been defined, it can be tested, executed, and published to a wider scope of managed elements and network elements.
For more information, see Creating a Command Using Command Builder, page 4-22.

Command Builder Window

Command Builder is launched by right-clicking a specific managed element or a selected object within a managed element and selecting **Management > Command Builder**.

The Command Builder window lists all existing commands that are available to the NE. (The technology-based commands that are packaged with Prime Network are not editable).
The commands that are listed depend on the NE type and the user’s access privileges.

**Figure 4-5** Command Builder Window

![Command Builder Window](image)

**Table 4-1** Command Builder Window

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the new command (also the filename).</td>
<td>ShowUsers</td>
</tr>
<tr>
<td>Menu Caption</td>
<td>The title that will appear in the command’s GUI window when it is launched from an NE.</td>
<td>List of Current Users</td>
</tr>
<tr>
<td>IMO Context</td>
<td>The inventory object associated with this command.</td>
<td>IMangedElement</td>
</tr>
<tr>
<td>Note</td>
<td>Commands are associated with a selected object within a managed element, enabling the command to use the object properties in the command definition. For example, if you select a port object, the portAlias and port status properties are automatically made available to the command.</td>
<td></td>
</tr>
<tr>
<td>Local</td>
<td>Specifies whether the command is inherited from a higher level (false) or is defined locally on the selected managed element (true).</td>
<td>false</td>
</tr>
</tbody>
</table>
Steps for Defining a New Command

Table 4-2 identifies the buttons that appear in the Command Builder window.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>New Element</td>
<td>Creates a new command definition on the local client machine.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Edit Element</td>
<td>Edits an existing command definition on the local client machine. When you edit an existing command, the changed command is saved as a local instance on the client machine. As with a new command, you can then publish it to make it available to other NEs. You can also edit commands that are packaged with Prime Network (for example, OAM commands that are launched from the right-click <strong>Commands</strong> menu). This is done by creating a clone of the command, which you can then edit.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Delete Element</td>
<td>Deletes a command that exists on the local client machine (has not been published).</td>
</tr>
<tr>
<td>![Image]</td>
<td>Export Element</td>
<td>Saves a full command definition on the gateway.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Import Element</td>
<td>Imports a command definition from the gateway to a local client machine. If the command already exists, it is overwritten (updated).</td>
</tr>
<tr>
<td>![Image]</td>
<td>Hierarchy Manager</td>
<td>Controls the NEs from which the command can be executed.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Run Command</td>
<td>Previews and executes a command. After you create, modify, or update a command, we recommend that you wait a few seconds before executing it. If the gateway is busy, waiting a few seconds allows sufficient time for Command Builder to obtain the correct version from the registry.</td>
</tr>
</tbody>
</table>

Creating a Command Using Command Builder

When you create a new command, you first create a local instance of the command. After you have tested the command, you can publish it to make it available to other NEs.

To create a command:

**Step 1** Launch Command Builder by right-clicking a managed element and choose **Management > Command Builder**. The window lists all existing commands that are available to the NE. (The technology-based commands that are packaged with Prime Network are not editable).

**Step 2** Click the **New Element** icon in the toolbar to open the New Command dialog box.

**Step 3** Enter the following information for your new command:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the new command (also the filename), such as <strong>ShowUsers</strong>.</td>
</tr>
<tr>
<td>Menu Caption</td>
<td>The title that will appear in the command’s GUI window when it is launched from an NE, such as <strong>List of Current Users</strong>.</td>
</tr>
</tbody>
</table>
Step 4  Click Next. The Command Authorizations dialog box is displayed.

Step 5  Select the security access roles that are authorized to execute the command.

Step 6  Click Next. The User Input Arguments dialog box is displayed.

You can define any number of input parameters. These parameters determine the structure and format of the input form. The input form is automatically generated when the command is executed.

You can use either of two types of command parameters: built-in parameters and user-defined parameters, both of which are replaced in runtime. All parameters (both built-in and user-defined) are available during command editing via a selection list. For more information about Prime Network Macro Language, see Prime Network Macro Language, page C-1.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Visible</td>
<td>Indicates whether or not the command should appear in the Prime Network Vision GUI client. For example, if you only want to use execute the command via the API, do not check the check box.</td>
</tr>
<tr>
<td>Menu Path</td>
<td>(If visible) The name that will appear in the NE’s right-click menu (such as Commands).</td>
</tr>
<tr>
<td>Context IMO</td>
<td>The object associated with this command. The object is within a managed element. All subobjects that do not appear in the inventory tree (such as parameter groups of a port) are listed in a drop-down list.</td>
</tr>
<tr>
<td>Timeout</td>
<td>The timeout value for the command, in milliseconds. The default value is 120000 milliseconds (2 minutes). If a timeout occurs, the command continues to run in the background.</td>
</tr>
<tr>
<td>Language</td>
<td>The scripting language to be used for the command:</td>
</tr>
<tr>
<td></td>
<td>• Prime Network Macro—Simple mode. (See Prime Network Macro Language, page C-1.)</td>
</tr>
<tr>
<td></td>
<td>• BeanShell—Programmable mode; full scripting language. (See BeanShell Commands, page C-11.)</td>
</tr>
<tr>
<td>Protocol</td>
<td>The protocol to use:</td>
</tr>
<tr>
<td></td>
<td>• Telnet</td>
</tr>
<tr>
<td></td>
<td>• SNMP (BeanShell only)</td>
</tr>
<tr>
<td>Warning Visible check box</td>
<td>This check box and its accompanying message text field appear only if the system is set to generate a message upon command execution warning the user that the command could potentially interrupt network services. You can deselect this check box to override this setting for the current command. When the user executes this command, no message will be shown.</td>
</tr>
<tr>
<td>Warning Text</td>
<td>Shows the message that will be displayed to users upon command execution. You can change the message as required. The text field is disabled if the Warning Visible check box is deselected</td>
</tr>
</tbody>
</table>
Step 7  To add a new argument, click **New**. The Add/Edit User Argument dialog box is displayed (Figure 4-6).

![Add/Edit User Argument for Command Dialog Box](image)

**Figure 4-6   Add/Edit User Argument for Command Dialog Box**

Step 8  Enter the required information:

<table>
<thead>
<tr>
<th>Property</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Parameter name. This entry must be unique and can contain only letters, numbers, hyphens (-), and underscores (_).</td>
</tr>
<tr>
<td>Caption</td>
<td>Parameter display name. This entry is displayed in the Command Builder execution window.</td>
</tr>
</tbody>
</table>
## Steps for Defining a New Command

1. Click the Advanced tab to open the Add Argument Advanced Controller dialog box.
2. Type the type of input that will be required upon execution of the command. Only input values that are valid for the selected type are accepted. These values are validated during runtime.
   - String
   - Integer
   - IPSubnet
   - Combo—For more information about defining a Combo field type, see **Defining a Combo Field Type for a Command Builder Command**, page 4-28.
   - IP Address
   - Float
   - Long
   - Text Area—Multi-line string field type into which you can cut and paste information, including end of line characters <CR><LF>. This is referenced in the script as a single attribute.

   **Note** This feature should be used only for multi-line parameter values (e.g., license, banner, and so on). It is not intended for configuration of multiple commands in a single parameter. Doing so will download all commands to the device, but present only a partial output in the command builder output.

<table>
<thead>
<tr>
<th>Property</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of input that will be required upon execution of the command. Only input values that are valid for the selected type are accepted. These values are validated during runtime.</td>
</tr>
<tr>
<td></td>
<td>- String</td>
</tr>
<tr>
<td></td>
<td>- Integer</td>
</tr>
<tr>
<td></td>
<td>- IPSubnet</td>
</tr>
<tr>
<td></td>
<td>- Combo—For more information about defining a Combo field type, see <strong>Defining a Combo Field Type for a Command Builder Command</strong>, page 4-28.</td>
</tr>
<tr>
<td></td>
<td>- IP Address</td>
</tr>
<tr>
<td></td>
<td>- Float</td>
</tr>
<tr>
<td></td>
<td>- Long</td>
</tr>
<tr>
<td></td>
<td>- Text Area—Multi-line string field type into which you can cut and paste information, including end of line characters &lt;CR&gt;&lt;LF&gt;. This is referenced in the script as a single attribute.</td>
</tr>
<tr>
<td>Width</td>
<td>Field width, in number of characters. Relevant for the Command Builder execution window.</td>
</tr>
<tr>
<td>Visible</td>
<td>Indicates whether this parameter appears in the Command Builder execution window. Check this check box to display the parameter, or uncheck the check box to hide the parameter from the user. If the argument is hidden, it can still be used in the command (with its default value).</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> When the parameter is not visible and has been assigned a default value, it can serve as a constant argument.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Specifies a tooltip for the command parameter. This string is displayed for the parameter field in the input form (see <strong>Testing the Command Locally Before Deploying It To Other NEs</strong>, page 4-33). The tooltip can be a maximum of 256 characters.</td>
</tr>
<tr>
<td>Default</td>
<td>A default value for the parameter.</td>
</tr>
<tr>
<td>Required</td>
<td>Indicates whether the argument is mandatory or optional. The mandatory arguments are displayed in bold font in the input form (see <strong>Testing the Command Locally Before Deploying It To Other NEs</strong>, page 4-33).</td>
</tr>
</tbody>
</table>

Click the Advanced tab to open the Add Argument Advanced Controller dialog box.
The Advanced option enables you to do additional actions on the parameter values using BeanShell.

- **On Populate**—The BeanShell script, executed when you click Run Command, can be used to populate the parameters values according to the script logic.
- **On Validate**—The BeanShell script, executed when you click Preview or Execute Now, can be used to validate the parameters values according to the script logic.

**Note**
When creating or editing On Populate or On Validate BeanShell scripts, you must restart the client for the changes to take effect.

**Step 9**
Click **OK**. The newly created argument is displayed in the User Input Arguments dialog box.

**Step 10**
To change sequence in which arguments appear in the input form, select an argument and click **Move Up** or **Move Down**.

**Step 11**
Click **Next**. The Tab Pages dialog box is displayed.

Use this feature if you want your input form to have different tabs. By default, all of the parameters are displayed in a single tab, General.

**Step 12**
If you want to use tabs, do the following:

- **a.** Click **New**. The Add/Edit User Tab Page dialog box is displayed.

**Figure 4-7**  
**Add/Edit User Tab Page for Command Dialog Box**

- **b.** Enter a name for the Tab and select the required parameter.

  You can define a maximum of 20 tabs for a command. The name of the tab can contain a maximum of 20 characters.

- **c.** Repeat the steps for additional tabs.
Step 13  Click Next to define the command script, which can be either Prime Network Macro Language scripts or Beanshell scripts. For more information, see Command Manager and Command Builder: Macro Language and Beanshell Reference, page C-1. The Script Lines dialog box is displayed, enabling you to add or edit a script line, as shown in Figure 4-8.

Note  An efficient way to do this is to create the script in a text editor, then cut and paste it into the New Command dialog box.

Step 14  Enter the required information, using the following guidelines:

- To view all user-defined and built-in parameters in the Command Builder application, position the cursor in the Script or Rollback field and press Ctrl-Spacebar. A dialog box is displayed that lists all available arguments (containing both the user-defined input argument and the built-in properties of the IMO context). Select an entry from the list and then click OK to add it to the Script or Rollback field.
- Pragmas are enclosed with square brackets: [...].
- It is possible to use multiple pragmas in a single line, in which case all pragmas are analyzed. If the same type of pragma is repeated, only the last one is used.
- If carriage returns are required in the command line, enter the escape sequence &cr.
Steps for Defining a New Command

Step 15 Click Finish. The Create Command dialog box is displayed.

A LED indicates the progress or status of the command as it is being saved to the registry:
- Blue—The command definition is being saved.
- Green—The command has been created or updated successfully.
- Red—Command Builder failed to create or update the command.

Step 16 Click Close when the command has been successfully saved. The newly created command is displayed in the Command Builder table.

See Testing the Command Locally Before Deploying It To Other NEs, page 4-33 to test the command.
See Publishing Commands to Other NEs, page 4-33 to publish the command.

Note If you plan to publish the command to multiple network elements so you can work on commands in bulk, be sure to delete your local copy of the command after it is published. Otherwise, when you choose multiple managed elements, the command will not be listed.

Defining a Combo Field Type for a Command Builder Command

If you want to use a combo box in your input form, choose Combo in the Add/Edit User Argument dialog box (Step 8 of the previous procedure), a Browse button is enabled. Use it to create a selection list (drop-down list) of valid options that will be displayed.

This example creates a combo box with Up and Down choices.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>The actual Telnet script lines sent to the NE. The script lines can contain optional inline directives (pragmas) for finer granularity control. For more information about the supported pragmas, see Supported Pragmas, page C-4.</td>
</tr>
<tr>
<td>Rollback</td>
<td>(Optional) The rollback script that is used when the command fails.</td>
</tr>
<tr>
<td>Failure Condition</td>
<td>(Optional) A general failure condition that applies to all script lines.</td>
</tr>
<tr>
<td></td>
<td>To specify a failure condition:</td>
</tr>
<tr>
<td></td>
<td>1. Check the Failure Condition check box.</td>
</tr>
<tr>
<td></td>
<td>2. In the Failure Condition field, enter the text that is to be looked for during script execution. If the specified text appears in the reply, the command is aborted.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Description</td>
<td>Script The actual Telnet script lines sent to the NE. The script lines can contain optional inline directives (pragmas) for finer granularity control. For more information about the supported pragmas, see Supported Pragmas, page C-4.</td>
</tr>
<tr>
<td>Rollback</td>
<td>(Optional) The rollback script that is used when the command fails.</td>
</tr>
<tr>
<td>Failure Condition</td>
<td>(Optional) A general failure condition that applies to all script lines.</td>
</tr>
<tr>
<td></td>
<td>To specify a failure condition:</td>
</tr>
<tr>
<td></td>
<td>1. Check the Failure Condition check box.</td>
</tr>
<tr>
<td></td>
<td>2. In the Failure Condition field, enter the text that is to be looked for during script execution. If the specified text appears in the reply, the command is aborted.</td>
</tr>
</tbody>
</table>
Steps for Defining a New Command

Step 3 Enter the required information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>A value that will be associated with the option; for example, 1.</td>
</tr>
<tr>
<td>Label</td>
<td>The description of the entry that is displayed in the selection list (drop-down list) of the input form, such as Up.</td>
</tr>
</tbody>
</table>

Step 4 Click Add.

Step 5 Repeat Steps 3 and 4 as needed until you have added all entries (such as 2 and Down).

Step 6 Click Close.

End-to-End Example of Creating a Macro Language Command

This topic provides an example of how to create the command, addvrf, using Prime Network Macro Language.

Step 1 Select the element that you want to configure this command for in the Prime Network Vision tree pane, context pane, or Inventory window.

Step 2 Right-click the element, then choose Management > Command Builder. The Command Builder wizard is displayed.

Step 3 Click New. The New Command dialog box is displayed.

Step 4 Define the command identification information:
- Name—addvrf
- Caption—Add VRF
- Menu Visible—Checked
- Menu Path—VRF Commands
- Context IMO—Automatically displayed
- Timeout—180000
- Language—Prime Network Macro
- Protocol—Telnet is selected by default

Step 5 Click Next. The Command Authorizations dialog box is displayed.

Step 6 Select the security access role Administrator.

Step 7 Click Next. The User Input Arguments dialog box is displayed.

Step 8 Click New. The Add/Edit User Argument for addvrf Command dialog box is displayed.
Step 9 Using Table 4-3, enter the information for the parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Parameter 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>vrfname</td>
<td>rd</td>
<td>rt</td>
</tr>
<tr>
<td>Caption</td>
<td>VRF Name</td>
<td>Route Distinguisher</td>
<td>Route Target Both</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
<td>String</td>
<td>String</td>
</tr>
<tr>
<td>Width</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Visible</td>
<td>Select</td>
<td>Select</td>
<td>Select</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Enter VRF name</td>
<td>Enter Route</td>
<td>Enter Target</td>
</tr>
<tr>
<td>Required</td>
<td>Checked</td>
<td>Unchecked</td>
<td>Checked</td>
</tr>
</tbody>
</table>

Step 10 Click OK in the Add/Edit User Argument dialog box after each parameter. The new user-defined input parameters are displayed in the User Input Arguments dialog box (Figure 4-9).

Figure 4-9 User Input Arguments Dialog Box

Step 11 Click Next. The Tab Pages dialog box is displayed.

Step 12 Click New. The Add/Edit User Tab Page dialog box is displayed.

Step 13 Enter a VRF Name and select vrfname.
Step 14  Click OK. The newly added tab pages are displayed in Tab Pages dialog box.

**Figure 4-10  Tab Pages Dialog Box**

![Tab Pages Dialog Box](image)

Step 15  Click Next. The Script Lines dialog box is displayed, enabling you to add the script lines.

Step 16  Add the script lines, as shown in Figure 4-11.
Step 17  Click **Finish**. The Create Command dialog box is displayed. LEDs indicate the progress or status of the command as it is being saved to the registry.

Step 18  Click **Close** when the command is complete. The newly created `addvrf` command is displayed in the Command Builder table.

Step 19  Select the `addvrf` command in the Command Builder table.

Step 20  Run the command in one of the following ways:

- Click **Run Command** in the toolbar.
- Choose **Tools > Run Command**.
- Right-click the command, then choose **Run Command**.

The input form is generated and displayed. The Route Distinguisher and Route Target are displayed in General tab and vrfname is displayed in a separate tab called VRF Name.

In the General tab, the Route Target is a mandatory field (bold font) and Route Distinguisher is an optional field.

Step 21  Enter values in the VRF Name, Route Distinguisher, and Route Target fields.

Step 22  Click **Preview** to see how the command, including variables, looks before it is executed.

Step 23  Click **Execute Now** to view the results of the `addvrf` command as it is being executed.

Step 24  Close the input form to return to the Command Builder window.
Testing and Publishing Commands

The following topics describe how to test and publish commands:

- Testing the Command Locally Before Deploying It To Other NEs, page 4-33
- Publishing Commands to Other NEs, page 4-33

Testing the Command Locally Before Deploying It To Other NEs

Before you publish a command and apply it to other NEs, test it on your local NE using the following procedure. Once you have done this, you can apply it manually to multiple managed NEs, or publish it and make it available to a larger group of NEs (by family, NE type, or software version).

Step 1
From the Command Builder window, right-click the command and choose Run Command. Command Builder generates your input form.

Step 2
Complete the input form and click Preview.

Step 3
Click the Result tab to verify the command and variables before executing the command on the NE.

Step 4
If the command is successful and you want to execute it on the local NE, click Execute Now.

Note
You might be prompted to enter your device access credentials. Once you have entered them, these credentials will be used for every subsequent execution of a command or activation in the same GUI client session. If you want to change the credentials, click Edit Credentials. The Edit Credentials button will be disabled if the command is scheduled to run at a later time or if it is an SNMP command.

Alternatively, if you are authorized by the Administrator to schedule jobs, you can use the Scheduling tab to schedule the command to run at a later time. You can check the job results by selecting Tools > Scheduled Jobs from the Prime Network Vision Tools menu.

Every command that is executed is logged in the Prime Network event database. The command’s execution history can be viewed using Prime Network Events. For more information about Prime Network Events, see the Cisco Prime Network 4.0 User Guide.

Publishing Commands to Other NEs

Publishing is the process of applying a command to a wider scope of managed NEs, so that the other NEs can use the new command. The Command Builder Hierarchy Manager dialog box controls the publishing of commands across the inheritance hierarchy. Figure 4-12 shows an example of an inheritance hierarchy. In this example, the top level of the hierarchy is All devices and the lowest level of the hierarchy is Device XYZ.
Steps for Defining a New Command

Figure 4-12  Inheritance Hierarchy Example

When a command is published to a node in the hierarchy, it overrides any inherited command from a higher level and automatically applies to all its children. For example, if a command is published to Cisco 7200, it overrides any variant of this command it inherited from a higher level and is assigned to all NEs of type Cisco 7200 in the system. NEs above the Cisco 7200 class are not affected.

Note
A user with a Configurator role can add and publish commands on all NEs regardless of their assigned device scopes.

Note
If you plan to use your commands in workflows, make sure the commands are published to all of the NEs that will be affected by the workflow, otherwise the workflow will fail. See Steps for Creating a Workflow Template, page D-5.

To publish a command:

Step 1  From the Command Builder window, right-click the command and choose Hierarchy Manager.

Note
The names displayed in the VNE Hierarchy Location column depends on the registry settings. It is determined by the VNE schema (which controls the NEs that are managed and modeled by Prime Network). For example, a user-friendly name is displayed if a hierarchy path has been defined in the registry.

Rows are displayed in descending order with the top row representing the highest level of the hierarchy and the bottom row representing the lowest level of the hierarchy. The following information is provided for each level:

- **Exist**—If checked, indicates that a local variant of the command exists for that VNE hierarchy location.
- **Registry Key**—The hierarchy path as defined in the registry.

Table 4-4 describes the tools that are displayed in the Hierarchy Manager dialog box.
Steps for Defining a New Command

Step 2
Select the node in the hierarchy from where you want to Copy/Cut the command.

Step 3
Click Copy or Cut in the toolbar to copy or cut the command.

Step 4
Select the node in the hierarchy where you want to publish the command.

Step 5
Click Paste on the toolbar to paste the command. The command is published to the selected node in the hierarchy.

Note
If you plan to publish the command to multiple network elements so you can perform commands in bulk, be sure to delete your local copy of the command after it is published. Otherwise when you choose multiple NEs, the command will not be listed.

Table 4-4  Hierarchy Manager Dialog Box Tools

<table>
<thead>
<tr>
<th>Button Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copies the command from a selected node in the hierarchy so that it can be pasted onto another node in the hierarchy. A copy icon is displayed to the left of the selected node.</td>
</tr>
<tr>
<td>Cuts the command from a selected node in the hierarchy so that it can be moved to another node in the hierarchy. A cut icon is displayed to the left of the selected node.</td>
</tr>
<tr>
<td>Pastes the command that was copied or cut from a selected node in the hierarchy onto another node in the hierarchy. A paste icon is displayed to the left of the selected node.</td>
</tr>
<tr>
<td>Deletes the command from the selected node in the hierarchy.</td>
</tr>
<tr>
<td>If the command has been deleted from all nodes, it is removed from the list in the Command Builder window.</td>
</tr>
<tr>
<td>Saves a full command definition to a file that can later be imported to another managed element. For more information, see Exporting Commands with Command Builder, page 4-36.</td>
</tr>
<tr>
<td>Performs one of the following actions, depending upon whether or not a version of the command definition already exists in Command Builder:</td>
</tr>
<tr>
<td>• For new command definitions, imports a full command definition to a managed element. For more information, see Importing Commands with Command Builder, page 4-36.</td>
</tr>
<tr>
<td>• For existing command definitions, replaces the existing command definition with an updated version of the command definition.</td>
</tr>
</tbody>
</table>

If you select a group of network elements but the command is not listed, it is likely due to one of the following reasons:

• The command was not published to at least one of the network elements. You must publish the command to that network element using the hierarchy manager.

• One of the network elements has a local copy of the command. You must delete the local copy of the command using the hierarchy manager.

Note
If a network element has more than one command instance, the command instance that is executed will be the one in the lowest hierarchy node.
Steps for Defining a New Command

Exporting Commands with Command Builder

When you export a command, a file containing the full command definition is created on the client machine. This is normally done when you want to manually import the command file to other NEs rather than use the Hierarchy Manager and the publishing procedure. The file is not copied to any other NEs; it is created so it can be imported by other NEs.

- **Step 1** In the Command Builder window, right-click the command and choose **Export Element**.
- **Step 2** Command Builder lists all versions of the command. In other words, if you have a 7206 NE with one version, but all other 7200 NEs have a different version, Command Builder would display both versions because both have been saved on your client machine. Check the version you want to export and click **OK**.
- **Step 3** Browse to the directory where you want to save the command.
- **Step 4** In the File name field, enter a name and click **Save**. The command is saved in XML format on the local client machine.

Importing Commands with Command Builder

Importing commands makes new commands available to an NE. For example, if you created a new command for NE 1, you could export the command from NE 1, and then import it to NE 2. The export is performed by launching Command Builder from NE 1, and the import is done by launching Command Builder from NE 2, as long as NE 2 is the same NE type.

If the import operation will overwrite a command that already exists, one of the following will happen:

- For a local command, Prime Network overwrites the existing definition.
- For a published command, Prime Network generates an error message which states that the command already exists. You must delete the existing command instance using the procedure described in **Deleting Commands, page 4-37**.

You can import multiple commands using this procedure as long as all of the commands are associated with the same VNE.

To import commands:

- **Step 1** In the Command Builder window, choose **Tools > Import Element**.
- **Step 2** Browse to the directory that contains the commands that you want to import.
- **Step 3** Select the commands that you want to import. To select multiple commands, press **Shift** or **Ctrl** while choosing the commands.
- **Step 4** Click **Open**. The Import Elements dialog box is displayed.
  
  If you select multiple files, Command Builder presents an Import Element dialog box for each command.
- **Step 5** In the Import Element dialog box, select the VNE hierarchy location for the specified command.
- **Step 6** Click **OK**. The Command Builder window is displayed.
- **Step 7** Click **Close**. The commands are imported and displayed in the Command Builder window.
Deleting Commands

The procedure for deleting commands depends on whether the command is local or has been published.

- Local commands can be deleted from the Command Builder window by right-clicking the command and choosing Delete.
- Published commands must first be deleted from the applicable nodes using the Hierarchy Manager (right-click the command, then choose Hierarchy Manager). You must delete all instances from all applicable nodes.

You can delete multiple commands at a time as long as all of the commands are associated with the same VNE. You may want to keep a local copy of the command before you delete it.
Performing Device Configuration and Activation Workflows Using Transaction Manager

The following topics explain how to use Prime Network Transaction Manager to perform device configuration and activation workflows:

- **What is Transaction Manager?**, page 5-1
- **Setup Tasks for Transaction Manager**, page 5-2
- **Steps for Creating and Deploying Device Configuration Operations Using Transaction Manager**, page 5-3
- **Transaction Manager Window and Repository**, page 5-3
- **Creating Transactions Using the Prime Network XDE SDK**, page 5-4
- **Importing Transactions Into Prime Network**, page 5-5
- **Testing and Executing Transactions**, page 5-5
- **Finding and Controlling Transaction Jobs**, page 5-6

**What is Transaction Manager?**

Transaction Manager replaces the Prime Network Workflow and Action features in all new installations of Prime Network 4.0. If you have upgraded to Prime Network 4.0, the Workflow and Activation features are still available, but they will be deprecated in the future. We recommend that you use Transaction Manager.

Transaction Manager provides a GUI framework you can use to schedule and run transactions (workflows) that are created using the Prime Network XDE Eclipse SDK. You can also run transactions using the NBI.

Transactions are XDE procedures that contain tasks that are grouped together and specified into a flow, with certain sequences, branches, and failure policies (including rollback procedures). Transactions can include commands that you created using Command Manager. Transactions can also include Command Builder commands only if you have performed the tasks outlined in the required extensions to XDE SDK feature by the Transaction Manager Prime Network XDE Eclipse SDK (which has special features to work with Command Builder scripts).
You cannot use Command Manager with the legacy Workflow or Activation features.

Transaction rules, parameters, and implementation are stored on the gateway. Transactions (XDE procedures) are saved as archive files (.xar) and maintained at $XMP_HOME/xmp_inventory/xde-home/packages/standard. Jobs are also stored on the gateway and are purged according to the global settings in Prime Network.

Setup Tasks for Transaction Manager

Before you use Transaction Manager, check the Administration GUI client settings that controls whether users must enter their credentials before running transactions that include command scripts.

A user must have Administrator or Configurator privileges to run transactions. If per-user job authorization is enabled, Administrator and Configurator users must also be granted job privileges. The following table explains this and other global settings that can affect the transactions function. (These are in the Administration GUI client under Global Settings > Security Settings > User Account Settings.

<table>
<thead>
<tr>
<th>Administration GUI Client Global Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Scheduling</td>
<td>Enables and disables the global per-user job authorization mode. If the mode is enabled, job scheduling privileges are controlled by the setting in the individual user accounts.</td>
</tr>
<tr>
<td></td>
<td>• If this mode is enabled and an Administrator or Configurator user is granted privileges, they can schedule jobs across the product.</td>
</tr>
<tr>
<td></td>
<td>• If this mode is enabled and an Administrator or Configurator user is not granted privileges, the job scheduling features in their GUI clients are disabled.</td>
</tr>
<tr>
<td>Execution of Commands</td>
<td>If enabled (that is, the “Ask for user credentials when running device configuration operation” check box is checked), users must enter their credentials when they execute a transaction. Provisioning and Audit events display an additional column that lists the username. This setting is disabled by default.</td>
</tr>
</tbody>
</table>

For more information on these global settings, see the Cisco Prime Network 4.0 Administrator Guide.
## Steps for Creating and Deploying Device Configuration Operations Using Transaction Manager

The following table lists the steps you must follow to create and execute a transaction.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Check the settings that may affect who can run commands you create.</td>
<td>Setup Tasks for Transaction Manager, page 5-2</td>
</tr>
<tr>
<td>Step 2</td>
<td>Create the transaction using the Prime Network XDE Eclipse SDK.</td>
<td>Creating Transactions Using the Prime Network XDE SDK, page 5-4</td>
</tr>
<tr>
<td>Step 3</td>
<td>Import the transactions into Transaction Manager.</td>
<td>Importing Transactions Into Prime Network, page 5-5</td>
</tr>
<tr>
<td>Step 4</td>
<td>Test the transaction to preview the script execution, and execute the transaction.</td>
<td>Testing and Executing Transactions, page 5-5</td>
</tr>
<tr>
<td>Step 5</td>
<td>Check the transaction job status.</td>
<td>Finding and Controlling Transaction Jobs, page 5-6</td>
</tr>
</tbody>
</table>

## Transaction Manager Window and Repository

You can launch Transaction Manager from Change and Configuration Management, as shown in the following figure. (You may have to expand the title bar by clicking the arrow at the top left.)

When you select **Transaction Manager > Transactions**, Prime Network displays all of the transactions on the Prime Network gateway. After you create transactions, you can import them into Transaction Manager and they will be listed in the transaction repository.
Creating Transactions Using the Prime Network XDE SDK

Use the Prime Network XDE SDK to create procedures called transactions (activation workflows). The XDE SDK is an Eclipse-based plug-in that provides a complete development environment for creating flowchart and device interaction packages. The XDE SDK includes a graphical flowchart editor for creating procedures, and uses an expression language that is focused on string-based and XML-oriented data processing.

Transactions can include Command Manager commands, Command Builder commands, and CLI commands—or a combination of the three. However, if you want to use Command Builder commands in a transaction, you must create an XDE Protocol Abstraction Layer (PAL) Action to use in transactions.

The Cisco Developer Network provides a detailed procedure that explains how to:

- Install the XDE SDK on your PC.
- Create the PAL Action that enables you to use Command Builder scripts in transactions. The PAL Action is created using a custom PAL handler named CBScriptHandler.

To obtain this procedure:

**Step 1** Log into the Cisco Developer Network home page for Prime Network at: https://developer.cisco.com/site/prime-network/. To log in, you must have a Cisco.com account with partner level access, or you must be a Prime Network licensee.

**Step 2** On the Prime Network home page, select Documentation > Development Guides > Integration Guides and Resources.

**Step 3** Locate and download the document entitled Prime Network 4.0—Creating Prime Network Transactions. You will be prompted to agree to the supplemental terms.
For installing XDE and creating the necessary PAL action, contact Advanced Services.

**Importing Transactions Into Prime Network**

When you copy transactions into Prime Network, make sure you are logged in as *pn-user* so that the transactions are copied with the correct permissions.

**Step 1**
Log in as *pn-user* (also called *anauser*) on the gateway server.

**Step 2**
Copy (ftp) the transactions into the following location:

```
$ANAHOME/XMP_Platform/xmp_inventory/xde-home/packages/standard
```

Test and run the transaction as described in *Testing and Executing Transactions*, page 5-5.

**Testing and Executing Transactions**

When you test a transaction, you can see how it will appear to users. Use the **preview** feature to see the CLI commands called by the transaction. This includes all CLI commands in Command Builder and Command Manager scripts.

After you execute a transaction with **Create Execution Job**, Prime Network displays the job status page from which you can get job details.

**Step 1**
Choose **Transaction Manager > Transactions**, select the transaction from the list, and click **Next**.

**Step 2**
Choose the devices the transaction should be run on and click **Next**. You can quickly check the device properties by clicking the icon next to the device IP address, as shown in the following figure.

**Step 3**
If required, enter the input parameters for the transaction and click **Next**. (Not all transactions require input parameters.)

**Step 4**
Give the transaction job a meaningful name (in the Job Name field), and run the job.
Finding and Controlling Transaction Jobs

Step 5  In the job dialog box, click the job hyperlink to view the status.

You can check the results of each step in the transaction by clicking the hyperlink in the Status column.

<table>
<thead>
<tr>
<th>Job Execution Results Tab</th>
<th>Provides Information About:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result</td>
<td>The last step result of the transaction (provided by the transaction)</td>
</tr>
<tr>
<td>Transaction Log</td>
<td>Log containing the results of device interaction (for example, the result of a command execution).</td>
</tr>
<tr>
<td>Debug Trace</td>
<td>Logging statements from the transaction.</td>
</tr>
</tbody>
</table>

Finding and Controlling Transaction Jobs

Transaction Manager jobs are automatically deleted according to the Prime Network job purging settings. By default, these jobs are never purged. For information on the user roles required to manage transaction jobs, see Setup Tasks for Transaction Manager, page 5-2.

For an example of how to get details about an executed job, see Testing and Executing Transactions, page 5-5.
You can use the filter mechanism to locate executed transactions using different search criteria, such as username, device name or IP, time stamps, and so forth. To view all of the possible criteria, click the Criteria drop-down list. When you choose a criteria, you then supply a value and click Go.

You can also locate transactions using a search based on input parameters. In this case, you supply the search criteria (in addition to the value), as shown in the following procedure.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose <strong>Transaction Manager &gt; Jobs</strong>, select the transaction from the list, and click <strong>Next</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>From the Criteria drop-down list, choose <strong>Input Parameters</strong>. The Criteria field becomes an editable text box.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Criteria text box, overwrite the <strong>Input Parameter</strong> text with any string; for example, <strong>Interface</strong>.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select an operator from the drop-down list; for example, <strong>Contains</strong>.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Enter a value; for example, <strong>gigabit/0/1</strong>.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click <strong>Go</strong>.</td>
</tr>
</tbody>
</table>
Adding Support for New Events Using the VCB

The VCB can be used to enable Prime Network to recognize additional events and to customize the way events are handled. For example, you might want Prime Network to recognize traps that are specific to a new technology or a custom syslog that you have defined. You might also want to change the settings of a system default event, for example, change the severity from major to minor.

In addition, you can define criteria for marking new or existing events as flapping events. Flapping events are events that rapidly change state and are identified based on the number of times and the frequency with which the change of state occurs. Prime Network does not send an event for each change of state but sends one event indicating that the event is flapping. Thereafter, no events are generated for any state change. The event is updated periodically if the flapping persists. A clearing event is sent when flapping has stopped.

You can also define expedite rules that will force polling whenever a specific event is received.

You can customize events using the VCB tool within Prime Network, or using VCB CLI commands. This chapter describes event customization using the Prime Network VCB GUI. For information on using the CLI method, see VCB CLI Reference: Events Commands, page B-31.

These topics explain how to use the VCB to create support for events, and to change how events are handled:

- Enabling Support for Unsupported Traps, page 6-2
- Enabling Support for a Custom Syslog, page 6-7
- Testing Your New Events, page 6-11
- Customizing Existing Events, page 6-12

For general information about the VCB, see VCB Overview, page 3-1. For information on the level of support for various features in the different types of VNEs, see Comparison of Generic SNMP VNEs, U-VNEs, and Developed VNEs, page 3-3.
Enabling Support for Unsupported Traps

This procedure describes how to add unsupported traps as events in Prime Network based on a particular MIB definition file.

Use the VCB to add support for unsupported traps, as follows:

Step 1. In the VCB tool, go to the VNE Drivers tab.

Step 2. Click on the arrow next to the VNE driver on which you want the additional traps to be supported.

Step 3. Click the Trap Parsing Rule link to show a list of traps associated with this parsing rule.

Step 4. Click Add from MIB. This launches a wizard which enables you to analyze a specified MIB and select the traps to be supported.

Step 5. Click Browse and select the MIB file you want to upload to the Prime Network gateway. You can upload an individual MIB file or a zip file containing multiple MIB files. The file extension should be .mib or .mib, .zip, or no extension. If you select a zip file, a list of the contained MIBs is displayed. You can select one or more of these MIBs to upload.

A list of MIB dependencies is displayed. A green check mark indicates that the dependency file has been found on the server.
Figure 6-2  MIB Dependencies

Step 6  If any of the dependencies is not found, click **Browse** and select the dependency file to upload.

Step 7  Click **Next**. A list of traps is displayed. A red icon to the left of the trap indicates that it is not supported. A green icon indicates that the trap is already supported.

Step 8  Check the check box next to the trap(s) to be supported. If you select multiple traps, they must be of the same type. Click **Next**.

At this point, an event is created. Each trap you selected becomes a subtype of the new event. The Event Definition wizard is displayed to enable you to complete the definition of the new event.

Step 9  Click on **Step 1 - Event Definition** and provide the following information:

- Event name and OID—these are pre-populated but can be changed if necessary. The OID is the common prefix of the OIDs of the selected subtypes.
- Category—predefined category from 3GPP standards (according to ITU-T Recommendations X.733 and X.736). You can change the category if necessary.
- Nature—defines whether the event is automatically cleared by a clearing event or it needs to be manually cleared. Possible values are:
  - ADAC (Automatically Detected Automatically Cleared)—The event is automatically detected and automatically cleared by the system. For example, “link down” event. Select this option if the event has a clearing event, for example, “link up”.
  - ADMC (Automatically Detected Manually Cleared)—The event must be manually cleared by the user. For example, “DWDM fatal error” syslog. Select this option if the event does not have a clearing event.
Step 10  To define the criteria by which this trap will be considered a flapping event, check the Flapping check box. This would be relevant for network or communication related events that potentially could change state frequently. For example, link up/down, BGP neighbor up/down. When an event is flapping, Prime Network generates a single event indicating the flapping status and does not generate an additional event for each state change.

Enter the following information to define flapping criteria:

- **Clear Interval**—The flapping event will be cleared when the flapping has stopped for the specified time interval (in milliseconds).

- **Flapping Interval and Flapping Threshold**—To be defined as a flapping event, the event must change state every X milliseconds (Flapping Interval), and must occur Y consecutive times (Flapping Threshold). For example, if the Flapping Interval is 60000 msecs (one minute) and the Flapping Threshold is 5, the event must change state five times, every one minute, in order to be considered flapping.

- **Update Interval and Update Threshold**—An update event indicating that the event is still flapping will be sent either when the specified Update Interval has passed or when the event is received more times than the specified Update Threshold. For example, if the Update Interval is 100000 msecs and the Update Threshold is 500, an update event will be generated if the event remains flapping for longer than 100000 msecs or if the event is received more than 500 times, whichever occurs first.

Step 11  Click on **Step 2 - Subtype Definition**. You will see that a subtype has been created for each unsupported trap you selected. Edit the information for each subtype as required:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the event subtype</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a string that describes the event subtype.</td>
</tr>
<tr>
<td>Severity</td>
<td>Select the severity to be attributed to the subtype.</td>
</tr>
<tr>
<td>Ticketable</td>
<td>Check the check box if you want Prime Network to create a ticket for this event if there is no root cause event to which it can be correlated. If you make a subtype ticketable, a ticket will be generated for it. When a non-ticketable subtype of the same event arrives (for example, a warning or clearing event), the ticket will be updated.</td>
</tr>
<tr>
<td>Auto-Clear</td>
<td>Check the check box if you want Prime Network to automatically clear the event. Prime Network clears a ticket if all of its events either are cleared or are configured for automatic clearing.</td>
</tr>
<tr>
<td>Correlate</td>
<td>Check the check box if you want the event to be correlated to a root-cause alarm.</td>
</tr>
</tbody>
</table>

In addition, if you selected the Flapping check box in the previous step, you will see that Flapping subtypes have been created. By default, the flapping subtype consists of the event name and the flapping subtype name. This can be changed as required; for example, you can also change the severity of the flapping subtype so that it matches the severity of the event.
**Step 12** Click on **Step 3 - Subtype Identification**. In this step, you define how Prime Network will differentiate between the subtypes, as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>By TrapOID</td>
<td>Select this option if each subtype has a unique OID. In the Replacing Rules section, specify the OID suffix for each subtype. The OID suffix must be an integer.</td>
</tr>
<tr>
<td>By Varbind Value</td>
<td>Select this option if the subtypes have the same trap OID and you want to use one of the varbind values to differentiate between the subtypes. In the Replacing Rules section, select the required varbind from the drop-down menu or enter free text, and then define the values for each subtype.</td>
</tr>
<tr>
<td>By Varbind OID</td>
<td>Select this option if there is a varbind for each subtype. In the Replacing Rules section, specify the common prefix of the varbind OIDs and the suffix for each subtype.</td>
</tr>
</tbody>
</table>

**Step 13** Click on **Step 4 - Association**, in which you associate the event with the VNE. Specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Type</td>
<td>The entity to which the event should be associated.</td>
</tr>
<tr>
<td>ManagedElement Key</td>
<td>Select this option if there is no specific interface or other component of the VNE from which the event is generated.</td>
</tr>
<tr>
<td>Interface Key From Ifindex</td>
<td>Creates the interface device component key from the ifIndex and associates the event with the appropriate interface layer.</td>
</tr>
<tr>
<td>Interface Key From Ifname</td>
<td>Associates the event with a specific interface that you specify in the Interface Identifier field.</td>
</tr>
<tr>
<td>Logical Container Key</td>
<td>Associates the event with a designated logical container that you select in the Logical Container field.</td>
</tr>
<tr>
<td>ModuleDC Key Given EntPhysicalIndex</td>
<td>Associates the event with a designated module DC.</td>
</tr>
<tr>
<td>ModuleDC With SlotSubslot Value Key</td>
<td>Associates the event with the corresponding module, based on the slot number.</td>
</tr>
<tr>
<td>Pw Interface Key From Tunnelindex</td>
<td>Associates trap events with the designated pseudowire tunnel interface.</td>
</tr>
</tbody>
</table>

**Logical Container** Applicable only when the source type is Logical Container Key. This field lists the various logical containers for which the VCB supports event association. For example, BGP traps/syslogs can be associated with the MP-BGP type container, ISIS events with the ISIS System container, and so on.

**Instance Identifier Location** Specify whether the identifier of the event is based on a value or a varbind OID.
Enabling Support for Unsupported Traps

### Field | Description
--- | ---
Instance Identifier Varbind OID | Select the varbind that contains the instance information. Prime Network uses varbind OID to locate the varbind in the trap PDU and locates the instance information from either the OID or the value depending what was selected as the instance identifier location (OID or value).

### Source Location | Specify whether the event source can be found in a value or a varbind OID.

### Source Varbind ID | Select the varbind that contains the source information. Prime Network uses varbind OID to locate the varbind in the trap PDU and locates the source information from either the OID or the value depending what was selected as the source location (OID or value).

**Step 14** Optionally, click on Step 5 - Expedite if you want the device to be polled immediately for inventory updates upon receipt of the event, instead of waiting for the next polling cycle which may take up to twenty four hours for VNEs using reduced polling. Click Add to create an expedite rule and provide the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Level | - Select VNE Component if the expedite command will run on a component of the VNE.  
- Select VNE if the expedite command will run on the VNE level. |
| Class | Shows the VNE-level or the component-level command classes. Select the command class that contains the relevant expedite command. |
| Command Name | Shows the commands belonging to the selected class. Select the relevant command. |
| Delay | Delay (in milliseconds). By default, the command will be executed immediately upon receipt of the event (default value is 0). |
| Key | Component level only. This is the entity by which the component will be identified. If the source type is the same as the source type specified for association, there is no need to specify the key again here. |

**Note** Command expedition might result in unnecessary polling of devices which puts a load on the device and might affect performance. Therefore, before creating command expedition rules, consider whether the event is specific to a particular VNE or common to all VNEs and might affect the performance of VNEs using regular polling.

**Step 15** Click on Step 6 - Pattern to determine which VNE drivers will be extended to support this event. This is determined by selecting the parsing rule groups per scheme that will be extended. The event will be supported on all VNE drivers that use the specified parsing rule groups.

**Step 16** Click Add to select additional parsing rule groups, as required, either for the Product or IpCore scheme.

**Note** Certain parsing rules groups inherit from other groups. If you select multiple groups, make sure that your selection does not include a base (parent) group as well as the group that inherits from the base group. See Parsing Rule Group Inheritance Structure, page 6-11 for the relationship between parsing rule groups.
Step 17  Click **Finish**. A dialog box displays a list of the traps that were added.

Step 18  If you want to enable support for additional traps, click **Select Different Trap**, otherwise click **Close**.

---

**Enabling Support for a Custom Syslog**

In this example, a custom syslog is generated by a router, using Embedded Event Manager (EEM), when the Windows XP server being monitored is not reachable. The custom syslog is `%HA_EM-6-LOG: IPSLA-XP: Windows-XP unreachable`. This event is sent to Prime Network but is not recognized or parsed.

Use the VCB to add support for this custom syslog, as follows:

**Step 1**  In the VCB tool, go to the VNE Drivers tab.

**Step 2**  Click on the arrow next to the VNE driver that represents the router that generates the custom syslog to expand its display. The Syslog Parsing Rule field shows the parsing rule used to parse events for this VNE driver, for both Product and IpCore schemes.

**Step 3**  Click the Syslog Parsing Rule link to show a list of syslog events associated with this parsing rule.

**Step 4**  Click the Add Row button to start defining the new syslog.

**Step 5**  Enter a unique name for the syslog in the Event Name field. For example, Monitoring XP Server.

**Step 6**  Check the Flapping check box if you want to define the criteria by which this trap will be considered a flapping event. This is relevant for network or communication related events that potentially could change state frequently. For example, link up/down, BGP neighbor up/down. When an event is flapping, Prime Network generates a single event indicating the flapping status and does not generate an additional event for each state change.

Enter the following information to define flapping criteria:

- **Clear Interval**—The flapping event will be cleared when the flapping has stopped for the specified time interval (in milliseconds).

- **Flapping Interval and Flapping Threshold**—To be defined as a flapping event, the event must change state every X milliseconds (Flapping Interval), and must occur Y consecutive times (Flapping Threshold). For example, if the Flapping Interval is 60000 msecs (one minute) and the Flapping Threshold is 5, the event must change state five times, every one minute, in order to be considered flapping.

- **Update Interval and Update Threshold**—An update event indicating that the event is still flapping will be sent either when the specified Update Interval has passed or when the event is received more times than the specified Update Threshold. For example, if the Update Interval is 100000 msecs and the Update Threshold is 500, an update event will be generated if the event remains flapping for longer than 100000 msecs or if the event is received more than 500 times, whichever occurs first.

**Step 7**  Click **Next** to go to the next step in the wizard which is to define the event subtypes. If you selected the Flapping check box in the previous step, you will see that flapping subtypes have been created. By default, the flapping subtype consists of the event name and the flapping subtype name. This can be changed as required. You can also change the severity of the flapping subtype so that it matches the severity of the event, for example.
Step 8  Enter the following information to define the first event subtype:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the event subtype, for example, XP server inaccessible.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a string that describes the event, for example, “The XP server cannot be reached.”</td>
</tr>
<tr>
<td>Severity</td>
<td>Select the severity to be attributed to the event.</td>
</tr>
<tr>
<td>Ticketable</td>
<td>Check the check box if you want Prime Network to create a ticket for this event if there is no root cause event to which it can be correlated.</td>
</tr>
<tr>
<td>Auto Clear</td>
<td>Check the check box if you want Prime Network to automatically clear the event, without waiting for a clear event or for manual clearing of the event. If the auto clear check box is checked, the event will be cleared automatically 4 minutes after the last modification.</td>
</tr>
<tr>
<td>Correlate</td>
<td>Check the check box if you want the event to be correlated to a root-cause alarm.</td>
</tr>
</tbody>
</table>

Step 9  Click **Add** to define a second subtype, for example, XP server accessible, with severity “Cleared”.

**Figure 6-3  Subtype Definition**

Step 10  Click **Next** to go to the next step in the wizard which is identification and association of the event. In this step, you will provide an example of the raw event and you will define parameters by which the event will be identified.
Step 11 Enter the following information to define event identification and association.

**Note** You can provide multi-word values for the following parameters in the Event Identification and Association section while creating a syslog event: Interface Identifier, Interface Name, Substring(s) to Ignore, Subtype Key, and Instance Identifier Prefix.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Event</td>
<td>Provide the raw event syntax as an example, so that the system can parse it.</td>
</tr>
<tr>
<td>Subtype Key</td>
<td>Keyword that identifies the subtype. The keyword should be taken from the raw event. In this example, the key would be “unreachable”.</td>
</tr>
<tr>
<td>Source Type</td>
<td>Select the source component of the device from which the event is generated. For this example, select ManagedElement Key because there is no specific interface or other component from which the event is generated. In other cases, you might choose from the following options:</td>
</tr>
<tr>
<td>Efp Key From Ifname Serviceid</td>
<td>Associates the event with a specific EFP DC, based on the EFP ID and the interface name.</td>
</tr>
<tr>
<td>Interface Key From Ifname</td>
<td>Associates the event with a specific interface that you specify in the Interface Name field.</td>
</tr>
<tr>
<td>Logical Container Key</td>
<td>Associates the event with a designated logical container that you select in the Container Type field.</td>
</tr>
<tr>
<td>ModuleDC With SlotSubslot Value Key</td>
<td>Associates the event with the corresponding module, based on the slot number.</td>
</tr>
<tr>
<td>Instance Identifier Prefix</td>
<td>The unique identifier prefix that you specify in the new event location string which helps you to differentiate between the same event on the same interface but with a different CLI. The instance identifier prefix you provide will be displayed in Cisco Prime Network Vision and Cisco Prime Network Events along with the location identifier.</td>
</tr>
<tr>
<td>Interface Identifier</td>
<td>Specify a value by which the interface will be identified (ifIndex is used to identify the interface).</td>
</tr>
<tr>
<td>Instance Identifier</td>
<td>Specify the identifier of the instance. For this example, the instance identifier could be Windows XP.</td>
</tr>
<tr>
<td>Substring(s) to Ignore</td>
<td>Prime Network filters the events that need to be parsed and processed based on the value(s) specified in this argument.</td>
</tr>
</tbody>
</table>

Step 12 Click **Next** to go to the next step in the wizard which is identification of the event subtypes. In this step, you will define values for each of the subtypes. In this example, the values could be “unreachable” for XP server inaccessible and “reachable” for XP server accessible.
Step 13  Optionally, go to Step 5 - Expedite if you want the device to be polled immediately for inventory updates upon receipt of the event, instead of waiting for the next polling cycle which may take up to twenty four hours for VNEs using reduced polling. Click Add to create an expedite rule and provide the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Level          | • Select Component if the expedite command will run on a component of the VNE.  
• Select Technology if the expedite command will run on the VNE level. |
| Class          | Shows the VNE-level or the component-level command classes. Select the command class that contains the relevant expedite command. |
| Registration Name | Shows the commands belonging to the selected class. Select the relevant command. |
| Delay          | Delay (in milliseconds). By default, the command will be executed immediately upon receipt of the event (default value is 0). |
| Key            | Component level only. This is the entity by which the component will be identified. If the source type is the same as the source type specified for association, there is no need to specify the key again here. |

**Note**  Command expedition might result in unnecessary polling of devices which puts a load on the device and might affect performance. Therefore, before creating command expedition rules, consider whether the event is specific to a particular VNE or common to all VNEs and might affect the performance of VNEs using regular polling.

Step 14  Click Next to go to the next step in the wizard which determines which VNE drivers will be extended to support this event. This is determined by selecting the parsing rule groups per scheme that will be extended. The event will be supported on all VNE drivers that use the specified parsing rule groups.

Step 15  Click Add to select additional parsing rule groups, as required. In this example, all VNE drivers associated with group cisco-syslog-product-parsing-rules will be extended to support the new syslog. You can select additional groups for the Product scheme or you can select the IpCore scheme and a parsing rule group.

**Note**  Certain parsing rules groups inherit from other groups. If you select multiple groups, make sure that your selection does not include a base (parent) group as well as the group that inherits from the base group. See Parsing Rule Group Inheritance Structure, page 6-11 for the relationship between parsing rule groups.

Step 16  Click Finish. The event now appears in the list of syslogs for the cisco-syslog-product-parsing-rules group.
Parsing Rule Group Inheritance Structure

Table 6-1 shows the inheritance structure for parsing rule groups. The groups on the left inherit settings from the groups on the right.

**Table 6-1 Parsing Rule Groups Inheritance**

<table>
<thead>
<tr>
<th>This Parsing Rule Group...</th>
<th>Inherits Settings from This Group:</th>
</tr>
</thead>
<tbody>
<tr>
<td>cisco-asr90xx-syslog-ipcore-parsing-rules</td>
<td>cisco-ios-syslog-ipcore-parsing-rules</td>
</tr>
<tr>
<td>cisco-asr90xx-trap-ipcore-parsing-rules</td>
<td>cisco-ios-trap-ipcore-parsing-rules</td>
</tr>
<tr>
<td>cisco-ciscocpt-trap-ipcore-parsing-rules</td>
<td>cisco-trap-ipcore-parsing-rules</td>
</tr>
<tr>
<td>cisco-ciscocpt-syslog-ipcore-parsing-rules</td>
<td>cisco-syslog-ipcore-parsing-rules</td>
</tr>
<tr>
<td>cisco-ios-syslog-ipcore-parsing-rules</td>
<td>cisco-ios-syslog-product-parsing-rules</td>
</tr>
<tr>
<td>cisco-me26xx-syslog-ipcore-parsing-rules</td>
<td>cisco-syslog-ipcore-parsing-rules</td>
</tr>
<tr>
<td>cisco-syslog-ipcore-parsing-rules</td>
<td>cisco-syslog-product-parsing-rules</td>
</tr>
<tr>
<td>cisco-trap-ipcore-parsing-rules</td>
<td>cisco-trap-product-parsing-rules</td>
</tr>
</tbody>
</table>


## Testing Your New Events

After you have enabled support for a trap or syslog in the VCB, you can simulate the event to check that the operation has been successful. After you simulate the event and send it to the Prime Network gateway, it should appear in the Prime Network Events and Prime Network Vision GUI.

To test an event:

- **Step 1** Select the event you want to test.
- **Step 2** Click **Test Event**.
- **Step 3** In the displayed Test Event dialog, select the device on which you want to simulate the event in the Device IP field.
- **Step 4** Provide any required information. For syslogs, the message box is automatically populated only if the message was included in the parsing rules when the event was created.
- **Step 5** Click **Send**. The event will be sent to the specified device.
Step 6  Open Prime Network Vision or Prime Network Events and check that the event appears in the list of events for the device. If it is not a correlated event, it will appear in the GUI almost immediately after the event is sent. If it is a correlated event, it could take up to three minutes before it appears in the GUI.

Step 7  If the event does not appear in the GUI, you can troubleshoot by following the instructions in Troubleshooting Event Customization Using the VCB CLI, page B-53.

Customizing Existing Events

Using the VCB, you can change the way Prime Network deals with events. For example, you can change the severity of an event, or you can instruct the system to drop the event. Event customization is described in the following sections:

- Changing the Severity of an Event Subtype, page 6-12
- Dropping an Event, page 6-12
- Restoring a System Default Event, page 6-13
- Deleting Events, page 6-14

Changing the Severity of an Event Subtype

The events that are supported by default in Prime Network are attributed with a specific severity. You can customize the event and change the severity if it is not appropriate for your organization. For example, the Prime Network system considers the event, “ASR5 port down” to have a severity of “Warning”. However, in your organization, this event might be considered to be “Major” and you want the event to be marked as such.

To change the severity of an event subtype:

Step 1  In the VCB tool, select **Tools > Events** or click on the Events tab.

Step 2  Click the arrow next to the event you want to customize to expand its display.

Step 3  Select the required severity from the Severity drop-down menu and click **Save**.

Dropping an Event

By default, when an event is received by Prime Network, it is archived and parsed. Only events that have been parsed will appear in Prime Network Events tables. You can choose to drop an event so that it no longer appears in the tables. The event will no longer be actionable, meaning that it will not be processed and parsed, but it will be archived. In the case of service events, the event will no longer be generated by the system so there will be no archiving.

When an event has been dropped, it cannot longer be edited or updated (but it can be restored).

To drop an event:

Step 1  In the VCB tool, select **Tools > Events** or click on the Events tab.

Step 2  Select the event you want to drop and click **Modify Inbound Handling**.
Customizing Existing Events

Step 3  Click **OK** in the confirmation message.
The Inbound Handling column for the event will change to Archived Only for syslogs and traps or to Disabled for system events.

Restoring a Dropped Event

To restore a dropped event:

Step 1  In the VCB tool, select **Tools > Events** or click on the Events tab.
Step 2  Select the event you want to restore and click **Modify Inbound Handling**.
Step 3  Click **OK** in the confirmation message.
The Inbound Handling column for the event will change to Parsed.

Restoring a System Default Event

If you have edited a system default event and you want to go back to the original event, you can restore the system default event.
The Overriding System Default column indicates whether or not a system default event has been edited. The values for this column are true or false.

**Note**  A VNE upgrade package might provide support for events that you previously added using the VCB. After you have upgraded the VNE driver, such events are marked as overriding the system default. Use this procedure to restore the system default event that is provided with the upgrade.

To restore a system default event:

Step 1  In the VCB tool, select **Tools > Events** or click on the Events tab.
Step 2  Select the event you want to restore and click **Restore**.
Step 3  Click **OK** in the confirmation message.
The Overriding System Default column for the event will change to False.
Deleting Events

User-defined events can be deleted as long as they are not overrides of system default events. System default events cannot be deleted.

For system default overrides, a Restore button is provided instead of the Delete button.

To delete an event:

<table>
<thead>
<tr>
<th>Step 1</th>
<th>In the VCB tool, select <strong>Tools &gt; Events</strong> or click on the Events tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Select the event you want to delete and click <strong>Delete</strong>.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click <strong>OK</strong> in the confirmation message.</td>
</tr>
</tbody>
</table>

The event is removed from the table.
Adding New Threshold-Crossing Alarms

Prime Network enables the creation of Threshold-Crossing Alarms (TCAs), which are generated when a specific condition is met. These alarms can be viewed in the Prime Network Vision and Events GUI clients.

TCAs are associated with soft properties. A soft property is a mechanism for extending the NE information that Prime Network models. The soft property contains rules for retrieving new NE information, parsing the retrieved information, and displaying it in the Inventory window. To create a TCA, you can apply it to an existing soft property, or create a new soft property and associate a TCA to it. For information on creating soft properties, see Steps for Adding New NE Property Information to the Inventory, page 2-3.

This topic explains how to create TCAs for soft properties:

- Creating a New Threshold-Crossing Alarm, page 7-1

Creating a New Threshold-Crossing Alarm

The procedure for creating a TCA is an extension of the procedure for creating a soft property, described in Displaying a New Property in the Inventory Window, page 2-4. You can create a TCA for an existing soft property, or create a new soft property and associate a TCA to it. You can create multiple TCAs for the same soft property. If necessary, the TCA can be disabled, in which case it will not be triggered for the specified condition until it is re-enabled.

TCAs are only supported on Property type soft properties.

Before You Begin

- Locate the soft property for which you want to define an alarm condition by right-clicking the relevant NE and choosing Management > Soft Properties Management.
- If you need to create a new soft property, follow the procedure in Displaying a New Property in the Inventory Window, page 2-4 or Adding a New Inventory Table Containing SNMP get Details, page 2-11
Creating a New Threshold-Crossing Alarm

To create a TCA:

**Step 1** In Prime Network Vision, right-click a relevant NE and choose Management > Soft Properties Management.

The Soft Properties Manager dialog box opens and displays any existing soft properties for the selected NE.

**Step 2** If you are creating a new soft property, choose File > New Element and follow the procedure in Displaying a New Property in the Inventory Window, page 2-4.

or

If you are adding a TCA for an existing soft property, choose File > Edit Element. This displays a window listing the complete hierarchy for the soft property. Checks indicate the classes to which the soft property is available.

**Step 3** In the Edit Soft Property dialog box, locate the local instance of the soft property; this is most likely at the very bottom of the table. Select it and click OK.

**Step 4** Click the TCA Alarms tab. If the soft property has any defined TCAs, they will be listed.

**Step 5** Click Add to open the Add TCA dialog box.

**Step 6** Click the General tab and enter the basic alarm information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Alarm name that is displayed in the ticket pane when the alarm is triggered.</td>
<td>My value is not 5</td>
</tr>
<tr>
<td>Enabled</td>
<td>Whether the VNE is monitoring for this alarm. This field allows you to temporarily disable a TCA, if needed.</td>
<td>(Enabled)</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) A description of the alarm.</td>
<td>Show this alarm if the value is not equal to 5</td>
</tr>
<tr>
<td>Alarm Severity</td>
<td>Choose the severity that is appropriate for this TCA in your network: Critical, Major, Minor, Warning, or Normal (clearing).</td>
<td>Critical</td>
</tr>
<tr>
<td>Can be correlated to other alarms</td>
<td>Enables correlating this alarm to other alarms.</td>
<td>(Not selected)</td>
</tr>
<tr>
<td>Other alarms can correlate to this alarm</td>
<td>Enables other alarms to correlate to this alarm.</td>
<td>(Not selected)</td>
</tr>
</tbody>
</table>

**Step 7** Click the Trigger tab and define the conditions that will trigger the alarm.

**Note** For triggers that require numeric values, the parse integer rule must be applied on the soft property as an ending rule.
Chapter 7  Adding New Threshold-Crossing Alarms

Creating a New Threshold-Crossing Alarm

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Equal</td>
<td>Generates an alarm when the soft property value is equal to the specified target value.</td>
</tr>
<tr>
<td>Value Not Equal</td>
<td>Generates an alarm when the soft property value is not equal to the specified target value.</td>
</tr>
<tr>
<td>Upper Threshold</td>
<td>Generates an alarm when the value exceeds the specified value. Clear this alarm when the value drops below the specified value. The upper threshold value must be numeric.</td>
</tr>
<tr>
<td>Lower Threshold</td>
<td>Generates an alarm when the value drops below the specified value. Clear this alarm when the value rises above the specified value. The lower threshold value must be numeric.</td>
</tr>
<tr>
<td>Upper Rate</td>
<td>Checks counter value changes over a period of one second. Generates an alarm when the specified upper rate is exceeded. Clears the alarm when the rate drops to the specified value. When this trigger is used with the 'Trigger alarm only if change persists more than' option, you can check that the rate is maintained above the specified value over time.</td>
</tr>
<tr>
<td>Note</td>
<td>If the property is sampled every $x$ seconds, the calculation is the current value less the previous value divided by $x$ seconds.</td>
</tr>
<tr>
<td>Lower Rate</td>
<td>Checks counter value changes over a period of one second. Generates an alarm when the rate drops below the specified lower rate. Clears the alarm when the rate reaches the specified value. When this trigger is used with the 'Trigger alarm only if change persists more than' option, you can check that the rate is maintained below the specified value over time.</td>
</tr>
<tr>
<td>Note</td>
<td>If the property is sampled every $x$ seconds, the calculation is the current value less the previous value divided by $x$ seconds.</td>
</tr>
</tbody>
</table>

Step 8  To generate the alarm only if the trigger condition is maintained for a certain length of time, select the relevant check box and specify the length of time in seconds.

Step 9  Click OK to exit the Edit TCA dialog box.

Step 10  Click OK to exit the Edit Soft Property dialog box.

Step 11  Click Close to exit the Soft Properties Manager.

The TCA is activated on the NE. If the trigger conditions are met, you should see the event in the Tickets tab (Prime Network Vision) or tickets table (Prime Network Events). When you restart the VNE, the TCA is applied to all similar components on the VNE.

If you want to make the TCA available to other NEs, follow the procedure in Making the Soft Property Available to Other NEs, page 2-14.
Creating a New Threshold-Crossing Alarm
Adding External Launch Points to the GUI Client

These topics describe how to add launch points from Prime Network to external applications:

- Overview: Adding External Launch Points, page 8-1
- Adding an External Launch Point to the GUI Client, page 8-3
- Deleting an External Launch Point, page 8-10
- Sample BQL Scripts for Launching External Applications, page 8-11

Overview: Adding External Launch Points

If you have configurator or higher privileges, Prime Network allows you to add right-click menu options to elements in order to launch external applications or URLs. These are called external launch points. When the external launch point is clicked, it invokes the external application (for example, a script or batch file), or opens the specified URL in the default browser. Figure 8-1 illustrates a new launch point named My Utilities.
Overview: Adding External Launch Points

You can add launch points to any IMO, including network elements, links, tickets, and events. You identify the IMO according to IMO type. The launch points appear as additional right-click menu options on all IMOs of the specified type.

You can narrow down the instances on which the external launch point appears by filtering by any of the properties of the IMO. You can also create a launch point on a property of a referenced IMO.

When you add a launch point, the site.xml file is updated on the Prime Network gateway. The new launch point (right-click menu option) will appear in all Prime Network clients that connect to the gateway.

The scripts or batch files used in the external launch point definition can be copied to one of the following locations:

- The Prime Network client machine—In this case, the launch point will only be functional on that client.
- The Prime Network gateway, under the Main/webstart/scripts directory—In this case, the scripts will be downloaded automatically to all clients associated with the gateway, upon next login. The launch points will be functional from all these clients. Please follow the instructions in Enabling Automatic Download of BQL Scripts to Clients, page 8-10, to enable the automatic download of the scripts to the clients.
- A shared location.
Adding an External Launch Point to the GUI Client

Adding an external launch point involves the following steps:

1. **Identifying the IMO Context and Properties**, page 8-3
2. **Creating BQL Scripts**, page 8-4
3. **Running BQL Scripts**, page 8-10
4. **Enabling Automatic Download of BQL Scripts to Clients**, page 8-10

**Note**
You should maintain a list of all the IMO contexts where launch points have been added, as there is no way to get such a list from the system. This will enable you to update or delete external launch points at a later stage.

**Identifying the IMO Context and Properties**

To identify the IMO context and properties:

**Step 1** Select a network element from the Tree pane.

**Step 2** Press F2. The All Properties viewer appears in a separate window.

**Step 3** Make a note of the IMO type. If you are in the Map pane, you should make a note of the IMO type that is part of ContainedIMO and not part of IHierarchyNode; for example, IPortConnector or IManagedElement.

Example 1: Identifying IManagedElement in the Tree pane:

```java
com.sheer.imo.IManagedElement
{[ManagedElement(Key=ana7609-1)]}
```

Example 2: Identifying IPortConnector in the Tree pane:

```java
com.sheer.imo.IPortConnector
{[ManagedElement(Key=ana7609-1)][PhysicalRoot][Chassis][Slot(SlotNum=5)][Module][Port(Port Number=GigabitEthernet5/1 - Missing Pluggable Port)]}
```

Example 3: Identifying IManagedElement in the Map pane:

```java
[HierarchyNode(Id=1001)][ContainedImo]
  key=Imo, value=com.sheer.imo.IManagedElement
  {[ManagedElement(Key=ana7609-1)]}
```

**Step 4** Make a note of the property key name; for example, in IManagedElement write down IP; in IPortConnector write down PortAlias.

Example 1: IManagedElement

```java
key=DeviceName, value=ana7609-1
key=IP, value=172.20.68.72
```

Example 2: IPortConnector

```java
key=Location, value=5.GigabitEthernet5/1 - Missing Pluggable Port
key=PortAlias, value=GigabitEthernet5/1 - Missing Pluggable Port
```
## Creating BQL Scripts

Read the *Cisco Prime Network Integration Developer Guide* for an understanding of Broadband Query Language (BQL), and as a prerequisite to understanding this section.

Table 8-1 describes the format and syntax that you must follow when writing the BQL set command to launch an external application:

<table>
<thead>
<tr>
<th>Property / Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>management.IExternalLaunch</td>
<td></td>
<td>The OID contains the context and unique name of the external launch point.</td>
</tr>
<tr>
<td>ID / OID</td>
<td>Examples:</td>
<td>It defines the IMO type on which the external launch point is defined, for example:</td>
</tr>
<tr>
<td></td>
<td>For network elements:</td>
<td>• IMangedElement—Network elements.</td>
</tr>
<tr>
<td></td>
<td>{{ExternalLaunch(Context ImoType=com.sheer.imo.IMangedElement) (Name=example1)}}</td>
<td>• IEvent (or any other subtype, like ISyslogAlarm)—Events and their subtypes.</td>
</tr>
<tr>
<td></td>
<td>For tickets:</td>
<td>• ITicket—Tickets.</td>
</tr>
<tr>
<td></td>
<td>{{ExternalLaunch(Context ImoType=com.sheer.imo.newalarm.ITicket) (Name=example36)}}</td>
<td>• ITopologicalLink—Links.</td>
</tr>
</tbody>
</table>
Adding an External Launch Point to the GUI Client

FilterParameters/Parameter

Example:

```
<Filter type="management.IExternalLaunchFilter">
  <FilterParameters type="IMObjects_Array">
    <management.IExternalLaunchFilterParameter type="management.IExternalLaunchFilterParameter">
      <Value type="String">reg-exp</Value>
      <Property type="String">SysLocation</Property>
    </management.IExternalLaunchFilterParameter>
    <management.IExternalLaunchFilterParameter type="management.IExternalLaunchFilterParameter">
      <Value type="String">reg-exp</Value>
      <Property type="String">ObjectId.Key</Property>
    </management.IExternalLaunchFilterParameter>
    <management.IExternalLaunchFilterParameter type="management.IExternalLaunchFilterParameter">
      <Value type="String">reg-exp</Value>
      <Property type="String">@IBusinessObject.Notes</Property>
    </management.IExternalLaunchFilterParameter>
    <management.IExternalLaunchFilterParameter type="management.IExternalLaunchFilterParameter">
      <Value type="String">~time~</Value>
      <Property type="String">ScriptMetadataOids</Property>
      <Match type="String">all</Match>
    </management.IExternalLaunchFilterParameter>
    <management.IExternalLaunchFilterParameter type="management.IExternalLaunchFilterParameter">
      <Value type="String">1-100</Value>
      <Property type="String">CpuUsage</Property>
    </management.IExternalLaunchFilterParameter>
  </FilterParameters>
  <Match type="String">any</Match>
</Filter>
```

Enables you to apply a filter to narrow down the instances on which the external launch point will be available. For example, you can use this filter if you want only IMOs with specific properties to have the external launch point, rather than all IMOs of the specified type.

You can use any of the IMO’s properties in the filter.

The filter property value can be:

- **Numbers**—a pipe-delimited list of numbers and ranges, such as: "1|4-6|8"

- **Strings and other scalar properties**—a Java regular expression (reg-exp) that is checked for containment, i.e., a full match is not required. Scalar properties are converted to string values, and null values are converted to empty strings ("").

- **Enum properties**—either the enum number or string value.

- **Arrays**—value is one of the above, with the option to specify whether any (at least one) or all of the items must match the filter value.

Multiple filter criteria are also supported. The match any or match all option should include the logical condition between the criteria elements.

### Table 8-1 BQL Command Format and Syntax (continued)

<table>
<thead>
<tr>
<th>Property / Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FilterParameters/Parameter/Property</td>
<td>Example:</td>
<td>Enables you to apply a filter to narrow down the instances on which the external launch point will be available. For example, you can use this filter if you want only IMOs with specific properties to have the external launch point, rather than all IMOs of the specified type. You can use any of the IMO’s properties in the filter. The filter property value can be:</td>
</tr>
<tr>
<td></td>
<td>&lt;Filter type=&quot;management.IExternalLaunchFilter&quot; &gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;FilterParameters type=&quot;IMObjects_Array&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;management.IExternalLaunchFilterParameter type=&quot;management.IExternalLaunchFilterParameter&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Value type=&quot;String&quot;&gt;reg-exp&lt;/Value&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Property type=&quot;String&quot;&gt;SysLocation&lt;/Property&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/management.IExternalLaunchFilterParameter&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;management.IExternalLaunchFilterParameter type=&quot;management.IExternalLaunchFilterParameter&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Value type=&quot;String&quot;&gt;reg-exp&lt;/Value&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Property type=&quot;String&quot;&gt;ObjectId.Key&lt;/Property&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/management.IExternalLaunchFilterParameter&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;management.IExternalLaunchFilterParameter type=&quot;management.IExternalLaunchFilterParameter&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Value type=&quot;String&quot;&gt;reg-exp&lt;/Value&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Property type=&quot;String&quot;&gt;@IBusinessObject.Notes&lt;/Property&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/management.IExternalLaunchFilterParameter&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;management.IExternalLaunchFilterParameter type=&quot;management.IExternalLaunchFilterParameter&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Value type=&quot;String&quot;&gt;<del>time</del>&lt;/Value&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Property type=&quot;String&quot;&gt;ScriptMetadataOids&lt;/Property&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Match type=&quot;String&quot;&gt;all&lt;/Match&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/management.IExternalLaunchFilterParameter&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;management.IExternalLaunchFilterParameter type=&quot;management.IExternalLaunchFilterParameter&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Value type=&quot;String&quot;&gt;1-100&lt;/Value&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Property type=&quot;String&quot;&gt;CpuUsage&lt;/Property&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/management.IExternalLaunchFilterParameter&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/FilterParameters&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Match type=&quot;String&quot;&gt;any&lt;/Match&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/Filter&gt;</td>
<td></td>
</tr>
</tbody>
</table>
### Adding an External Launch Point to the GUI Client

#### Adding an External Launch Point to the GUI Client

**Examples:**
- Specifying a batch file located on the client machine:
  ```
  <ExternalBatchToExecute type="String">C:\runthis.bat</ExternalBatchToExecute>
  ```
- Specifying a batch file located on the gateway machine, this batch file will be automatically downloaded from the gateway machine:
  ```
  <ExternalBatchToExecute type="String">foldername/runthis.bat</ExternalBatchToExecute>
  ```
- Specifying a URL:
  ```
  <ExternalBatchToExecute type="String">http:\www.cisco.com</ExternalBatchToExecute>
  ```
- Passing an environment variable:
  ```
  <ExternalBatchToExecute type="String">%java_home%\bin\javadoc</ExternalBatchToExecute>
  ```

**Table 8-1: BQL Command Format and Syntax (continued)**

<table>
<thead>
<tr>
<th>Property / Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ExternalBatchToExecute / String</strong></td>
<td>Examples:</td>
<td>Defines the details of the executable steps or batch file to be invoked. You:</td>
</tr>
<tr>
<td></td>
<td>• Specifying a batch file located on the client machine:</td>
<td>• Must specify the parameters as an array when using a script.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cannot pass any parameters in the URL. You must use batch files or LineToExecute to pass the parameters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Can include more commands as part of a batch file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Can include an environment variable when invoking the batch file.</td>
</tr>
<tr>
<td></td>
<td>• Specifying a URL:</td>
<td>To define a string that represents the URL or script which is executed along with its parameters, use the LineToExecute property.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Passing an environment variable:</td>
<td></td>
</tr>
</tbody>
</table>
Adding an External Launch Point to the GUI Client

### Table 8-1  BQL Command Format and Syntax (continued)

<table>
<thead>
<tr>
<th>Property / Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LineToExecute / String</td>
<td>Example:</td>
<td>Defines a string that represents the URL or script which is executed along with its parameters.</td>
</tr>
<tr>
<td></td>
<td>Launching a URL with the Gateway IP, network element IP, and logged-in username parameters, using / as delimiter:</td>
<td>The syntax includes:</td>
</tr>
<tr>
<td></td>
<td>&lt;LineToExecute type=&quot;String&quot;&gt;<a href="http://url.example.com/$GW$/$com.sheer.im">http://url.example.com/$GW$/$com.sheer.im</a> o.IManagedElement.IP$/USERNAME$&lt;/LineToExecute&gt;</td>
<td>• $—Used when you specify an IMO property definition.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>• ~—Used when you specify a Soft Property definition.</td>
</tr>
<tr>
<td></td>
<td>Launching a URL from the soft property from the interface of the supported IMO:</td>
<td>• $number$—The parameter whose index is a number.</td>
</tr>
<tr>
<td></td>
<td>&lt;LineToExecute type=&quot;String&quot;&gt;<a href="http://url.example.com/$GW$/$com.sheer.im">http://url.example.com/$GW$/$com.sheer.im</a> o.IEthernetService.NetworkElemnt#softproperty$/USERNAME$&lt;/LineToExecute&gt;</td>
<td>• $USERNAME$—The logged-in username.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• $GW$ —The Prime Network gateway IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note The &amp; character should be written as &amp; when used inside a BQL command.</td>
</tr>
<tr>
<td>MenuCaption / String</td>
<td>Example:</td>
<td>You can define the launch point of the external application from a soft property of the supported IMO by using the OID of the supported IMO.</td>
</tr>
<tr>
<td></td>
<td>&lt;MenuCaption type=&quot;String&quot;&gt;ping&lt;/MenuCaption&gt;</td>
<td>Note The soft property need to be already defined in the IMO of the supported network element.</td>
</tr>
<tr>
<td>MenuPath / String</td>
<td>Example:</td>
<td>The wording of the right-click menu option to be used for the external launch.</td>
</tr>
<tr>
<td></td>
<td>&lt;MenuPath type=&quot;String&quot;&gt;external launch demo&lt;/MenuPath&gt;</td>
<td>Note Unless you want to create a mnemonic, do not use an underscore (_) character at the beginning of the string. For example, if _Scripts is specified as the menu caption, the result will be having the menu caption as Scripts, where g is the mnemonic.</td>
</tr>
<tr>
<td>Parameters / IMObjects_Array</td>
<td>&lt;Parameters type=&quot;IMObjects_Array&quot;&gt;</td>
<td>The menu path to be followed to get to the external launch point. You can have a sub-menu separated by a forward slash (/).</td>
</tr>
</tbody>
</table>

### Example:

- For launching a URL with the Gateway IP, network element IP, and logged-in username parameters, using / as delimiter:
  ```
  &lt;LineToExecute type="String">http://url.example.com/$GW$/$com.sheer.im o.IManagedElement.IP$/USERNAME$</LineToExecute&gt;
  ```

- For launching a URL from the soft property from the interface of the supported IMO:
  ```
  &lt;LineToExecute type="String">http://url.example.com/$GW$/$com.sheer.im o.IEthernetService.NetworkElemnt#softproperty$/USERNAME$</LineToExecute&gt;
  ```

### Note

- The & character should be written as &amp; when used inside a BQL command.

- You can define the launch point of the external application from a soft property of the supported IMO by using the OID of the supported IMO.

- The soft property need to be already defined in the IMO of the supported network element.
### Table 8-1  
**BQL Command Format and Syntax (continued)**

<table>
<thead>
<tr>
<th>Property / Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role / String</td>
<td>Example: &lt;Role type=&quot;string&quot;&gt;CONFIGURATOR&lt;/Role&gt;</td>
<td>Defines the minimum user role required to use the launch point—administrator, configurator, and so on. If this is not defined, all users will have access to the launch point.</td>
</tr>
<tr>
<td>Selection Limit / Int</td>
<td>Example: &lt;SelectionLimit type=&quot;int&quot;&gt;2&lt;/SelectionLimit&gt;</td>
<td>Defines the number of items that must be selected for the launch point to be displayed. For example, if the selection limit is 2, the right-click menu option will not appear if only one item is selected, or if three items are selected. It will only appear if two items are selected.</td>
</tr>
<tr>
<td>ID / OID</td>
<td>{{ExternalLaunchParameter(Index=1)}}</td>
<td>Index value defines the order in which the parameters will be passed to the script.</td>
</tr>
<tr>
<td>IMOType / String</td>
<td>Example 1: &lt;IMOType type=&quot;String&quot;&gt;com.sheer.imo.IPortConnector&lt;/IMOType&gt;</td>
<td>Defines the IMO context type. You can also leave this field empty. You can pass the parameter not only from the IMO and its parent on which you set the menu but also from the IMO tree up to IManagedElement. It can be the parent or the higher level IMO depending on the IMO that you have selected for your menu.</td>
</tr>
<tr>
<td></td>
<td>Example 2: &lt;IMOType type=&quot;String&quot;&gt;com.sheer.imo.newalarm.ITicket&lt;/IMOType&gt;</td>
<td></td>
</tr>
<tr>
<td>PropertyName / String</td>
<td>Example 1: &lt;PropertyName type=&quot;String&quot;&gt;PortAlias&lt;/PropertyName&gt;</td>
<td>Defines the property or soft property name within the IMO context type. This value is used as an argument when invoking the application. You can also have any constant value. If the property value is another IMO, you can retrieve the properties of this IMO using a dot notation (see Example 3). If the property value is an OID, you can retrieve the properties of the referenced IMO using the # notation (see Example 4).</td>
</tr>
<tr>
<td></td>
<td>Example 2: &lt;PropertyName type=&quot;String&quot;&gt;LatestState&lt;/PropertyName&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example 3 (retrieving properties of a contained IMO): &lt;PropertyName type=&quot;String&quot;&gt;ObjectId.Key&lt;/PropertyName&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example 4 (retrieving properties not available at time of execution): &lt;PropertyName type=&quot;String&quot;&gt;Port#PortDescription&lt;/PropertyName&gt;</td>
<td></td>
</tr>
</tbody>
</table>
Adding an External Launch Point to the GUI Client

Defining Soft Property Parameters for a BQL Script

You can use a soft property as a parameter in an external launch BQL command. You can specify the soft property that you want to define the external launch to be performed. To specify this, enter the following in the line to execute property of the BQL Command:

<LineToExecute
type="String">http://url.example.com/$GW$/com.sheer.imo.IEthernetService.NetworkElemnt#$soft property#$/$USERNAME$</LineToExecute>

To define a soft property parameter you need to write the soft property name (not the label) in the PropertyName entry, and add the following entry to the parameter definition:

<SoftProperty type="boolean">true</SoftProperty>

If you do not add this entry, by default the value is assumed to be false.

Parameters that have the value true for the soft property entry are not validated in the definition of the command.

The launch point will be visible even if the IMO does not have the soft property defined on it. When a soft property is not defined, an appropriate message is displayed after the command is run.

Note

If you create an ExternalBatchtoExecute-based external launch command that includes a soft property and the specified soft property does not exist on the IMO, the output will have an empty string (" "). This is to ensure that any logic built in to the script which depends on the parameter order, functions as desired. You may use the ReplaceNullWith external launch command parameter if you want to get a different string for the null value.

Table 8-1 BQL Command Format and Syntax (continued)

<table>
<thead>
<tr>
<th>Property / Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RunSingleCommand / Boolean</td>
<td>Example:</td>
<td>If the value is set to true, a single script will be run for all the selected objects. If set to false, a script will be run for each of the selected objects.</td>
</tr>
<tr>
<td></td>
<td>&lt;RunSingleCommand type=&quot;boolean&quot;&gt;true&lt;/RunSingleCommand&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The script will be called once, with the required properties of all selected IMOs passed at the same time.</td>
<td></td>
</tr>
<tr>
<td>ReplaceNullWith / String</td>
<td>Example:</td>
<td>If you want a null value not to be ignored or replaced with an empty string, you can use the ReplaceNullWith string. This is optional. In the example, the null value will be replaced by N/A. See Defining Soft Property Parameters for a BQL Script for more information on the usage of this property.</td>
</tr>
<tr>
<td></td>
<td>&lt;ReplaceNullWith type=&quot;String&quot;&gt;N/A&lt;/ReplaceNullWith&gt;</td>
<td></td>
</tr>
</tbody>
</table>
Running BQL Scripts

See the *Cisco Prime Network Integration Developer Guide* to understand how to run a BQL script. This guide is located in the Prime Network Technology Center on the Cisco Developer Network (CDN), under the Integration tab.

Enabling Automatic Download of BQL Scripts to Clients

You have the option to have the scripts downloaded automatically to all clients associated with the gateway, upon next login.

To enable automatic download of scripts to clients:

**Step 1**  Create a directory for your scripts under the Main/webstart/scripts directory on the Prime Network gateway.

**Step 2**  Run `~/Main/scripts]% updateXLaunchScripts.pl` on the gateway to update the auto-deployable scripts jar.

The next time a client connects to the gateway, the scripts will be downloaded and extracted by the client application.

Deleting an External Launch Point

You can delete an external application launch point using the BQL **Delete** command.

**Note**  See the *Cisco Prime Network Integration Developer Guide* for an understanding of BQL, and as a prerequisite to understanding this section.

To delete the launch point:

**Step 1**  Create a BQL script with the **Delete** command as shown below:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<command name="Delete">
  <param name="oid">
    <value>
      <management.IExternalLaunch>
        <ID type="Oid">{[ExternalLaunch(ContextImoType=com.sheer.imo.IPortConnector
          ) Name=example4]}
        </ID>
      </management.IExternalLaunch>
    </value>
  </param>
</command>
```

**Step 2**  Run the BQL script.

**Step 3**  Launch Prime Network Vision to verify that the launch point has been removed.
Sample BQL Scripts for Launching External Applications

This chapter provides example scripts for launching external applications using BQL.

### For a BQL Example That:

<table>
<thead>
<tr>
<th>Script Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Runs a single script on selected tickets using their latest state and last modification time as parameters</td>
<td>Example 1, page 8-11</td>
</tr>
<tr>
<td>Runs a single script on selected tickets that include Layer 2 in their description, using their latest state and last modification time as parameters</td>
<td>Example 2, page 8-12</td>
</tr>
<tr>
<td>Includes a soft property parameter in a BQL command to create an external launch point on a network element</td>
<td>Example 3, page 8-13</td>
</tr>
<tr>
<td>Uses a batch file to invoke an application</td>
<td>Example 4, page 8-13</td>
</tr>
<tr>
<td>Executes a script named C:/script.bat using PortAlias and the logged-in username as parameters</td>
<td>Example 5, page 8-14</td>
</tr>
<tr>
<td>Launches a URL that uses the parameters values gateway IP, NE IP and the logged-in username; and uses / as a delimiter</td>
<td>Example 6, page 8-14</td>
</tr>
<tr>
<td>Launches a URL that uses the parameters a, b, and c whose values are, respectively, the soft property showClock, a constant string &quot;constant&quot;, and the logged-in username</td>
<td>Example 7, page 8-15</td>
</tr>
<tr>
<td>Launches a URL that uses the parameters a, b, c and d whose values are, respectively, the IMO property IP, the property PortAlias, a constant string &quot;any_const_parameter&quot;, and the logged-in username; and uses the existing Parameters element</td>
<td>Example 8, page 8-15</td>
</tr>
<tr>
<td>Uses an environment variable to invoke an application</td>
<td>Example 9, page 8-16</td>
</tr>
<tr>
<td>Uses multiple IMO contexts to launch an application</td>
<td>Example 10, page 8-16</td>
</tr>
</tbody>
</table>

For details about the format and the syntax of BQL scripts, see Creating BQL Scripts, page 8-4.

### Note

<param name = "replace"> is always set to true. This value replaces the old value with the new value based on the script that is invoked.

#### Example 1

This example runs a single script on the selected tickets with their latest state and last modification time as parameters.

```xml
<command name="Set">
  <param name="imo">
    <value>
      <management.IExternalLaunch>
        <ID type="Oid">{[ExternalLaunch(ContextImoType=com.sheer.imo.newalarm.ITicket (Name=print state)]]</ID>
        <ExternalBatchToExecute type="String">C:\script.bat</ExternalBatchToExecute>
      </management.IExternalLaunch>
    </value>
  </param>
</command>
```
Example 2

This example runs a single script on the selected tickets with their latest state and last modification time as parameters, for tickets that include Layer 2 in their description.

<command name="Set">
<param name="imo">
  <value>
    <management.IExternalLaunch>
    <ID type="Oid">{{ExternalLaunch(ContextImoType=com.sheer.imo.newalarm.ITicket)
    (Name=print state)}}</ID>
    <ExternalBatchToExecute type="String">C:\script.bat</ExternalBatchToExecute>
    <LatestState type="String">Layer 2</LatestState>
    <MenuCaption type="String">Print state</MenuCaption>
    <MenuPath type="String">My apps</MenuPath>
    <Parameters type="IMObjects_Array">
    <management.IExternalLaunchParameter>
    <ID type="Oid">{{ExternalLaunchParameter[Index=1]}}</ID>
    <IMOType type="String">com.sheer.imo.newalarm.ITicket</IMOType>
    <PropertyName type="String">LatestState</PropertyName>
    </management.IExternalLaunchParameter>
    <management.IExternalLaunchParameter>
    <ID type="Oid">{{ExternalLaunchParameter[Index=2]}}</ID>
    <IMOType type="String">com.sheer.imo.newalarm.ITicket</IMOType>
    <PropertyName type="String">LastModificationTime</PropertyName>
    </management.IExternalLaunchParameter>
    </Parameters>
    <RunSingleCommand type="boolean">true</RunSingleCommand>
  </management.IExternalLaunch>
  </param>
<param name="replace">
  <value>true</value>
</param>
</command>
Example 3

This example includes a soft property parameter in a BQL command for an external launch point on a network element.

```xml
<command name="Set">
  <param name="imo">
    <value>
      <management.IExternalLaunch>
        <ID type="Oid">{[ExternalLaunch(ContextImoType=com.sheer.imo.IMangedElement)(Name=InfoVista-Launch-test-2)]}</ID>
        <ElementType type="String">Cisco 7206VXR</ElementType>
        <ExternalBatchToExecute type="String">C:/IV/launch-report.bat</ExternalBatchToExecute>
        <MenuCaption type="String">test4</MenuCaption>
        <MenuPath type="String">Performance/Test4</MenuPath>
        <Parameters type="IMObjects_Array">
          <management.IExternalLaunchParameter>
            <ID type="Oid">{[ExternalLaunchParameter(Index=1)]}</ID>
            <IMOType type="String">com.sheer.imo.IMangedElement</IMOType>
            <PropertyName type="String">showClock</PropertyName>
            <SoftProperty type="boolean">true</SoftProperty>
          </management.IExternalLaunchParameter>
          <management.IExternalLaunchParameter>
            <ID type="Oid">{[ExternalLaunchParameter(Index=2)]}</ID>
            <IMOType type="String">com.sheer.imo.IMangedElement</IMOType>
            <PropertyName type="String">IP</PropertyName>
            <SoftProperty type="boolean">false</SoftProperty>
          </management.IExternalLaunchParameter>
          <management.IExternalLaunchParameter>
            <ID type="Oid">{[ExternalLaunchParameter(Index=3)]}</ID>
            <IMOType type="String">com.sheer.imo.IMangedElement</IMOType>
            <PropertyName type="String">ElementTypeKey</PropertyName>
          </management.IExternalLaunchParameter>
        </Parameters>
        <Vendor type="String">Cisco</Vendor>
      </management.IExternalLaunch>
    </value>
  </param>
  <param name="replace">
    <value>true</value>
  </param>
</command>
```

Example 4

This example uses a batch file to invoke an application.

```xml
<command name="Set">
  <param name="imo">
    <value>
      <management.IExternalLaunch>
        <ID type="Oid">{[ExternalLaunch(ContextImoType=com.sheer.imo.IMangedElement)(Name=example1)]}</ID>
        <ElementType type="String">Cisco</ElementType>
        <Vendor type="String">Cisco</Vendor>
        <ExternalBatchToExecute type="String">C:\runthis.bat</ExternalBatchToExecute>
        <MenuCaption type="String">ping</MenuCaption>
        <MenuPath type="String">external launch/file example</MenuPath>
      </management.IExternalLaunch>
    </value>
  </param>
</command>
```
Example 5

This example executes a script C:/script.batch with parameters PortAlias and the logged-in username.

```xml
<?xml version="1.0" encoding="UTF-8"?
<command name="Set"
<param name="imo">
<value>
<management.IExternalLaunch>
<ID type="Oid">{{ExternalLaunch(ContextImoType=com.sheer.imo.IPortConnector)
(NAME=example)}}</ID>
<MenuCaption type="String">My Example</MenuCaption>
<MenuPath type="String">My Menu/My Sub Menu</MenuPath>
<LineToExecute type="String">$com.sheer.imo.IPortConnector.PortAlias $USERNAME$</LineToExecute>
</management.IExternalLaunch>
</value>
</param>
<param name="replace">
<value>true</value>
</param>
</command>
```

Example 6

This example launches a URL with parameter values Gateway IP, the NE IP and the logged-in username, using / (forward slash) as delimiter.

```xml
<?xml version="1.0" encoding="UTF-8"?
<command name="Set">
<param name="imo">
<value>
<management.IExternalLaunch>
<ID type="Oid">{{ExternalLaunch(ContextImoType=com.sheer.imo.IPortConnector)
(NAME=example)}}</ID>
<Vendor type="String">Cisco</Vendor>
<MenuCaption type="String">My Example</MenuCaption>
<MenuPath type="String">My Menu/My Sub Menu</MenuPath>
<LineToExecute type="String">http://url.example.com/$GW$/com.sheer.imo.IMangedElement.IP/$USERNAME$</LineToExecute>
</management.IExternalLaunch>
</value>
</param>
<param name="replace">
<value>true</value>
</param>
</command>
```
Example 7

This example launches a URL with parameters a, b, and c, whose values are the soft property showClock, a constant string constant, and the logged-in username.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<command name="Set">
  <param name="imo">
    <value>
      <management.IExternalLaunch>
        <ID type="Oid">{[ExternalLaunch(ContextImoType=com.sheer.imo.IPortConnector) (Name=example)]}</ID>
        <ElementType type="String">IOU</ElementType>
        <MenuCaption type="String">My Example</MenuCaption>
        <MenuPath type="String">My Menu/My Sub Menu</MenuPath>
        <LineToExecute type="String">http://url.example.com/my.action?a=~com.sheer.imo.IManagedElement.showClock~&amp;b=constant&amp;c=$USERNAME$</LineToExecute>
      </management.IExternalLaunch>
    </value>
  </param>
  <param name="replace">
    <value>true</value>
  </param>
</command>
```

Example 8

This example launches a URL with parameters a, b, c, and d, whose values are the IMO property IP, property PortAlias, a constant string any_const_parameter, and the logged-in username, using the existing Parameters element.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<command name="Set">
  <param name="imo">
    <value>
      <management.IExternalLaunch>
        <ID type="Oid">{[ExternalLaunch(ContextImoType=com.sheer.imo.IPortConnector) (Name=example)]}</ID>
        <ElementType type="String">IOU</ElementType>
        <MenuCaption type="String">My Example</MenuCaption>
        <MenuPath type="String">My Menu/My Sub Menu</MenuPath>
        <LineToExecute type="String">http://url.example.com/my.action?a=$1$&amp;b=$2$&amp;c=$3$&amp;d=$USERNAME$</LineToExecute>
        <Parameters type="IMObjects_Array">
          <management.IExternalLaunchParameter>
            <ID type="Oid">{[ExternalLaunchParameter(Index=1)]}</ID>
            <IMOType type="String">com.sheer.imo.IManagedElement</IMOType>
            <PropertyName type="String">IP</PropertyName>
          </management.IExternalLaunchParameter>
          <management.IExternalLaunchParameter>
            <ID type="Oid">{[ExternalLaunchParameter(Index=2)]}</ID>
            <IMOType type="String">com.sheer.imo.IPortConnector</IMOType>
            <PropertyName type="String">PortAlias</PropertyName>
          </management.IExternalLaunchParameter>
          <management.IExternalLaunchParameter>
            <ID type="Oid">{[ExternalLaunchParameter(Index=3)]}</ID>
          </management.IExternalLaunchParameter>
        </Parameters>
      </management.IExternalLaunch>
    </value>
  </param>
  <param name="replace">
    <value>true</value>
  </param>
</command>
```
Example 9

This example uses an environment variable to invoke an application.

```xml
<command name="Set">
  <param name="imo">
    <value>
      <management.IExternalLaunch>
        <ID type="Oid">{{[ExternalLaunch{ContextImoType=com.sheer.imo.IMangedElement}(Name=example3)]}}</ID>
        <ElementType type="String">Cisco</ElementType>
        <Vendor type="String">Cisco</Vendor>
        <ExternalBatchToExecute type="String">%EMS_A%runthis.bat</ExternalBatchToExecute>
        <MenuCaption type="String">environment variable</MenuCaption>
        <MenuPath type="String">External Launch</MenuPath>
        <Parameters type="IMObjects_Array">
          <management.IExternalLaunchParameter>
            <ID type="Oid">{{[ExternalLaunchParameter{Index=1}]}}</ID>
            <IMOType type="String"></IMOType>
            <PropertyName type="String">www.cisco.com</PropertyName>
          </management.IExternalLaunchParameter>
          <management.IExternalLaunchParameter>
            <ID type="Oid">{{[ExternalLaunchParameter{Index=2}]}}</ID>
            <IMOType type="String">com.sheer.imo.IMangedElement</IMOType>
            <PropertyName type="String">IP</PropertyName>
          </management.IExternalLaunchParameter>
        </Parameters>
      </management.IExternalLaunch>
    </value>
  </param>
  <param name="replace">
    <value>true</value>
  </param>
</command>
```

Example 10

This example uses multiple IMO contexts to launch an application.

```xml
<command name="Set">
  <param name="imo">
    <value>
      <management.IExternalLaunch>
        <ID type="Oid">{{[ExternalLaunch{ContextImoType=com.sheer.imo.IMangedElement}(Name=example3)]}}</ID>
        <ElementType type="String">IOU</ElementType>
      </management.IExternalLaunch>
    </value>
  </param>
  <param name="replace">
    <value>true</value>
  </param>
</command>
```
<Vendor type="String">Cisco</Vendor>
<ExternalBatchToExecute
type="String">c:runthis.bat</ExternalBatchToExecute>
<MenuCaption type="String">ping</MenuCaption>
<MenuPath type="String">External Launch</MenuPath>
<Parameters type="IMObjects_Array">
  <management.IExternalLaunchParameter>
    <ID type='Oid'>{{ExternalLaunchParameter(Index=1)}}</ID>
    <IMOType type="String">com.sheer.imo.IManagedElement</IMOType>
    <PropertyName type="String">IP</PropertyName>
  </management.IExternalLaunchParameter>
  <management.IExternalLaunchParameter>
    <ID type='Oid'>{{ExternalLaunchParameter(Index=2)}}</ID>
    <IMOType type="String">com.sheer.imo.IPortConnector</IMOType>
    <PropertyName type="String">PortAlias</PropertyName>
  </management.IExternalLaunchParameter>
  <management.IExternalLaunchParameter>
    <ID type='Oid'>{{ExternalLaunchParameter(Index=3)}}</ID>
    < IMOType type="String"></IMOType>
    <PropertyName type="String">any_const_parameter</PropertyName>
  </management.IExternalLaunchParameter>
</Parameters>

</management.IExternalLaunch>

<command>
  <param name="replace">
    <value>true</value>
  </param>
</command>
Soft Properties: Supported Parsing Operators, Rules, and Regular Expressions

These topics provide listings of the operators, rules, and expressions that are supported for creating soft properties.

- **Supported Parsing Rules and Operators, page A-1**
- **Supported Regular Expressions, page A-3**

For information on supported triggers for TCAs, see *Creating a New Threshold-Crossing Alarm*, page 7-1.

### Supported Parsing Rules and Operators

Table A-1 lists the predefined text manipulation operators available for parsing raw device input and turning each into a soft property that is available in the Add/Edit Parsing Rule dialog box.

**Table A-1  Supported Parsing Operators and Rules for Soft Properties**

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Parameter</th>
<th>Parameter Description</th>
<th>Parameter Validation Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header and Footer</td>
<td>Removes a specified number of lines from the header and footer of the input text.</td>
<td>Header lines</td>
<td>Number of header lines to be removed.</td>
<td>Integers only. Mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Footer lines</td>
<td>The number of footer lines to be removed.</td>
<td>Integers only. Mandatory.</td>
</tr>
<tr>
<td>Remove Lines</td>
<td>Removes a range of lines from the specified starting row to the specified end row the input text.</td>
<td>From line</td>
<td>Index of first row to begin removal, inclusive.</td>
<td>Integer only. Mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To line</td>
<td>Index of last row to be removed, inclusive.</td>
<td>Integer only; must be equal to or greater than From line. Mandatory.</td>
</tr>
<tr>
<td>Select Lines</td>
<td>Extracts a range of lines from the specified starting row to the specified end row of the input text.</td>
<td>From line</td>
<td>Index of first row to begin selection, inclusive.</td>
<td>Integer only. Mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To line</td>
<td>Index of last row to be selected, inclusive.</td>
<td>Integer only; must be equal to or greater than From line. Mandatory.</td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
<td>Parameter</td>
<td>Parameter Description</td>
<td>Parameter Validation Rules</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>-----------</td>
<td>-----------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Replace</td>
<td>Finds one substring or all occurrences of a substring that matches a specified regular expression, and replaces it with a specified value.</td>
<td>Expression</td>
<td>Search for value or regular expression.</td>
<td>Text. Mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>With</td>
<td>Replace string with value or regular expression.</td>
<td>Text. Mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>From Index</td>
<td>Starting index.</td>
<td>Integer; must be 1 or higher. Mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Replace All</td>
<td>Check box. Select this option to replace all occurrences of the matching substrings, otherwise only the first instance is replaced.</td>
<td>Default is unchecked.</td>
</tr>
<tr>
<td>Match</td>
<td>Finds and extracts a substring that matches a specified regular expression. If no match can be found, the output buffer receives an empty string or receives the original input, based on choice in If no match drop down list.</td>
<td>Expression</td>
<td>Search for value or regular expression.</td>
<td>Text. Mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If no match</td>
<td>Returns the original input or and empty string, based on your choice.</td>
<td></td>
</tr>
<tr>
<td>Set</td>
<td>Prints the results of the input and output buffers.</td>
<td>Expression</td>
<td>Regular expression template to use for formatting. $_$ specifies the main output buffer.</td>
<td>Text. Mandatory.</td>
</tr>
<tr>
<td>Substring</td>
<td>Extracts a substring of a specified length from a specified starting point.</td>
<td>From Index</td>
<td>Begin index to select.</td>
<td>Integer; must be 1 or higher. Mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Length</td>
<td>How many characters to select.</td>
<td>Integer. Mandatory.</td>
</tr>
<tr>
<td>Parse Integer</td>
<td>Uses the substring rule. When a result is received with the substring, it is converted into an integer value.</td>
<td>From Index</td>
<td>Starting index to select.</td>
<td>Integer; must be 1 or higher. Mandatory.</td>
</tr>
<tr>
<td>Note</td>
<td>If the substring operator contains any characters, the parsing integer operator fails.</td>
<td>To Index</td>
<td>Ending index to select.</td>
<td>Integer. Mandatory.</td>
</tr>
</tbody>
</table>
Supported Regular Expressions

A regular expression consists of a character string in which some characters are given special meaning with regard to pattern matching. These topics are based on the documentation of the package GNU RegExp. These tables list the supported and unsupported expressions.

**Note**

Some flavors of regular expression utilities support additional escape sequences. The following is not meant to be an exhaustive list. In the future, gnu.regexp might support some or all of the following but they are currently unsupported:

- `(?mods)` — Inline compilation/execution modifiers (Perl5)
- `\G` — End of previous match (Perl5)
- `[symbol.]` — Collating symbol in class expression (POSIX).
  - `[^class=]` — Equivalence class in class expression (POSIX)
  - `s/foo/bar` — Style expressions as in sed and awk

**Table A-2**  
**Supported Positional Operators**

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>^</td>
<td>Matches at the beginning of a line.</td>
</tr>
<tr>
<td>$</td>
<td>Matches at the end of a line.</td>
</tr>
<tr>
<td>\A</td>
<td>Matches the start of the entire string.</td>
</tr>
<tr>
<td>\Z</td>
<td>Matches the end of the entire string.</td>
</tr>
<tr>
<td>\b</td>
<td>Matches at a word break (Perl5 syntax only).</td>
</tr>
<tr>
<td>\B</td>
<td>Matches at a nonword break (opposite of \b) (Perl5 syntax only).</td>
</tr>
<tr>
<td>&lt;</td>
<td>Matches at the start of a word (egrep syntax only).</td>
</tr>
<tr>
<td>&gt;</td>
<td>Matches at the end of a word (egrep syntax only).</td>
</tr>
</tbody>
</table>

**Table A-3**  
**Supported One-Character Operators**

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Matches any single character.</td>
</tr>
<tr>
<td>\d</td>
<td>Matches any decimal digit.</td>
</tr>
<tr>
<td>\D</td>
<td>Matches any nondigit.</td>
</tr>
<tr>
<td>\n</td>
<td>Matches a newline character.</td>
</tr>
<tr>
<td>\r</td>
<td>Matches a return character.</td>
</tr>
<tr>
<td>\s</td>
<td>Matches any whitespace character.</td>
</tr>
<tr>
<td>\S</td>
<td>Matches any nonwhitespace character.</td>
</tr>
<tr>
<td>\t</td>
<td>Matches a horizontal tab character.</td>
</tr>
<tr>
<td>\w</td>
<td>Matches any word (alphanumeric) character.</td>
</tr>
</tbody>
</table>
**Supported Regular Expressions**

### Table A-3 Supported One-Character Operators (continued)

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\W</td>
<td>Matches any nonword (alphanumeric) character.</td>
</tr>
<tr>
<td>\x</td>
<td>Matches the character ( x ), if ( x ) is not one of the above listed escape sequences.</td>
</tr>
</tbody>
</table>

### Table A-4 Supported Character Class Operators

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[abc]</td>
<td>Matches any character in the set ( a, b, ) or ( c ).</td>
</tr>
<tr>
<td>![abc]</td>
<td>Matches any character not in the set ( a, b, ) or ( c ).</td>
</tr>
<tr>
<td>[a-z]</td>
<td>Matches any character in the range ( a ) to ( z ), inclusive.</td>
</tr>
<tr>
<td>Leading or trailing dash</td>
<td>Interpreted literally.</td>
</tr>
</tbody>
</table>

### Table A-5 Supported Character Class Operators—if RE_CHAR_CLASSES Is Enabled

<table>
<thead>
<tr>
<th>Character Sequences</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[:alnum:]</td>
<td>Any alphanumeric character.</td>
</tr>
<tr>
<td>[:alpha:]</td>
<td>Any alphabetic character.</td>
</tr>
<tr>
<td>[:blank:]</td>
<td>A space or horizontal tab.</td>
</tr>
<tr>
<td>[:cntrl:]</td>
<td>A control character.</td>
</tr>
<tr>
<td>[:digit:]</td>
<td>A decimal digit.</td>
</tr>
<tr>
<td>[:graph:]</td>
<td>A nonspace, noncontrol character.</td>
</tr>
<tr>
<td>[:lower:]</td>
<td>A lowercase letter.</td>
</tr>
<tr>
<td>[:print:]</td>
<td>Same as graph, but also space and tab.</td>
</tr>
<tr>
<td>[:punct:]</td>
<td>A punctuation character.</td>
</tr>
<tr>
<td>[:space:]</td>
<td>Any whitespace character, including newline and return.</td>
</tr>
<tr>
<td>[:upper:]</td>
<td>An uppercase letter.</td>
</tr>
<tr>
<td>[:xdigit:]</td>
<td>A valid hexadecimal digit.</td>
</tr>
</tbody>
</table>

### Table A-6 Supported Subexpressions and Back References

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(abc)</td>
<td>Matches whatever the expression ( abc ) would match, and saves it as a subexpression. Also used for grouping.</td>
</tr>
<tr>
<td>(?;....)</td>
<td>Pure grouping operator; does not save contents.</td>
</tr>
<tr>
<td>(?#...)</td>
<td>Embedded comment; ignored by engine.</td>
</tr>
<tr>
<td>( n )</td>
<td>Where ( 0 &lt; n &lt; 10 ), matches the same thing the ( n )th subexpression matched.</td>
</tr>
</tbody>
</table>
Table A-7  Supported Branching (Alternation) Operator

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>b</td>
</tr>
</tbody>
</table>

Table A-8  Supported Repeating Operators (Operate on Previous Atomic Expression)

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Matches the preceding expression or the null string.</td>
</tr>
<tr>
<td>*</td>
<td>Matches the null string or any number of repetitions of the preceding expression.</td>
</tr>
<tr>
<td>+</td>
<td>Matches one or more repetitions of the preceding expression.</td>
</tr>
<tr>
<td>{m}</td>
<td>Matches exactly m repetitions of the one-character expression.</td>
</tr>
<tr>
<td>{m,n}</td>
<td>Matches between m and n repetitions of the preceding expression, inclusive.</td>
</tr>
<tr>
<td>{m,}</td>
<td>Matches m or more repetitions of the preceding expression.</td>
</tr>
</tbody>
</table>

Table A-9  Supported Lookahead

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(?=foo)</td>
<td>Matches at any position where foo would match, but does not consume any characters of the input.</td>
</tr>
<tr>
<td>(?!foo)</td>
<td>Matches at any position where foo would not match, but does not consume any characters of the input.</td>
</tr>
</tbody>
</table>
VCB: CLI Commands and Template Reference

These topics provide reference information for VCB CLI commands and templates:

- VCB CLI Reference: vcb and vcb sitechanges Commands, page B-1
- VCB CLI Reference: U-VNEs Commands, page B-3
- VCB CLI Reference: Standard and Pluggable Modules Commands, page B-17
- VCB CLI Reference: Events Commands, page B-31
- VCB Template Reference, page B-56

VCB CLI Reference: vcb and vcb sitechanges Commands

These topics provide reference information for the the `vcb` and `vcb sitechanges` commands which are used to deploy, maintain, and remove VCB customizations.

- `vcb`, page B-1
- `vcb sitechanges`, page B-3

vcb

The `vcb` command is the wrapper for all VCB-related commands.

Syntax

```plaintext
{uvne|module|pluggablemodule|event|eventpattern|eventparsingrules|devicetype} 
{add|view|modify|delete} args... [-help ] [-debuglevel {error|warn|info|debug}] [-logfile logfile] -user username -password password 

vcb {eventarg} {view} [-help ] [-debuglevel {error|warn|info|debug}] [-logfile logfile] 
-user username -password password 

vcb {sitechanges} {view|export|delete} [-help ] [-debuglevel {error|warn|info|debug}] 
[-logfile logfile] -user username -password password
```

For information—descriptions, options, and usage—about specific commands, see specific command references:

- VCB CLI Reference: U-VNEs Commands, page B-3
- VCB CLI Command Reference: Device Types Commands, page B-12
- VCB CLI Command Reference: Standard Modules, page B-18
- VCB CLI Command Reference: Pluggable Modules, page B-25
Global Command Options

Table B-1 describes the global options and arguments that are common to all `vcb` commands and subcommands.

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>help</td>
<td></td>
<td>Displays online help about the command. Use this option for each subcommand.</td>
</tr>
<tr>
<td>debuglevel</td>
<td></td>
<td>Determines which messages are logged based on the message severity. Valid values are: error, warn (default), info, and debug. For example, if debuglevel is set to warn, all warning and error messages are saved to the log file.</td>
</tr>
<tr>
<td>logfile</td>
<td>logfile</td>
<td>Logs the CLI output to the file specified in the logfile argument.</td>
</tr>
<tr>
<td>userdefined</td>
<td></td>
<td>Displays the registrations that have been added to the site.xml file using the VCB or any other tool.</td>
</tr>
<tr>
<td>user</td>
<td>username</td>
<td>BQL username.</td>
</tr>
<tr>
<td>password</td>
<td>password</td>
<td>BQL password.</td>
</tr>
</tbody>
</table>

Description

Use the `vcb` command to create and update VNE registry configuration files. Use the `vcb` command to add, delete, view, and modify information in these files, based on the subcommands that are used with it.

The `vcb` command performs the following high-level operations:

- Executes Prime Network administrator-level operations. It also provides a service to handle authorization errors. VCB users must have the Prime Network admin user role and associated privileges in order to perform registry configuration commands.
- Verifies that the expected version of Prime Network is running.
- Provides help information for each command.
- Logs all internal commands.
- Centralizes error handling for exceptions.

General Error Codes

Table B-2 General Error Codes — `vcb`

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Signifies OK.</td>
</tr>
<tr>
<td>10</td>
<td>Operation not permitted. An attempt was made to perform an operation limited to processes with appropriate privileges or to the owner of a file or other resources.</td>
</tr>
<tr>
<td>11</td>
<td>User does not have Prime Network admin privileges.</td>
</tr>
<tr>
<td>20</td>
<td>No such file or directory. A component of a specified pathname did not exist, or the pathname was an empty string. This might occur when the argument is a DSP or to a registry hive.</td>
</tr>
<tr>
<td>30</td>
<td>Failed to connect to Prime Network server.</td>
</tr>
</tbody>
</table>
**vcb sitechanges**

The `vcb sitechanges` command affects all extensions in the local site.xml file—displaying, exporting, or deleting them—whether the extensions were created by the VCB or by other Prime Network utilities.

**Syntax**

```
vcb sitechanges {view|export|delete} [-help] [-debuglevel {error|warn|info|debug}] [-logfile logfile] -user username -password password
```

**Description**

Use the `vcb sitechanges` command to view all customizations that were made to the site.xml registry file whether by the VCB or by other Prime Network utilities. Use the `vcb sitechanges` command also to write all customizations to script files that enable you to import changes to another system or to delete all changes, returning the system to factory default.

Because the VCB does not differentiate between changes made by the VCB and changes made by other Prime Network utilities, the `vcb sitechanges export` and `vcb sitechanges delete` commands create script files to enable you to inspect commands before you execute them. Edit the script files before running them to ensure that only the customizations that you are interested in are acted upon.

---

### Table B-2  General Error Codes—vcb (continued)

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>I/O error. Some physical input or output error occurred.</td>
</tr>
<tr>
<td>50</td>
<td>Invalid argument. Some invalid argument was supplied.</td>
</tr>
<tr>
<td>60</td>
<td>Incompatible Prime Network version of VCB; expected $vcb_expected_version$ and found Prime Network $ana_running_version$.</td>
</tr>
<tr>
<td>70</td>
<td>Bad procedure for program. A Remote Procedure Call (RPC) call was attempted for a procedure which does not exist in the VCB program.</td>
</tr>
<tr>
<td>80</td>
<td>Function not implemented. Attempted a system call that is not available on this system.</td>
</tr>
</tbody>
</table>

---

**VCB CLI Reference: U-VNEs Commands**

These topics provide reference information for the `vcb uvne` commands you can use to create, view, modify, and delete U-VNEs:

- `vcb uvne add`, page B-3
- `vcb uvne view`, page B-6
- `vcb uvne modify`, page B-9
- `vcb uvne delete`, page B-11

**vcb uvne add**

The `vcb uvne add` command creates a U-VNE by associating a U-VNE template with the device type associated with the given sysOID, or by cloning from an existing device or device family.
VCB CLI Reference: U-VNEs Commands

Syntax

\begin{verbatim}
vcb uvne add -sysoid sysoid -template template name -group template filename [-devicetype device type name] -user username -password password
vcb uvne add -sysoid sysoid -clonesysoid clone_sysoid -user username -password password
vcb uvne add -sysoid sysoid -clonedevicefamily devicefamily [-devicetype device type] -user username -password password
vcb uvne add -sysoid sysoid -softwareversion software-version -clonesoftwareversion clone-softwareversion -clonedevicefamily devicefamily -scheme <product|ipcore > [-devicetype device type name] -user username -password password
\end{verbatim}

Description

The `vcb uvne add` command creates a U-VNE-driver for the device type associated with the given sysOID using the specified U-VNE template. Creating a U-VNE-driver enables the Auto Detect feature in Prime Network to associate a device with this sysOID with the VNE-driver implementation defined by the template.

This command creates a separate registry configuration for the U-VNE. Any configuration setting given in the command parameters affect this copy.

\textbf{Note}

This command does not create the device category for the device. For more information, see `vcb devicetype add`, page B-12.

Usage Examples

\textbf{Example 1}

```
vcb uvne add -sysoid 1.2.3.4 -template GenericUVNE -group uvne -user root -password admin
```

Enables discovery of the device with sysOID 1.2.3.4 using the GenericUVNE template, which is located in group uvne-product.

The command does not create any device attributes for the newly added device. To assign the device a user-friendly name and the correct device category, use the \texttt{-devicetype} option (see the “vcb devicetype add” section on page B-12).

\textbf{Example 2}

```
vcb uvne add -sysoid 1.2.3.4 -clonesysoid 1.3.6.1.4.1.9.1.108 -user root -password admin
```

Enables discovery of a new device (with sysOID 1.2.3.4) that points to registration—scheme and instrumentation commands—of the already supported sysOID 1.3.6.1.4.1.9.1.108.

(To create a list of already supported VNEs, see `vcb uvne view`, page B-6.)

\textbf{Example 3}

```
vcb uvne add -sysoid 1.2.3.4 -softwareversion 12.6(2) -clonesoftwareversion 12.0(23)S2 -clonedevicefamily 100xx -scheme product -user root -password admin
```

Adds support for a new device (with sysOID 1.2.3.4) based on the device family 100xx. Also adds support for the new software version for this device family. (For a list of already supported software versions, see `vcb uvne view`, page B-6.)
Example 4

```
vcb uvne add -sysoid .1.2.3.4 -clonefamily 100xx -user root -password admin
```

Enables discovery of a new device (with sysOID .1.2.3.4), that points to registrations—scheme and instrumentation commands—for the device family 100xx.

Options

### Table B-3 Options and Arguments—vcb uvne add

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysoid</td>
<td>sysoid</td>
<td>The sysObject ID of the device for which to create a U-VNE-driver using the implementation defined in the U-VNE template.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Each sysOID value in the system must be unique.</td>
</tr>
<tr>
<td>template</td>
<td>template name</td>
<td>The name of the U-VNE template from which to create the U-VNE-driver. See U-VNE Templates, page B-56.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: This option is mutually exclusive with the -clonesysoid and -clonefamily options.</td>
</tr>
<tr>
<td>group</td>
<td>template filename</td>
<td>The name of the file in which the U-VNE template is located. U-VNE templates are located in the uvne-product file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Use this option with the -template option only.</td>
</tr>
<tr>
<td>devicetype</td>
<td>device type name</td>
<td>(Optional) The U-VNE device type name. If not specified, the device type is:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Defined as Unknown when the option is not specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Inherited from the device or device family when you use the -clonesysoid option.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The device type name appears in the UI and is associated with a category; its category determines which icon is displayed, and other presentation aspects are derived from this reference. To use a new device type name, first add it using the vcb devicetype add command. For more information, see vcb devicetype add, page B-12.</td>
</tr>
<tr>
<td>clonesysoid</td>
<td>clone-sysoid</td>
<td>The sysObject ID of an already supported VNE. To view sysOIDS for supported VNEs, use the vcb uvne view -sysoid all command.</td>
</tr>
<tr>
<td>softwareversion</td>
<td>software-version</td>
<td>The software version that you want to add for a U-VNE. To obtain the software version string, use the show version command.</td>
</tr>
<tr>
<td>clonesoftwareversion</td>
<td>clone-softwareversion</td>
<td>An already supported software version that you want to clone. The software version must already be supported for a particular device family.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For a list of supported software versions, use the command vcb uvne view -scheme &lt;ipcore</td>
</tr>
</tbody>
</table>
Table B-3  Options and Arguments—vcb uvne add (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clonedevicefamily</td>
<td>devicefamily</td>
<td>A supported device family. For a list of supported device families, use the command `vcb uvne view -scheme &lt;ipcore</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> This option is mutually exclusive with the <code>-template</code> option.</td>
</tr>
</tbody>
</table>

Error Codes

Table B-4  Error Codes—vcb uvne add

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>The sysOID already exists and is already modeled as a VNE.</td>
</tr>
<tr>
<td>102</td>
<td>U-VNE template file not found.</td>
</tr>
<tr>
<td>103</td>
<td>No such template name in the templates file.</td>
</tr>
<tr>
<td>104</td>
<td>No such device type configuration exists.</td>
</tr>
</tbody>
</table>

**Note** For the list of general VCB error codes, see General Error Codes, page B-2.

vcb uvne view

The `vcb uvne view` command returns an existing U-VNE configuration.

Syntax

```
vcb uvne view -sysoid {sysoid | all} -user username -password password [-userdefined][-detail]
vcb uvne view -template {template name | all} -group <template group name> -user username -password password
```

Description

Use the `vcb uvne view` command to:

- Display information based on the specified sysOID.
- Display available templates found in the specified group.
Usage Examples

Example 1
vcb uvne view -sysoid 1.2.3.4 -user root -password admin -userdefined

Returns the configuration of the VNE with the sysOID 1.2.3.4, including the U-VNE template (or the device family for a developed VNE). If device-type associations are defined (using the vcb devicetype add command), these associations are also displayed.

Example 2
vcb uvne view -sysoid all -user root -password admin

Returns all the sysoid supported in Prime Network.

Example 3
vcb uvne view -sysoid all -user root -password admin -detail

Returns all known configured sysOIDs (regular VNEs) and also this command would show following additional informations

- Module Spec Name associated with the sysoid.
- Syslog and Trap Parsing rule name associated with the sysoid

Here is an example of the output:

```
SysOid......:.9.7.6.5.4.3
DeviceFamily:76xx
CloneSysOid...:1.3.6.1.4.1.9.1.863
Scheme........:product
Module Spec........:ciscophysicalspec2
Trap Parsing Rule...:cisco-trap-product-parsing-rules
Syslog Parsing Rule.:cisco-syslog-product-parsing-rules
Scheme........:ipcore
Module Spec........:ciscophysicalspec2
Trap Parsing Rule...:cisco-trap-ipcore-parsing-rules
Syslog Parsing Rule.:cisco-syslog-ipcore-parsing-rules

SysOid......:.3.4.5.6.7
Template....:GenericUVNE
Group.......:uvne
Device Type:UNKNOWN
Scheme........:product
Module Spec........:N/A
Trap Parsing Rule...:genericuvne-trap-parsing-rules
Syslog Parsing Rule.:genericuvne-syslog-parsing-rules
```
Options

Table B-5 Options and Arguments—vcb uvne view

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysoid sysoid</td>
<td>Returns the configuration of the specified VNE, including the device type, the user-friendly name, and the template (for U-VNEs).</td>
</tr>
<tr>
<td>Tip</td>
<td>Enter all as the sysoid to view the configuration of all sysOIDs (U-VNEs and developed VNEs) configured in the system.</td>
</tr>
<tr>
<td>group template filename</td>
<td>Returns the configuration of all sysOIDs and templates contained in the specified group.</td>
</tr>
<tr>
<td>Tip</td>
<td>Enter all as the template filename to view the template associations for each group in the system.</td>
</tr>
<tr>
<td>userdefined</td>
<td>Lists the U-Vne created through vcb command only.</td>
</tr>
<tr>
<td>details</td>
<td>Shows following additional information:</td>
</tr>
<tr>
<td></td>
<td>• Module Spec Name associated with the sysoid.</td>
</tr>
<tr>
<td></td>
<td>• Syslog and Trap Parsing rule name associated with the sysoid</td>
</tr>
</tbody>
</table>

Note: For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-6 Error Codes—vcb uvne view

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>102</td>
<td>U-VNE template file not found.</td>
</tr>
<tr>
<td>103</td>
<td>No such template name in the templates file.</td>
</tr>
<tr>
<td>104</td>
<td>No such device type configuration exists.</td>
</tr>
<tr>
<td>111</td>
<td>The SysOID specified does not exist.</td>
</tr>
</tbody>
</table>

Note: For the list of general VCB error codes, see General Error Codes, page B-2.
vcb uvne modify

The `vcb uvne modify` command modifies the configuration of an existing U-VNE.

Syntax

```
vcb uvne modify -sysoid sysoid -template template name -group template filename -user username -password password
vcb uvne modify -sysoid sysoid -devicetype device type -user username -password password
vcb uvne modify -sysoid sysoid -clonesysoid sysoid -user username -password password
vcb uvne modify -sysoid sysoid -softwareversion softwareversion -clonesoftwareversion clonesoftwareversion -clonedevicefamily devicefamily -scheme vnescheme -user username -password password
vcb uvne modify -sysoid sysoid -clonedevicefamily devicefamily -user username -password password
```

Description

Use the `vcb uvne modify` command to:

- Associate the U-VNE with another U-VNE template.
- Change the device type associated with the U-VNE.
- Change the cloning reference of a U-VNE.

Usage Examples

**Example 1**

```
vcb uvne modify -sysoid .1.2.3.4 -group uvne-product -template GenericUVNE -user root -password admin
```

Modifies the template of the U-VNE to the newly specified template defined in the given group.

**Example 2**

```
vcb uvne modify -sysoid .1.2.3.4 -devicetype CISCO_1760 -user root -password admin
```

Modifies the device type for the U-VNE with sysOID 1.2.3.4.

**Example 3**

```
vcb uvne modify -sysoid .1.2.3.4 -clonesysoid .1.3.6.1.4.1.9.1.108 -user root -password admin
```

Modifies a device, with sysOID 1.2.3.4, to point to a new device family based on the clone sysoid 1.3.6.1.4.1.9.1.108.

**Example 4**

```
vcb uvne modify -sysoid .1.2.3.4 -clonedevicefamily 12xxx -user root -password admin
```

Modifies support for a new device, with sysOID 1.2.3.4, to point to registrations—scheme and instrumentation commands—of the device family 12xxx.
Options

Table B-7  Options and Arguments—vcb uvne modify

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysoid sysoid</td>
<td>The sysObject ID of the U-VNE-driver configuration that you want to modify.</td>
</tr>
<tr>
<td>template template name</td>
<td>The name of the U-VNE template to which the U-VNE should be associated. Use this option to modify the U-VNE template from which the U-VNE-driver derives its configuration.</td>
</tr>
<tr>
<td>group template filename</td>
<td>The name of the group that includes the U-VNE template, such as uvne-product.</td>
</tr>
<tr>
<td>devicetype device type</td>
<td>The device type associated with the U-VNE.</td>
</tr>
<tr>
<td>clonesysoid clone-sysoid</td>
<td>The sysObject ID of an already supported VNE. To view sysOIDs for supported VNEs, use the vcb uvne view -sysoid all command.</td>
</tr>
<tr>
<td>softwareversion software-version</td>
<td>The software version that you want to support for a U-VNE. To obtain the software version string, use the show version command.</td>
</tr>
<tr>
<td>clonesoftwareversion clone-softwareversion</td>
<td>An already supported software version that you want to clone. The software version must already be supported for a particular device family.</td>
</tr>
<tr>
<td>clonedevicefamily deviceFamily</td>
<td>A supported device family. For a list of supported device families, use the command vcb uvne view -sysoid all -user user -password password. For more information, see vcb uvne view, page B-6.</td>
</tr>
</tbody>
</table>

Note
For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-8  Error Codes—vcb uvne modify

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>102</td>
<td>U-VNE template file not found.</td>
</tr>
<tr>
<td>103</td>
<td>No such template name in the templates file.</td>
</tr>
<tr>
<td>104</td>
<td>No such device type configuration exists.</td>
</tr>
<tr>
<td>112</td>
<td>The sysOID does not exist or already exists and is already modeled as a VNE.</td>
</tr>
</tbody>
</table>

Note
For the list of general VCB error codes, see General Error Codes, page B-2.
vcb uvne delete

The **vcb uvne delete** command deletes a U-VNE.

**Syntax**

```
vcb uvne delete -sysoid sysoid -user username -password password
vcb uvne delete -sysoid sysoid -devicefamily DeviceFamilyName -scheme schemeName -softwareversion "softwareVersionNumber" -user username -password password
```

**Description**

The **vcb uvne delete** command is useful when migrating from a U-VNE to a developed VNE. If, in an upgrade, Prime Network provides a DSP that contains a developed VNE to support the device type, the need for the U-VNE is eliminated. You must delete the U-VNE before Prime Network can use the developed VNE to model and manage the device.

Deleting a template-based U-VNE has no effect on the U-VNE template from which it derives its implementation.

**Usage Example**

**Example 1**
```
vcb uvne delete -sysoid .1.2.3.4 -user root -password admin
```
Deletes the U-VNE-driver configured for the device with sysOID 1.2.3.4.

**Example 2**
```
vcb uvne delete -sysoid .1.2.3.4 -devicefamily 70xx -scheme product -softwareversion "12.0(23)S3"
```
Deletes the software configuration for U-VNE driver configured for the device with sysOID .1.2.3.4. Use the command in Example 1 to delete the U-VNE.

Note that the vcb uvne delete syntax should match the vcb uvne add syntax to avoid items being left in the site.xml after the delete action. For example, if the vcb uvne add syntax is as follows:
```
vcb uvne add -sysoid .1.3.6.1.4.1.9.1.917 -softwareversion "15.0(2)S1" -clonesoftwareversion "gt 12.2(52)SG" -clonedevicefamily cisco-catalyst-4900-series -scheme product -devicetype CISCO_CATALYST_4900M -override -user root -password admin
```
then, the vcb uvne delete syntax should be as follows:
```
vcb uvne delete -sysoid .1.3.6.1.4.1.9.1.917 -devicefamily cisco-catalyst-4900-series -scheme product -softwareversion "15.0(2)S1" -user root -password admin
```
Options

Table B-9 Options and Arguments—vcb devicetype add

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysoid sysoid</td>
<td>The sysObject ID of the U-VNE configuration that you want to delete.</td>
</tr>
<tr>
<td></td>
<td>Note Deleting the U-VNE does not delete or otherwise affect the U-VNE template from which the U-VNE was created.</td>
</tr>
</tbody>
</table>

Note For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-10 Error Codes—vcb devicetype add

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>112</td>
<td>The sysOID does not exist or already exists and is already modeled as a VNE.</td>
</tr>
</tbody>
</table>

Note For the list of general VCB error codes, see General Error Codes, page B-2.

VCB CLI Command Reference: Device Types Commands

These topics provide reference information for the vcb devicetype commands you can use to create, view, modify, and delete user-experience attributes for device types:

- vcb devicetype add, page B-12
- vcb devicetype view, page B-14
- vcb devicetype modify, page B-15
- vcb devicetype delete, page B-16

vcb devicetype add

The vcb devicetype add command creates new user-experience attributes for the specified device type. Each device type is associated with a user-friendly name, icon, and device grouping.

Syntax

vcb devicetype add -devicetype device_type -category prime_network_device_category -name device_name [-key device_type_key] -user root -password admin
Description

The `vcb devicetype add` command creates user-experience attributes that affect how a device type is managed and displayed in Prime Network.

Note

This command is typically used before adding a new U-VNE using the `vcb uvne add` command. For more information, see `vcb uvne add`, page B-3.

Usage Example

```bash
vcb devicetype add -devicetype CISCO_1760 -category ROUTER -name "Cisco 1760 Router" -user root -password admin
```

Adds a device-type definition for the Cisco 1760 router, including the device category and user-friendly name that will appear in the Prime Network UI. Reference this definition when adding U-VNE definitions for a Cisco 1760 device using the `vcb uvne add` command.

Options

<table>
<thead>
<tr>
<th>Table B-11 Options and Arguments — vcb devicetype add</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>devicetype</td>
</tr>
</tbody>
</table>
| category | prime network device category | The category to assign to the new device type, entered as a string (router, switch, unknown, and so on).
By default, the device category defined in the U-VNE template is used. |
| name | device name | The name to display for this device type in Prime Network.
By default, the name is empty. |
| key | device type key | (Optional) The unique ID of the new device type. This value is not displayed in Prime Network. |

Note

For the list of global options, see *Global Command Options*, page B-2.
Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>501</td>
<td>Device type name already exists in the deviceTypes</td>
</tr>
<tr>
<td>502</td>
<td>Category value does not match any of the possible values</td>
</tr>
<tr>
<td>503</td>
<td>Key for this template is not unique</td>
</tr>
<tr>
<td>504</td>
<td>Device type name contains illegal characters</td>
</tr>
<tr>
<td>505</td>
<td>SysOID not found or not bound to device type in devicetypes.xml</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.

vcb devicetype view

The vcb devicetype view command returns an existing device-type association.

Syntax

```
vcb devicetype view -devicetype {device type | all} -user root -password admin
```

Description

Use the vcb devicetype view command to:
- Display user-experience attributes based on the specified device type.
- Display the list of device types defined in the system.
- Display all available device categories.

Usage Examples

Example 1

```
vcb devicetype view -devicetype all -user root -password admin
```

Returns a list of all device types defined in Prime Network.

Example 2

```
vcb devicetype view -devicetype CISCO_1760 -user root -password admin
```

Returns the device type details for device type CISCO_1760, including the category and user-friendly name defined for this type.
Options

Table B-13  Options and Arguments — vcb devicetype view

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>devicetype</td>
<td>device type name</td>
<td>The name of the device type user-experience attributes (including name and device category) that you want to view.</td>
</tr>
<tr>
<td>category</td>
<td>category value</td>
<td>Returns all defined device categories (router, switch, and so on) and their numeric equivalents.</td>
</tr>
</tbody>
</table>

Note
For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-14  Error Codes — vcb devicetype view

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>511</td>
<td>deviceType not found</td>
</tr>
</tbody>
</table>

Note
For the list of general VCB error codes, see General Error Codes, page B-2.

vcb devicetype modify

The vcb devicetype modify command modifies the user-experience attributes associated with specific device types.

Syntax

vcb devicetype modify -devicetype device type name [-category prime network device category] [-name device name] [-key device type key] -user username -password password

Description

The vcb devicetype modify command overwrites the user-experience settings defined for a device type, including the name, icon, and device category as they appear in Prime Network.

Usage Example

vcb devicetype modify -devicetype CISCO_1760 -category DSLAM -name "Cisco 1760 DSLAM" -user root -password admin

Modifies the category and name assigned to the specified device type. Any VNE that uses the U-VNE-driver associated with this device type inherits these modified user-experience attributes.
Options

**Table B-15 Options and Arguments—vcb devicetype modify**

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>devicetype</td>
<td>The name of the device type user-experience attributes that you want to modify.</td>
</tr>
<tr>
<td>category prime network device category</td>
<td>(Optional) Modifies the category assigned to the device type. Enter the category as a string (router, switch, unknown, and so on).</td>
</tr>
<tr>
<td>name device name</td>
<td>(Optional) Modifies the name that is displayed for this device type in Prime Network.</td>
</tr>
<tr>
<td>key device type key</td>
<td>(Optional) Modifies the unique ID of the device type. This value is not displayed in Prime Network.</td>
</tr>
</tbody>
</table>

**Note**  
We recommend that you *not* use this option, and let the VCB define the key instead.

**Error Codes**

**Table B-16 Error Codes—vcb devicetype modify**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>502</td>
<td>Category value does not match any of the possible values for this enum</td>
</tr>
<tr>
<td>503</td>
<td>Key for this device type is not unique</td>
</tr>
<tr>
<td>504</td>
<td>Device type name contains illegal characters</td>
</tr>
<tr>
<td>511</td>
<td>Device type not found</td>
</tr>
</tbody>
</table>

**Note**  
For the list of general VCB error codes, see General Error Codes, page B-2.

**vcb devicetype delete**

The `vcb devicetype delete` command deletes the user-experience attributes that are defined for the specified device type.

**Syntax**

```
vcb devicetype delete -devicetype device type -userdefined -user username -password password
```
Description

The `vcb devicetype delete` command deletes the user-friendly name, icon, and grouping that were defined for the specified device type from the site.xml file. It does not delete or otherwise modify the U-VNE template from which the U-VNE for this device type was created.

Usage Example

```bash
vcb devicetype delete -devicetype CISCO_1760 -userdefined -user root -password admin
```

Deletes the user-experience attributes defined for the CISCO_1760 device type.

Options

<table>
<thead>
<tr>
<th>Table B-17</th>
<th>Options and Arguments—<code>vcb devicetype delete</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Argument</td>
</tr>
<tr>
<td>devicetype</td>
<td>device type</td>
</tr>
</tbody>
</table>

Note
For the list of global options, see Global Command Options, page B-2.

Error Codes

<table>
<thead>
<tr>
<th>Table B-18</th>
<th>Error Codes—<code>vcb devicetype delete</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>511</td>
<td>Device type not found.</td>
</tr>
</tbody>
</table>

Note
For the list of general VCB error codes, see General Error Codes, page B-2.

VCB CLI Reference: Standard and Pluggable Modules Commands

You can use the VCB CLI to create and manage standard and pluggable modules as described in these topics:

- VCB CLI Command Reference: Standard Modules, page B-18
- VCB CLI Command Reference: Pluggable Modules, page B-25
VCB CLI Command Reference: Standard Modules

These topics provide reference information for the vcb module commands you can use to create, view, and delete standard modules:

- vcb module add, page B-18
- vcb module view, page B-20
- vcb module delete, page B-24

vcb module add

The vcb module add command adds support for a new module type by creating a new registration from the specified template. This support enables VNEs that contain this module to properly recognize and model it in Prime Network.

Syntax

vcb module add -module module identifier -template template name -group module group
[ -hardwaredesc Hardware Description of the Module ] -user username -password password
vcb module add -module module identifier -template template name -sysoid <sysobject ID
devicefamily under which module should be supported> -scheme <ipcore|product> [ -hardwaredesc Hardware Description of the Module ] -user username -password password

Description

The vcb module add command enables the VNE to automatically detect a physical module based on an implementation defined in a module template. It can be used to:

- Create a module definition based on the module identifier. When this option is used, any VNE that uses the same spec file for its module definitions can model the new module.
- Create a module definition based on an extension to the definition used by the driver of a specific device (defined by its sysOID). When this option is used, only this particular device can model the new module.

This command updates the site.xml file, in which customizations are stored. Doing so enables the tool to differentiate between factory defaults (changes supplied from DSPs) and changes initiated by the VCB.

Usage Examples

Example 1

vcb module add -module ".1.3.6.1.4.1.9.12.3.1.9.29.99" -template "1.2.3.4" -group ciscoentitymibsSpec -hardwaredescription cevCat6kWs6kpfc3b -user root -password admin

Adds support for a module with the module ID .1.3.6.1.4.1.9.12.3.1.9.29.99, based on the 1.2.3.4 module template, which is listed in the spec group, ciscoentitymibsSpec. The hardware description is cevCat6kWs6kpfc3b.
Example 2

```
vcb module add -module "1.3.6.1.4.1.9.12.3.1.9.29.99" -sysoid "7.7.7"
-template "1.2.3.4" -scheme product -user root -password admin
```

Adds support for a module with the ID 1.3.6.1.4.1.9.12.3.1.9.29.99, based on module template 1.2.3.4. The VCB looks up the module spec used by the VNE-driver with the sysOID 7.7.7, and registers the new module for this device only (not for all devices that share the same module spec file).

Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>module</td>
<td>module identifier</td>
<td>The module identifier, a number, string, or OID. The module identifier should be unique and new.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> The value specified for this argument must match the value returned from the physical command investigation.</td>
</tr>
<tr>
<td>group</td>
<td>module group</td>
<td>The module group is a repository that might be shared across multiple device types. It specifies where the template is located. For the module groups that you can extend, see Module Groups and Module Specification Files, page B-66.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Regular modules and pluggable modules use different module spec files. For information about pluggable modules, see VCB CLI Command Reference: Pluggable Modules, page B-25.</td>
</tr>
<tr>
<td>sysoid</td>
<td>sysoid</td>
<td>The sysObjectID of the device that belongs to particular device family for which a concrete module is created using the implementation defined in the template.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> This sysObjectID must already exist in the system.</td>
</tr>
<tr>
<td>scheme</td>
<td>scheme</td>
<td>Scheme name which will be used while adding the VNE.</td>
</tr>
<tr>
<td>template</td>
<td>template name</td>
<td>The name of the template that contains the implementation of the physical investigation of this module.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tip</strong> The template option need not be specified if the module does not support any ports; SIP and other carrier cards are examples of modules that do not support ports.</td>
</tr>
<tr>
<td>hardwareDescription</td>
<td>hardware description</td>
<td>(Optional) Hardware description of the given module.</td>
</tr>
</tbody>
</table>

**Note** For the list of global options, see Global Command Options, page B-2.
Error Codes

Table B-20  Error Codes—vcb module add

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>No such template name in the templates file.</td>
</tr>
<tr>
<td>111</td>
<td>The SysOID specified does not exist in site.xml.</td>
</tr>
<tr>
<td>401</td>
<td>Module already exists in the spec file or in site.xml (thus is already modeled).</td>
</tr>
<tr>
<td>402</td>
<td>Module template file not found.</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.

vcb module view

The vcb module view command returns an existing module configuration.

Syntax

vcb module view -sysoid <sysoid> -module {module identifier | all} -user root -password admin -scheme <scheme>
vcb module view -group module group -module {module identifier | all} -user root -password admin
vcb module view -group module group -template {template name | all} -user root -password admin

Description

Use the vcb module view command to:

- Display module information based on the driver associated with the defined sysOID.
- Display details about the specified module.
- Display available templates found in the specified module spec file.

Usage Examples

Example 1

vcb module view -sysoid .1.2.3.4 -module all -user root -password admin -scheme product

Returns the list of supported modules for the device with sysOID 1.2.3.4.

Example 2

vcb module view -sysoid .1.2.3.4 -module 50068 -user root -password admin -scheme product

Returns the port layer definitions for module 50068, which was added to the VNE-driver for the device with sysOID 1.2.3.4.
Example 3
vcb module view -group ciscophysicalspec2 -module all -user root -password admin

Returns a list of all supported modules contained in the specified module group.

Example 4
vcb module view -group ciscophysicalspec2 -module 20091 -user root -password admin

Returns the port layer definitions for module 20091, which is part of the group ciscophysicalspec2.

Example 5
vcb module view -group ciscoentitymibspec -template all -user root -password admin

Returns a list of all templates defined in the specified module group.

Example 6
vcb module view -group ciscoentitymibspec -template ethernetDefault -user root -password admin

Returns the port layer definitions of the template if it is defined in the specified module group.

Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysoid</td>
<td>sysoid</td>
<td>The sysOID of the device that contains the module configuration that you want to view.</td>
</tr>
<tr>
<td>module</td>
<td>module identifier</td>
<td>The module whose port layer configuration you want to view. The identifier can be a number, string, or OID, depending on the type of identifier used by the relevant device type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tip</strong> Enter <strong>all</strong> as the <strong>module identifier</strong> to return a list of all modules in the defined device or group, listed by identifier.</td>
</tr>
<tr>
<td>group</td>
<td>module group</td>
<td>The module spec group associated with the module or template whose details you want to view.</td>
</tr>
<tr>
<td>template</td>
<td>template name</td>
<td>The name of the module template whose port layer configuration you want to view.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tip</strong> Enter <strong>all</strong> as the <strong>template name</strong> to return the list of all module templates contained in the specified module spec group.</td>
</tr>
<tr>
<td>- scheme</td>
<td>scheme</td>
<td>Scheme name which will be used while adding the VNE.</td>
</tr>
</tbody>
</table>

Note
For the list of global options, see Global Command Options, page B-2.
Error Codes

Table B-22  Error Codes—vcb module view

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>No such template name in the template file</td>
</tr>
<tr>
<td>402</td>
<td>Module template file not found</td>
</tr>
<tr>
<td>411</td>
<td>SysOID specified does not exist in site.xml or vendor file</td>
</tr>
<tr>
<td>412</td>
<td>Module identifier specified does not exist</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.

vcb module modify

Use the vcb module modify command to modify the associated module template.

Syntax

vcb module modify -module module identifier -group module group -template template name
[ -hardwaredesc Hardware Description of the Module -user username -password password]

vcb module modify -module module identifier -sysoid device sysoid -scheme <ipcore|product> -template template name [ -hardwaredesc Hardware Description of the Module ] -user username -password password

Description

The vcb module modify command can be used to:

- Associate a module with another module template.
- Change the association between a module and its module template for a device specified by its sysOID.

Usage Examples

Example 1

vcb module modify -module 20091 -group ciscophysicalspec2
-template GE-fiberoptic-ethernet-default -user root -password admin

Modifies the registration for module 20091 by associating it with module template GE-fiberoptic-ethernet-default, which is part of group ciscophysicalspec2. This module definition replaces the one obtained from the template that was specified when the module was first added. This change affects all devices that contain this module.

Example 2

vcb module modify -sysoid .1.2.3.4 -module 50068 -group ciscophysicalspec2
-template oc3-ppp-default -user root -password admin -scheme product

Modifies the registration for module 50068 by associating it with module template cc3-ppp-default. This change affects only the device with sysOID 1.2.3.4.
Options

**Table B-23  Options and Arguments—vcb module modify**

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
</table>
| module module identifier | The module configuration that you want to modify. The identifier can be a number, string, or OID, depending on the type of identifier used by the relevant device type.  
**Note** The value specified for this argument must match the value returned by the device when investigating this module. |
| group module group | The name of the group that contains the module template to apply to the module. |
| sysoid sysoid | The sysObject ID of the device that contains the module configuration that you want to modify.  
**Note** You must specify a sysoid that was added using the VCB. |
| template template name | The name of the module template with which the defined module should be associated. Use this option to change the module template from which the module derives its configuration. |
| hardwareDescription hardware description | (Optional) Hardware description of the given module. |
| scheme scheme | Scheme name which will be used while adding the VNE. |

**Note** For the list of global options, see *Global Command Options, page B-2.*

Error Codes

**Table B-24  Error Codes—vcb module modify**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>No such template name in the template file</td>
</tr>
<tr>
<td>402</td>
<td>Module template file not found</td>
</tr>
<tr>
<td>411</td>
<td>SysOID specified does not exist in site.xml or vendor file</td>
</tr>
<tr>
<td>412</td>
<td>Module identifier specified not found or already exists in vendor spec file</td>
</tr>
</tbody>
</table>

**Note** For the list of general VCB error codes, see *General Error Codes, page B-2.*
vcb module delete

Use the `vcb module delete` command to delete the association between a module and the implementation defined in a module template.

Syntax

```
vcb module delete -module module identifier -group module group -user username -password password
vcb module delete -module module identifier -sysoid device sysoid -scheme <ipcore|product> -user username -password password
```

Description

**Note**

Use the `vcb module delete` command to enable VNEs to use factory-supplied updates if they become available.

The `vcb module delete` command is useful when migrating from an interim solution to a more complete implementation. Removing the association to the module from the site.xml file enables Prime Network to automatically detect a deployed implementation in a DSP.

Use the `vcb module delete` command:

- To delete the association between a module and its implementation on a specific device based on a defined sysOID. Other VNEs that use this implementation will still be able to identify the module.
- To delete the association between a module and its implementation on all devices that use the module as specified by the relevant group name. When the `-group` option is used, any VNEs that used this implementation will no longer be able to identify the module.

**Note**

- You can delete only those modules that were originally added using the VCB. Module definitions added as part of a developed VNE cannot be deleted.
- You can delete the module association on a specific device only when the association was created for that specific device.
- Deleting the module configuration does not delete or otherwise affect the template from which the configuration was created.

Usage Examples

**Example 1**
```
vcb module delete -module 20091 -group ciscophysicalspec2 -user root -password admin
```
Deletes the definition for module 20091 from the group ciscophysicalspec2. The module definition is deleted from all devices that contain this module.

**Example 2**
```
vcb module delete -sysoid .1.2.3.4 -module 50068 -user root -password admin -scheme product
```
Deletes the definition for module 50068 from the device with sysOID 1.2.3.4. Other devices that contain this module are unaffected.
Options

Table B-25  Options and Arguments — vcb module delete

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>module</td>
<td>module identifier</td>
<td>The module configuration that you want to delete. The identifier can be a number, string, or OID, depending on the type of identifier used by the relevant device type.</td>
</tr>
<tr>
<td>sysoid</td>
<td>device sysoid</td>
<td>The sysObject ID of the device that contains the module configuration that you want to delete.</td>
</tr>
<tr>
<td>group</td>
<td>module group</td>
<td>The module spec group that contains the template whose implementation you want to delete from the module.</td>
</tr>
<tr>
<td>scheme</td>
<td>scheme</td>
<td>Scheme name which will be used while adding the VNE.</td>
</tr>
</tbody>
</table>

Note  For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-26  Error Codes — vcb module delete

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>402</td>
<td>Module template file not found.</td>
</tr>
<tr>
<td>411</td>
<td>sysOID does not exist in the site.xml file or vendor spec file.</td>
</tr>
<tr>
<td>412</td>
<td>Module identifier not found or already exists in the vendor spec file.</td>
</tr>
</tbody>
</table>

Note  For the list of general VCB error codes, see General Error Codes, page B-2.

VCB CLI Command Reference: Pluggable Modules

These topics provide reference information for the vcb pluggablemodule commands you can use to create, view, modify, and delete pluggable modules:

- vcb pluggablemodule add, page B-26
- vcb pluggablemodule view, page B-28
- vcb pluggablemodule modify, page B-29
- vcb pluggablemodule delete, page B-30

Note  To add, view, modify, or delete regular modules, see VCB CLI Command Reference: Standard Modules, page B-18.
vcb pluggablemodule add

Use the `vcb pluggablemodule add` command to create a pluggable module definition that is associated using the module identifier. Use this command for pluggable modules such as SFPs and XFPs.

Syntax

```
vcb pluggablemodule add -group groupName -module moduleno -pid pid -mediatype MediaType -pluggabletype pluggableType -user username -password password
vcb pluggablemodule add -group groupName -containeroid containeroid -user username -password password
vcb pluggablemodule add -group groupName -basetype basetype -user username -password password
```

Description

Prime Network does not model pluggable modules, only the ports on them. Configuration details that are entered using this command are displayed at the port level to differentiate between pluggable and regular ports. Changes made through this command apply to all VNEs that use the same spec file for pluggable ports.

The container oid and base type value are additional configuration information needed to model pluggable module properly. When you add new pluggable module make sure that container oid and base type values are added in the system.

Usage Example

```
vcb pluggablemodule add -module ".1.3.6.1.4.1.9.12.3.1.9.51.22"
   -group pluggable-ports-spec -mediatype fiber -pluggabletype SFP -user root -password admin

Adds support for a pluggable module of type SFP with the module ID .1.3.6.1.4.1.9.12.3.1.9.51.22, to the pluggable-ports-spec module specification file. The media type is fiber optic.

vcb pluggablemodule add -group pluggable-ports-spec -basetype .1.3.6.1.4.1.9.12.3.1.9.52
   -user root -password admin

Add pluggable module base type configuration with the base type value .1.3.6.1.4.1.9.12.3.1.9.52, to the pluggable-ports-spec module specification file.

vcb pluggablemodule add -group pluggable-ports-spec -containeroid .1.3.6.1.4.1.9.12.3.1.5.153
   -user root -password admin

Add pluggable module container oid configuration with the container oid .1.3.6.1.4.1.9.12.3.1.9.52, to the pluggable-ports-spec module specification file.
```
Options

Table B-27 Options and Arguments—vcb pluggablemodule add

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
</table>
| module          | The identifier for the module that you want to add. The identifier can be a number, string, or OID, depending on the type of identifier used by the relevant device type.  
**Note** The value specified for this argument must match the value returned by the device when investigating this module. |
| moduleno        |                                                                             |
| group           | The name of the group.                                                     |
| pluggable port  |                                                                             |
| group           |                                                                             |
| pid             | The pid for the module.                                                    |
| pid             |                                                                             |
| mediatype       | The media type of the port on the pluggable module.                        |
| MediaType       |                                                                             |
| pluggable type  | The type of the pluggable module; one of SFP, XFP, X2, XENPAK.             |
| pluggableType   |                                                                             |
| containeroid    | The oid of a pluggable module container where the pluggable module will be inserted. |
| basetype        | The oid of a pluggable module without the last octet in the oid. For example, if the oid of a pluggable module is .1.3.6.1.4.1.9.12.3.1.9.52.10 then the basetype oid would be .1.3.6.1.4.1.9.12.3.1.9.52 |

**Note** For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-28 Error Codes—vcb pluggablemodule add

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>403</td>
<td>Pluggable module spec file not found</td>
</tr>
<tr>
<td>404</td>
<td>Invalid pluggable module type</td>
</tr>
</tbody>
</table>

**Note** For the list of general VCB error codes, see General Error Codes, page B-2.
vcb pluggablemodule view

Use the **vcb pluggablemodule view** command to display details for a pluggable module.

**Syntax**

```bash
vcb pluggablemodule view -group groupName -module moduleno | all [-userdefined]-user username -password password
vcb pluggablemodule view -group groupName -containeroid oid | all [-userdefined]-user username -password password
vcb pluggablemodule view -group groupName -basetype basetype| all [-userdefined]-user username -password password
```

**Description**

Use the **vcb pluggablemodule view** command to display the pluggable module details—such as pid, media type, and pluggable type—for one or all modules in the given pluggable port group.

**Usage Examples**

```bash
vcb pluggablemodule view -group pluggable-port-spec -module ".1.3.6.1.4.1.9.12.3.1.9.51.22" -user root -password admin
```

Returns the pluggable module details—such as pid, media type, and pluggable type—for the module with the given vendor oid.

```bash
vcb pluggablemodule view -group pluggable-port-spec -containeroid all -user root -password admin
```

Returns the pluggable module container oid details, if the list has userdefined container oid, it is marked with # after the oid.

```bash
vcb pluggablemodule view -group pluggable-port-spec -basetype all -user root -password admin
```

Returns the pluggable module details.

**Options**

**Table B-29 Options and Arguments—vcb pluggablemodule view**

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>module moduleno</td>
<td>The identifier for the module that you want to view. The identifier can be a number, string, or OID, depending on the type of identifier used by the relevant device type. <strong>Tip</strong> Enter <strong>all</strong> as the module no to return the list of all modules contained in the specified pluggable port group.</td>
</tr>
<tr>
<td>group groupName</td>
<td>The name of the group.</td>
</tr>
</tbody>
</table>

**Note**

For the list of global options, see *Global Command Options, page B-2.*
Error Codes

Table B-30   Error Codes—vcb pluggablemodule view

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>403</td>
<td>Pluggable module spec file not found.</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.

vcb pluggablemodule modify

Use the vcb pluggablemodule modify command to change the pluggable module configuration.

Syntax

vcb pluggablemodule modify -group groupName -module moduleno -pid pid {[-mediatype MediaType] | [-pluggabletype pluggabletype]}

Description

The vcb pluggablemodule modify command enables you to modify the configuration for a pluggable module.

Usage Example

vcb module modify -module ".1.3.6.1.4.1.9.12.3.1.9.51.22" -group pluggable-ports-spec
-.mediatype "fiber optic" -user root -password admin

Modifies the mediaType attribute of the pluggable module with identifier .1.3.6.1.4.1.9.12.3.1.9.51.22.

Options

Table B-31   Options and Arguments—vcb pluggablemodule modify

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>module moduleno</td>
<td>The identifier for the pluggable module configuration that you want to modify. The identifier can be a number, string, or OID, depending on the type of identifier used by the relevant device type.</td>
</tr>
<tr>
<td>group pluggable port group</td>
<td>The name of the group.</td>
</tr>
<tr>
<td>pid pid</td>
<td>The pid for the module.</td>
</tr>
<tr>
<td>mediatype MediaType</td>
<td>(Optional) The media type of the port on the pluggable module.</td>
</tr>
<tr>
<td>pluggable type pluggableType</td>
<td>(Optional) The type of the pluggable module; one of SFP, XFP, X2, AND XENPAK.</td>
</tr>
</tbody>
</table>

Note

For the list of global options, see Global Command Options, page B-2.
Error Codes

Table B-32 Error Codes—vcb pluggablemodule modify

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>403</td>
<td>Pluggable module spec file not found</td>
</tr>
<tr>
<td>404</td>
<td>Invalid pluggable module type</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.

vcb pluggablemodule delete

Use the `vcb pluggablemodule delete` command to delete a pluggable module that was previously added using the VCB.

Syntax

```
vcb pluggablemodule delete -group pluggableportgroupN -module moduleno -user username -password password
vcb pluggablemodule delete -group pluggableportgroup -containeroid container oid -user username -password password
vcb pluggablemodule delete -group pluggableportgroup -basetype basetype oid -user username -password password
```

Description

Use the `vcb pluggablemodule delete` command to delete pluggable modules that were created using the VCB.

Note

Use the `vcb pluggablemodule delete` command to enable VNEs to use factory-supplied updates when they are available.

Usage Examples

```
vcb pluggablemodule delete -module "1.3.6.1.4.1.9.12.3.1.9.51.22" -group pluggable-ports-spec -user root -password admin
```

Removes the definition for the pluggable module with identifier 1.3.6.1.4.1.9.12.3.1.9.51.22.

```
vcb pluggablemodule delete -basetype "1.3.6.1.4.1.9.12.3.1.9.52" -group pluggable-ports-spec -user root -password admin
```

Removes the definition for the pluggable module basetype with identifier 1.3.6.1.4.1.9.12.3.1.9.52.

```
vcb pluggablemodule delete -containeroid "1.3.6.1.4.1.9.12.3.1.5.153" -group pluggable-ports-spec -user root -password admin
```

Removes the definition for the pluggable module container oid with identifier 1.3.6.1.4.1.9.12.3.1.5.153.
Appendix B     VCB: CLI Commands and Template Reference

VCB CLI Reference: Events Commands

This section describes the CLI commands that can be used to customize events, as follows:

- VCB CLI Reference: vcb event Commands, page B-31
- VCB CLI Reference: vcb eventparsingrules Commands, page B-41
- VCB CLI Reference: vcb eventpattern Commands, page B-47
- VCB CLI Reference: vcb eventarg Command, page B-53

VCB CLI Reference: vcb event Commands

These topics provide reference information for the vcb event commands you can use to create, view, modify, and delete events:

- vcb event add, page B-31
- vcb event view, page B-34
- vcb event modify, page B-37
- vcb event delete, page B-39

vcb event add

Use the vcb event add command to create an event definition for a syslog or a trap in Prime Network based on user input.

Note

To create a script to add unsupported traps from a MIB, use the e vcb event view command with the -generatecli option. To list the traps in a MIB that are supported and those that are not, use the vcb event view command with the -mibfile option. For more information, see vcb event view, page B-34.
### Syntax

```plaintext
vcb event add -eventtype {syslog|trap} -eventname eventName [-alarmid alarmId]
{[-subtype1 subtype1Name |-ticketable1]
[-severity1 critical|major|minor|warning|info|cleared]}
[-shortdesc1 short description string] [-autoclear1 false|true]

{[-subtype n subtypeName] [-ticketable n][-severity n critical|major|minor|warning|info|cleared]}
{[-shortdesc n short description string] [-autoclear n false|true]}

-user username -password password
```

### Description

The `vcb event add` command creates an event definition in Prime Network based on the user input. Afterwards, the VNE-driver can create specific instances of this event for incoming traps or syslogs, persist them in the event database, and forward them to interested clients.

### Usage Example

```plaintext
vcb event add -eventtype syslog
-eventname "stack switch status syslog"
subtype1 "stack switch removed syslog"
-severity1 minor
-subtype2 "stack switch added syslog"
-severity2 cleared
-user root -password admin
-faultnature ADAC
-faultcategory "QOS"
```

Adds a syslog event definition with the name “stack switch status syslog”. Two subtypes are added: “stack switch removed syslog” with severity minor and “stack switch added syslog” with severity cleared. By default, the subevents are not ticketable.

The syslog for which the event definition was added is:

```
STACKMGR-4-SWITCH_[ADDED|REMOVED]: Switch [dec] has been [ADDED to|REMOVED from] the stack.
```

A device sends one syslog when a switch is added to a stacked device (clear alarm) and another syslog when a switch is removed from a stacked device (asserted minor alarm).

### Options

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>eventtype</code> event type</td>
<td>Type of event. Valid values:</td>
</tr>
<tr>
<td></td>
<td>• syslog</td>
</tr>
<tr>
<td></td>
<td>• trap</td>
</tr>
<tr>
<td><code>eventname</code> event name</td>
<td>Unique string that identifies the event within Prime Network.</td>
</tr>
</tbody>
</table>
### Table B-34 Options and Arguments—vcb event add (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>alarmid</td>
<td>alarm ID</td>
<td>(Optional) Unique integer identifier for the event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Recommendation—Do not provide this argument; the VCB automatically generates a unique number.</td>
</tr>
<tr>
<td>subtype</td>
<td>subtypen name</td>
<td>Unique string that identifies the subevent with the Prime Network event.</td>
</tr>
<tr>
<td>ticketable</td>
<td></td>
<td>(Optional) Optional parameter for subtype. If specified, indicates that a ticket should be generated for this subevent. By default, no ticket is generated for the subtype.</td>
</tr>
<tr>
<td>-autoclear</td>
<td>false</td>
<td>(Optional) Optional parameter for subtype. If the event is ticketable, setting autoclear to false causes the subevent to remain asserted until the clear alarm arrives or the user manually acknowledges or clears the subevent. <strong>Note</strong> Root cause events are not auto cleared even when autoclear is set to false. By default, autoclear is true for user-defined event definitions.</td>
</tr>
<tr>
<td>severity</td>
<td>severity level</td>
<td>Optional parameter for subtype. The severity of the subevent. Possible values are critical, major, minor, warning, info, and cleared. Info is the default severity value for a subevent.</td>
</tr>
<tr>
<td>shortdesc</td>
<td>short description</td>
<td>Optional parameter for subtype. A short description of the subevent. This string is stored in the event database. By default, the subtype value is used as the default shortdesc value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameter that indicates how the fault is cleared, either manually or automatically. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ADAC (Automatically Detected Automatically Cleared) - The event is automatically detected and automatically cleared by the system. For example, “link down” event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ADMC (Automatically Detected Manually Cleared - The event must be manually cleared by the user. For example, “DWDM fatal error” syslog.</td>
</tr>
</tbody>
</table>
### vcb event view

Use the `vcb event view` command to list event definition registrations.

#### Syntax

- **vcb event view** `-eventname` *(eventName | all) [-substringmatch]*) `-user` *username* `-password` *password* `-eventtype` *(trap | syslog | service)*
- **vcb event view** `-genericevents` *all | trap | syslog [-ipaddress vneip] [-date yyyy-mm-dd] [-time hh:mm:ss] [-maxrecords num]-user* *username* `-password` *password*
- **vcb event view** `-mibfile` *complete-path-mibFilename [-generatecli -repository ParsingrulesHive - group PatternsHive]* `-user` *username* `-password` *password*

---

**Table B-34**  
**Options and Arguments—vcb event add (continued)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-faultcategory</code></td>
<td></td>
<td>Event category (3GPP standards). Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• COMMUNICATIONS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• QOS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PROCESSING</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• EQUIPMENT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ENVIRONMENTAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• UNDETERMINED</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• INTEGRITYVIOLATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OPERATIONALVIOLATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PHYSICALVIOLATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SECURITYORSERVICEMECHANISNMVIOLATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• TIMEDOMAINVIOLATION</td>
</tr>
</tbody>
</table>

---

**Note**  
For the list of global options, see *Global Command Options, page B-2.*

**Error Codes**

**Table B-35**  
**Error Codes—vcb event add**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>201</td>
<td>Event name already exists in Prime Network.</td>
</tr>
<tr>
<td>202</td>
<td>Alarm ID already exists in Prime Network.</td>
</tr>
</tbody>
</table>

---

**Note**  
For the list of general VCB error codes, see *General Error Codes, page B-2.*
Description

The vcb event view command enables you to view event definitions including event properties such as alarm ID, event subtypes, severity, and ticketability.

Usage Examples

vcb event view -userdefined -eventname all -user root -password admin
Returns all the event definitions that were added to Prime Network using the VCB.

vcb event view -eventname bgp -substringmatch -user root -password admin
Returns all BGP event definitions in Prime Network, including those that were added using the VCB.

vcb event view -user root -password admin -eventname bgp -substringmatch -eventtype service
Returns all BGP service events.

vcb event view -mibfile /mibs/IF-MIB -user root -password admin
Returns lists of supported events and unsupported events based on the traps in the IF-MIB file.

vcb event view -mibfile /mibs/IF-MIB -generateeventcli -group cisco-trap-product-parsing-rules -repository cisco-trap-repository -user root -password admin
Creates, but does not run, a script /Main/VcbEventCommand.sh. The script contains three vcb commands for each unsupported trap; the commands add an event (and provide an event ID), event parsing rules, and an event pattern. Optionally, edit the script.

To run the script, change permissions on the file to ensure that it is executable and supply a username and password as input; see this example:

chmod 755 VcbEventCommand.sh
./VcbEventCommand.sh -user root -password admin

Note

The Prime Network gateway maintains a known list of MIBs that are used to provide translation for trap varbinds when displayed in the UI. When an event is added from a MIB that is unknown to the gateway, the VCB does not add the MIB to the known MIB list. As a result, the varbinds for this trap might not be translated to user-friendly names.

Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>eventname</td>
<td>eventName</td>
<td>Unique string that represents the event. <strong>Tip</strong>: Enter all as the eventName to display information on all the event definitions in Prime Network. Use this argument with caution because the number of events can potentially be very large.</td>
</tr>
<tr>
<td>substringmatch</td>
<td></td>
<td>(Optional) Indicates that the event name argument is not an exact match.</td>
</tr>
<tr>
<td>eventtype</td>
<td>trap</td>
<td>Displays events of a specific type - traps, syslogs or service events.</td>
</tr>
</tbody>
</table>
Table B-36  Options and Arguments—vcb event view (continued)

<table>
<thead>
<tr>
<th>Option Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>generic events</td>
<td>Displays all events from the Prime Network database (in raw format).</td>
</tr>
<tr>
<td>generic event type</td>
<td>Tip Enter all as the generic event type to display information on all the events in Prime Network.</td>
</tr>
<tr>
<td>ipaddress neip</td>
<td>(Optional) Generic events filter. IP address for the NE for which you want to see generic events.</td>
</tr>
<tr>
<td>date yyyy-mm-dd</td>
<td>(Optional) Generic events filter. The date after which the events arrived. Returns events that arrived after the given day.</td>
</tr>
<tr>
<td>time hh:mm:ss</td>
<td>(Optional) Generic events filter. The time after which the events arrived. Returns events that arrived after the given time.</td>
</tr>
<tr>
<td>maxrecords num</td>
<td>(Optional) Generic events filter. The maximum number of events that you want to display. The default value is 100.</td>
</tr>
<tr>
<td>mibfile complete-path-mibFilename</td>
<td>Loads MIB modules and compares the traps defined in the MIB against the events that are supported in Prime Network. Displays lists of supported traps and unsupported traps. Note Before using this command option, copy the MIB and dependent MIB files to a local folder. Rename each MIB file, removing the .my file extension from it.</td>
</tr>
<tr>
<td>generatecli</td>
<td>(Optional) When provided, produces a script, NETWORKHOME/Main/VcbEventCommand.sh. The script contains commands to add basic event support for each unsupported trap that was identified through the -mibfile option.</td>
</tr>
<tr>
<td>repository ParsingrulesHive</td>
<td>Mandatory -generatecli option. Hive that includes event parsing rules for traps.</td>
</tr>
<tr>
<td>group PatternsHive</td>
<td>Mandatory -generatecli option. Hive that includes event patterns for traps.</td>
</tr>
</tbody>
</table>

Note
For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-37  Error Codes—vcb event view

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>231</td>
<td>No such event exists in the events file</td>
</tr>
</tbody>
</table>

Note
For the list of general VCB error codes, see General Error Codes, page B-2.
vcb event modify

Use the vcb event modify command to modify events that were previously defined using the VCB or to modify event attributes for factory-defined events (by using the -override option). This command can also be used to drop events.

Syntax

vcb event modify -eventname eventName [-alarmid alarmId] [-override]
{ -subtype1 subtypeName [ {-ticketable1} | -autoclear1 false|true] -severity1 critical|major|minor|warning|info|cleared
 -shortdesc1 short description string... 
{ -subtype2 subtypeName [ {-ticketable2} | -autoclear2 false|true] -severity2 critical|major|minor|warning|info|cleared
 [ -shortdesc2] short description string
 -eventtype trap | syslog | service | drop }

Description

The vcb event modify command modifies an event definition in Prime Network. It can also be used to instruct the system to drop a specific event.

Note

Support for modifying an event is limited due to the complexity involved. When additional changes are required—such as changing the name of an event or a subtype—the supported procedure is to delete the entire event definition and add it afresh:

- Delete the event, event pattern, and associated event parsing rules.
- Add the event, event pattern, and event parsing rules.

Usage Examples

vcb event modify -eventname "stack switch status syslog"
-subtype1 "stack switch removed syslog" -severity1 major -ticketable1 -user root
-password admin

Updates the event definition for the stack switch status syslog, changing the severity of the specified subtype to major and making the subtype ticketable. For a corresponding example of how this event was added, see Usage Example, page B-32 for the vcb event add.

vcb event modify -eventname "bgp trap" -override -eventtype drop -user root -password admin

Drops the “bgp trap” event. This overrides the system-defined event.

Options

<table>
<thead>
<tr>
<th>Table B-38</th>
<th>Options and Arguments—vcb event modify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>Argument</td>
</tr>
<tr>
<td>eventname</td>
<td>eventName</td>
</tr>
<tr>
<td>eventtype</td>
<td>trap</td>
</tr>
</tbody>
</table>
### Table B-38 Options and Arguments—vcb event modify (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>alarmid</td>
<td>alarmId</td>
<td>(Optional) Unique integer identifier for the event. If not provided, the VCB automatically generates a unique number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> We recommend that you do not provide an input alarm ID.</td>
</tr>
<tr>
<td>subtypen</td>
<td>subtypenName</td>
<td>Unique string that identifies the subevent with the Prime Network event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To retain ticketability for any ticketable subtype—whether you want to modify the subtype or not—you must enter the subtype option and argument along with the ticketable option (below).</td>
</tr>
<tr>
<td>ticketable</td>
<td></td>
<td>(Optional) Parameter for subtype. Indicates whether a ticket should be generated for this subtype. If not specified, no ticket is generated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> To retain ticketability, supply the ticketable option for all subtypes that are currently defined as ticketable events (even for subtypes that you do not intend to modify). Otherwise, the subtypes are modified to be non-ticketable events.</td>
</tr>
<tr>
<td>-autoclear</td>
<td>false</td>
<td>(Optional) Parameter for subtype. If the event is ticketable, setting autoclear to false causes the subevent to remain asserted until the clear alarm arrives or the user manually acknowledges or clears the subevent.</td>
</tr>
<tr>
<td></td>
<td>true</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Root cause events are not autocleared even when autoclear is set to false. By default, autoclear is true for user-defined event definitions.</td>
</tr>
<tr>
<td>severity</td>
<td>value</td>
<td>(Optional) Parameter for subtype. Specifies the severity of the subevent. Possible values are critical, major, minor, warning, info, and cleared.</td>
</tr>
<tr>
<td></td>
<td>description string</td>
<td></td>
</tr>
<tr>
<td>override</td>
<td></td>
<td>(Optional) Indicates that you expect to override attributes for a factory-defined event.</td>
</tr>
<tr>
<td>-faultnature</td>
<td></td>
<td>Parameter that indicates how the fault is cleared, either manually or automatically. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ADAC (Automatically Detected Automatically Cleared) - The event is automatically detected and automatically cleared by the system. For example, “link down” event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ADMC (Automatically Detected Manually Cleared) - The event must be manually cleared by the user. For example, “DWDM fatal error” syslog.</td>
</tr>
</tbody>
</table>
vcb event delete

Use the `vcb event delete` command to delete an event definition. The `vcb event delete` does not delete or change the event template from which the event definition was cloned.

**Syntax**

```
vcb event delete -eventname eventName -user username -password password
```
Description

The `vcb event delete` command removes event definitions created using the VCB and removes event attribute overrides from factory-defined events. Deleting a factory-defined event removes event attribute overrides only and not the event itself; the original event attributes are then applied to future events.

Usage Example

```
vcb event delete -eventname "stack switch status syslog" -user root -password admin
```

Deletes the event definition. All registry entries added as a part of the event add command are removed from the site.xml file.

Options

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>eventname</td>
<td>eventName</td>
</tr>
<tr>
<td>eventName</td>
<td>Name of the event to be deleted</td>
</tr>
</tbody>
</table>

Note

For the list of global options, see Global Command Options, page B-2.

Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>231</td>
<td>No such event exists in the events file</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.
VCB CLI Reference: vcb eventparsingrules Commands

These topics provide reference information for the `vcb eventparsingrules` commands you can use to create, view, modify, and delete event parsing rules:

- `vcb eventparsingrules add`, page B-41
- `vcb eventparsingrules view`, page B-43
- `vcb eventparsingrules modify`, page B-45
- `vcb eventparsingrules delete`, page B-46

**vcb eventparsingrules add**

Use the `vcb eventparsingrules add` command to create a VNE-driver registration for adding parsing rules to support a new trap or syslog by customizing a specified set of event templates.

**Syntax**

```
vcb eventparsingrules add -templates templateName1, templateName2, …, templateNamen
  -group repository -rulename rulename [-enable]
  ( [-arg1 -arg1Value...-argN argNValue] ) -user username -password password
```

**Description**

The `vcb eventparsingrules add` command creates a VNE-driver event registration based on the templates chosen by the user. This enables Prime Network to identify and associate the event to a particular device component instead of classifying the event as a generic event.

The command does the following:

- Creates a separate registry configuration (a copy) for customizing the event. Parameters that you input using the command affect the copy.
- Creates rules for handling the event based on the event template and user input.
- Updates the site.xml file, so that Prime Network can differentiate customizations created using the VCB from changes supplied in VNE-driver registration files.

**Usage Example**

```
vcb eventparsingrules add -enable
    -templates syslog-identification, syslog-subtype-from-expression, create-managedelement-key, create-a
    na-syslog-event
    -group cisco-syslog-repository
    -rulename stack-switch-status-syslog
    -syslog_identification_testmessage "STACKMGR-4-SWITCH_ADDED: Switch 2 has been added
      to the stack"
    -syslog_identification_expression "STACKMGR-4-SWITCH_%%subtypekey%%: Switch
      %%uniqueid%% has been .*"
    -syslog_subtype_from_expression_replacing_rules "ADDED-stack switch added
      syslog, REMOVED-stack switch removed syslog"
    -create_ana_syslog_event_type "stack switch status syslog"
    -user root -password admin
```
Adds parsing rules to identify the syslog correctly, associates it with the correct device component, and creates the corresponding Prime Network event and subevent.

Four event templates are entered:

- **syslog-identification**—Rules that pertain to syslog identification.
- **syslog-subtype-from-expression**—Rules that map the syslog values (in this case, ADDED and REMOVED) to the event subtype names: stack switch added syslog, stack switch removed syslog. The example includes two rules, separated by commas.

  > Note  
  
  Rules must be comma-separated. Each rule must include a value and event subtype, separated by a hyphen: value-event subtype.

- **create-managedelement-key**—Indicates that the syslog should be associated with the managed element. (There are no input parameters for this template.)
- **create-ana-syslog-event**—Provides rules for creating instances of the corresponding Prime Network event (defined with the `vcb event add` command).

Input parameters for the event templates are variable arguments that depend on the templates selected.

- **syslog_identification_expression**—The actual syslog message with input that is of interest to the user and is masked with special keys, such as %%subtypekey%%, %%uniqueid%%, and %%entityid%%, depending on which is applicable. In the previous example, only subtypekey and uniqued parameters are relevant.

  > Note  
  
  Only a substring of the message is used in the example, because whatever comes afterward is of no interest to the user.

- **syslog_subtype_from_expression_replacing_rules**—Specifies the mapping from the subtypekey to the subevent name. The subevent string should exactly match one of the subevent names that was defined using the `vcb event add` command.
- **create_ana_syslog_event_type**—Specifies the event name.

  > Note  
  
  This parameter should exactly match the event name defined using the `vcb event add` command.

### Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>templates</td>
<td><code>template name1, ... template namen</code></td>
<td>Comma-separated list of event template names. Event templates are divided into categories that correspond to the function they fulfill (identification, association, and so on.) Depending upon the trap or syslog that you are adding, select no more than one template from each template category.</td>
</tr>
<tr>
<td>group</td>
<td><code>repository</code></td>
<td>Specifies the vendor-specific trap or syslog repository file under which the customizations should be made.</td>
</tr>
<tr>
<td>rule</td>
<td><code>rulename</code></td>
<td>String that is used as a key name for event rule definition.</td>
</tr>
</tbody>
</table>
Appendix B  VCB: CLI Commands and Template Reference

VCB CLI Reference: Events Commands

Table B-42  Options and Arguments—vcb eventparsingrules add (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>enable</td>
<td></td>
<td>(Optional) Indicates whether the rule is enabled or disabled. Only enabled rules are used to parse incoming traps and syslogs.</td>
</tr>
<tr>
<td>variable arguments</td>
<td></td>
<td>Arguments vary from one event template to another event template.</td>
</tr>
<tr>
<td>syslog_identification_ testmessage</td>
<td></td>
<td>(Optional) Parameter valid for syslogs only. An example syslog message used to check the correctness of the regular expression that the VCB creates automatically based on user input.</td>
</tr>
</tbody>
</table>

Note

For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-43  Error Codes—vcb eventparsingrules add

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>211</td>
<td>Event template file not found.</td>
</tr>
<tr>
<td>103</td>
<td>No such template name in template file.</td>
</tr>
<tr>
<td>212</td>
<td>Only one template can be selected from each template category.</td>
</tr>
<tr>
<td>213</td>
<td>Invalid expression for syslog.</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.

vcb eventparsingrules view

The vcb eventparsingrules view command displays event registrations. Use it to verify that you successfully added an event parsing rule or to view parameters (to fill them in based on the example).

Syntax

vcb eventparsingrules view -group repository name -rulename { rulename | all } [-detail] [-userdefined] -user username -password password
vcb eventparsingrules view -template templateName | all -inputparam -user username -password password

Description

The vcb eventparsingrules view command shows configuration settings. Use it to list:

- Details of the events repository for a particular rulename or for all the events in the file. The information displayed includes the parsing rules and important parameters in each rule.
- Input parameters in the event template specified by -template option. If all is specified, the user input parameters of all the templates are displayed.
Usage Examples

Example 1

```
vcb eventparsingrules view -template syslog-identification -inputparam -user root -password admin
```

Displays the syslog-identification event template definition, including a detailed description of the input parameters required when using the template to add event parsing rules.

Example 2

```
vcb eventparsingrules view -group cisco-syslog-repository -userdefined -rulename all -user root -password admin
```

Displays all event parsing rules that were defined using the VCB under the cisco-syslog-repository hive.

Example 3

```
vcb eventparsingrules view -group cisco-syslog-repository -rulename stack-switch-status-syslog -user root -password admin
```

Displays the event parsing rules for the event “stack-switch-status-syslog” which was created using the VCB.

Example 4

```
vcb eventparsingrules view -group cisco-syslog-repository -rulename all -user root -password admin
```

Displays all the event parsing rules present in the hive cisco-syslog-repository, including those added using the VCB.

Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>group</td>
<td>The trap or syslog repository filename.</td>
</tr>
<tr>
<td></td>
<td>repository name</td>
<td></td>
</tr>
<tr>
<td></td>
<td>rulename</td>
<td>The unique string that is used to represent the event parsing rules.</td>
</tr>
<tr>
<td></td>
<td>ruleName</td>
<td></td>
</tr>
<tr>
<td></td>
<td>detail</td>
<td>(Optional) Lists the entire rule contents including the parsing rule entry details.</td>
</tr>
<tr>
<td></td>
<td>template</td>
<td>The event template name.</td>
</tr>
<tr>
<td></td>
<td>templateName</td>
<td></td>
</tr>
<tr>
<td></td>
<td>inputparam</td>
<td>(Optional) Lists template definition entries that require user input when creating event parsing rules.</td>
</tr>
</tbody>
</table>

For the list of global options, see Global Command Options, page B-2.
Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>No such template name in the templates file.</td>
</tr>
<tr>
<td>222</td>
<td>Parsing rules repository not found.</td>
</tr>
<tr>
<td>231</td>
<td>No such rule name in the site.xml.</td>
</tr>
</tbody>
</table>

Note
For the list of general VCB error codes, see General Error Codes, page B-2.

vcb eventparsingrules modify

Use the `vcb eventparsingrules modify` to modify the parsing rule definitions. The most common use case for this command is to select one or more different templates because the certification of the customization failed.

Syntax

```
vcb eventparsingrules modify -template templateName1, templateName2, ..., templateNameN
-group repository -rulename ruleName [-enable] [ [-arg1 -arg1Value...-argN argNValue]] -user username -password password
```

Description

The `vcb eventparsingrules modify` command changes parsing rule definitions based on the templates chosen by the user. The command can also be used to add parsing rules that were inadvertently omitted when adding the parsing rule. For example, use the command to add the rules for extracting the uniqueid parameter.

Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>templates</td>
<td>template name1,</td>
<td>Comma-separated list of event template names. Event templates are divided</td>
</tr>
<tr>
<td></td>
<td>... template nameN</td>
<td>into categories that correspond to the function they fulfill (identification,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>association, and so on.) Depending upon the trap or syslog that you are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>adding, select no more than one template from each template category.</td>
</tr>
<tr>
<td>group</td>
<td>repository</td>
<td>The hive under which the customizations should be made. The hive is the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>vendor-specific trap or syslog repository file.</td>
</tr>
<tr>
<td>rulename</td>
<td>ruleName</td>
<td>String that is used as a key name for event rule definition.</td>
</tr>
</tbody>
</table>
### VCB CLI Reference: Events Commands

**VCB CLI Reference: Events Commands**

#### Appendix B

**VCB CLI Commands and Template Reference**

**Table B-46**

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>enable</td>
<td>(Optional) Indicates whether the rule should be enabled or disabled. Only enabled rules are used to parse incoming traps and syslogs.</td>
<td></td>
</tr>
<tr>
<td>variable arguments</td>
<td>Each event template can require different input and a different number of input parameters from none to more than one. See Event Templates Input Summary—Required and Optional Input, page B-83.</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

For the list of global options, see Global Command Options, page B-2.

### Error Codes

**Table B-47**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>No such template name in the templates file.</td>
</tr>
<tr>
<td>211</td>
<td>Event template file not found.</td>
</tr>
<tr>
<td>212</td>
<td>Only one template can be selected from each template category.</td>
</tr>
</tbody>
</table>

**Note**

For the list of general VCB error codes, see General Error Codes, page B-2.

### vcb eventparsingrules delete

Use the `vcb eventparsingrules delete` command to delete the parsing rule definitions of an event. Doing so does not delete or change the event template from which that event definition was cloned.

#### Syntax

```
vcb eventparsingrules delete -group repository hive -rulename rulename -user username -password password
```

#### Description

The `vcb eventparsingrules delete` command removes event parsing rule definitions created from an event template. It does not change or delete the event template itself.

#### Usage Example

```
vcb eventparsingrules delete -group cisco-syslog-repository -rulename stack-new-master-syslog
```

This example deletes the stack-new-master-syslog rule from the cisco-syslog-repository hive.
Options

Table B-48 Options and Arguments—vcb eventparsingrules delete

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group</td>
<td>repository hive</td>
<td>The hive from which to remove the event parsing rule.</td>
</tr>
<tr>
<td>rulename</td>
<td>ruleName</td>
<td>The rule to delete.</td>
</tr>
</tbody>
</table>

Note

For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-49 Error Codes—vcb eventparsingrules delete

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>222</td>
<td>Parsing rules repository not found.</td>
</tr>
<tr>
<td>241</td>
<td>No such rule name in the site.xml.</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.

VCB CLI Reference: vcb eventpattern Commands

These topics provide reference information for the vcb eventpattern commands you can use to create, view, modify, and delete event patterns:

- vcb eventpattern add, page B-47
- vcb eventpattern view, page B-49
- vcb eventpattern modify, page B-51
- vcb eventpattern delete, page B-52

vcb eventpattern add

Use the vcb eventpattern add command to create a VNE-driver registration that points from the parsing rules hive, which is scheme or VNE-specific, to the parsing rules defined in the repository file.

Note

Only those events that have this pointer are deemed as supported events. Other events are deemed generic events despite having parsing rules and event definitions.

Syntax

vcb eventpattern add [-patternid patternId] -group parsing rules hive -repository parsing rules repository hive -rulename ruleName -user username -password password
Description

The **vcb eventpattern add** command creates a pointer from the parsing-rules hive to the repository where the actual parsing rules are defined.

Usage Examples

```bash
vcb eventpattern add
  -patternid 202 -group cisco-syslog-product-parsing-rules
  -repository cisco-syslog-repository
  -rulename stack-switch-status-syslog -user username -password password
```

Adds a pointer from the parsing rules file to the actual definitions in the parsing-rules hive with pattern ID 202. It points to the key (rule) named stack-switch-status-syslog in the cisco-syslog-repository file.

Options

<table>
<thead>
<tr>
<th>Table B-50</th>
<th>Options and Arguments—vcb eventpattern add</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Argument</strong></td>
</tr>
<tr>
<td>patternid</td>
<td><em>patternId</em></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>group</td>
<td><em>parsing rules hive</em></td>
</tr>
<tr>
<td>repository</td>
<td><em>parsing rules repository hive</em></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>rulename</td>
<td><em>rulename</em></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For the list of global options, see **Global Command Options, page B-2**.
Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>221</td>
<td>Parsing rules hive not found.</td>
</tr>
<tr>
<td>222</td>
<td>Parsing rules repository not found.</td>
</tr>
</tbody>
</table>

Note
For the list of general VCB error codes, see General Error Codes, page B-2.

vcb eventpattern view

Use the `vcb eventpattern view` command to display event registrations. It is useful when you need to verify successful completion of an add command or to help find a similar case for filling in parameters on other commands.

Syntax

```
vcb eventpattern view -group parsingrules hive -rulename { rulename | all } [-substringmatch] [-full] -user username -password password
```

Description

The `vcb eventpattern view` command shows the actual set of events that are supported by a particular NE type or scheme. It displays the pattern ID and the repository file where the event parsing rules are defined. When the substringmatch option is used, only rules that contain a certain substring are displayed; use this option, for example, to obtain rules for a technology name such as MPLS.

Usage Examples

**Example 1**

```
vcb eventpattern view -group cisco-syslog-parsing-rules -rulename stack-switch-status-syslog -user root -password admin
```

Displays the event pattern definition for the specified rulename; that is, the pattern ID, and the pattern is pointing to the parsing rules repository.

**Example 2**

```
vcb eventpattern view -group cisco-syslog-parsing-rules -rulename all -user root -password admin
```

This example shows all the event pattern definitions in the specified hive.
Example 3

```
vcb eventpattern view -group cisco-syslog-parsing-rules -userdefined
    -rulename bgp -substringmatch -full -user root -password admin
```

This example shows the entire event definition for all BGP events (including those defined using the VCB) defined in the cisco-syslog-parsing-rules hive. The following information is displayed:

- Pattern definitions—Parsing rules repository, pattern ID
- Parsing rules definitions—All rules in the definition that require user input, and the values set for these parameters
- Event definitions—Event attributes such as eventname, subevent names, ticketability, severity and so on

Options

Table B-52 Options and Arguments—vcb eventpattern view

<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group</td>
<td>parsingrules hive</td>
<td>The parsing-rules filename used by the NE type or scheme.</td>
</tr>
<tr>
<td>rulename</td>
<td>rule name</td>
<td>Unique string that represents the event parsing rules. <strong>Tip</strong> Enter all as the rule name to list all event parsing rules defined in the repository.</td>
</tr>
<tr>
<td>substringmatch</td>
<td>(Optional) Indicates that the rule name provided is not an exact match. This option is useful when you want to know the names of all rules that belong to a particular technology, such as BGP.</td>
<td></td>
</tr>
<tr>
<td>full</td>
<td>(Optional) Displays the entire details of the event, from the pattern definition and parsing rules to the event definition. Provides the complete picture of how an event is supported in Prime Network. <strong>Note</strong> Avoid this option when using the “all” argument because it can result in a very large output.</td>
<td></td>
</tr>
</tbody>
</table>

Note

For the list of global options, see Global Command Options, page B-2.

Error Codes

Table B-53 Error Codes—vcb eventpattern view

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>221</td>
<td>Parsing rules hive not found.</td>
</tr>
<tr>
<td>241</td>
<td>No such rule name in the site.xml.</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.
vcb eventpattern modify

Use the `vcb eventpattern modify` command to modify the pointer to the parsing rules.

Syntax

```
vcb eventpattern modify -patternid patternId -group parsing rules hive [-repository parsing rules repository hive] [-rulename ruleName] -user username -password password
```

Description

The `vcb eventpattern modify` command modifies the pointer from the parsing-rules hive to the repository where the actual parsing rules are defined.

Usage Examples

```
vcb eventpattern modify
   -patternid 202
   -group cisco-syslog-product-parsing-rules
   -repository cisco-router-syslog-repository -user root -password admin
```

This example assumes that we are starting with the eventpattern with ID 202 that points to the cisco-syslog-repository (as shown in Usage Examples for the `vcb eventpattern add` command). In this example, we modify the repository for the eventpattern with ID 202 to the cisco-router-syslog-repository.

Options

```
<table>
<thead>
<tr>
<th>Option</th>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>patternid</td>
<td>patternId</td>
<td>Unique integer to identify the supported event to a VNE.</td>
</tr>
<tr>
<td>group</td>
<td>parsing rules hive</td>
<td>The hive in which this pattern is to be modified. The parsing-rules hives are generally scheme-specific. VNE-specific definitions can also be made using this hive.</td>
</tr>
<tr>
<td>repository</td>
<td>parsing rules repository hive</td>
<td>(Optional) The hive where the actual parsing rules are defined (the trap/syslog repository). Enter the same hive that was specified when creating parsing rules registrations using the <code>vcb eventparsingrules add</code> command.</td>
</tr>
<tr>
<td>rulename</td>
<td>ruleName</td>
<td>String that is used as a key name for event rule definition. Note Enter exactly the same string as the one that was specified when creating parsing rules registrations using the <code>vcb eventparsingrules add</code> command.</td>
</tr>
</tbody>
</table>
```

For the list of global options, see Global Command Options, page B-2.
Appendix B      VCB: CLI Commands and Template Reference

Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>221</td>
<td>Parsing rules hive not found.</td>
</tr>
<tr>
<td>222</td>
<td>Parsing rules repository not found.</td>
</tr>
<tr>
<td>271</td>
<td>Pattern with ID not found</td>
</tr>
</tbody>
</table>

Note

For the list of general VCB error codes, see General Error Codes, page B-2.

vcb eventpattern delete

Use the vcb eventpattern delete command to delete the parsing rule from the list of supported event patterns. Doing so does not delete the parsing rules in the repository file.

Syntax

\[
\text{vcb eventpattern delete } \text{-group parsing rule hive \text{-patternid pattern ID \text{-user username}} \text{-password password}}
\]

Description

The vcb eventpattern delete command removes the pointer to the parsing rule defined in the repository file.

Usage Examples

vcb eventpattern delete -group cisco-syslog-parsing-rules -patternid 202 -user root -password admin

Deletes the parsing rules pattern with ID 202. All registry entries added as a part of the vcb eventpattern add command will be removed from site.xml.

Options

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>patternid pattern ID</td>
<td>Unique integer to identify the supported event to a VNE.</td>
</tr>
<tr>
<td>group parsing rules hive</td>
<td>The hive in which this pattern is to be modified. The parsing-rules hives are generally scheme-specific. VNE-specific definitions can also be made using this hive.</td>
</tr>
</tbody>
</table>

Note

For the list of global options, see Global Command Options, page B-2.
Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>221</td>
<td>Parsing rules hive not found.</td>
</tr>
<tr>
<td>271</td>
<td>Pattern with ID not found</td>
</tr>
</tbody>
</table>

VCB CLI Reference: vcb eventarg Command

vcb eventarg view

Use the `vcb eventarg view` command to display event parsing rule arguments and descriptions.

Syntax

```
vcb eventarg view -user username -password password
```

Description

The `vcb eventarg view` command option displays all the VCB event parsing rules template variable arguments along with descriptions.

Troubleshooting Event Customization Using the VCB CLI

Errors that you receive from the VCB CLI are self-explanatory. Most errors make very clear what you need to do to correct the problem that has occurred. For example, if an event name already exists, you must enter a different event name. If an alarm ID or pattern ID is already in use, you should omit the related option and argument from your command and allow the VCB to generate a unique ID for you.

Note

To get more information, add the `-debug` option to any `vcb` command; for more information, see Global Command Options, page B-2.
Errors that occur in the server are not as obvious. If a newly supported event does not appear in Prime Network Events or Prime Network Vision, you need to perform some troubleshooting, as follows:

**Step 1**
Ensure that the device is configured to send events to Prime Network gateway. Use any tool to snoop and check whether the simulated network events that you are sending are actually arriving at the Prime Network gateway. If not, fix the issue whether it is connectivity, firewall and so on, then proceed to next step.

For detailed information, see VCB CLI Reference: Events Commands, page B-31.

**Step 2**
Enable debug for event processing in the VNE. Execute the following commands for the AVM that has the VNE that you will be testing.

```
rungTool.sh -gs localhost set 127.0.0.1
avm<avmid>/services/logger/log4j.category.com.sheer.metrocentral.frame
twork.eventapplication.SendAlarmMessageUtil DEBUG
rungTool.sh -gs localhost set 127.0.0.1
avm<avmid>/services/logger/log4j.category.com.sheer.metrocentral.frame
twork.eventmanager.EventManager DEBUG
rungTool.sh -gs localhost set 127.0.0.1
avm<avmid>/services/logger/log4j.category.com.sheer.metrocentral.frame
twork.eventapplication.parsing.ParsingApplication DEBUG
```

**Step 3**
Allow the VNE to come up, then open the log file for the AVM. Check whether the newly added pattern is being loaded at VNE startup. Look for an entry in the log file that is similar to the following text:

```
DEBUG [06 21 2010 12:19:59.524 IST] - ParsingApplication.buildRulesMatrix - pattern ATMLC-6-CLOCKING with index 5001 in the registry is now mapped into index 123 in the parsing application.
```

The above DEBUG statement includes both the rulename (ATMLC-6-CLOCKING with) and the pattern id (5001) of the newly added event. If a similar statement is not printed for the newly added event, go to Step 4; otherwise, go to Step 5.

**Step 4**
Review the `vcb eventparsingrules add` command that you used, checking whether you enabled the event using the `-enable` option. If the command was issued without the `-enable` option, delete the event parsing rules using the `vcb eventparsingrules delete` command and add the event parsing rules again, ensuring that you use with the `-enable` option.

**Step 5**
Check statically whether the links between event pattern, event parsing rules, and event are OK. To perform this check, use the `vcb eventpattern view` command with the `-full` option (see Example 3, page B-50). The output should display details of all the three customizations. A typo in the rulename, event type name, or event subtype name can prevent the links from being established and result in a partial display. For example, if the rulename in the `vcb eventpattern` command does not match that used in the `vcb eventparsingrules` command, only event pattern details will be displayed; details for event parsing rules and the event will not be displayed.

If the output is OK (that is, it includes details for all three customizations), go to Step 7. Otherwise, go to Step 6.

**Step 6**
Review the commands that have been issued and re-add or modify the customizations as required. Then go back to Step 5.
Step 7   After the static verification that you perform in step 5 succeeds, check whether the parsing itself is failing. Put a tail on the AVM log file and resend the simulated event. When parsing fails, the event is classed as a generic event. Log output similar to the following will appear.

```plaintext
DEBUG [06 21 2010 16:11:09.623 IST] - EventManager.filterEventApplications - Event has been dropped by application
[com.sheer.metrocentral.framework.eventapplication.filter.GenericSyslogTypeFilterAp p]

####### com.sheer.metrocentral.framework.eventapplication.types.EventData
#######
# Id : = 137611826381_1277116869542
# Unique source ID: = null
# Type : = generic syslog
# SubType : = generic syslog
# SourceOID : = {[ManagedElement(Key=10.77.212.205)]}[Syslog]}
# Event Time : = 1277116869542
# Info : = 7.212.205 %FAN-3-FAN_OK: Fan 3 had earlier reported a rotation error. It is ok now
# CorrelationKeys: =
#      CK=(MC.DA-10.77.212.205)-25:52:0:0 [16]
# Adjacent XID : = null
# Source IP interface: = null
```

Step 8   Open the log file and go backwards from the end of the file until you come to the place where logs pertaining to the actual parsing process are available. Search for the string 'Testing pattern: handle rulename', where rulename is the string you used in the `vcb eventpattern add` command. Here you will find logs that report the results of testing each rule. Identify the rule that failed as shown in the following log.

```plaintext
Stack: [(uniqeid=>3),(syslog=>7.212.205 %FAN-3-FAN_OK: Fan 3 had earlier reported a rotation error. It is ok now),(subtypekey=>0K),(.prulescache=>{}),(counter=>0)]
Event Data :

####### com.sheer.metrocentral.framework.eventapplication.parsing.types.RawSyslogEventData
#######
# Id : = 4311876356_1277116869490
# Unique source ID: = null
# Type : = raw event
# SubType : = raw syslog
# SourceOID : = null
# Event Time : = 1277116869494
# Info : = 7.212.205 %FAN-3-FAN_OK: Fan 3 had earlier reported a rotation error. It is ok now
# syslog = 7.212.205 %FAN-3-FAN_OK: Fan 3 had earlier reported a rotation error. It is ok now
```

java.lang.reflect.InvocationTargetException
In the above example, the parsing rule that failed is ChangeArgumentValue. The failure implies that the replacing rules that map the network event parameters to the Prime Network event subtypes are failing. Review the replacing_rules arguments used in the `vcb eventparsingrules` command and make the necessary changes.

The list of parsing rules (classes) and the corresponding option in vcb are given in the following table. Review the parameter values of the failing option and make appropriate changes.

Repeat the above steps until all errors are resolved and the event is parsed correctly and the Prime Network event is generated as expected.

## VCB Template Reference

Use the information in this section to determine which template best matches the device, module, or event that you want to manage with Prime Network. Information in this section is also useful when you test the customizations that you have made.

Topics include:
- U-VNE Templates, page B-56
- Module Templates, page B-65
- Event Templates, page B-80

### U-VNE Templates

Features, advantages, and limitations of template-based U-VNEs are template-dependent. The `GenericUVNE` template uses the same set of MIB-II based instrumentation for logical inventory discovery as is used by the Prime Network Generic SNMP VNE. The advantage of the U-VNE—created using the VCB and the `GenericUVNE` template—over the Generic SNMP VNE is that you can identify the device type for the U-VNE and further extend the U-VNE for additional event recognition using the VCB.

For more information, see the following sections:
- Methods for Creating U-VNEs—Overview, page 3-7
- Comparison of Generic SNMP VNEs, U-VNEs, and Developed VNEs, page 3-3
- GenericUVNE Template, page B-57
GenericUVNE Template

The GenericUVNE template is applicable to Cisco and non-Cisco NEs and supports event customization with event association to Managed Element only.

Use the GenericUVNE template to model any NE that is not currently supported by Prime Network. A U-VNE created this way is very similar to the Generic SNMP VNE. It provides basic information, such as the physical interfaces available on the device and their status, rudimentary logical modeling, and parsing of basic traps; see GenericUVNE—Supported Traps, page B-59. Using the VCB, however, you can configure additional traps and syslog recognition for a U-VNE created using the GenericUVNE template.

This U-VNE models NEs using SNMP MIB-II, which is the most generic and widely used management interface. This U-VNE does not consider the device vendor, device type, or software version of the NE that it models. Using the VCB, however, you can update device type attributes for a U-VNE created using the GenericUVNE template.

Table B-58 summarize the features and advantages of the GenericUVNE template.

<table>
<thead>
<tr>
<th>Features</th>
<th>Advantages</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same physical and logical inventory as a Generic SNMP VNE.</td>
<td>When compared with a Generic SNMP VNE, this U-VNE provides:</td>
<td>Event association to Managed Element only</td>
</tr>
<tr>
<td>Applicable to Cisco and non-Cisco NEs.</td>
<td>• Simplified trap and syslog recognition (using the VCB).</td>
<td></td>
</tr>
<tr>
<td>User-defined device type attributes:</td>
<td>• Application of soft property and activation scripts to a specific U-VNE (as opposed to a device type).</td>
<td></td>
</tr>
<tr>
<td>– Device category—Determines the icon that is displayed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>– Element type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event recognition, enabling Prime Network to forward events from unsupported devices to OSS applications.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note—The Expedited column in the service event tables in this chapter can contain these values:

Y—Indicates that the service event is expedited by a syslog or trap generated by the device. This means that the syslog or trap causes the VNE to poll the device without waiting for the usual polling cycle, thus enabling quicker detection of the event.

N—Indicates that the service event is not expedited. The service event is not expedited. This means that the VNE will poll this device during the next regularly scheduled polling cycle.

Note—In some of the following tables, attributes, protocols, technologies, etc. are listed as supported. Supported denotes that SNMP queries are made to the NE for those attributes, etc. Whether values are available in response to the queries depends on whether the instrumentation supported in the NE works.
See the following sections:

- GenericUVNE—Physical Inventory Model, page B-58
- GenericUVNE—Logical Inventory Model, page B-59
- GenericUVNE—Supported Traps, page B-59
- GenericUVNE—Supported Events, page B-60
- GenericUVNE—Limitations, page B-60
- GenericUVNE—Supported Topologies, page B-60
- GenericUVNEs—Supported Technologies, page B-61
- GenericUVNE—Supported Service Events, page B-65

GenericUVNE—Physical Inventory Model

A U-VNE created using the GenericUVNE template uses a static model for the device chassis. The rest of the physical inventory is modeled using the ifTable. Since modules are not modeled, this U-VNE creates a single generic module on which all of the physical interfaces reside.

Table B-59 describes which MIB tables are used to model the physical inventory components that are supported by a U-VNE created using the GenericUVNE template.

Table B-59  MIBs Used for Physical Inventory Model of GenericUVNE

<table>
<thead>
<tr>
<th>Logical Component</th>
<th>MIB Table</th>
<th>Columns/Tables Used For Modeling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interfaces</td>
<td>ifTable</td>
<td>• ifDescr</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ifType</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ifOperStatus</td>
</tr>
<tr>
<td>Ports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port status</td>
<td>ifTable</td>
<td>• ifOperStatus and ifAdminStatus</td>
</tr>
<tr>
<td>Port speed</td>
<td>ifTable</td>
<td>• ifSpeed</td>
</tr>
<tr>
<td>MAC address</td>
<td>ifTable</td>
<td>• ifPhysAddress (Ethernet ports)</td>
</tr>
</tbody>
</table>

Note: Certain general properties on the managed element, such as system description, are modeled using the RFC1213-MIB.
Appendix B VCB: CLI Commands and Template Reference

VCB Template Reference

GenericUVNE—Logical Inventory Model

Table B-60 describes which MIB tables are used to model the logical inventory components that are supported by a U-VNE created using the GenericUVNE template. Attributes in Table B-60 are taken from MIB-II.

Table B-60 MIBs Used for Logical Inventory Model of GenericUVNE

<table>
<thead>
<tr>
<th>Logical Component</th>
<th>MIB Table</th>
<th>Columns/Tables Used For Modeling</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Interfaces</td>
<td>ipAddrTable</td>
<td>• ipAdEntIfIndex&lt;br&gt;• ipAdEntNetMask</td>
</tr>
<tr>
<td>ARP table</td>
<td>ipNetToMediaTable</td>
<td>• ipNetToMediaPhysAddress&lt;br&gt;• ipNetToMediaType</td>
</tr>
<tr>
<td>Routing table</td>
<td>ipRouteTable</td>
<td>• ipRouteDest&lt;br&gt;• ipRouteIfIndex&lt;br&gt;• ipRouteNextHop&lt;br&gt;• ipRouteType&lt;br&gt;• ipRouteMask</td>
</tr>
<tr>
<td>Bridging table</td>
<td>dot1dTpFdbTable</td>
<td>—</td>
</tr>
<tr>
<td>Default bridge</td>
<td>dot1dBridge</td>
<td>• dot1dBaseBridgeAddress&lt;br&gt;• dot1dBaseType</td>
</tr>
</tbody>
</table>

GenericUVNE—Supported Traps

A U-VNE created using the GenericUVNE template can parse the standard MIB-II and Bridge-MIB traps listed in Table B-61.

Table B-61 Supported Traps for GenericUVNE

<table>
<thead>
<tr>
<th>Standard MIB-II Traps</th>
<th>MIBs</th>
</tr>
</thead>
<tbody>
<tr>
<td>authenticationFailure</td>
<td>mplsTunnelReoptimized</td>
</tr>
<tr>
<td>bgpBackwardTransition</td>
<td>mplsTunnelRerouted</td>
</tr>
<tr>
<td>bgpEstablished</td>
<td>mplsTunnelUp</td>
</tr>
<tr>
<td>coldStart</td>
<td>ospfIfAuthFailure</td>
</tr>
<tr>
<td>entConfigChange</td>
<td>ospfIfConfigError</td>
</tr>
<tr>
<td>linkDown</td>
<td>ospfIfRxBadPacket</td>
</tr>
<tr>
<td>linkUp</td>
<td>ospfIfStateChange (down)</td>
</tr>
<tr>
<td>mplsL3VpnVrfDown</td>
<td>ospfIfStateChange (up)</td>
</tr>
<tr>
<td>mplsL3VpnVrfNumVrfRouteMaxThreshExceeded</td>
<td>ospfMaxAgeLsa</td>
</tr>
<tr>
<td>mplsL3VpnVrfRouteMidThreshExceeded</td>
<td>ospfNbrStateChange (down)</td>
</tr>
<tr>
<td>mplsL3VpnVrfUp</td>
<td>ospfNbrStateChange (up)</td>
</tr>
<tr>
<td>mplsLdpInitSessionThresholdExceeded</td>
<td>ospf-if-packet-retransmit</td>
</tr>
<tr>
<td>mplsLdpSessionDown</td>
<td>ospfOriginateLsa</td>
</tr>
</tbody>
</table>
A U-VNE created using the GenericUVNE template can identify traps, but it cannot correlate them. This is because this U-VNE does not include the model entities required by higher trap parsing levels.

For example, if Prime Network receives an mplsTunnelDown trap from a device modeled with the GenericUVNE template, Prime Network can identify the Tunnel Down trap, but it cannot perform correlation on the trap. The reason is that this U-VNE does not investigate tunnels, which means that there is no Device Component in the model to which Prime Network can attach a correlation flow.

For this U-VNE, event association is always to the Managed Element.

**GenericUVNE—Supported Events**

A U-VNE created using the GenericUVNE template supports the service events listed in Table B-62.

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Supported</th>
<th>Expedited</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Unreachable</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Discard Packets</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Dropped Packets</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Port Flapping</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Port Down</td>
<td>Y</td>
<td>N</td>
</tr>
</tbody>
</table>

**GenericUVNE—Limitations**

A U-VNE created using the GenericUVNE template uses MIB2 to cover the widest possible range of NEs. Although MIB2 is a widely accepted industry standard, most network equipment vendors augment MIB2 with other Management Interfaces such as private MIBs, Telnet, XML, and so on. In addition, different vendors sometimes have different implementations of standard MIBs. As a result, even the limited model created by this U-VNE is dependent on the vendor’s adherence to general network management standards.

**GenericUVNE—Supported Topologies**

A U-VNE created using the GenericUVNE template supports the topologies listed in Table B-63.

<table>
<thead>
<tr>
<th>Topology Type</th>
<th>Link Type</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>Ethernet</td>
<td>Y</td>
</tr>
<tr>
<td>Physical Layer</td>
<td>Ethernet</td>
<td>Y</td>
</tr>
</tbody>
</table>
GenericUVNEs—Supported Technologies

The following sections list the objects and attributes that are recognized on a U-VNE created using the GenericUVNE template, per technology:

- IP, page B-61
- Ethernet (IEEE 802.3), page B-62
- Base Logical Components, page B-63
- Common, page B-64

**IP**

Table B-64 lists the IP attribute support on a U-VNE created using the GenericUVNE template.

*Note* Table B-64 includes the supported technologies only.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMO Name—IIPInterface</td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>Y</td>
</tr>
<tr>
<td>Subnetwork Mask</td>
<td>Y</td>
</tr>
<tr>
<td>IP Interface Addresses Array</td>
<td></td>
</tr>
<tr>
<td>Interface Name</td>
<td></td>
</tr>
<tr>
<td>Interface Description</td>
<td>Y</td>
</tr>
<tr>
<td>IP Interface State</td>
<td>Y</td>
</tr>
<tr>
<td>OSPF Interface Cost</td>
<td></td>
</tr>
<tr>
<td>Broadcast Address</td>
<td></td>
</tr>
<tr>
<td>MTU</td>
<td></td>
</tr>
<tr>
<td>Lookup Method</td>
<td></td>
</tr>
<tr>
<td>Address Resolution Type</td>
<td></td>
</tr>
<tr>
<td>ARP Timeout</td>
<td></td>
</tr>
<tr>
<td>Secured ARP</td>
<td></td>
</tr>
<tr>
<td>ICMP Mask Reply</td>
<td></td>
</tr>
<tr>
<td>IGMP Proxy</td>
<td></td>
</tr>
<tr>
<td>HSRP Groups</td>
<td></td>
</tr>
<tr>
<td>IP Multiplexing Table</td>
<td></td>
</tr>
<tr>
<td>IANA Type</td>
<td></td>
</tr>
<tr>
<td>Containing CTPs</td>
<td></td>
</tr>
<tr>
<td>Contained CTPs</td>
<td></td>
</tr>
</tbody>
</table>
### Table B-64  IP Attribute Support on GenericUVNEs (continued)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IMO Name—IRoutingEntity</strong></td>
<td></td>
</tr>
<tr>
<td>Routing Table</td>
<td>Y</td>
</tr>
<tr>
<td>ARP Entity</td>
<td>Y</td>
</tr>
<tr>
<td>Routing Table Changes</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Y</td>
</tr>
<tr>
<td>Logical Sons</td>
<td>Y</td>
</tr>
<tr>
<td><strong>IMO Name—IRoutingEntry</strong></td>
<td></td>
</tr>
<tr>
<td>Destination IP Subnet</td>
<td>Y</td>
</tr>
<tr>
<td>Next Hop IP Address</td>
<td>Y</td>
</tr>
<tr>
<td>Type</td>
<td>Y</td>
</tr>
<tr>
<td>Routing Protocol Type</td>
<td>Y</td>
</tr>
<tr>
<td>Outgoing Interface Name</td>
<td>Y</td>
</tr>
<tr>
<td><strong>IMO Name—IARPEntry</strong></td>
<td></td>
</tr>
<tr>
<td>ARP Table</td>
<td>Y</td>
</tr>
<tr>
<td><strong>IMO Name—IARPEntry</strong></td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>Y</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Y</td>
</tr>
<tr>
<td>Port</td>
<td>Y</td>
</tr>
<tr>
<td>Entry Type</td>
<td>Y</td>
</tr>
</tbody>
</table>

**Ethernet (IEEE 802.3)**

Table B-65 lists the Ethernet (IEEE 802.3) attribute support on a U-VNE created using the GenericUVNE template.

### Table B-65  Ethernet (IEEE 802.3) Attribute Support on GenericUVNEs

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IMO Name—IEthernet</strong></td>
<td></td>
</tr>
<tr>
<td>MAC Address</td>
<td>Y</td>
</tr>
<tr>
<td>Duplex Mode</td>
<td></td>
</tr>
<tr>
<td>Output Flow Control</td>
<td></td>
</tr>
<tr>
<td>Input Flow Control</td>
<td></td>
</tr>
<tr>
<td>IANA Type</td>
<td></td>
</tr>
<tr>
<td>Containing CTPs</td>
<td></td>
</tr>
</tbody>
</table>
### Table B-65  Ethernet (IEEE 802.3) Attribute Support on GenericUVNEs (continued)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contained CTPs</td>
<td></td>
</tr>
<tr>
<td>Port Type</td>
<td></td>
</tr>
</tbody>
</table>

### Base Logical Components

Table B-66 lists the base logical attribute support on a U-VNE created using the GenericUVNE template.

#### Note

Table B-66 includes the supported technologies only.

### Table B-66  Base Logical Components Attribute Support on GenericUVNEs

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMO Name—IManagedElement</td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>Y</td>
</tr>
<tr>
<td>Communication State</td>
<td>Y</td>
</tr>
<tr>
<td>Investigation State</td>
<td>Y</td>
</tr>
<tr>
<td>Element Category</td>
<td>Y</td>
</tr>
<tr>
<td>Element Type and Key</td>
<td>Y</td>
</tr>
<tr>
<td>Device Name</td>
<td>Y</td>
</tr>
<tr>
<td>System Name</td>
<td>Y</td>
</tr>
<tr>
<td>System Description</td>
<td>Y</td>
</tr>
<tr>
<td>Up Time</td>
<td>Y</td>
</tr>
<tr>
<td>Software Version</td>
<td>Y</td>
</tr>
<tr>
<td>Vendor Identity</td>
<td></td>
</tr>
<tr>
<td>Memory and CPU Usage</td>
<td></td>
</tr>
<tr>
<td>DRAM Free</td>
<td></td>
</tr>
<tr>
<td>DRAM Used</td>
<td></td>
</tr>
<tr>
<td>Flash Device Size</td>
<td></td>
</tr>
<tr>
<td>NVRAM Size</td>
<td></td>
</tr>
<tr>
<td>Processor DRAM</td>
<td></td>
</tr>
<tr>
<td>Sys Contact</td>
<td></td>
</tr>
<tr>
<td>Sys Location</td>
<td></td>
</tr>
<tr>
<td>Serial Number</td>
<td></td>
</tr>
<tr>
<td>File Systems</td>
<td></td>
</tr>
</tbody>
</table>
### Table B-66  Base Logical Components Attribute Support on GenericUVNEs (continued)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMO Name—ISystemService</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>Up Time</td>
<td></td>
</tr>
</tbody>
</table>

### Common

Table B-67 lists the common attribute support on a U-VNE created using the GenericUVNE template.

**Note**

Table B-67 includes the supported technologies only.

### Table B-67  Common Attribute Support on GenericUVNEs

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMO Name—IPhysicalLayer</td>
<td></td>
</tr>
<tr>
<td>Media Type</td>
<td></td>
</tr>
<tr>
<td>Clocking Source</td>
<td></td>
</tr>
<tr>
<td>Maximum Speed</td>
<td>Y</td>
</tr>
<tr>
<td>Is Internal Port</td>
<td></td>
</tr>
<tr>
<td>Discarded Bandwidth</td>
<td></td>
</tr>
<tr>
<td>Dropped Bandwidth</td>
<td></td>
</tr>
<tr>
<td>Input Bandwidth</td>
<td></td>
</tr>
<tr>
<td>Output Bandwidth</td>
<td></td>
</tr>
<tr>
<td>Discarded and Received Input Data Counters</td>
<td>Y</td>
</tr>
<tr>
<td>Dropped and Forward Output Data Counters</td>
<td>Y</td>
</tr>
<tr>
<td>Administrative Status</td>
<td>Y</td>
</tr>
<tr>
<td>Operational Status</td>
<td>Y</td>
</tr>
<tr>
<td>Last Changed</td>
<td>Y</td>
</tr>
<tr>
<td>IANA Type</td>
<td></td>
</tr>
<tr>
<td>Containing CTPs</td>
<td></td>
</tr>
<tr>
<td>Contained CTPs</td>
<td></td>
</tr>
<tr>
<td>Port Alias</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B  VCB: CLI Commands and Template Reference

VCB Template Reference

GenericUVNE—Supported Service Events

Table B-68 lists the supported service events on a U-VNE created using the GenericUVNE template.

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Supported</th>
<th>Expedited</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Unreachable</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Discard Packets</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Dropped Packets</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Port Flapping</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Port Down</td>
<td>Y</td>
<td>N</td>
</tr>
</tbody>
</table>

Module Templates

Module templates define a set of port layers—from the connector at Layer 0 to encapsulation at Layer 2—that are applicable to a module. These templates ensure that each port is modeled with the correct port layer information based on the iType obtained from the SNMP MIB output.

Module templates are applicable to standard modules only (not pluggable modules). You do not need to use a module template to add a pluggable module.

When adding support for a new module using the VCB, you must identify the module template that matches the capabilities of the module.
For example, the atm-default module template contains the following port layer definitions, which are typical port layers for an OC3 ATM card:

- Layer 0—Fiber optic
- Layer 1—OC3
- Layer 2—ATM

These definitions make this template suitable for modules with ports that:

- Use fiber optic cable.
- Support the OC-3 data transfer rates over SONET.
- Use ATM encapsulation for transporting IP traffic between two peers.

**Note**

You cannot add modules to a U-VNE created using the GenericUVNE template.

Module templates are collected into groups, such as the ciscophysicalspect2 group for Cisco modules. The information contained in the module specification files is summarized in the Module Groups and Module Specification Files, page B-66.

**Note**

Module definitions that you create with the VCB are added to the module group that contains the template on which the definition is based.

After you obtain the module identifier and research the capabilities of the module, use Module Templates by Technology, page B-69 to identify the module template that best matches the module. You can then add support for the module using the VCB.

This section contains the following topics:

- Module Groups and Module Specification Files, page B-66
- Module Templates by Technology, page B-69

### Module Groups and Module Specification Files

**Note**

Unlike the modeling that Prime Network does for standard modules, Prime Network models only the ports for pluggable modules. The only module group for pluggable modules is the pluggable-ports-spec file. The remainder of this section applies to standard modules only (not pluggable modules).

A module group is the name of a vendor-specific module specification file that is stored in the Prime Network registry. A module specification file is an XML file that lists supported modules and other properties, such as port layers and sysOID. When you use `vcb module` commands to add, modify, or delete a module:

- You provide the name of a module specification file as an argument to the `-group` option. (For more information, see VCB CLI Command Reference: Standard Modules, page B-18.)
- The VCB modifies the module specification file: adding, updating, or deleting the module definition.

**Note**

The VCB allows you to update and delete only those modules that you added using the VCB.
Prime Network enables you to extend the following module specification files:
- ciscophysicalspec2
- ciscocatalyst3400spec
- cisco-catalyst-spec

Table B-69 summarizes the technologies that are supported and the module templates that are provided in the module specification files. For more information about a module template, use the link in the Technologies column.

**Table B-69 Module Group Summary for Standard Modules**

<table>
<thead>
<tr>
<th>Module Group</th>
<th>Technologies</th>
<th>Template Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>ciscophysicalspec2</td>
<td>Ethernet (Fixed), page B-69</td>
<td>• A10GigaEthernet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ethernet-default-over-optic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ethernetDefault</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• gigaEthernet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• EthernetChannelSwitchDefault</td>
</tr>
<tr>
<td>Ethernet (Multiloader), page B-70</td>
<td></td>
<td>• 10Gigaethernet-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gigaethernet-Fiber</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• GE-fiberoptic-ethernet-default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ethernetDefault-RJ45-or-Fiber2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• E1orGigabitTechnology2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• GE-over-OC12-pos-default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• GE-over-OC3-pos-default3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ethernet-or-oc-pos-default3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ethernet-or-OC12-pos-default3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ethernet-or-oc48-pos-default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DWDMA10GigaEthernet</td>
</tr>
<tr>
<td>POS (Fixed), page B-72</td>
<td></td>
<td>• PPPdefaultOC48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PPPdefault</td>
</tr>
<tr>
<td>POS (Multiloader), page B-72</td>
<td></td>
<td>• POS-OC3-default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PPPdefaultOC12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PPPdefaultOC192</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PPPdefaultOC3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PPPdefaultOC768</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DWDMOC768</td>
</tr>
</tbody>
</table>
### Table B-69  Module Group Summary for Standard Modules (continued)

<table>
<thead>
<tr>
<th>Module Group</th>
<th>Technologies</th>
<th>Template Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>ciscophysicalspec2 (continued)</td>
<td>Channelized T1/E1 (Fixed), page B-73</td>
<td>• RJ45-T1E1Channelized</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• T1E1Channelized</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• T1E1Channelized-ATMorCEM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• E3Default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• E3Loader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• E1Channelized</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• E1Default</td>
</tr>
<tr>
<td>Channelized OCXX (Fixed), page B-74</td>
<td></td>
<td>• ChannelizedOC3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ChannelizedOC12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ChannelizedOC12xx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ChannelizedOCxx</td>
</tr>
<tr>
<td>ATM (Fixed), page B-74</td>
<td></td>
<td>• atmDefault</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• atmOverOC12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• atm-over-e3ds3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• T1E1_ATM-IMA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ds1Default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ds3Default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• adslDefault</td>
</tr>
<tr>
<td>ATM (Multiloader), page B-75</td>
<td></td>
<td>• T3Channelized</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• T3Loader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• layer2-over-ds1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• layer2-over-ds3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• layer2-over-ds3-over-bnc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pppOverDS3Default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• layer2-over-e1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HSSIDefault</td>
</tr>
<tr>
<td>Multitechnology, page B-76</td>
<td></td>
<td>• 36xxMultiTechnologiesModuleDefault</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 8xxMultiTechnologiesModuleDefault</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MultiTechnologiesModuleLayers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MultiTechnologiesModuleDefault2</td>
</tr>
<tr>
<td>Serial, page B-77</td>
<td></td>
<td>• PPPwithRJ11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• multichannelDefault</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• serialPPPoDefault</td>
</tr>
<tr>
<td>ISDN, page B-78</td>
<td></td>
<td>• ds1T1Default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• BRIDefault</td>
</tr>
</tbody>
</table>

Cisco Prime Network 4.0 Customization Guide
This section presents module templates organized by technology:

- Ethernet (Fixed), page B-69
- Ethernet (Multiloader), page B-70
- POS (Fixed), page B-72
- POS (Multiloader), page B-72
- Channelized T1/E1 (Fixed), page B-73
- Channelized OCXX (Fixed), page B-74
- ATM (Fixed), page B-74
- ATM (Multiloader), page B-75
- Multitechnology, page B-76
- Serial, page B-77
- ISDN, page B-78
- Generic, page B-78
- Ethernet (Cisco Catalyst 3400), page B-79
- Ethernet (Cisco Catalyst), page B-79

**Ethernet (Fixed)**

Table B-70 lists module templates that support EthernetCSMA/CD at Layer 1 and a single connector type at Layer 0. When there is more than one Layer 2 option, Layer 2 is modeled based on transmission rate.
Module Group

These templates are defined in the ciscophysicalspec2 module group.

Table B-70  Module Templates—Ethernet (Fixed)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>A10GigaEthernet</td>
<td>Fiber optic</td>
<td>EthernetCSMA/CD</td>
<td>10 Gigabit Ethernet</td>
<td>• WS-SUP32-10GE-3B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• 7600-ES+2TG</td>
</tr>
<tr>
<td>ethernet-default-over-optic</td>
<td>Fiber optic</td>
<td>EthernetCSMA/CD</td>
<td>• Ethernet</td>
<td>• WS-6700-DFC3B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Fast Ethernet</td>
<td>• WS-6700-DFC3BXL</td>
</tr>
<tr>
<td>ethernetDefault</td>
<td>RJ45</td>
<td>EthernetCSMA/CD</td>
<td>• Ethernet</td>
<td>• 8FE-TX-RJ45</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Fast Ethernet</td>
<td>• SPA-8X1FE-TX-V2</td>
</tr>
<tr>
<td>gigaEthernet</td>
<td>Fiber optic</td>
<td>EthernetCSMA/CD</td>
<td>Gigabit Ethernet</td>
<td>• WS-X4624-SFP-E</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• 7600-ES+3C</td>
</tr>
<tr>
<td>EthernetChannelSwitchDefault</td>
<td>RJ45</td>
<td>EthernetCSMA/CD</td>
<td>EtherChannel</td>
<td>NM-16ESW</td>
</tr>
</tbody>
</table>

Ethernet (Multiloader)

Table B-71 lists Ethernet module templates that support multiple options at more than one port layer.

Module Group

These templates are defined in the ciscophysicalspec2 module group.

Note

In addition to Ethernet, some module templates in Table B-71 also support POS or DWDM ports. (See the footnotes for Table B-71.)

Table B-71  Module Templates—Ethernet (Multiloader)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>10Gigaethernet-Gigaethernet-Fiber¹</td>
<td>Fiber optic • RJ45</td>
<td>EthernetCSMA/CD</td>
<td>• 10 Gigabit Ethernet</td>
<td>• 76-ES+XC-20G3C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Gigabit Ethernet</td>
<td>• WS-X45-SUP6-E</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• WS-X4606-X2-E</td>
</tr>
<tr>
<td>GE-fiberoptic-ethernet-default²</td>
<td>RJ45</td>
<td>EthernetCSMA/CD</td>
<td>• Ethernet</td>
<td>catalyst375024ME (cevModuleCat375024M)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Fast Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td>ethernetDefault-RJ45-or-Fiber³</td>
<td>Fiber optic • RJ45</td>
<td>EthernetCSMA/CD</td>
<td>• Ethernet</td>
<td>• WS-X4232-RJ-XX</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Fast Ethernet</td>
<td>• WS-X4524-GB-RJ45V</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td>Template Name</td>
<td>Layer 0</td>
<td>Layer 1</td>
<td>Layer 2</td>
<td>Example Modules</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>E1orGigabitTechnology^2</td>
<td>• RJ45</td>
<td>EthernetCSMA/CD</td>
<td>• Ethernet</td>
<td>Motherboard for 2941 (cevCpu2941)</td>
</tr>
<tr>
<td></td>
<td>• Fiber optic</td>
<td></td>
<td>• Fast Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• RJ48</td>
<td>DS1/E1</td>
<td>• Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td>GE-over-OC12-pos-default^3</td>
<td>Fiber optic</td>
<td>OC12</td>
<td>• PPP</td>
<td>OSM-4OC12-POS-SI+</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>EthernetCSMA/CD</td>
<td>• Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td>GE-over-OC3-pos-default^4</td>
<td>Fiber optic</td>
<td>OC3</td>
<td>• PPP</td>
<td>OSM-4OC3-POS-SI+</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RJ45</td>
<td>EthernetCSMA/CD</td>
<td>• Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td>ethernet-or-oc-pos-default^5</td>
<td>Fiber optic</td>
<td>OC3</td>
<td>• PPP</td>
<td>OSM-2+4GE-WAN+</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>EthernetCSMA/CD</td>
<td>• Fast Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 10 Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td>ethernet-or-OC12-pos-default^3</td>
<td>Fiber optic</td>
<td>OC12</td>
<td>• PPP</td>
<td>OSM-2OC12-POS-SI+</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td>OSM-2OC12-POS-SI+</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EthernetCSMA/CD</td>
<td>• Fast Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 10 Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td>ethernet-or-oc48-pos-default</td>
<td>Fiber optic</td>
<td>OC48</td>
<td>• PPP</td>
<td>OSM-1OC48-POS-SI+</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>EthernetCSMA/CD</td>
<td>• Fast Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 10 Gigabit Ethernet</td>
<td></td>
</tr>
<tr>
<td>DWDMA10GigaEthernet^4</td>
<td>Fiber optic</td>
<td>• DWDM</td>
<td>10 Gigabit Ethernet</td>
<td>76-ES+XT-2TG3CXL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• EthernetCSMA/CD</td>
<td></td>
<td>76-ES+XT-4TG3C</td>
</tr>
</tbody>
</table>

1. The connector type is modeled as RJ45 only for a Gigabit Ethernet port that is not pluggable. The connector type for other Gigabit Ethernet and 10 Gigabit Ethernet ports is modeled as fiber optic.
2. The connector type is modeled based on transmission rate.
3. This module template supports either Ethernet or POS ports.
4. This module template supports either Ethernet or DWDM ports.
POS (Fixed)

Table B-72 lists POS module templates that support fixed Layer 0 (fiber optic) and Layer 1 (OC3, OC12, or OC48) options.

**Module Group**
These templates are defined in the ciscophysicalspec2 module group.

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps) Supported</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPPdefaultOC48</td>
<td>2488.32 Fiber optic OC48</td>
<td>• PPP</td>
<td></td>
<td>• HDLC</td>
<td>• SFP-OC48-IR1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
<td></td>
<td>• gsr-e-qoc48-sm-Ir-sc</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• 16OC48-POS/DPT</td>
</tr>
<tr>
<td>PPPdefault</td>
<td>155.52 Fiber optic OC3</td>
<td>• PPP</td>
<td>• HDLC</td>
<td>• Frame relay</td>
<td>• GSR-SFC6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• GSR-CSC</td>
</tr>
</tbody>
</table>

POS (Multiloader)

Table B-73 lists templates for POS modules with multiple Layer 2 options.

**Module Group**
These templates are defined in the ciscophysicalspec2 module group.

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps) Supported</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>POS-OC3-default</td>
<td>155.52 Fiber optic OC3</td>
<td>• PPP</td>
<td>• HDLC</td>
<td>• Frame Relay</td>
<td>SPA-8XOC12-POS</td>
</tr>
<tr>
<td>PPPdefaultOC12</td>
<td>622.08 Fiber optic OC12</td>
<td>• PPP</td>
<td>• HDLC</td>
<td>• Frame Relay</td>
<td></td>
</tr>
<tr>
<td>PPPdefaultOC192</td>
<td>9,953.28 Fiber optic OC192</td>
<td>• PPP</td>
<td>• HDLC</td>
<td></td>
<td>SPA-OC192POS-LR</td>
</tr>
<tr>
<td>PPPdefaultOC3</td>
<td>155.52 Fiber optic OC3</td>
<td>• PPP</td>
<td>• HDLC</td>
<td>• Frame Relay</td>
<td>• SFP-OC3-SR</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• SFP-OC3-IR1</td>
</tr>
</tbody>
</table>
### Table B-73  Module Templates—POS (Multiloader) (continued)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps) Supported</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPPdefaultOC768</td>
<td>39,813.12</td>
<td>Fiber optic</td>
<td>OC768</td>
<td>• PPP</td>
<td>1OC768-ITU/C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Frame Relay</td>
<td></td>
</tr>
<tr>
<td>DWDMOC768</td>
<td>39,813.12</td>
<td>Fiber optic</td>
<td>OC768</td>
<td>• PPP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
</tbody>
</table>

### Channelized T1/E1 (Fixed)

Table B-74 lists templates for channelized T1/E1 modules where port layers are fixed.

**Module Group**

These templates are defined in the ciscophysicalspec2 module group.

### Table B-74  Module Templates—Channelized T1/E1 (Fixed)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps) Supported</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>RJ45-T1E1Channelized</td>
<td>1.544</td>
<td>RJ45</td>
<td>T1E1</td>
<td>—</td>
<td>SPA-8XCHT1/E1</td>
</tr>
<tr>
<td>T1E1Channelized</td>
<td>1.544</td>
<td>RJ48</td>
<td>T1E1</td>
<td>—</td>
<td>• NM-2CE1T1-PRI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• PA-MC-4T1</td>
<td></td>
</tr>
<tr>
<td>T1E1Channelized-ATMorCEM†</td>
<td>1.544</td>
<td>RJ48</td>
<td>T1E1</td>
<td>—</td>
<td>HWIC-4T1/E1</td>
</tr>
<tr>
<td>E3Default</td>
<td>44.736</td>
<td>BNC</td>
<td>DS3</td>
<td>—</td>
<td>ESR-8E3/DS3</td>
</tr>
<tr>
<td>E3Loader</td>
<td>44.736</td>
<td>BNC</td>
<td>DS3</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>E1Channelized</td>
<td>1.544</td>
<td>RJ48</td>
<td>E1</td>
<td>—</td>
<td>PA-8CE1</td>
</tr>
<tr>
<td>E1Default</td>
<td>1.544</td>
<td>RJ45</td>
<td>E1T1</td>
<td>—</td>
<td>VWIC2-1MFT-T1E1</td>
</tr>
</tbody>
</table>

1. Layer 2—ATM or CEM—is built at runtime.
**Channelized OCXX (Fixed)**

Table B-75 lists templates for Optical Carrier modules where port layers are fixed.

**Module Group**

These templates are defined in the ciscophysicalspec2 module group.

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps)</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>ChannelizedOC3</td>
<td>155.52</td>
<td>Fiber optic</td>
<td>OC3</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>ChannelizedOC12</td>
<td>622.08</td>
<td>Fiber optic</td>
<td>OC12</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>ChannelizedOC12xx</td>
<td>622.08</td>
<td>Fiber optic</td>
<td>OC12</td>
<td>—</td>
<td>SPA-1XCHOC12/DS0</td>
</tr>
<tr>
<td></td>
<td>Note: See CSCtd93353 in CDETs.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ChannelizedOCxx</td>
<td>155.52</td>
<td>Fiber optic</td>
<td>OC3</td>
<td>—</td>
<td>SPA-1XCHSTM1/OC3</td>
</tr>
<tr>
<td></td>
<td>Note: See CSCtd93353 in CDETs.</td>
<td></td>
<td></td>
<td></td>
<td>SPA-CHOC3-CE-ATM</td>
</tr>
</tbody>
</table>

**ATM (Fixed)**

Table B-76 lists templates for ATM modules where port layers are fixed.

**Module Group**

These templates are defined in the ciscophysicalspec2 module group.

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps)</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>atmDefault</td>
<td>155.52</td>
<td>Fiber optic</td>
<td>OC3</td>
<td>ATM</td>
<td>GSR-SFC12410</td>
</tr>
<tr>
<td>atmOverOC12</td>
<td>—</td>
<td>Fiber optic</td>
<td>OC12</td>
<td>ATM</td>
<td>· SPA-1XOC12-ATM-V2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>· SPA-1XOC12-ATM</td>
</tr>
<tr>
<td>atm-over-e3ds3</td>
<td>—</td>
<td>RJ48</td>
<td>DS3</td>
<td>ATM</td>
<td></td>
</tr>
<tr>
<td>T1E1_ATM-IMA</td>
<td>1.544</td>
<td>RJ48</td>
<td>T1E1</td>
<td>ATM</td>
<td></td>
</tr>
<tr>
<td>ds1Default</td>
<td>—</td>
<td>BNC</td>
<td>DS1</td>
<td>ATM</td>
<td></td>
</tr>
</tbody>
</table>
### Table B-76  Module Templates—ATM (Fixed) (continued)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps) Supported</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>ds3Default</td>
<td>—</td>
<td>BNC</td>
<td>DS3</td>
<td>ATM</td>
<td>PA-A3-T3</td>
</tr>
<tr>
<td>adslDefault</td>
<td>—</td>
<td>RJ11</td>
<td>ADSL</td>
<td>ATM</td>
<td>WIC-1SHDSL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>WIC-1ADSL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>WIC-1ADSL-DG</td>
</tr>
</tbody>
</table>

#### ATM (Multiloader)

Table B-77 lists templates for ATM modules with multiple Layer 2 options.

### Module Group

These templates are defined in the ciscophysicalspec2 module group.

### Table B-77  Module Templates—ATM (Multiloader)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps) Supported</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>T3Channelized1</td>
<td>—</td>
<td>BNC</td>
<td>DS3</td>
<td>• PPP</td>
<td>SPA-2XCT3/DS0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td>PA-2T3/E3-EC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• ATM</td>
<td></td>
</tr>
<tr>
<td>T3Loader</td>
<td>—</td>
<td>BNC</td>
<td>DS3</td>
<td>• PPP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• ATM</td>
<td></td>
</tr>
<tr>
<td>layer2-over-ds1</td>
<td>1.544</td>
<td>RJ48</td>
<td>DS1</td>
<td>• PPP</td>
<td>VWIC-2MFT-T1-DIR</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• ATM</td>
<td></td>
</tr>
<tr>
<td>layer2-over-ds3</td>
<td>44.736</td>
<td>RJ48</td>
<td>DS3</td>
<td>• PPP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• ATM</td>
<td></td>
</tr>
<tr>
<td>layer2-over-ds3-over-bnc</td>
<td>44.736</td>
<td>BNC</td>
<td>DS3</td>
<td>• PPP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• ATM</td>
<td></td>
</tr>
</tbody>
</table>
Table B-77  Module Templates — ATM (Multiloader) (continued)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (Mbps) Supported</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>pppOverDS3Default</td>
<td>44.736</td>
<td>BNC</td>
<td>DS3</td>
<td>• PPP</td>
<td>• copper-6ds3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td>• copper-12ds3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• 2DS3-SMB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• NM-4T</td>
</tr>
<tr>
<td>layer2-over-e1</td>
<td>1.544</td>
<td>RJ48</td>
<td>E1</td>
<td>• PPP</td>
<td>NM-1CE1T1-PRI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• ATM</td>
<td></td>
</tr>
<tr>
<td>HSSIDefault</td>
<td>—</td>
<td>DB50</td>
<td>HSSI</td>
<td>• PPP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
</tr>
</tbody>
</table>

1. This module template supports both full and channelized T3 and ATM over T3.

Multitechnology

Table B-78 lists multitechnology templates, including the following, which support modules where the connector type is not determined:

- MultiTechnologiesModuleLayers
- MultiTechnologiesModuleDefault

Note

Do not use these templates unless no other template matches the modules to be added.

Module Group

These templates are defined in the ciscophysicalspec2 module group.

Table B-78  Module Templates — Multitechnology

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>36xxMultiTechnologiesModuleDefault&lt;sup&gt;1&lt;/sup&gt;</td>
<td>RJ45</td>
<td>• EthernetCSMA/CD</td>
<td>• Fast Ethernet</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gigabit Ethernet</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Serial</td>
<td>• PPP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• HDLC</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Frame relay</td>
<td></td>
</tr>
</tbody>
</table>
### Table B-78  Module Templates—Multitechnology (continued)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
</table>
| 8xxMultiTechnologiesModuleDefault | RJ45 | • EthernetCSMA/CD  
• Serial | • Fast Ethernet  
• Gigabit Ethernet | — |
| MultiTechnologiesModuleLayers² | RJ11  
• RJ45  
• RJ48  
• Fiber optic  
• DB60 | • EthernetCSMA/CD  
• DS1  
• E1  
• OC3  
• ADSL  
• Serial | • Fast Ethernet  
• Gigabit Ethernet  
• PPP  
• HDLC  
• Frame relay | OSM-1CHOCL2/T3-SI |
| MultiTechnologiesModuleDefault³ | RJ11  
• RJ45  
• RJ48  
• Fiber optic  
• DB60 | • EthernetCSMA/CD  
• DS1  
• E1  
• OC3  
• ADSL  
• Serial | • Fast Ethernet  
• Gigabit Ethernet  
• PPP  
• HDLC  
• Frame relay  
• ATM | gsr-sfc16-oc192 |

1. This module template primarily supports Cisco 3600 series modules.
2. Use this template only when no other template matches the modules to be supported.

### Serial

Table B-79 lists templates that provide support for modules with serial interfaces when the information for Layer 1 is not clear.

### Module Group

These templates are defined in the ciscophysicalsce2 module group.

### Table B-79  Module Templates—Serial

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPPwithRJ11</td>
<td>RJ11</td>
<td>Serial</td>
<td>PPP</td>
<td>WIC-1AM-V2</td>
</tr>
<tr>
<td>multichannelDefault</td>
<td>RJ48</td>
<td>Serial</td>
<td>PPP</td>
<td>—</td>
</tr>
</tbody>
</table>
| serialPPPDefault | RJ45  
• RJ48  
• Fiber optic  
• DB60  
• Generic connector | Serial | • PPP  
• HDLC  
• Frame relay | • HWIC-4T  
• NM-2W  
• WIC-SERIAL-1T |
ISDN

Table B-80 lists templates for ISDN modules.

**Module Group**

These templates are defined in the ciscophysicalspec2 module group.

### Table B-80 Module Templates—ISDN

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Maximum Transmission Rate (kbps) Supported</th>
<th>Layer 0¹</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>ds1T1Default</td>
<td></td>
<td>• RJ45</td>
<td>• DS1</td>
<td>ISDN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• RJ48</td>
<td>• E1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DB60</td>
<td>• EthernetCSMA/CD</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fiber optic</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BRIDefault</td>
<td>64</td>
<td>RJ45</td>
<td>ISDN layer 1</td>
<td>ISDN layer 2</td>
<td>WIC-1B-U-V2</td>
</tr>
</tbody>
</table>

¹. The connector type is modeled based on the type of port.

Generic

Table B-81 lists generic templates. Use them to configure modules for technologies that Prime Network does not support.

**Module Group**

These templates are defined in the ciscophysicalspec2 module group.

### Table B-81 Module Templates—Generic

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>TSLineDefault¹</td>
<td>Generic connector</td>
<td>Generic Layer 1</td>
<td>—</td>
<td>• NM-16A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• NM-32A</td>
</tr>
<tr>
<td>generic-port¹</td>
<td>Generic connector</td>
<td>Generic Layer 1</td>
<td>Generic Layer 2</td>
<td>—</td>
</tr>
<tr>
<td>voiceEMDefault²</td>
<td>RJ45</td>
<td>Generic Layer 1</td>
<td>Generic Layer 2</td>
<td>• VIC-EM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• VIC-4VP-FXS-DID</td>
</tr>
</tbody>
</table>

¹. This template provides support for modules whose technologies are not currently supported in Prime Network.

². This template provides support for voice modules.
Ethernet (Cisco Catalyst 3400)

Table B-82 lists templates that support modules for the Cisco Catalyst 3400 device group.

**Module Group**

These templates are defined in the ciscocatalyst3400spec module group.

### Table B-82 Module Templates—Ethernet (Cisco Catalyst 3400)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>cisco-3400-MultiTechnologies ModuleDefault</td>
<td>RJ45</td>
<td>EthernetCSMA/CD</td>
<td>Ethernet</td>
<td>3400 fixed modules</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td></td>
<td></td>
<td></td>
<td>Not recommended for 10/100/1000 Ethernet ports. Instead, use cisco-3400-ethernetDefault-RJ45-or-Fiber. (See CSCtd93353 in CDETs.)</td>
</tr>
<tr>
<td>cisco-3400-ethernetDefault-RJ45-or-Fiber</td>
<td>• RJ45</td>
<td>• Fiber optic</td>
<td>• Ethernet</td>
<td>3400 fixed modules</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• FastEthernet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• GigaEthernet</td>
<td></td>
</tr>
</tbody>
</table>

Ethernet (Cisco Catalyst)

**Note**

For modules in the Cisco Catalyst 3400 device group, see Ethernet (Cisco Catalyst 3400).

Table B-83 lists templates that support modules for Cisco Catalyst devices.

**Module Group**

These templates are defined in the cisco-catalyst-spec module group.

### Table B-83 Module Templates—Ethernet (Cisco Catalyst)

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Layer 0</th>
<th>Layer 1</th>
<th>Layer 2</th>
<th>Example Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>EthernetDefault</td>
<td>RJ45</td>
<td>EthernetCSMA/CD</td>
<td>Ethernet</td>
<td>• WS-C3560G-24TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• WS-SUP720-3BXL</td>
</tr>
<tr>
<td>FastEthernetDefault</td>
<td>RJ45</td>
<td>EthernetCSMA/CD</td>
<td>FastEthernet</td>
<td>• WS-X4148-RJ</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td></td>
<td></td>
<td></td>
<td>• ws-c2924-xl-v</td>
</tr>
<tr>
<td>GigaEthernetDefault</td>
<td>RJ45</td>
<td>EthernetCSMA/CD</td>
<td>GigaEthernet</td>
<td>• WS-F6K-MSFC2A</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td></td>
<td></td>
<td></td>
<td>• OSM-2+4GE-WAN+</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: CSCtd93353 in CDETs.
Event Templates

Event templates work together to extract information from a syslog or a trap and to generate the keys and the location ID for associating a Prime Network event with a managed element device component. For more information, see the following sections:

- Terminology Used in Event Templates, page B-80
- Supported Interface Types, page B-81
- Event Templates Functional Summary, page B-81
- Event Templates Input Summary—Required and Optional Input, page B-83

For information about specific template types, see the following sections:

- Event Identification Templates, page B-85
- Unique ID Templates—for Traps Only, page B-87
- Event Subtype Templates, page B-88
- Entity ID Templates—for Traps Only, page B-90
- Entity Key Templates, page B-91
- Prime Network Event Templates, page B-93

Terminology Used in Event Templates

The following terms are used in the tables in this section.

**Entity ID**

The entity ID identifies the entity in the VNE with which to associate the event. For example, for interface-based events, ifIndex or ifName can be used as the entity ID.

**Unique ID**

The unique ID is used to create a unique location for the event when association to the exact entity is not possible. For example, when associating BGP traps to the Managed Element, the neighbor IP address can be used as the unique ID.
Supported Interface Types

The VCB can automatically identify the following interface types and associates events to them:

- Ether Channel
- GRE Tunnel
- DSO Bundle
- MPLSTunnel
- IMA Group
- MLPPP
- CEM Group
- IpInterface (Loopback, Vlan, all other subinterfaces)

For other interface types, the VCB associates the event to the layer 1 device component.

Event Templates Functional Summary

Event templates extract information and generate keys to associate an event with the correct VNE or U-VNE component. Table B-84 lists event templates (by type) and explains what each template does.

<table>
<thead>
<tr>
<th>Table B-84 Event Template Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Template</strong></td>
</tr>
<tr>
<td><strong>Event Identification Templates—Mandatory. Use one.</strong></td>
</tr>
<tr>
<td>snmp-trap-identification</td>
</tr>
<tr>
<td>syslog-identification</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Event Subtype Templates—Optional. Use one if there are subtypes for the event.</strong></td>
</tr>
<tr>
<td>snmp-trap-subtype-from-oid</td>
</tr>
<tr>
<td>snmp-trap-subtype-from-trapoid</td>
</tr>
<tr>
<td>snmp-trap-subtype-from-value</td>
</tr>
<tr>
<td>syslog-subtype-from-expression</td>
</tr>
</tbody>
</table>
## Table B-84  Event Template Functions (continued)

<table>
<thead>
<tr>
<th>Template</th>
<th>Performs This Function for a...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Syslog</td>
</tr>
<tr>
<td>Unique ID Templates—Optional.</td>
<td>Use one when you cannot associate the event to an exact entity.</td>
</tr>
<tr>
<td>snmp-trap-identifier-from-oid</td>
<td>—</td>
</tr>
<tr>
<td>snmp-trap-identifier-from-value</td>
<td>Extracts the unique ID</td>
</tr>
<tr>
<td>Entity ID Templates—Optional.</td>
<td>Use one when you can associate the event to an exact entity.</td>
</tr>
<tr>
<td>snmp-trap-entity-from-oid</td>
<td>—</td>
</tr>
<tr>
<td>snmp-trap-entity-from-value</td>
<td>Extracts the entity ID</td>
</tr>
<tr>
<td>Entity Key Templates—Mandatory.</td>
<td>Use one.</td>
</tr>
<tr>
<td>create-managedelement-key</td>
<td>• Creates the device component key</td>
</tr>
<tr>
<td></td>
<td>• Associates the event with the Managed Element device component</td>
</tr>
<tr>
<td>create-interface-key-from-ifindex</td>
<td>Creates the interface device component key from the ifIndex, using the entity ID that was extracted by an entity ID template (snmp-trap-entity-from-oid or snmp-trap-entity-from-value)</td>
</tr>
<tr>
<td></td>
<td>Associates the event with the appropriate interface layer; see Supported Interface Types, page B-81</td>
</tr>
<tr>
<td>create-interface-key-from-ifname</td>
<td>• Creates the interface device component key from the ifname, using the entity ID that was extracted by:</td>
</tr>
<tr>
<td></td>
<td>– syslog-identification template for a syslog</td>
</tr>
<tr>
<td></td>
<td>– an entity ID template (snmp-trap-entity-from-oid or snmp-trap-entity-from-value) for a trap</td>
</tr>
<tr>
<td></td>
<td>• Associates the event with the appropriate interface layer; see Supported Interface Types, page B-81</td>
</tr>
<tr>
<td>Note</td>
<td>This template is more frequently used with syslogs than with traps.</td>
</tr>
</tbody>
</table>

### Prime Network Event Templates—Mandatory. Use one.

<table>
<thead>
<tr>
<th>Template</th>
<th>Performs This Function for a...</th>
</tr>
</thead>
<tbody>
<tr>
<td>create-ana-trap-event</td>
<td>Creates both of the following:</td>
</tr>
<tr>
<td></td>
<td>• A unique location for the event, based on the entity ID (device component key) or the unique ID (extracted by an entity ID or a unique ID template)</td>
</tr>
<tr>
<td></td>
<td>• Prime Network event, using subtypes extracted by an event subtype template:</td>
</tr>
<tr>
<td></td>
<td>– snmp-trap-subtype-from-oid</td>
</tr>
<tr>
<td></td>
<td>– snmp-trap-subtype-from-trapoid</td>
</tr>
<tr>
<td></td>
<td>– snmp-trap-subtype-from-value</td>
</tr>
</tbody>
</table>
### Table B-84  
**Event Template Functions (continued)**

<table>
<thead>
<tr>
<th>Template</th>
<th>Performs This Function for a...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Syslog</td>
</tr>
<tr>
<td>create-ana-syslog-event</td>
<td>Creates both of the following:</td>
</tr>
<tr>
<td></td>
<td>• A unique location for the event, based on entity ID (device component key) or unique ID (extracted by the syslog-identification template).</td>
</tr>
<tr>
<td></td>
<td>• Prime Network event, using subtypes extracted by the syslog-identification template.</td>
</tr>
<tr>
<td></td>
<td>Trap</td>
</tr>
</tbody>
</table>

For the input required for each template, see Event Templates Input Summary—Required and Optional Input, page B-83.

### Event Templates Input Summary—Required and Optional Input

Table B-85 summarizes event templates and the mandatory and optional input arguments for them.

### Table B-85  
**Event Template Variables**

<table>
<thead>
<tr>
<th>Templates</th>
<th>Variable Name</th>
<th>Variable Type</th>
<th>Variable Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Identification Templates</td>
<td>expression</td>
<td>Mandatory</td>
<td>Regular expression to match against the incoming syslog message.</td>
</tr>
<tr>
<td></td>
<td>testmessage</td>
<td>Optional</td>
<td>String that is an example of the actual syslog message.</td>
</tr>
<tr>
<td></td>
<td>oid</td>
<td>Mandatory</td>
<td>SNMP trap OID.</td>
</tr>
<tr>
<td>Unique ID Templates</td>
<td>inOID</td>
<td>Mandatory</td>
<td>Partial string that uniquely identifies the required OID in the varbind list.</td>
</tr>
<tr>
<td></td>
<td>index</td>
<td>Optional</td>
<td>Used to create a unique location ID for the event when association to the exact entity is not possible. Default value is 1.</td>
</tr>
<tr>
<td></td>
<td>inOID</td>
<td>Mandatory</td>
<td>Partial string that uniquely identifies the required OID in the varbind list.</td>
</tr>
</tbody>
</table>
### Event Subtype Templates

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Type</th>
<th>Variable Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>snmp-trap-subtype-from-oid</td>
<td>inOID</td>
<td>Mandatory Partial string that uniquely identifies the required OID in the varbind list.</td>
</tr>
<tr>
<td></td>
<td>replacing-rules</td>
<td>Defines mapping between event subtype and value in the trap that indicates the subtype.</td>
</tr>
<tr>
<td></td>
<td>index</td>
<td>Optional Used to create a unique location ID for the event when association to the exact entity is not possible. Default value is 1.</td>
</tr>
<tr>
<td>snmp-trap-subtype-from-trapoid</td>
<td>replacing-rules</td>
<td>Mandatory Defines the mapping between event subtype and value in the trap that indicates the subtype.</td>
</tr>
<tr>
<td>snmp-trap-subtype-from-value</td>
<td>inOID</td>
<td>Mandatory Partial string that uniquely identifies the required OID in the varbind list.</td>
</tr>
<tr>
<td></td>
<td>replacing-rules</td>
<td>Defines the mapping between event subtype and value in the trap that indicates the subtype.</td>
</tr>
<tr>
<td>syslog-subtype-from-expression</td>
<td>replacing-rules</td>
<td>Mandatory Defines the mapping between event subtype and value in the trap that indicates the subtype.</td>
</tr>
</tbody>
</table>

### Entity ID Templates

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Variable Type</th>
<th>Variable Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>snmp-trap-entity-from-oid</td>
<td>inOID</td>
<td>Mandatory Partial string that uniquely identifies the required OID in the varbind list.</td>
</tr>
<tr>
<td></td>
<td>index</td>
<td>Optional Used to create a unique location ID for the event when association to the exact entity is not possible. Default value is 1.</td>
</tr>
<tr>
<td>snmp-trap-entity-from-value</td>
<td>inOID</td>
<td>Mandatory Partial string that uniquely identifies the required OID in the varbind list.</td>
</tr>
</tbody>
</table>

### Entity Key Templates

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>create-interface-key-from-ifindex</td>
<td>—</td>
</tr>
<tr>
<td>create-interface-key-from-ifname</td>
<td>—</td>
</tr>
<tr>
<td>create-managedelement-key</td>
<td>—</td>
</tr>
</tbody>
</table>

### Prime Network Event Templates

<table>
<thead>
<tr>
<th>Template Name</th>
<th>Type</th>
<th>Variable Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>create-ana-trap-event</td>
<td>type</td>
<td>Event name, a string that must match the event name used to create the Prime Network event using the <code>vcb event add</code> command.</td>
</tr>
<tr>
<td></td>
<td>subtype</td>
<td>Event subtype name, a string that must match the subtype name used to create the Prime Network event using the <code>vcb event add</code> command.</td>
</tr>
</tbody>
</table>
**Event Identification Templates**

Event identification templates are mandatory. You must use one of these templates:

- **snmp-trap-identification**, page B-85
- **syslog-identification**, page B-86

### snmp-trap-identification

This template supports SNMP V1, V2, and V3 traps. Any incoming SNMP V1 traps are converted automatically to SNMP V2 and then parsed as SNMP V2 traps. (The first rule in this template is the conversion rule.)

#### Mandatory Input

- **oid**—The trap OID. Table B-86 describes how to format the OID for different traps.

#### Table B-86 Template Input—snmp-trap-identification

<table>
<thead>
<tr>
<th>If the OID...</th>
<th>Format Input Like This...</th>
<th>Example Input String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is for a V1 trap</td>
<td>Supply the enterprise OID appended by 0 and then by the specific type.</td>
<td>—</td>
</tr>
<tr>
<td>Contains subtype information as these do:</td>
<td>Remove subtype information from the input string.</td>
<td>1.3.6.1.4.1.9.10.65.2.0.5</td>
</tr>
<tr>
<td>- mplsLdpLibLspUp - 1.3.6.1.4.1.9.10.65.2.0.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- mplsLdpLibLspDown - 1.3.6.1.4.1.9.10.65.2.0.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Is an informational trap as this one is: mplsLdpPathVectorLimitMismatch - 1.3.6.1.4.1.9.10.65.2.0.2</td>
<td>Supply the entire OID.</td>
<td>1.3.6.1.4.1.9.10.65.2.0.2</td>
</tr>
</tbody>
</table>
This template supports syslogs. This template contains a single rule that extracts not only event identification information, but also subtype, unique ID, and entity ID when they are available for the event.

**Mandatory Input**

**expression**—A regular expression to be matched against the incoming syslog message.

The input string need not be a complete regular expression. It can be a partial syslog message with the parameters in which you are interested marked using keywords. Replace event-specific parameters in the syslog message with the following keywords:

- %%subtypekey%%—Use when the substring represents an event subtype.
- %%uniqueid%%—Use when the substring represents a parameter that uniquely identifies the event.
- %%entityid%%—Use when the substring represents the associated entity of the event.

For example, for the following syslogs:

%C6KENV-4-CLOCKFAILED: clock [dec] failed

%C6KENV-4-CLOCKOK: clock [dec] operational

you could provide the following input string:

%%C6KENV-4-CLOCK%%: clock %%uniqueid%%

There are no %%entityid%% parameters in this example, because this syslog must be associated with the ManagedElement device component.

The VCB uses the input string to automatically create a regular expression:

```
\.*C6KENV-4-CLOCK\((S+)\):clock \((S+)\).*
```

There are instance when we require more than one input to uniquely identify the entity in the VNE. VCB allows you to subscript the keywords %%entityid%% and %%uniqueid%% with integers in order to specify more than one input that constitutes the entityid, for example, %%entityid1%%, %%entityid2%%.

For example, for EFP syslogs:

%ETHER_SERVICE-6-UPDOWN: Service instance 111 on interface GigabitEthernet10/0/3 changed to down.

Here, service instance id and interface name are inputs required to uniquely identify the EFP instance in the VNE. Read the template documentation to determine which variable should be marked as entityid1 and which should be marked entityid2.
Optional Input

testmessage—An input string that supplies an example of the actual syslog message. For example:
%C6KENV-4-CLOCKFAILED: clock 1 failed
If supplied, VCB checks this test message against the automatically created regular expression.

Input Format

- syslog_identification_expression regular_expression
- syslog_identification_testmessage message

Unique ID Templates—for Traps Only

Note
For syslogs, unique ID information is extracted by the event identification template. For more
information, see Event Identification Templates, page B-85.

The unique ID differentiates a particular instance of an event from other events of the same type. This
parameter is required when:

- It is not possible to associate the event to the appropriate device component in the VNE for some
  reason, possibly one of the following:
  - The device component is not modeled due to lack of technology support.
  - The corresponding key generation template is not available.
- A unique ID is not required at this time. For example, when Prime Network associates interface
  traps to a managed element device component, the ifIndex or ifName is the unique ID.

Prime Network automatically appends this unique ID to the location, thereby creating a unique
location for each interface despite associating the event with a common entity, the managed element
device component.

These templates differ in the way the information is extracted from the trap; select and use only one of
the following:

- snmp-trap-identifier-from-oid, page B-87
- snmp-trap-identifier-from-value, page B-88

snmp-trap-identifier-from-oid

The rules in this template extract the unique identifier from one of the OIDs in the varbind list of the trap.

Mandatory Input

inOID—A partial string that uniquely identifies the required OID in the varbind list.

Optional Input

index—The location of the required value from the end of the OID. Default value is 1.

Input Format

- snmp_trap_identifier_from_oid_inOID OID
- snmp_trap_identifier_from_oid_index indexValue
snmp-trap-identifier-from-value

The rules in this template extract the unique identifier from the value of one of the OIDs in the varbind list.

**Mandatory Input**

- **inOID**—A partial string that uniquely identifies the required OID in the varbind list.

**Input Format**

```
-snmp_trap_identifier_from_value_inOID OID
```

### Event Subtype Templates

Use an event subtype template when configuring a trap or a syslog that includes event subtypes. For example, you should use an event subtype template when events arrive as a multistatus set or in asserted and cleared pairs, as is the case with link status traps. Link status traps send Link Down and Link Up traps, two subevents that are related to the same event:

- An asserted event indicates that the link is down.
- A clearing event indicates that the link status has changed to up.

Event subtype templates do the following:

- Extract event subtype information for traps. (For syslogs, event subtype information is extracted by the syslog-identification template; see syslog-identification, page B-86.)
- Map the subtype value to the event subtype name defined in Prime Network.

When subtypes exist for a trap, use one of these event subtype templates:

- snmp-trap-subtype-from-oid, page B-88
- snmp-trap-subtype-from-trapoid, page B-89
- snmp-trap-subtype-from-value, page B-89

When subtypes exist for a syslog, use this template:

- syslog-subtype-from-expression, page B-90.

### snmp-trap-subtype-from-oid

The rules in this template extract event subtype information from one of the OIDs in the varbind list of the trap.

**Mandatory Input**

- **inOID**—A partial string that uniquely identifies the required OID in the varbind list.

- **replacing-rules**—Replacing rules define the mapping between the event subtype and the value in the trap that indicates the subtype.

The format for a rule is `value-event subtype`. The hyphen between the value and the event subtype is mandatory. Rules must be comma-separated.

---

**Note**

Supply the same event subtype that was defined for the event with the `vcb event add` command. Use the `vcb event view` command to obtain a list of subtypes.
Optional Input

index—The location of the required value from the end of the OID. Default value is 1.

Input Format

- `snmp_trap_subtype_from_oid_inOID OID`
- `snmp_trap_subtype_from_oid_index indexValue`
- `snmp_trap_subtype_from_oid_replacing_rules value-subtype, value-subtype, value-subtype`

Note

The hyphen between value and subtype is required.

### snmp-trap-subtype-from-trapoid

The rules in this template extract event subtype information from one of the OIDs in the varbind list of the trap.

Mandatory Input

replacing-rules—Replacing rules define the mapping between the event subtype and the value in the trap that indicates the subtype.

The format for a rule is `value-event subtype`. Rules must be comma-separated.

Note

Supply the same event subtype that was defined for the event with the `vcb event add` command. Use the `vcb event view` command to obtain a list of subtypes.

Input Format

- `snmp_trap_subtype_from_trapoid_replacing_rules value-subtype, value-subtype, value-subtype`

### snmp-trap-subtype-from-value

The rules in this template extract the event subtype information from the value of one of the OIDs in the varbind list.

Mandatory Input

- inOID—A partial string that uniquely identifies the required OID in the varbind list.
- replacing-rules—Replacing rules define the mapping between the event subtype and the value in the trap that indicates the subtype.

The format for a rule is `value-event subtype`. Rules must be comma-separated.

Note

Supply the same event subtype that was defined for the event with the `vcb event add` command. Use the `vcb event view` command to obtain a list of subtypes.

Input Format

- `snmp_trap_subtype_from_value_inOID inOID`
- `snmp_trap_subtype_from_value_replacing_rules value-subtype, value-subtype, value-subtype`
syslog-subtype-from-expression

The rules in this template extract the event subtype information from the value of one of the OIDs in the varbind list.

**Mandatory Input**

*replacing-rules*—Replacing rules define the mapping between the event subtype and the value in the trap that indicates the subtype.

The format for a rule is *value-event subtype*. Rules must be comma-separated.

```
Note
Supply the same event subtype that was defined for the event with the vb event add command. use the vb event view command to obtain a list of subtypes.
```

**Input Format**

```
-syslog_subtype_from_expression_replacing_rules value-subtype, value-subtype, value-subtype
```

Entity ID Templates—for Traps Only

```
Note
For syslogs, entity ID information is extracted by an event identification template. For more information, see Event Identification Templates, page B-85.
```

The entity ID specifies the device component to which the event should be associated in the VNE. These templates differ in the way that the information is extracted from the trap:

- [snmp-trap-entity-from-oid](#), page B-90
- [snmp-trap-entity-from-value](#), page B-91

**snmp-trap-entity-from-oid**

The rules in this template extract the entity ID from one of the OIDs in the varbind list of the trap.

**Mandatory Input**

*inOID*—A partial string that uniquely identifies the required OID in the varbind list

**Optional Input**

*index*—The location of the required value from the end of the OID. Default value is 1.

**Input Format**

```
-snmp_trap_entity_from_oid_inOID inOID
```
snmp-trap-entity-from-value

The rules in this template extract the entity ID from the value of one of the OIDs in the varbind list.

**Mandatory Input**

**inOID**—A partial string that uniquely identifies the required OID in the varbind list

**Input Format**

```
-snmp_trap_entity_from_value_inOID  inOID
```

### Entity Key Templates

Selecting a template from this category is mandatory. Entity key templates use the entity ID information—extracted using other templates—to generate a key to uniquely identify the device component in the VNE. The event is later associated with the corresponding device component.

For templates that extract the entity ID, see [syslog-identification](#), page B-86 and [Entity ID Templates—for Traps Only](#), page B-90.

Select one of the following templates:

- [create-interface-key-from-ifindex](#), page B-91
- [create-interface-key-from-ifname](#), page B-91
- [create-managedelement-key](#), page B-91
- [create-efp-key-from-ifname-serviceid](#), page B-92
- [create-logical-container-key](#), page B-92
- [create-moduleDC-key-given-entPhysicalIndex](#), page B-92
- [create-moduleDC-with-slotSubslot-value-key](#), page B-92
- [create-pw-interface-key-from-tunnelindex](#), page B-92

### create-interface-key-from-ifindex

This template creates the interface device component key from the ifIndex and associates the event with the appropriate interface layer.

No input is required.

### create-interface-key-from-ifname

This template creates the interface device component key from an ifName and associates the event with the appropriate interface layer.

No input is required.

### create-managedelement-key

This template creates the managed element device component key, associating the event with the managed element device component.

No input is required.
create-efp-key-from-ifname-serviceid

This template creates the EFP DC key from the Service Instance+ifName.

Note
The service instance ID should be marked as %%entityid1%% and interface name as %%entityid2%% in the syslog expression given by the user.

The event will be associated with particular EFP DC. For example, consider the following:
Syslog Feb 8 11:04:18 MSK: %ETHER_SERVICE-6-UPDOWN: Service instance 214 on interface TenGigabitEthernet3/3 changed to up
The syslog expression for this should be given as %ETHER_SERVICE-6-UPDOWN: Service instance %%entityid1%% on interface %%entityid2%% change to %%subtypekey%%.
No input is required.

create-logical-container-key

This template associates syslog/trap events to the designated containers, as preferred.
Containers list:
CfmService,BfdService,MPBgp,REPService,StpService,SbcService,EthernetLMI,ISISSystem,LSE,Cl
ockService. Provide the desired logical container string, from the containers list.
Requires mandatory user input.

create-moduleDC-key-given-entPhysicalIndex

This template associates trap events to the designated moduleDC, when its observed entPhysicalIndex of Entity-MIB, through mib instrumentation queries from the device; Is given as the input for the desired module entity.
No input is required.

create-moduleDC-with-slotSubslot-value-key

This template associates syslog events to the corresponding module, knowing the residing slot number.
For example, Syslog message "%OIR-6-REMCARD: Card removed from slot 4, interfaces disabled" USER_INPUT_MANDATORY <- %OIR-6-REMCARD: Card removed from slot%%entityid%%, interfaces disabled entityid < 4
No input is required.

create-pw-interface-key-from-tunnelindex

This template associates trap events to the designated pseudowire tunnel interface. To achieve this, provide the appropriate oid of the var bind for the trap to be associated with this pseudowire tunnel interface while providing inputs for "snmp-trap-entity-from-oid" template. The tunnel interface index provided by "snmp-trap-entity-from-oid" template, becomes the automatic input to the current "create-pw-interface-key-from-tunnelindex" template.
No input is required.
Prime Network Event Templates

These templates create a unique location ID for the event using the device component key and unique ID information created in the previous rules.

create-ana-trap-event

Template to create a unique location ID for a Prime Network trap event.

Mandatory Input

type—A string that specifies the event name.

Note
This string should match the event name that was used to create the Prime Network event using the vcb event add command. View the event name using the vcb event view command.

Optional Input

subtype—A string that specifies the event subtype name.

Note
The subtype parameter is mandatory for INFO events because INFO events do not have subtypes. For events that have subtypes, the subtype parameter is not needed.

Input Format

- create_ana_trap_event_type type
- create_ana_trap_event_subtype subtype

create-ana-syslog-event

Template to create a unique location ID for a Prime Network syslog event.

Mandatory Input

type—A string that specifies the event name. Mandatory for an INFO event only.

Note
This string should match the event name used for creating the Prime Network event using the vcb event add command.

Optional Input

subtype—A string that specifies the event subtype name.

Note
The subtype parameter is mandatory for INFO events because INFO events do not have subtypes. For events that have subtypes, the subtype parameter is not needed.
Input Format
- `create ana syslog_event_type type`
- `create ana syslog_event_subtype subtype`

**Note**
For more information about `vcb eventparsingrules` commands, see VCB CLI Reference: `vcb eventparsingrules Commands`, page B-41.
Prime Network Command Manager and Command Builder support two languages for writing command scripts:

- **Prime Network Macro Language**—Provides simple sequences of Telnet commands, runtime-replaced user-defined input parameters, and inline execution directives that are executed sequentially as Telnet configuration commands on an NE. See Prime Network Macro Language, page C-1.
- **BeanShell**—Provides a fully programmatic logic via scripting language (including conditions, loops, and external files). See BeanShell Commands, page C-11.

### Prime Network Macro Language

These topics describe the Prime Network Macro Language and its syntax, how to use parameters and pragmas, and a detailed example for writing Prime Network Macro Language scripts. These topics are intended for use by programmers who want to write command scripts that are executed within the Prime Network activation framework.

Topics include:

- What Are Prime Network Macro Language Scripts?, page C-1
- Properties Available from the IMO Context, page C-2
- Specifying and Using Parameters, page C-2
- Supported Pragmas, page C-4
- Example, page C-8

### What Are Prime Network Macro Language Scripts?

A Prime Network Macro Language script is a simple sequence of Telnet commands, runtime-replaced input arguments, and inline execution directives that are executed sequentially as Telnet configuration commands on a networking device. Prime Network Macro Language script lines are evaluated in runtime for argument replacements that result in the generation of a Telnet device configuration command that can be sent to the device. Each command line is validated according to the inline directives that can abort
and roll back the script or continue executing the next script line. Prime Network Macro Language scripts can be created using Command Manager or Command Builder, or can be provided externally using the Prime Network BQL API.

A Prime Network Macro Language script is usually made of a command script and a rollback script. You can specify that if a command script fails, a rollback script is called.

When defining Prime Network Macro Language scripts, you can:

- Import or paste scripts from external sources.
- Define inline directives (pragmas) for validating the network element’s reply.
- Define a rollback script for undoing failed commands.

### Properties Available from the IMO Context

The script IMO context makes the Prime Network Information Model Objects available to the script as built-in arguments. A script IMO context can be any object that can be represented by a Prime Network IMO, ranging from a managed element to a port connector to a routing entry. Example IMO contexts can include:

<table>
<thead>
<tr>
<th>NE Type</th>
<th>IMO Name</th>
<th>Example Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managed device</td>
<td>IManagedElement</td>
<td>CommunicationStateEnum, DeviceName, ElementType</td>
</tr>
<tr>
<td>Port</td>
<td>IPortConnector</td>
<td>portalias, location, ifindex</td>
</tr>
</tbody>
</table>

For more information about Prime Network Macro Language Built-in parameters, see Built-In Parameters, page C-4.

### Specifying and Using Parameters

Prime Network Macro Language supports two types of script parameters: User-defined and built-in; both are replaced at runtime. In the Command Manager and Command Builder GUIs, all parameters (both built-in and user-defined) are available during command editing via a selection list.

To view all user-defined and built-in parameters in the Command Manager and Command Builder applications, press **Ctrl-Spacebar** to open the selection list of available arguments (containing both the user-defined input argument and the built-in properties of the IMO context).

Prime Network Macro Language represents both types of parameters in script lines within dollar signs; for example, $...$. For instance, in a VRF configuration command, the input variable vrfName can be defined as ip vrf $vrfName$.

**Note**

- Timeouts for pragmas and scripts are supported using BQL. This adds a timeout type integer defined in milliseconds. We recommend that if you change the timeout for the pragma, you also change the timeout for the script.
- An example of a timeout for a pragma is `route-target both $rt$ [timeout=2000].`
- An example of a timeout for a script is `<Timeout type="Integer">5000</Timeout>`.
User-Defined Parameters

User-defined input parameters must be defined up front. A parameter specification includes parameter name, type, and even an optional default value. User-defined parameters can be defined using Command Manager or Command Builder, or through the Prime Network API.

Table C-1 provides a complete list of user-defined parameter properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Parameter name. Can contain only letters, digits, hyphen (-), and underscore (_), and must be unique.</td>
</tr>
<tr>
<td>Caption</td>
<td>Parameter display name. Visible in the Command Manager and Command Builder script execution window.</td>
</tr>
<tr>
<td>Type</td>
<td>String, Integer, IPSubnet, Combo, IP, Float, Long.</td>
</tr>
<tr>
<td>Width</td>
<td>Field width, in characters. Relevant for the Command Manager and Command Builder script execution window.</td>
</tr>
<tr>
<td>Visible</td>
<td>Indicates whether or not the parameter appears in the window. Relevant for the Command Manager and Command Builder script execution window.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Tooltip for the command parameter. Note: This property is only available through the Command Manager and Command Builder GUIs.</td>
</tr>
<tr>
<td>Default</td>
<td>A default value for the parameter. Note: This property is only available through the Command Manager and Command Builder GUIs.</td>
</tr>
<tr>
<td>Required</td>
<td>Indicates whether the argument is mandatory or optional. Note: This property is only available through the Command Manager and Command Builder GUIs.</td>
</tr>
</tbody>
</table>

Some parameter properties are relevant only for the script data entry window in Command Manager and Command Builder.

During runtime, the script is executed via a BQL command. As with all BQL commands, if the argument types do not match, an exception is returned to the user.

User-defined parameters values can be provided in the following ways:

- Using flow-through activation—The input parameters are provided as part of the API before they are sent to the VNE.
- Run from Prime Network Vision as a GUI-based command—You provide the input parameters before they are sent to the VNE; for example, by entering a value or choosing one from a drop-down list.
Multiple Formats for IP Subnet Parameters

Prime Network Macro Language scripts support multiple formats for IP subnet parameters, as described in Table C-2, using the example 198.168.2.10 255.255.255.0.

Table C-2 Formats for IP Subnet Parameters

<table>
<thead>
<tr>
<th>#</th>
<th>Format</th>
<th>Description</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>maskbits</td>
<td>The IP of the subnet converted to an integer value. Bits only.</td>
<td>30</td>
</tr>
<tr>
<td>2</td>
<td>ip</td>
<td>Only the IP without the mask.</td>
<td>198.168.2.10</td>
</tr>
<tr>
<td>3</td>
<td>mask</td>
<td>The IP of the subnet mask without the IP address.</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>4</td>
<td>networkmask</td>
<td>The mask address converted to the network.</td>
<td>0.0.0.255</td>
</tr>
<tr>
<td>5</td>
<td>ipmaskbits</td>
<td>The IP and the value of the mask bits.</td>
<td>IP/30</td>
</tr>
<tr>
<td>6</td>
<td>ipmask</td>
<td>The IP mask. This is the default.</td>
<td>198.168.2.10 255.255.255.0</td>
</tr>
<tr>
<td>7</td>
<td>ipmasknot</td>
<td>The IP and the network address.</td>
<td>198.168.2.10 + 0.0.0.255</td>
</tr>
</tbody>
</table>

For example, routeadd$SB:IP$mask$SB:mask$ extracts the IP and then the subnet.

Built-In Parameters

Built-in parameters are the built-in properties available in IMO arguments of the IMO context (such as portalias or status), which are automatically set to their runtime value during execution. The built-in properties include IMO attributes, OID attributes, and instrumentation data.

Note

To view all user-defined and built-in parameters in the Command Manager and Command Builder application, press Ctrl-Spacebar to open the selection list of available arguments (containing both the user-defined input argument and the built-in properties of the IMO context).

Supported Pragmas

You can insert inline directives (pragmas) in the script lines for increased granularity control. Pragmas are enclosed within square brackets ([...]). Table C-3 lists the pragmas that Prime Network Macro Language scripts support.

Table C-3 Supported Pragmas

<table>
<thead>
<tr>
<th>Pragma</th>
<th>Short Description</th>
<th>Refer to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Line-specific success check.</td>
<td>Success</td>
</tr>
<tr>
<td>Fail</td>
<td>Line-specific failure check.</td>
<td>Fail</td>
</tr>
<tr>
<td>Prompt</td>
<td>Line-specific prompt assertion validation.</td>
<td>Prompt</td>
</tr>
<tr>
<td>Rollback</td>
<td>Rollback enable or disable.</td>
<td>Rollback</td>
</tr>
</tbody>
</table>
### Prime Network Macro Language

#### Note
Wherever the carriage return character is required in the middle of a command line, use the escape sequence `&cr`.

#### Note
You can use multiple pragmas in a single line; when this occurs, all pragmas are analyzed. If the same type of pragma is repeated, only the last one is used.

### Success

#### Description

A *success* pragma is validated against the script line reply. The success pragma verifies that a required substring exists in the reply. If the substring is not found, the script fails.

#### Syntax

```
[success=<string>]
```

where `<string>` represents the expected return value from the device. `<string>` can be simple text or can contain arguments that are replaced in runtime.

#### Directives

The pragma succeeds and the script continues only if `<string>` is found in the device reply. The pragma fails if `<string>` does not exist in the reply.

`<string>` can be a regular expression; it does not necessarily have to be an exact string to match.

#### Examples

The following example verifies that the specified VRF `$newVrf$` does not already exist:

```
show ip vrf $newVrf$  [success=% No VRF $newVrf$]
```

Using Trial for `newVrf`, this pragma succeeds if the device reply contains `% No VRF Trial`.

### Fail

#### Description

A *fail* pragma is validated against the script line reply. The fail pragma verifies that a required substring does not exist in the reply.
Appendix C
Command Manager and Command Builder: Macro Language and Beanshell Reference

Prime Network Macro Language

Syntax

\[ \text{fail=\langle string\rangle} \]

where \langle string\rangle represents the value that should not be included in the device reply. \langle string\rangle can be simple text or can contain arguments that are replaced in runtime.

Directives

The script fails if \langle string\rangle is found in the device reply. The script continues if \langle string\rangle does not exist in the reply.

\langle string\rangle can be a regular expression; it does not necessarily have to be an exact string to match.

Example

The following example sets a route distinguisher:

\[ \text{rd } \$\text{newRD}\$ \ [\text{fail=} % \text{Cannot set RD } \$\text{newRD}\$] \]

Using 60:60 for newRD, this pragma yields failure only if the device reply contains =% Cannot set RD 60:60.

Prompt

Description

A prompt pragma is validated against the next Telnet command prompt. The full prompt pragma verifies that the prompt equals the given string. If the prompt differs from the string, the script fails.

Syntax

\[ \text{prompt=\langle prompt\rangle} \]

where \langle prompt\rangle represents the new expected prompt. \langle prompt\rangle can be simple text or can contain arguments that are replaced in runtime before being sent to the device.

Directives

The pragma is successful and script execution continues only if \langle prompt\rangle is found as the suffix of the device prompt. The pragma fails if \langle prompt\rangle is not found in the suffix of the device prompt.

Example

The following example changes the Telnet prompt and validates the change in the newly returned Telnet prompt:

\[ \text{configure terminal} \ [\text{prompt=} (\text{config})\#] \]

This pragma succeeds only if the next device prompt ends with (config)#.
Partial Prompt

Description

A partial prompt pragma is validated against the next Telnet command prompt. The partial prompt pragma verifies that the suffix of the prompt equals the given string. If the suffix differs from the string, the script fails.

Syntax

[prompt=\^<prompt>]

where <prompt> represents the expected full prompt. <prompt> can be simple text or can contain arguments that are replaced in runtime before being sent to the device.

Directives

The pragma is successful and script execution continues only if the next full prompt equals <prompt>. The pragma fails if the next prompt does not equal <prompt>.

Example

The following example changes the Telnet prompt and validates the change in the newly returned Telnet prompt:

```
configure terminal [prompt=^router(config)#]
```

This pragma yields success only if the next device prompt matches router(config)# exactly.

Rollback

Description

A rollback pragma determines that rollback will be executed only upon failures from this point onward.

Note

Be sure the rollback script restores the device prompt to its original value before the script was initiated.

Directives

If the script fails after the [rollback] marker, then rollback is executed.

Note

If the rollback script fails, no additional actions can be performed.

Activity

Description

An activity pragma sets the text that, if the script fails, appears in the script’s result as the name of the activity that failed. The failed activity name (label) appears in the returned result and in the provisioning event that is generated.
Prime Network Macro Language

Appendix C Command Manager and Command Builder: Macro Language and Beanshell Reference

Syntax

```
(activity=<activity>)
```

where `<activity>` represents an inline remark comment. `<activity>` can be simple text or can contain arguments that are replaced in runtime before being sent to the device.

Directives

When a failure occurs later in the script, you are notified of the error by activity name.

Example

```
(activity=now adding the vrf)
```

Enum

**Description**

An enum pragma defines the values that are used when substituting parameter names into a Telnet string.

**Directives**

The pragma is successful only if you input one of the values in the list. The pragma fails if you do not input one of the values in the list.

**Example**

The enum pragma appears at the top of the script:

```
[enum RouteTargetType Enum 0=export;1=import]
```

Later in the script, the parameter `RouteTargetType Enum` is used:

```
no route-target $RouteTargetTypeEnum$ $RouteTarget$
```

The value that is substituted into the Telnet command for `$RouteTargetTypeEnum$` is export or import instead of 0 or 1.

**Example**

The following command script and rollback script perform an *Add VRF* configuration. The scripts use user-defined arguments to represent the VRF name, route target, and route distinguisher; several types of pragmas to validate the device reply; and remarks in the command script, and rollback script.

**Command Script**

```
[enum rd 1=60:60;2=80:80]
show ip vrf $vrfName$ [success=% No VRF named $vrfName$]
[activity=prepare for VRF creation]
config terminal [success=Enter configuration commands, one per line. End with CNTL/Z.]
[prompt=(config)]
ip vrf $vrfName$ [prompt=(config-vrf)]
[rollback]
```
Rollback Script

```plaintext
config terminal
no ip vrf $vrfName$
end
```

Table C-4 lists the user-defined argument definitions used in the script.

**Table C-4 User-Defined Argument Definitions**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Default</th>
<th>Explanation</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>vrfName</td>
<td>String</td>
<td>N/A</td>
<td>The VRF name. The value provided for this argument is used as the VRF table name.</td>
<td>Manhattan</td>
</tr>
<tr>
<td>rt</td>
<td>String</td>
<td>N/A</td>
<td>The VRF route target, in the format integer:integer. The value provided for this argument is used as is for the device configuration.</td>
<td>60:60</td>
</tr>
<tr>
<td>rd</td>
<td>String</td>
<td>1</td>
<td>In this example, the system administrator would like the route distinguisher to be based on the predefined enumerated values list. Therefore, the route distinguisher is provided in the format of an integer to be used as a lookup table key, and not x:y.</td>
<td>1, 2, or any valid value according to the enum pragma</td>
</tr>
</tbody>
</table>

Table C-5 provides an explanation of the command script line by line.

**Table C-5 Command Script Explanation**

<table>
<thead>
<tr>
<th>Script Line</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[enum rd 1=60:60;2=80:80]</td>
<td>The line enumerates the possible values of the route distinguisher argument.</td>
</tr>
<tr>
<td>show ip vrf $vrfName$ [success=% No VRF named $vrfName$]</td>
<td>Verify if the requested VRF already exists. Continue to create the VRF only if the requested VRF name is not found.</td>
</tr>
<tr>
<td>[activity=prepare for VRF creation]</td>
<td>Remark to state that the following section is preparation for VRF creation.</td>
</tr>
<tr>
<td>config terminal [success=Enter configuration commands, one per line. End with CNTL/Z.] [prompt={(config)}]</td>
<td>Change mode command. Continue to the next command if the success pragma string is found in the device reply and prompt changes to config.</td>
</tr>
<tr>
<td>ip vrf $vrfName$ [prompt={config-vrf}]</td>
<td>Change mode command. Continue to the next command if prompt changes to config-vrf.</td>
</tr>
<tr>
<td>[rollback]</td>
<td>Placeholder to state that rollback should be executed only if a subsequent script line fails.</td>
</tr>
</tbody>
</table>
Table C-5  Command Script Explanation (continued)

<table>
<thead>
<tr>
<th>Script Line</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[activity=create VRF]</td>
<td>Remark to state that the following section is actually the VRF creation.</td>
</tr>
<tr>
<td>rd $rd$ [fail=% Cannot set RD, check if it's unique]</td>
<td>Set the route distinguisher. If this command fails, the rollback script is called.</td>
</tr>
<tr>
<td>route-target both $rt$</td>
<td>Set the route target. If this command fails, the rollback script is called.</td>
</tr>
<tr>
<td>end</td>
<td>Change mode command. Return to normal (enable) mode.</td>
</tr>
</tbody>
</table>

Table C-6 provides an explanation of the activation rollback script line by line.

Table C-6  Rollback Script Explanation

<table>
<thead>
<tr>
<th>Script Line</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>config terminal</td>
<td>Set the device to terminal mode.</td>
</tr>
<tr>
<td>no ip vrf $vrfName$</td>
<td>Delete the VRF from the device.</td>
</tr>
<tr>
<td>end</td>
<td>Change mode command. Return to normal (enable) mode.</td>
</tr>
</tbody>
</table>

Running the Script

The script is executed with the following input arguments:

vrfName=Trial
rd=2
rt=60:60

The Telnet commands as sent to the device (preview):

show ip vrf Trial
config terminal
ip vrf Trial
rd 80:80
route-target both 60:60
end
------Rollback------
config terminal
no ip vrf Trial
end

Full session:

vrfName=Trial
rd=2
rt=60:60

PE-North#show ip vrf Trial
% No VRF named Trial
PE-North#config terminal
Enter configuration commands, one per line. End with CNTL/Z.
PE-North(config)#ip vrf Trial
PE-North(config-vrf)#rd 80:80
PE-North(config-vrf)#route-target both 60:60
PE-North(config-vrf)#end
Rerunning the script with the same input values (VRF already exists; the command stops after VRF name verification):

```
P-E-North#show ip vrf Trial
Name              Default RD      Interfaces
Trial              80:80
P-E-North#
^ Failed to find the text '% No VRF named Trial' in the device reply!, script terminated.
```

Running the script with a different VRF name but the same route target (RT) and route distinguisher (RD) (VRF creation begins and then is rolled back due to RD already in use):

```
vrfName=Trial2
rd=2
rt=50:50

P-E-North#show ip vrf Trial2
% No VRF named Trial2
P-E-North#config terminal
Enter configuration commands, one per line. End with CNTL/Z.
P-E-North(config)#ip vrf Trial2
P-E-North(config-vrf)#rd 80:80
% Cannot set RD, check if it's unique
P-E-North(config-vrf)#
^ Error in activity 'create VRF'.
^ Found the text '% Cannot set RD, check if it's unique' in the device reply!, script terminated.
-----Invoking Rollback-----
P-E-North#config terminal
Enter configuration commands, one per line. End with CNTL/Z.
P-E-North(config)#no ip vrf Trial2
% IP addresses from all interfaces in VRF Trial2 have been removed
P-E-North(config)#end
```

---

**BeanShell Commands**

These topics describe the methods that should be used for BeanShell in Prime Network commands when you want to interact with devices:

- [Telnet BeanShell Commands, page C-12](#)
- [SNMP BeanShell Commands, page C-13](#)

In addition, it provides Telnet and SNMP environment object examples.

---

**Caution**

Unlike Prime Network Macro Language, in BeanShell user arguments, inventory properties should *not* be embedded within dollar signs ($...$).

Figure C-1 presents the methods that should be used for BeanShell in Prime Network commands when interacting with devices for Telnet and SNMP interfaces.
Figure C-1  BeanShell Methods

Note
For setStatus, 1 = success and 2 = failure.

Telnet BeanShell Commands

The following are examples of the available predefined Telnet environment objects that you can use to interact with a device:

- `telnetInterface.config (prompt, telnet_command, true/false, timeout)`: Where:
  - `prompt` is the expected prompt after command is executed.
  - `telnet_command` is the actual command to be executed.
  - `true` displays the results and `false` hides the results.
  - `timeout` is the CLI time out in milliseconds. The default value is 20000 milliseconds (20 seconds).

- `telnetInterface.setStatus (1 or 2)`: Where 1 = success and 2 = fail; used, for example, to signal to Workflow Manager that a configuration command has succeeded or failed.

- `telnetInterface.println`: Used to print the output string on screen.

A timeout error reports the failure in the following format:

```
Unexpected error occurred during script execution:
receiveUntil(): general timeout expired(value=<elapsed_time_in_milliseconds>)
(command_run)
Elapsed time: <elapsed_time_in_seconds> seconds
```

where:

- `elapsed_time_in_milliseconds` is the length of the timeout in milliseconds.
- `command_run` is the command that was being executed when the timeout occurred.
- `elapsed_time_in_seconds` is the length of the timeout in seconds.
For example, a timeout error might read as follows:

```
Unexpected error occurred during script execution:
receiveUntil(): general timeout expired(value=10000)(copy tftp://171.69.75.3/radA020C.tmp
null:
Accessing tftp://171.69.75.3/radA020C.tmp...)  
Elapsed time: 10 seconds
```

**Reload Router Command Example**

The following is an example of using BeanShell script to reload a router.

```java
try {
    telnetInterface.config("[confirm]", "reload", false);
telnetInterface.config("#", "\n", false, 2000);
} catch (Exception e) {
telnetInterface.println("Router will reload");
}
```

**SONET Show Controller Data Command Example**

The following is an example of the BeanShell implementation of the SONET Controller Data command that displays SONET controller data:

```java
try {
    String sep = File.separator;
    source("." + sep + "scripts" + sep + "configuration" + sep + "cisco" + sep + "CiscoUtil.bsh");
    String strOid = oid.toString();
    String SEPARATOR = "PortNumber=POS”;
    int startIdx = strOid.indexOf(SEPARATOR);
    startIdx = startIdx + SEPARATOR.length();
    int endIdx = strOid.indexOf(')', startIdx);
    String interfaceName = strOid.substring(startIdx, endIdx);
    telnetInterface.println("Running command: show controller sonet "+interfaceName);
    String res = telnetInterface.retrieve("#", "show controller sonet "+interfaceName);
    telnetInterface.println(res);
telnetInterface.setStatus(XProvisioningConfigDeviceStatusMsg.STATUS_SUCCESS);
} catch (Exception e) {
telnetInterface.setStatus(XProvisioningConfigDeviceStatusMsg.STATUS_FAILURE);
telnetInterface.println("Exception occurred during execution of the script " + e.getMessage() );
}
```

**SNMP BeanShell Commands**

The following are examples of the available predefined SNMP environment objects that you can use to interact with a device:

- `snmpInterface.get (OID, true/false)—Gets OID, and displays or hides results.
- `snmpInterface.getNext (OID, true/false)—Gets next OID, and displays or hides results.
- `snmpInterface.set (OID, variable type, value)—Sets OID to specified value.
- `snmpInterface.walk (OID, true/false)`—Returns vector of strings.
- `snmpInterface.setStatus (1 or 2)`—Where 1 = success and 2 = failure; used, for example, to signal Workflow Manager that a configuration command has succeeded or failed.

For additional information about general scripting language, see [http://www.beanshell.org/](http://www.beanshell.org/).
Creating Workflows and Wizards Using the Workflow Editor and Activation Features

Using the Workflow GUI Client to Create Workflows

Note
The Workflow and Activation features are only available in upgrades to Prime Network 4.0. Because Workflow and Activation will be deprecated in the future, you should use Transaction Manager instead.

The following topics describe how to use the Prime Network Workflow GUI client to create workflow templates that allow you to deploy and execute a series of commands in runtime.

- What is Prime Network Workflow?, page D-2
- Prime Network Workflow Window, page D-2
- Steps for Creating a Workflow Template, page D-5
- Creating and Testing a New Workflow Template, page D-5
- Using Tasks in the Task Library, page D-8
- Prime Network Activation Workflow Template Attributes, page D-13
- Running, Viewing, Aborting, and Deleting Workflows, page D-14
- Viewing Workflow History Using Prime Network Events, page D-18
- Creating Custom Tasks for Workflows, page D-19

Additional information about Prime Network Workflow is available on the Cisco Developer Network (CDN), including sample workflow that will help you become familiar with the framework.
What is Prime Network Workflow?

**Note**
The Workflow and Activation features are only available in upgrades to Prime Network 4.0. Because Workflow and Activation will be deprecated in the future, you should use Transaction Manager instead.

Prime Network Workflow is used for creating activation workflow templates. A workflow template consists of several tasks which are grouped together and specified into a flow, with certain sequences, branches, and failure policies (including rollback procedures). You can test and preview workflow templates before deploying (copying) them to the gateway to make them available to Prime Network users.

After a template is deployed to the gateway, users with OperatorPlus privileges can execute the workflow using a BQL command. Each time a user executes a workflow, Prime Network creates a new workflow instance with its own unique ID, and stores it in the database. Thus there can be many instantiations of a single workflow template. Each instance has its own output, which you can export and use to analyze the commands.

Workflows can be nested, which means one workflow can invoke subworkflows synchronously, and pass arguments to each subworkflow invocation. This allows you to group and isolate tasks that are in a child workflow (sub-workflow) from tasks that are in the parent workflow.

Workflows can include commands that you created using Command Builder as long as the commands have been published (made accessible to) the NEs that will be affected by the workflow. Those commands are called by BQL tasks in the workflow. Like Command Builder, Workflow can access all information models (IMOs).

**Note**
You can use Command Builder, but not Command Manager, with the Workflow application.

The Workflow GUI is based on LiquidBPM by Autonomy, Inc., with extensions that are specific to Prime Network. Because in many cases the Prime Network procedure is the same as the LiquidBPM procedure, the topics in this section will direct you to the LiquidBPM online help, which can be launched from the Workflow GUI client.

The Workflow Engine resides on the gateway using AVM 66. A workflow that is stored on the gateway (rather than locally on a client machine) is called a **deployed** workflow. Deployed workflows can be managed from the Prime Network Administration GUI client, where users with Administrator privileges can view the workflow’s status and properties. To deploy, retrieve, or delete a workflow template from the gateway, AVM 66 must be running.

Prime Network Workflow Window

**Note**
The Workflow and Activation features are only available in upgrades to Prime Network 4.0. Because Workflow and Activation will be deprecated in the future, you should use Transaction Manager instead.

If Prime Network is installed as a standalone product, launch Workflow as follows:

**Start > All Programs > Cisco Prime Network > Cisco Prime Network Workflow**

If Prime Network is installed in suite mode with Cisco Prime Central, launch Workflow by selecting **Tools > Workflow** in the Prime Network Vision GUI client.
Figure D-1 shows an example of the Prime Network Workflow window when a template is opened.

**Figure D-1  Workflow Window**

<table>
<thead>
<tr>
<th></th>
<th>Drawing area</th>
<th></th>
<th>Task toolbar (see Table D-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Task attribute table</td>
<td>4</td>
<td>Tree</td>
</tr>
<tr>
<td>5</td>
<td>Action toolbar (see Table D-1)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table D-1  Important Workflow Template Actions**

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Workflow</td>
<td>creates a new workflow template and automatically saves it on the local client machine.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>If you want to create a wizard using the Activation Wizard Builder (AWB), choose File &gt; New Activation Workflow to create the activation. That template contains information that is necessary for creating a wizard using the AWB.</td>
</tr>
<tr>
<td>The Open Workflow, Save Workflow As, Rename Workflow, and Delete choices all perform operations on this same directory.</td>
<td></td>
</tr>
<tr>
<td>Import Workflow</td>
<td>loads a saved template XML file into the Workflow Editor.</td>
</tr>
</tbody>
</table>
### Table D-1  Important Workflow Template Actions (continued)

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Export saves a workflow template as an XML file on the local machine. This is useful if you want to perform file actions, such as copying or e-mailing it to another location. (The XML template is not saved in the Prime Network database.)</td>
</tr>
<tr>
<td><img src="image" alt="Execute" /></td>
<td>Execute runs the workflow template on the local machine. If the workflow template contains valid BQL tasks, they will be executed on the gateway.</td>
</tr>
<tr>
<td><img src="image" alt="Retrieve Workflow" /></td>
<td>Retrieve Workflow from Server retrieves a workflow template from the Prime Network database and loads it into the Workflow Editor.</td>
</tr>
<tr>
<td><img src="image" alt="Delete Workflow" /></td>
<td>Delete Workflow from Server deletes a workflow template from the Prime Network database.</td>
</tr>
<tr>
<td><img src="image" alt="Deploy Workflow" /></td>
<td>Deploy Workflow saves the workflow template on the gateway and in the Prime Network database.</td>
</tr>
</tbody>
</table>

### Table D-2  Important Workflow Template Tasks

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Execute BQL" /></td>
<td>Execute BQL calls commands that reside on the client machine. For more information, see Execute BQL Task, page D-8.</td>
</tr>
<tr>
<td><img src="image" alt="Workflow Call" /></td>
<td>Workflow call starts another independent workflow. Workflow Call Task, page D-10.</td>
</tr>
<tr>
<td><img src="image" alt="Subflow" /></td>
<td>Subflow another workflow in an embedded fashion. See Workflow Call Task, page D-10.</td>
</tr>
<tr>
<td><img src="image" alt="Lock" /></td>
<td>Lock protects a resource so that it cannot be used concurrently by multiple workflows. See Lock and Unlock Task, page D-12.</td>
</tr>
<tr>
<td><img src="image" alt="Unlock" /></td>
<td>Unlock unlocks a locked resource. Unlock unlocks a locked resource so that it can be locked and unlocked using the Lock task and the Unlock task. See Lock and Unlock Task, page D-12.</td>
</tr>
<tr>
<td><img src="image" alt="Activation Tokenizer" /></td>
<td>Activation Tokenizer provides repetitive looping so that multiple attributes can be passed to the workflow. See Activation Tokenizer Task, page D-13.</td>
</tr>
</tbody>
</table>
Steps for Creating a Workflow Template

Note

The Workflow and Activation features are only available in upgrades to Prime Network 4.0. Because Workflow and Activation will be deprecated in the future, you should use Transaction Manager instead.

These steps describe how to create a workflow template.

Figure D-2       Steps for Creating a Workflow

Step 1: Create a command using Command Builder and preview it

Step 2: Define tasks and workflows using Prime Network Workflow

Step 3: Test the workflow locally

Step 4: Deploy the workflow to the gateway

Step 5: Run the workflow

Step 6: View the workflow results in Prime Network Administration

Note

Commands you create with Command Builder must be published to all NEs that are part of the workflow. If a workflow calls a command that has not been published to the NE, it will fail on the NE. (You cannot use commands created using Command Manager.)

For more information about:

- Creating a command using the Command Manager GUI client, see Creating Commands and Command Scripts to Perform Device Configuration Operations, page 4-1.
- Creating a workflow template and testing it locally, see Creating and Testing a New Workflow Template, page D-5.
- Running the workflow, see Running, Viewing, Aborting, and Deleting Workflows, page D-14.

Creating and Testing a New Workflow Template

You can create workflow templates from scratch, or retrieve an existing workflow template, rename it, and edit it. When you create a new workflow template, the template information is saved on your local client machine until you deploy (save) it to the gateway. When you deploy the workflow template to the
gateway, it can be viewed and managed from the Prime Network Administration GUI client. To retrieve, deploy, or delete an existing workflow templates from the gateway, AVM 66 must be running so that Workflow and the gateway can properly communicate.

**Tip**
Use Export to save templates. This saves the template as an XML file.

Use this procedure to create a new workflow template.

**Step 1**
Launch Prime Network Workflow.

If Prime Network is installed as a standalone product, launch Workflow as follows:

*Start > All Programs > Cisco Prime Network > Cisco Prime Network Workflow*

If Prime Network is installed in suite mode with Cisco Prime Central, launch Workflow by selecting *Tools > Workflow* in the Prime Network Vision GUI client.

**Step 2**
Create the new workflow template by choosing one of the following:

- If you want to create a non-activation workflow, choose *File > New Workflow*.
- If you want to create an activation workflow, choose *File > New Activation Workflow*.
- To open an existing template, choose *File > Open Workflow*, which will list all of the templates that are stored in C:/Cisco Systems/Prime Network/studio_db.

**Step 3**
Name the template in accordance with the following rules, and click **OK**.

- Do not include underscore ( _ ) or percent (%) wildcards.
- If you are creating an activation workflow, give the template an **NSA_** prefix (otherwise it will not appear in the Activation History window).

**Tip**
Use a suffix to differentiate workflow templates created in different Prime Network versions, such as **_v_3_8** and **_v_3_9**. This will help when you upgrade the Prime Network software.

The template is saved on the local client machine under C:/Cisco Systems/Prime Network/studio_db.

**Step 4**
Add Tasks to the workflow template. The following steps describe the basic process:

a. Click a Task in the task toolbar, and click your mouse in the drawing area. The task is added to the drawing area.

Several tasks are especially useful for Prime Network and are described in *Using Tasks in the Task Library*, page D-8. For information about the other tasks that are available, see the LiquidBPM online help (select *File >Help* and select *Task Library*).

b. Assign properties to the task by right-clicking the task icon and selecting **Edit Properties**. This opens a **properties sheet**.

c. Define the properties. Properties are divided into three types:

- **General Properties**, which are property types that are common to all tasks (such as Name). Some properties are assigned by Prime Network (for example, a task ID number); these are called **fixed** properties. The other properties are defined by the user and are called **editable** properties.
- **Attributes**, which are task-specific properties.
Tip
Incorrect attribute names are a common cause of workflow template errors, so be careful when entering this information.

- Callback Scripts, which specify actions that should be performed (or criteria that should be met) before or after performing the task, or if an exception is encountered.

Tip
If you want Prime Network to generate an event when a workflow is aborted, configure a preActivateScript in the Callback Scripts tab:

```java
thisWorkflow.getRootTask().abort();
```

Note
By default, all attributes in Prime Network Workflow are of the type String. To use another attribute type, such as Integer, set the flag use-workflow-string-param-casting to true in NETWORKHOME/Main/registry/workflowavm.xml. In workflowavm.xml, the flag use-workflow-string-param-casting appears under the workflow key. After you change this flag to true, you can use attribute types other than String.

Step 5
Test the template locally.

a. Choose Tools > Execute Workflow. Different tabbed views are opened. The graphical, tabular, and XML views provide different ways to examine the workflow progress, and the Workflow State Analysis tab that reflects the activation status of the workflow.

b. Set the test attribute values:
   - Right-click anywhere in the grey area and select Workflow Properties.
   - In the Attributes tab, click the Default Values area and enter some values.
   - Click Apply and Close.

c. Click Activate. A Console window opens and prints the status of each task in the workflow template.

d. Close the Console window. Note that the shape and colors of the tasks in the Graphical View tab changes to show the activation status of each task: Ready (blue), Active (green), Abort (red), Done (grey), and Passive (light grey).

Step 6
Once you have tested the workflow template successfully on the local client, you can do any of the following:

a. Save the workflow template on the gateway and in the Prime Network database by choosing Tools > Deploy Workflow.

b. Use a BQL command to run the workflow template on the gateway. See Previewing and Running Workflow Templates, page D-15.

c. (Activation workflow templates only) Create a wizard that will call the workflow template. See Steps for Creating an Activation Wizard, page D-24.
Using Tasks in the Task Library

The following tasks are of special importance in Prime Network. See the accompanying topics for more information:

<table>
<thead>
<tr>
<th>Task Type</th>
<th>For more information, see:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute BQL</td>
<td>Execute BQL Task, page D-8</td>
</tr>
<tr>
<td>Workflow Call</td>
<td>Workflow Call Task, page D-10</td>
</tr>
<tr>
<td>Subflow</td>
<td>Subflow Task, page D-12</td>
</tr>
<tr>
<td>Lock and Unlock</td>
<td>Lock and Unlock Task, page D-12</td>
</tr>
<tr>
<td>Activation Tokenizer</td>
<td>Activation Tokenizer Task, page D-13</td>
</tr>
</tbody>
</table>

BQL commands are specified in the Command Template tab of the Task Properties dialog box, and the result is stored in a task attribute called Result so that it can be used by scripts and other tasks. The Command Template tab can reference workflow template attributes and task attributes. At runtime, the attribute's values are substituted into the template before it is run.

**Note**

The BQL task in a workflow template can only execute script BQLs and any of the generic commands: Get, Delete, Find, Update, or Set.

**Note**

When you execute a workflow to run commands on a device, using the RunWorkflow BQL command, it will be executed only if the preview flag in the RunWorkflow BQL is **false**. If the value of the preview flag is **true**, it will only be previewed. See Previewing and Running Workflow Templates, page D-15 for details.

**Execute BQL Task**

The BQL task in a workflow template can only execute script BQLs and any of the generic commands: Get, Delete, Find, Update, or Set. The Execute BQL task has an additional tab in its properties sheet, Command Template, where you enter the command definition.

In the following example, a user used an activation template, and created a BQL task and named it **Create VRF**. The BQL task calls **AddVrfSite**, which is a command the user built with Command Builder. (You cannot use commands created with Command Manager.) All of the attributes in the **AddVrfSite** command are entered in the Attributes tab.
Note that the attributes listed in Figure D-3 are used in the AddVrfSite command illustrated in Figure D-4.

Each BQL task includes a task attribute called RollbackEnabled which controls whether or not the BQL task command is rolled back if the workflow stops. The default value is True.

Tip

Incorrect attribute names (attribute evaluation failures) are a common cause of workflow template errors, so a best practice is to have the text of the Command Builder command on hand so you can cut and paste the attribute names into the Attributes tab. (You cannot use commands created with Command Manager.)
Using the Workflow GUI Client to Create Workflows

**Figure D-4** Command Template for a Create BQL Task

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$Attribute_name$</td>
<td>Designation for an attribute in a workflow template.</td>
</tr>
<tr>
<td>$Task_name:Attribute_name$</td>
<td>Designation for an attribute in a task.</td>
</tr>
</tbody>
</table>

**Workflow Call Task**

The Workflow Call task starts another independent workflow, called a child workflow. The parent workflow passes parameters to each subworkflow invocation. Using subflows lets you isolate the tasks. The Workflow Call task has two additional tabs in its properties sheet:

- **Assign Attributes**, where you specify the attributes to be used by the child workflows.
- **Target Template**, where you enter the child workflows that will be called by the parent workflow.

*Note*  
Child workflows are not visible through the API. You must interact directly with the parent workflow.

The parent workflow only runs when the subworkflow has finished.

A subflow does the following:

- The parent workflow passes parameters to the child workflow. If the parent workflow is aborted or deleted, the child workflow is also aborted or deleted.
- The child workflow is runs separately, and has its own scope for attributes. Its output is directed to the parent workflow.
The parent workflow waits for the child workflow to terminate, and only runs when the child workflow has finished. If the child workflow stops, the parent workflow also stops.

The maximum nesting depth is 16, and rollback is performed at all depths.

In the following example, a user created a workflow call task named Workflow Call. Figure D-5 shows the Assign Attributes tab, which instructs the task to use the parent attributes as input to this task.

_Figure D-5 Assign Attributes Tab for a Workflow Call Task_

Use the following format for entering information into the Assign Attributes tab.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>attribute_in_child_workflow=attribute_in_parent_workflow</code></td>
<td>Designation for attributes taken from a parent workflow.</td>
</tr>
<tr>
<td><code>attribute_in_child_workflow=task_in_parent_workflow:attribute_name</code></td>
<td>Designation for attributes taken from a particular task in the parent workflow.</td>
</tr>
</tbody>
</table>

The child workflows that will be called by this task are displayed in Figure D-6.
Subflow Task

The Subflow task is used to embed and run another workflow in a workflow instance. It is similar to the Workflow Call task except that in the Subflow task, the workflows are actually embedded in each other. The maximum workflow nesting depth is defined in the registry. The default value is 16.

To configure this type of task, see the instructions in Workflow Call Task, page D-10.

Lock and Unlock Task

The Lock and Unlock tasks allow you to protect a component from concurrent use by multiple workflows. Both tasks have an additional tab in its properties sheet, Resource Names, where you list the resources to be locked (and unlocked). A lock can be owned by only one workflow at a time.

Activities not related to workflows can access a resource even when it is locked by a workflow. Participation in the locking process is optional.

Resources are automatically locked during rollback, but the system prevents deadlocks before they occur. Upon detecting an imminent deadlock, the lock operation belonging to the workflow with the least progress fails. A failed lock might or might not abort the workflow.

Figure D-7 gives an example of a lock task.
In the text area, enter the names of the resources to be locked. Each resource name should be on a separate line.

You can also pass resource names as parameters to other workflows. This is similar to a command instance descriptor (CID), where you can designate the options that should be evaluated on execution.

**Activation Tokenizer Task**

The Activation Tokenizer task supports repetitive looping, where multiple values for an attribute are passed to the workflow. The wizard activation packs multiple values into an attribute using an “|” delimiter between values, and places them in a temporary internal attribute that can be used within the looping flow. For example, if you had four devices, you could designate them as follows:

\[
\text{MyDevices}=\text{dev1}|\text{dev2}|\text{dev3}|\text{dev4}
\]

The loop code would do four loops and with each loop, get a new attribute value for a device.

**Prime Network Activation Workflow Template Attributes**

All Prime Network activation workflows contain the following attributes. The AA prefix identifies them as Activation workflow attributes. They are all of type String.

**Table D-3  Workflow Attributes Supplied in Activation Workflows**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA_NSA_ActivationInfo</td>
<td>Text that is displayed in the Info column of the Activation History window. It is updated in the workflow to reflect a user-friendly message about the status of the workflow execution (for example, “See Workflow output for more details”).</td>
<td>Free form</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: “”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set by the workflow designer (example: “See Workflow Output for more details”)</td>
</tr>
<tr>
<td>AA_NSA_capabilities</td>
<td>Internal value set by the workflow designer to reflect the capabilities of the workflow.</td>
<td>add or remove</td>
</tr>
<tr>
<td></td>
<td></td>
<td>set of values delimited by</td>
</tr>
</tbody>
</table>
### Using the Workflow GUI Client to Create Workflows

#### Running, Viewing, Aborting, and Deleting Workflows

These topics explain how to perform workflow operations using saved templates:

- Previewing and Running Workflow Templates, page D-15
- View Workflow Status, page D-15
- View Workflow Output, page D-16
- Abort Workflow, page D-16
- Delete Workflow, page D-17

### Table D-3  Workflow Attributes Supplied in Activation Workflows

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Values: (see Description)</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA_NSA_coWFId</td>
<td>Maintains an association between related workflows.</td>
<td></td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td></td>
<td>A workflow containing the initial <strong>add</strong> operation should have a &quot;&quot; value.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>If a <strong>remove</strong> is later performed, its AA_NSA_coWFId value should be the same as the <strong>add</strong> workflow AA_NSA_coWFId value.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AA_NSA_CustomerName</td>
<td>Stores the customer name (requires per-service activation input).</td>
<td>Value: Free form</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: &quot;&quot;</td>
<td></td>
</tr>
<tr>
<td>AA_NSA_CreateTime</td>
<td>Stores the workflow creation time (in long format, stored as a string for BQL). Does not require user input because activations and deactivations manage this information. The time is in long format and stored as a string for BQL.</td>
<td>Values: Free form</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: &quot;&quot;</td>
<td></td>
</tr>
<tr>
<td>AA_NSA_operation</td>
<td>Set by Activation component to <strong>add</strong> for an activation and <strong>remove</strong> for a deactivation.</td>
<td>Values: <strong>add</strong> or <strong>remove</strong></td>
<td><strong>add</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: <strong>add</strong></td>
<td></td>
</tr>
<tr>
<td>AA_NSA_purge</td>
<td>Controls the purging behavior for a workflow instance record in the tablespace.</td>
<td>Values: <strong>none, false, pending,</strong> or <strong>true</strong></td>
<td><strong>none</strong></td>
</tr>
<tr>
<td></td>
<td>• Store instance indefinitely in the database: <strong>none</strong> or <strong>pending</strong></td>
<td>Default: <strong>none</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Purge according to Prime Network settings: <strong>true</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AA_NSA_serviceActivationId</td>
<td>Set by Activation component to the value of the IMetaDataListEntry ID. It is only stored during the workflow execution. This attribute is used by Activation History and Clone Activation feature to retrieve a more user-friendly display name (from Service.xml metadata file).</td>
<td>Default: <strong>none</strong></td>
<td></td>
</tr>
<tr>
<td>AA_NSA_type</td>
<td>Set by Activation component to <strong>NSA</strong> to distinguish these workflows from non-Prime Network workflows. Is used internally and cannot be modified.</td>
<td>Default: <strong>NSA</strong></td>
<td></td>
</tr>
<tr>
<td>AA_NSA_UserName</td>
<td>Stores the username at the time of activation or deactivation; no user input required.</td>
<td>Values: Free form</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: &quot;&quot;</td>
<td></td>
</tr>
</tbody>
</table>
Previewing and Running Workflow Templates

When you run a workflow, you may be shown a warning message. This is a global controls that is set from the Administration GUI client. For more information, see the Cisco Prime Network 4.0 Administrator Guide.

Use the following BQL command to preview or run a workflow that has been deployed to the gateway. This command returns the ID of the new workflow. (There is no option to run workflows from the Prime Network Administration GUI client.)

In this example, the preview value is set to false, and the task is fully executed. This is the default.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<command name="RunWorkflow">
  <param name="templateOid">
    <value>{[WorkflowTemplate(Name=test.template)]}</value>
  </param>
  <param name="workflowAttributes">
    <value>
      <IWorkflowStringAttribute>
        <ID type="Oid">{[WorkflowAttribute(Name=param1)]}</ID>
        <Value type="String">name</Value>
      </IWorkflowStringAttribute>
      <IWorkflowIntegerAttribute>
        <ID type="Oid">{[WorkflowAttribute(Name=param2)]}</ID>
        <Value type="Integer">3</Value>
      </IWorkflowIntegerAttribute>
    </value>
  </param>
  <param name="preview">
    <value>false</value>
  </param>
</command>
```

If the application settings (global settings in the Administration GUI) require input of each user's device access credentials, you need to add the following parameters to the command. If these parameters are not added, the credentials specified during VNE creation will be used.

```xml
<param name="DEVICE_USER_NAME"><value>user-name</value></param>
<param name="DEVICE_PASSWORD"><value>user-password</value></param>
```

This example sets the preview value to true.

```xml
<value>true</value>
```

View Workflow Status

Use the following BQL command to get the status of an executed workflow.

Users with Administrator privileges can view the status of a workflow can be checked from the Administration GUI client.
Using the Workflow GUI Client to Create Workflows

View Workflow Output

The following BQL command displays the output of a workflow. You can use this command when you are testing a workflow and after you execute it. Administrators can also view workflow output from the Administration GUI client by right-clicking a workflow and choosing Show Output.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<command name="GetWorkflowOutput">
  <param name="oid">
    <value>{[Workflow(Id=workflow-id)]}</value>
  </param>
</command>
```

This command returns the output as a string; for example:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<IMO>
  <Output type="String">
    ...  
    [progress messages and script testing results]
    ...
  </Output>
</IMO>
```

Abort Workflow

Workflows can be manually aborted using the BQL command below. Users with Administrator privileges can also abort running workflows from the Administration GUI client by right-clicking a running workflow and choosing Abort.

A workflow will automatically abort if any of its tasks are aborted. When a workflow aborts, a workflow rollback occurs. This means all Execute BQL tasks that have already run will roll back. The rollback is performed according to actions specified in the command when it was created using Command Builder. Scripts roll back in the reverse order of their execution. (You cannot use commands created with Command Manager.)

Rollback can be disabled for specific BQL tasks by setting the RollbackEnabled value task attribute to false in the respective BQL task. This is useful for a BQL task executing a script that does not have an appropriate rollback, or a BQL task executing a gateway command.
Note
If you want Prime Network Events to display an event when a Workflow is aborted, add the following line to the preActivateScript in the Callback Scripts tab:

```java
thisWorkflow.getRootTask().abort();
```

For more information, see Prime Network Workflow application online help for **Engine Behavior > Workflow State Transitions**.

Note
Gateway commands do not support rollback. Rollback scripts must be specified in the workflow templates.

The following BQL command stops a workflow that has been executed from the gateway. This includes stopping a running workflow, and rolling back all activation scripts that have been executed. Messages are returned only if the command fails.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<command name="AbortWorkflow">
  <param name="oid">
    <value>{[Workflow(Id=workflow-id)]}</value>
  </param>
</command>
```

Delete Workflow

This BQL command deletes an inactive workflow (that is, one that has already been completed or aborted) from the Prime Network database. Users with Administrator privileges can also delete workflows from the Administration GUI client by right-clicking a running workflow and choosing **Delete**.

Note
Delete operations performed from the Workflow GUI client will delete templates, not workflow instances.

Messages are only returned if the command fails.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<command name="Delete">
  <param name="oid">
    <value>{[Workflow(Id=workflow-id)]}</value>
  </param>
</command>
```

If successful, this command returns nothing.
Viewing Workflow History Using Prime Network Events

You can view the history of workflows by opening Prime Network Events and clicking the Provisioning Tab, as shown in Figure D-8.

*Figure D-8  Prime Network Events - Provisioning Tab*

You can also view the properties of the event, as shown in Figure D-9.
The Description area of the Provisioning Event Properties window displays the details of the execution of the workflow, including all scripts, script rollbacks, and log messages.

Creating Custom Tasks for Workflows

These topics explain how to extend the Workflow Engine with custom tasks and Prime Network Workflow callbacks:

- Writing the Code for New Custom Tasks, page D-20
- Packaging the New Tasks for Deployment to Devices, page D-21
- Deploying the Custom Tasks to Devices, page D-22
Writing the Code for New Custom Tasks

Custom Tasks

The procedure for developing custom tasks is explained in the LiquidBPM documentation. The following is the definition of a simple task class:

```java
package samples;

import com.dralasoft.workflow.Key;
import com.dralasoft.workflow.SynchronousTask;

public class CustomTask1 extends SynchronousTask {
    public CustomTask1(Key _key) {
        super(_key);
    }

    public void perform() {
        System.err.println("Hello from CustomTask1");
    }
}
```

Custom Task Panel Factories

A TaskPanelFactory implementation class can be assigned to each custom task class. This allows you to create custom property sheets for the custom class. This factory class should implement the interface `com.dralasoft.gui.common.ext.TaskPanelFactory`. A simple way to do this is to extend `com.dralasoft.gui.common.ext.DefaultPanelFactory` and override some of its methods.

Workflow Callbacks Class

It is possible to develop a class that implements the Prime Network Workflow callbacks. This class should implement the interface `com.sheer.client.workflowstudio.IWorkflowEditorCallbacks`, which includes the following methods:

```java
/**
 * Called before the deploy template action
 * @param templateName
 * @return true if deploy template action should proceed
 */
public boolean preDeployTemplate(String templateName);

/**
 * Called after the deploy template action
 * @param templateName
 */
public void postDeployTemplate(String templateName);

/**
 * Called before the delete template action
 * @param templateName
 * @return true if delete template action should proceed
 */
public boolean preDeleteTemplate(String templateName);

/**
 * Called after the delete template action
 * @param templateName
 */
public void postDeleteTemplate(String templateName);
```
/**
 * @param templateName
 * @return true if this template should be displayed, false if not
 */
public boolean shouldDisplayTemplate(String templateName);

Packaging the New Tasks for Deployment to Devices

Classes and resources must be packaged into JAR files to be deployed on the server. A JAR file can contain multiple tasks and an optional workflow callback implementation.

In addition to the class files, each JAR file must contain a descriptor file named extension-config.xml. This file contains the XML block or blocks that define the tasks’ appearance in the task palette, the tasks’ custom panel factories, and, optionally, the Prime Network Workflow callback implementation.

Custom Tasks

In addition to the custom tasks class files, task icons should be included in the JAR file. Task icons should measure 16 by 16 pixels and must be placed in the JAR file in the subdirectory, com/dralasoft/gui/common/images/16x16.

Custom Task Panel Factories

The full class name of the task panel factory should be added in an element called task-panel-factory-class inside the custom-task element. If this element is not specified, com.dralasoft.gui.common.ext.DefaultPanelFactory is used for the custom task.

Workflow Callbacks Class

Adding an editor-callbacks-class element to the extension-config element configures a class that implements the Prime Network Workflow callbacks. This element should be added to the extension-config.xml file in only one of the JAR files (if the element is present in more then one descriptor, one element’s value would be used arbitrarily).

The following example of the contents of a task descriptor file defines two task types, one of which has a task panel factory, and an editor callback implementation:

<extension-config>
  <editor-callbacks-class>
    samples.EditorCallbacksImpl
  </editor-callbacks-class>

  <custom-task>
    <class-name>samples.CustomTask1</class-name>
    <label>Custom Task 1</label>
    <icon>task1.png</icon>
    <tooltip>Custom Task 1</tooltip>
    <menu-display>true</menu-display>
    <toolbar-display>true</toolbar-display>
    <task-panel-factory-class>
      com.dralasoft.gui.common.ext.DefaultPanelFactory
    </task-panel-factory-class>
  </custom-task>

  <custom-task>
    <class-name>samples.CustomTask2</class-name>
    <label>Custom Task 2</label>
    <icon>task2.png</icon>
</extension-config>
Deploying the Custom Tasks to Devices

To deploy JAR files:

Step 1  Confirm that no workflows are currently running because this procedure will restart the Workflow engine.

Step 2  On the Prime Network gateway, create a directory called \texttt{NETWORKHOME}/dralasoft_extensions.

Step 3  Copy the JAR files to the \texttt{NETWORKHOME}/dralasoft_extensions directory.

Step 4  Run the script \texttt{NETWORKHOME}/Main/scripts/installDralasoftExtensions.pl.

\textbf{Note}  Run this script each time you want to add a JAR file, remove a JAR file, or replace an existing JAR file with a new version.

The script uninstalls and reinstalls JAR files so that the set of installed JAR files is the same as the contents of the directory \texttt{NETWORKHOME}/dralasoft_extensions. We therefore recommend that you keep files with a .jar extension here even after they have been deployed.

Step 5  When the script is done, launch Prime Network Workflow. The deployed JAR files are automatically downloaded, and the new tasks are included in the task toolbar.

Using the Activation Wizard Builder

\textbf{Note}  The Activation and Workflow features are only available in upgrades to Prime Network 4.0. Because Workflow and Activation will be deprecated in the future, you should use Transaction Manager instead.

These topics explain how users with Configurator or Administrator privileges can use the Activation Wizard Builder (AWB) to create an activation wizard, which can be accessed by network operators from Prime Network Vision, and used to run activations on managed devices.

Activation wizards provide an alternative to deploying workflows via BQL.

- What is the Activation Wizard Builder (AWB)?, page D-23
- AWB Window, page D-23
- Steps for Creating an Activation Wizard, page D-24
- Creating a New Activation Wizard, page D-25
- Adding an Activation Wizard to Prime Network Vision, page D-29
- Synchronizing the Wizard and a Workflow When a Workflow is Modified, page D-32
What is the Activation Wizard Builder (AWB)?

The AWB allows you to create a GUI interface for deploying activations, in the form of a wizard. When you create an activation wizard, you select a workflow template that defines the activation to be deployed to the managed devices. You then create the wizard screens and designate which workflow attributes should appear on each screen. You can configure attribute display names, wizard loops, tool tips, and conditions that determine the wizard content.

When you are done, the AWB validates the wizard definition. Then you can upload the wizard to the gateway and view it in Prime Network Vision. You can also change the configuration of existing wizards by downloading them from the gateway into AWB.

AWB Window

If Prime Network is installed as a standalone product, launch the AWB as follows:

b. Click Cisco Prime Network Activation Wizard Builder.

If Prime Network is installed in suite mode with Cisco Prime Central, launch Workflow by selecting Tools > Activation Wizard in the Prime Network Vision GUI client.

The Activation and Workflow features are only available in upgrades to Prime Network 4.0. Because Workflow and Activation will be deprecated in the future, you should use Transaction Manager instead.

Figure D-10 shows the AWB window. In this example, the window is displaying a wizard that has two pages and one unassigned attribute.
Using the Activation Wizard Builder

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Screens tab, where wizard screens (pages) are designed</td>
</tr>
<tr>
<td>2</td>
<td>Tool for adding information to a wizard screen</td>
</tr>
<tr>
<td>3</td>
<td>Workflow attributes that are not assigned to any wizard screen</td>
</tr>
<tr>
<td>4</td>
<td>Screens (pages) defined in this wizard</td>
</tr>
<tr>
<td>5</td>
<td>Actions for managing wizard screens</td>
</tr>
<tr>
<td>6</td>
<td>Supported actions for rearranging the appearance of attributes on the screen</td>
</tr>
<tr>
<td>7</td>
<td>Table listing all attributes assigned to individual wizard screens (you define display name, attribute type, initialization, validation, tooltip, etc.)</td>
</tr>
<tr>
<td>8</td>
<td>Wizards associated with the selected activation</td>
</tr>
<tr>
<td>9</td>
<td>All available workflows on gateway</td>
</tr>
<tr>
<td>10</td>
<td>AWB toolbar</td>
</tr>
<tr>
<td>11</td>
<td>AWB menu</td>
</tr>
<tr>
<td>12</td>
<td>Title bar displaying name of selected wizard</td>
</tr>
</tbody>
</table>

Table D-4  Important Activation Actions

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder icon]</td>
<td>Opens a wizard’s file set in AWB.</td>
</tr>
<tr>
<td>![Plus icon]</td>
<td>Imports a wizard (pages and activation XML files) from a local machine into AWB.</td>
</tr>
<tr>
<td>![Folder icon]</td>
<td>Exports a wizard (pages and activation XML files) from the AWB to your local machine.</td>
</tr>
<tr>
<td>![Validate icon]</td>
<td>Validates the current wizard’s definition.</td>
</tr>
<tr>
<td>![Preview icon]</td>
<td>Previews the XML of the current wizard.</td>
</tr>
<tr>
<td>![Download icon]</td>
<td>Downloads a wizard’s files from the gateway.</td>
</tr>
<tr>
<td>![Upload icon]</td>
<td>Uploads the current wizard’s files to the gateway and adds it to Prime Network Vision’s Activation menu.</td>
</tr>
<tr>
<td>![Manage icon]</td>
<td>Manages the wizard properties and directory.</td>
</tr>
<tr>
<td>![Refresh icon]</td>
<td>Synchronizes a wizard with a workflow that has been updated.</td>
</tr>
</tbody>
</table>

Steps for Creating an Activation Wizard

**Note**
The Activation and Workflow features are only available in upgrades to Prime Network 4.0. Because Workflow and Activation will be deprecated in the future, you should use Transaction Manager instead.

These steps describe how to create an activation wizard.
creating a new activation wizard

use the following procedure to create new prime network activation wizards. this procedure requires at least one workflow that is stored on the gateway.

**tip**

a best practice is to create a wizard design plan based on the workflow attributes. it will make the wizard creation process much simpler.

**note**

the cisco developer network (cdn) has some scripts that you can use as examples for using the framework. other activation scripts are only available through cisco advanced services.

**step 1**

verify that a workflow is stored on the gateway. (the workflow must be based on an activation workflow template—that is, the workflow must have been created using file > new activation workflow).

**step 2**

launch the awb.

if prime network is installed as a standalone product, launch the awb as follows:

a. go to http://gateway-ip:6080/ana/services/install/install/webstart.html

b. click cisco prime network activation wizard builder.
If Prime Network is installed in suite mode with Cisco Prime Central, launch Workflow by selecting **Tools > Activation Wizard** in the Prime Network Vision GUI client.

The workflows on the gateway are loaded into the Workflows area in the AWB window.

**Step 3**
Right-click the workflow and choose **Create Wizard**. AWB retrieves the workflow attributes and places them in the Unassigned Workflow Attributes area. These attributes define attributes appearance and behavior in the wizard. The first screen (Page1) is displayed in the screen area.

**Step 4**
Complete the attributes for the first screen.

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Read-only attribute name.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Attribute display name in wizard.</td>
</tr>
</tbody>
</table>
| Type | Attribute type. Note the following:  
- **Macro**—Populated based on a macro that is supplied with Prime Network or you create.  
- **Combo**—Creates a drop-down list of values (combo box).  
- **IMO Property**—Allows selection of an object in the Prime Network Vision GUI. |
| Initialization | Attribute initialization sequence, determined by the Type. |
| Macro |  
- **Macro Config**—List of available macros.  
- **Macro Parameters**—Lists attributes that can be selected to use as macro inputs.  
- **Returns Single Value**—If checked, the macro always returns a single value. The wizard field is a text box (not a combo box).  
- **Enable Default Value**—If checked, populates the value with the default value defined in Carry Over From Previous Iteration or Default Value Box fields.  
- **Carry Over From Previous Iteration**—If checked and wizard loops exist, initializes the attribute with value entered in the first loop. If not checked, enter the default value in box. |
| Combo |  
- **ID/Value**—Combo ID and values.  
- **Enable Default Value**—If checked, populates the value with the default value defined in Carry Over From Previous Iteration or Default Value Box fields.  
- **Carry Over From Previous Iteration**—If checked and wizard loops exist, initializes the attribute with value entered in the first loop. If not checked, enter the default value in box. |
| IMO Property |  
- **IMO Type**—Prime Network Information Model Object name.  
- **Depth and Property Name**—IMO type property to be retrieved.  
- **Macro Name**—List of available macros  
- **Returns Single Value**—If checked, the macro always returns a single value. The wizard field will be a text box and not a combo box.  
- **Parameter Mapped To**—Parameters that will be provided to the macro.  
- **Enable Default Value**—If checked, populates the value with the default value defined in Carry Over From Previous Iteration or Default Value Box fields.  
- **Carry Over From Previous Iteration**—If checked and wizard loops exist, initializes the attribute with value entered in the first loop. If not checked, enter the default value in box. |
| Required | Indicates whether the attribute is required. |
Repeat Step 4 for additional screens.

**Step 5**

If you want to add loops (iterative presentations of the wizard screens), complete the following steps.

a. Click the **Loops** tab. Figure D-12 shows the two Layer 3 VPN wizard loops. One loop consists of three pages (1,2,3) and the other contains one page (4). Both loops are required.

![AWB Loops Tab](image)

**Figure D-12 AWB Loops Tab**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validation</td>
<td>A regular expression that will be used to validate the operator entry. Examples include:</td>
</tr>
<tr>
<td></td>
<td>• [0]+(100[[1-9]][0-9][[1-9]]—Indicates any value between 0 and 999 is permitted.</td>
</tr>
<tr>
<td></td>
<td>• [Vv][Ii][Rr][Tt][Uu][Aa][Cc][Ee][Mm]([0-9]+)[1,][0-9]+—</td>
</tr>
<tr>
<td></td>
<td>Shows the specific characters and integers that are permitted.</td>
</tr>
<tr>
<td>ToolTip</td>
<td>Text displayed when user hovers the mouse over the attribute name.</td>
</tr>
<tr>
<td>Example</td>
<td>(If Type=String) Sample text for the attribute. This advises users of the permissible entry format. (The text appears in light gray and is removed as soon as the operator clicks the field.)</td>
</tr>
<tr>
<td>Shown When</td>
<td>If checked, the attribute field always appears in the wizard, even if it is disabled (normally not done).</td>
</tr>
<tr>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>Hidden</td>
<td>Never displays the attribute in the wizard. (Useful for unused parameters or to maintain compatibility with older workflows.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Loops tab</td>
<td></td>
</tr>
<tr>
<td>2 Loop actions</td>
<td></td>
</tr>
<tr>
<td>3 Loop attributes</td>
<td></td>
</tr>
</tbody>
</table>
b. Click **Add Loop**, then define the loop parameters.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>User-defined loop name. Double-click the cell to enter a name.</td>
</tr>
<tr>
<td>Screen</td>
<td>Designates the screens to be included in the loop.</td>
</tr>
<tr>
<td></td>
<td>1. Double-click the cell, then click the ellipsis [...] on the right side of the cell to display the Screens dialog box.</td>
</tr>
<tr>
<td></td>
<td>2. Choose the screens from the drop-down list for each Order number.</td>
</tr>
<tr>
<td></td>
<td>3. Click OK.</td>
</tr>
<tr>
<td>Iterations</td>
<td>Name of attribute that will collect the number of wizard iterations completed by operator when they launch wizard. (This value is passed to the workflow.)</td>
</tr>
<tr>
<td>Required</td>
<td>If checked, indicates the loop is required.</td>
</tr>
</tbody>
</table>

### Step 6

If you want to define attribute groups (attributes that will appear based on the values of another attribute), complete the following steps.

a. Click the **Groups** tab.

b. Click **Add Grouping**, and define the group parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>User-defined loop name. Double-click the cell to enter a name.</td>
</tr>
<tr>
<td>When</td>
<td>Read-only field used for a conditional display (defined in Any of the Values parameter).</td>
</tr>
<tr>
<td>Equal</td>
<td>Determines criteria for matching with Any of the Values field (defined in the Any of the Values parameter).</td>
</tr>
<tr>
<td>Any of the Values</td>
<td>Defines the parameters that cause the loop (per Name field) to appear:</td>
</tr>
<tr>
<td></td>
<td>1. Double-click the cell, then click the ellipsis on the right side of the cell.</td>
</tr>
<tr>
<td></td>
<td>2. In the Any of the Values dialog box, complete the following parameters:</td>
</tr>
<tr>
<td></td>
<td>- When Field—Determines the current attribute conditional display (attributes are defined in Screens tab).</td>
</tr>
<tr>
<td></td>
<td>- Equal To—If checked, group attributes will appear if the attribute value is equal to the value specified in ID/Value. (If unchecked, group attributes will appear if it is not equal.)</td>
</tr>
<tr>
<td></td>
<td>- ID/Value—Value the attribute must match (or not match) in order to be displayed.</td>
</tr>
<tr>
<td></td>
<td>3. Click OK.</td>
</tr>
</tbody>
</table>
Appendix D Creating Workflows and Wizards Using the Workflow Editor and Activation Features

Using the Activation Wizard Builder

Step 7 Validate the wizard by clicking **Wizard > Validate Wizard**. The validation command checks the wizard’s internal model, screens, groups, loops, and XML. If an error occurs, an explanatory message is displayed.

Step 8 Save the wizard to the gateway by clicking **Wizard > Upload to Gateway**. See Adding an Activation Wizard to Prime Network Vision, page D-29.

After you upload the wizard to the gateway, you can make it available to users in Prime Network Vision.

Adding an Activation Wizard to Prime Network Vision

This procedure uploads a wizard to the gateway and identifies how the wizard will appear in the Activation menu in Prime Network Vision.

Once you add an activation, only users with Administrator privileges can delete activations and activation templates from the Prime Network Administrator GUI client. Executed activations are automatically purged from the Prime Network database according to the purging settings set by the administrator. For more information, see the *Cisco Prime Network 4.0 Administrator Guide*.

To add an activation wizard to Prime Network Vision:

**Step 1** From the Wizard menu, choose **Upload to Gateway**. AWB performs a validation and displays the results.

**Step 2** In the Upload Wizard Metadata to Server window, expand the wizard directory to where you want to upload the wizard.

If you want to upload the wizard to a new directory or to a new wizard name, you must create the directory first.

a. To create a new category, click **Create Category**, enter the new category name in the Create New Category dialog box, then click **OK**. The new category appears in the Upload Wizard Metadata to Gateway.
b. To create a new wizard name, click **Create Wizard**, enter the following wizard attributes in the Edit Wizard Properties dialog box.

- **Wizard Name**—Enter the new wizard name.
- **Comment**—Enter comments, if desired.
- **Version**—Enter a version number, if desired.

c. Click **OK**. The new category appears in the Upload Wizard Metadata to Gateway window.

*Figure D-13 Creating a New Wizard Category and Wizard in the Network AWB Directory*

Step 3

Highlight the wizard in the Upload Wizard Metadata to Gateway window and click **OK**.

If you selected a new wizard, the upload occurs immediately, and you will see an Upload successful message.

If you selected a wizard with a wizard already associated to it, the Upload Wizard Metadata to Gateway will ask you to choose an option (as shown in *Figure D-14*).
**Step 4** Make your choice and click **OK**. The wizard is uploaded and a confirmation is displayed.

**Step 5** Click **OK**. The wizard becomes immediately available from the Activation menu in the Prime Network Vision GUI client.

---

**Running an Activation and View the Results**

Activations can be run from the Prime Network Vision GUI client. When you run an activation, you may be prompted for your credentials, or Prime Network may display a warning message. These are global settings that are controlled from the Administration GUI client.

---

**Note**

The Cisco Developer Network (CDN) has some scripts that you can use as examples for using the framework. Other activation scripts are only available through Cisco Advanced Services.

---

**Step 1** From the Vision main menu, choose **Activation > Activation**. This opens a menu that lists the activations that the user can run, depending on their user access role.

**Step 2** Expand the tree and highlight the activation wizard you want to run, and click **Next**.

**Step 3** Enter all of the required data. You can only run activations on devices that are within your device scope.

**Step 4** Check your entries and preview your changes:

a. Click the User Input tab and check all of the values you entered.

b. Click the Preview Configuration tab, which displays and validates the CLI commands that will be run on the device. It also highlights any errors so that you can make corrections to your input.
Using the Activation Wizard Builder

Appendix D  Creating Workflows and Wizards Using the Workflow Editor and Activation Features

Creating Workflows and Customizing Wizards

Creating Workflows and Wizards Using the Workflow Editor and Activation Features

Using the Activation Wizard Builder

Step 5  Run the activation.

\begin{itemize}
  \item \textbf{Note} \hspace{0.5cm} If you are prompted to enter your credentials, they will be used for every subsequent execution of a command or activation in the same GUI client session. If you want to change the credentials, click \textit{Edit Credentials}.
\end{itemize}

Step 6  View the output:

\begin{itemize}
  \item \textbf{a.} Select the activation in the Activation History window, right-click and choose \textbf{Show Output}. The information presented is similar to the data displayed in \textbf{Step 4} except it reflects the real runtime results.
    \begin{itemize}
      \item Workflow Output—The sequence of commands that were run on the devices.
      \item CLI Output—The actual CLI commands that were executed for the selected activation (for activations with an \textbf{Add} operation and a \textbf{Done} state).
    \end{itemize}
  \item \textbf{b.} If you want to view the output at a later time, export the activation to a local drive by clicking \textbf{Export to File}. We recommend that you do not change the file type.
\end{itemize}

Synchronizing the Wizard and a Workflow When a Workflow is Modified

If you update a workflow template that is called by a wizard, you must synchronize the wizard with the updated template using the following procedure.

Step 1  Verify that the updated workflow template has been deployed to the gateway (using Prime Network Workflow).

Step 2  From the Wizard menu, choose \textbf{Download from Gateway}.

Step 3  In the Download Wizard Metadata from Gateway dialog box, expand the wizard tree, choose the wizard you want to download and click \textbf{OK}.

Step 4  After the wizard is downloaded to the AWB, from the Wizard menu, choose \textbf{Sync with Workflow}. The Wizard and Workflow Synchronization window displays the changes between the workflow and the wizard.

Step 5  When the AWB discovers the changes, it will display a dialog box asking for confirmation to merge the changes. Click \textbf{Yes} and \textbf{OK} to merge the workflow changes into the wizard.

Step 6  After the changes are merged, define the merged items. (Use the same instructions that are described in \textit{Creating a New Activation Wizard}, page D-25.)

Step 7  Validate the wizard by clicking \textbf{Wizard > Validate Wizard}. The validation command checks the wizard’s internal model, screens, groups, loops, and XML. If an error occurs, an explanatory message is displayed.

Step 8  Save the wizard to the gateway by clicking \textbf{Wizard > Upload to Gateway}.

Step 9  In Upload Wizard Metadata to Gateway, choose the overwrite option to update the old workflow template with the new workflow template’s settings.

Step 10 Test the wizard from Prime Network Vision.
### Activation Wizard Builder

<table>
<thead>
<tr>
<th>GUI</th>
<th>D-23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loops tab</td>
<td>D-27</td>
</tr>
<tr>
<td>Overview</td>
<td>D-23</td>
</tr>
<tr>
<td>Prime Network support for</td>
<td>D-22</td>
</tr>
<tr>
<td>See also Transaction Manager</td>
<td></td>
</tr>
</tbody>
</table>

### Command Builder

<table>
<thead>
<tr>
<th>BeanShell commands</th>
<th>C-11</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP examples</td>
<td>C-13</td>
</tr>
<tr>
<td>Telnet examples</td>
<td>C-12</td>
</tr>
<tr>
<td>Command Builder window</td>
<td>4-20</td>
</tr>
<tr>
<td>Command Manager, compared</td>
<td>4-1</td>
</tr>
<tr>
<td>Command scripts, creating</td>
<td>4-19</td>
</tr>
<tr>
<td>Create a command</td>
<td>4-22</td>
</tr>
<tr>
<td>Define user input parameters</td>
<td>4-23</td>
</tr>
<tr>
<td>Delete commands</td>
<td>4-37</td>
</tr>
<tr>
<td>Execute commands</td>
<td>4-33</td>
</tr>
<tr>
<td>Export commands</td>
<td>4-36</td>
</tr>
<tr>
<td>Import commands</td>
<td>4-36</td>
</tr>
<tr>
<td>Macro Language</td>
<td>C-1</td>
</tr>
<tr>
<td>Overview</td>
<td>4-19</td>
</tr>
</tbody>
</table>

### Command Manager

| and global Prime Network settings | 4-2 |
| Command Builder, compared         | 4-1 |
| Command Manager window            | 4-5 |
| Commands, create                  | 4-7, 4-8 |
| Basic properties                  | 4-8 |
| Execution parameters              | 4-9 |
| Implementations (scripts)         | 4-11 |
| Command sequences, create         | 4-7, 4-14 |
| Delete commands                   | 4-18 |
| Jobs                              | |
| Control                           | 4-17 |
| Results                           | 4-15 |
| Move, import, export commands     | 4-17 |
| Overview                          | 4-3, 4-4 |
| Packages                          | |
| Create                            | 4-7 |
| Delete                            | 4-18 |
| Move                              | 4-17 |
| Repository                        | 4-5 |
| Testing commands                  | 4-15 |
| Use file input for command        | 4-16 |

### Devices

| New, add support for (VCB) | 3-6, 3-9 |
| Software versions, add support for (VCB) | 3-11 |
Index

E

events 7-1
  customize 6-12
  delete 6-14
  drop an event using VCB 6-12
  enable support for unsupported flapping 6-4
  restore a dropped event 6-13
  subtype, change severity 6-12
  syslog, enable custom 6-7
  test event customizations 3-22
  traps, support new 6-2
external launch points
  add to GUI 8-3
  delete 8-10
  overview 8-1

F

file input, using for commands (Command Manager) 4-16
flapping events 6-1, 6-7

G

genericUVNE template B-57

M

Macro Language C-1
  built-in parameters C-4
  formats for IP subnet parameters C-4
  properties C-2
  script example C-8
  script parameters C-2
  supported pragmas C-4
  user-defined parameters C-3

modules
  add support for pluggable 3-13, B-25
  add support for standard 3-12, B-18
templates 3-12

O

overview of customization tools 1-1

P

parsing rules
  for soft properties 2-5, A-1
  for syslogs 6-7
    groups inheritance structure 6-11
publishing soft properties 2-14

R

registry, view VCB customizations in 3-25

S

Soft Properties
  create threshold crossing alarms (TCAs) 7-1
  general parameters 2-4
  operators A-1
  overview 2-1
  parsing rules 2-5, A-1
  publish 2-14
    supported regular expressions A-3
    Table 2-11
software, add support for device (VCB) 3-11
syslogs, adding support for 6-7
**T**

Tabular soft properties  2-11
TCAs, create  7-1
Threshold Crossing Alarm, see TCA

Transaction Manager
   execute transactions  5-5
   import transactions  5-5
   jobs, finding and controlling  5-6
   overview  5-1, 5-3
   searching for executed transactions  5-6
   setup tasks  5-2
   test transactions  5-5
   Transaction Manager window  5-3
   XDE SDK and  5-4
   traps
      enable support for unsupported  6-2
      MIB, add from  6-2
      parsing rules  6-2
   triggers for TCAs  7-2

**U**

U-VNE
   CLI for adding and managing  B-3
   create  3-6
      cloning, by  3-8
      genericUVNE template, using  3-7
   definition  3-4
   templates  B-56
   test  3-15

**V**

VCB
   accessing  3-2
   add new device type  3-9
   add support for custom syslog  6-7
   add support for new events  6-1
   add support for pluggable module  3-13
   add support for standard module  3-12
   change severity of event-subtype  6-12
   CLI. See also VCB CLI
   customize events  6-12
   delete user-defined events  6-14
   deploy customizations to production  3-24
   drop event  6-12
   export customizations  3-27
   GUI vs. CLI  3-2
   import registry customizations  3-27
   templates
      events  B-80
      genericUVNE  B-57
      modules  B-65
      U-VNE  B-56
   test customizations  3-14
   troubleshoot customizations  3-23
   vcb sitechanges command  B-1
   view registry changes  3-25
   See also U-VNE

VNE Customization Builder, see VCB

VNEs, types (VCB)
   comparison of  3-4
   developed  3-3
   Generic SNMP  3-4
   U-VNE  3-4
Workflow

history \textbf{D-18}
overview \textbf{D-2}
Prime Network support for \textbf{D-2}
tasks. See workflow tasks
toolbar \textbf{D-2}
window \textbf{D-2}
See also Transaction Manager
workflow
templates. See workflow templates
workflow tasks
activation tokenizer \textbf{D-13}
execute BQL \textbf{D-8}
lock and unlock \textbf{D-12}
subflow task \textbf{D-12}
workflow call task \textbf{D-10}
See also Transaction Manager
workflow templates
attributes \textbf{D-13}
create \textbf{D-5}
run a workflow \textbf{D-15}
See also Transaction Manager

XDE SDK and Transaction Manager \textbf{5-4}